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Chapter 1 - Introduction What is Ham Radio Deluxe?

1 Introduction

What is Ham Radio Deluxe?

Ham Radio Deluxe (HRD) is an integrated suite of software products for amateur
radio. The five modules in the suite provide rig control, logging, digital communi-
cations, satellite tracking, and rotator control.

Rig Control Ham Radio Deluxe Rig Control provides rig control through a richly featured full
screen interface and other products in the Ham Radio Deluxe Suite via a direct
connection or TCP/IP remote access.

Logbook Ham Radio Deluxe Logbook provides QSO logging, DX cluster connectivity,
callsign lookup, awards tracking (with integration to LoTW, eQSL, and Ham
Radio Deluxelog.net), and contesting. Microsoft Access and MySQL are support
with strong features for backup and recovery.

Digital Master DM-780 provides most popular sound card digital modes with direct integration

(DM-780) to Ham Radio Deluxe Logbook.

Satellite Ham Radio Deluxe Satellite Tracking provides satellite operations with rig con-

Tracking trol and Google Earth integration.

Rotator Ham Radio Deluxe Rotator provides control for 15 popular models of antenna
rotators.

How It All Began

In early 2003 Peter PH1PH and Simon HB9DRYV talked about developing a sim-
ple program to control the soon to be released [ICOM IC-703.

Maybe it was the beer, maybe the desire to give something back to the radio ama-
teur community, however on June 6th, 2003 the first line of code was written,
Ham Radio Deluxe (Ham Radio Deluxe) was born.

By late 2005 the number of registered users stood at 20,006 — quite an achieve-
ment in such a short time.

This Guide

If you are only going to read one more section, then now go to Getting Started.

Please report errors and omissions to nOzrd(at)mnyarc.org or in the Ham Radio
Deluxe forums

http://forums.hrdsoftwarellc.com.

When you get there, select Headquarters>Documentaton.

As this guide matures further it may flow differently than it currently does. Please
check the table of contents for the new evolving layout. Note that this document
has some sections that are still in DRAFT mode which means that it can have lots
of old or wrong information.

Ham Radio Deluxe 1
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System Requirements

Computer

Ham Radio Deluxe is designed for Windows XP/SP3, Vista and Windows 7 or 8),
also Internet Explorer 6.0 (or higher) is required. Most modules will work on
Windows 2000. Digital Master 780 does not, however, work with Windows 2000.
The policy is to support Windows versions which are supported by Microsoft.

There are no plans for a LINUX or Macintosh native version, Ham Radio Deluxe
1s known to run under Wine for LINUX and PC emulators for the Macintosh.

The suggested minimum computer specification is:

Windows XP/SP3

Ham Radio Deluxe 500 MHz
Processor |DM780 1 GHz
HRD Logbook 500 MHz
Ham Radio Deluxe 1 GB
Memory |DM780 2 GB?
HRD Logbook 2GB
. Ham Radio Deluxe 20 MB
Hard Drive IVer OMB
Storage  RD Togbook 20 MB
Color Display 1024 x768 minimum 1280 x 1024 preferred

a. DM780 uses more resources than Ham Radio Deluxe when
decoding many signals simultaneously.

Windows Vista

Ham Radio Deluxe 2 GHz
Processor |DM780 2.4 GHz
HRD Logbook 2 GHz
Ham Radio Deluxe 3GB
Memory DM?780 3 GB
HRD Logbook 3GB
. Ham Radio Deluxe 20 MB
ngd Drive 80 50MB
torage I FRD Logbook 20 MB
Color Display 1024 x768 minimum 1280 x 1024 preferred

Windows 7/8 32 bit

Ham Radio Deluxe 2.4 GHz
Processor |[DM780 2.8 GHz Dual Core
HRD Logbook 2.4 MHz
Ham Radio Deluxe 4 GB
Memory |DM780 4GB
HRD Logbook 4 GB
. Ham Radio Deluxe 20 MB
Hard Drive DM7R0 SOMB
Storage  RB Togbook 20 MB
Color Display 1280 x1024 minimum {1920 x 1080 preferred

Ham Radio Deluxe
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Supported
Radios

Internet_
Connection

Radio
Interfacing

Ham Radio Deluxe

System Requirements

Windows 7/8 64 bit

Same requirements as 32 bit operating system EXCEPT double the memory to 6
GB.

Other Software
In addition, you will need the following free software for viewing demos and user

documentation.

¢ Adobe Reader 9 or newer
* Adobe Flash Version 11 or newer

If you do not have them, they can be downloaded from the Adobe website at:
http://eet.adobe.com/reader/ and http://eet.adobe.com/flashplayer/

You don“t need a radio — Ham Radio Deluxe comes with built-in Dem-o-matic
radio support (FTDX-5000, FTDX-9000, FT-450, FT-950, FT-2000, K2, Orion,
TS-480, TS-570, TS-590 and TS-2000).

Ham Radio Deluxe currently supports these ‘real’ radios:

e Alinco: DX-77, SR8, SR9

o Elecraft: K2, K3, KX3

* FlexRadio: PowerSDR

e ICOM:1C-31, IC-51, IC-5100, C-703, IC-706, IC-706MKII, IC-706 MKIIG,
1C-707,1C-718,1C-7200, IC-725,1C-726,1C-728, 1C-729, IC-7200, IC-735,
1C-736, IC-737,1C-738, IC-7400, IC-7410, IC-746, IC-746Pro, IC-751A,
IC-751A (Piexx), IC-756, IC-756Pro, IC-756Proll, IC-756Prolll, IC-761,
IC-765,1C-775DSP, IC-781, IC-821H, IC-7000, IC-7200, IC-7410, IC-7600,
IC-7700, IC-7800, I1C-9100,1C-910H, IC-R10, IC-R20, IC-R7000, IC-R75,
IC-R8500, IC-R9000, IC-R9500, PCR-1000

*  Kenwood: TS-50S, TS-60S, TS-140S, TS-4408S, TS-4508S, TS-480, TS-570,
TS-590, TS-680S, TS-690S, TS-790, TS-850, TS-870, TS-940S, TS-950,
TS-990, TS-2000, TS-B2000, R-5000

*  Microtelecom: Perseus

e  SDR-Radio: SDR-Radio

o Ten-Tec: TT-Argonaut, TT-Jupiter, TT-Pegasus, TT-Omni VII(Radio),
TT-Omni VII(Remote), TT-Orion, TT-Eagle, RX-350

*  Yaesu: FT-100, FT-450, FT-600, FT-767GX, FT-817, FT-840, FT-847,
FT-857, FT-890, FT-897, FT-900, FT-920, FT-950, FT-990, FT-1000D,
FT-1000MP MkV, FT-2000, FTDX-3000, FTDX-5000, FTDX-9000.

Not absolutely required but really is essential to fully utilize all the features. The
best connection is a full time connection such as cable or DSL. Registering the
program is much easier when done online.

Ham Radio Deluxe is designed to be used with one of the rigs listed above. Some
modules, however, can be used without a connection to a rig. Logging will work
but will not be as automated. Satellite tracking is still fun without a rig connected.
In fact, there are only a few of the above listed rigs that “really” work fully with
the satellite module.

Some of the rigs listed above do not fully avail themselves to all the features of
Ham Radio Deluxe. A number of the rigs do not provide Tx control easily. That is
the limit of the rig, not Ham Radio Deluxe.
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For CAT control, all radios require some sort of SERIAL connection between the
radio and the computer. Some of the newer model radios are equipped with a USB
port on the back of the radio. All that is needed there is a USB cable from the
radio to a USB port on the computer.

Other radios have a standard DB9 serial port on the back which either connects
directly to a DB9 Serial port connector on the back of the computer or through a
Serial/USB converter to a USB connector the computer, while others connect
from an ACC or DATA plug on the back of the radio through a Serial/USB con-
verter to the computer.

Many of these cables use the serial port. If you don’t have a serial port all is not
lost — USB serial converters are widely available. Also, there are options available
that are USB based.

One of these is HamLinkUSB from Timewave. This will allow rig control with
most of the radios listed above.

Note: If you need a Serial/USB converter be specially aware of the type of
chips and drivers that are in the converter you choose. We recommend
ONLY converters with FTDI or SI Labs chipsets and drivers. We have
found these to preform exceptionally well with HRD and other radio
related software.

Beware of Prolific chipsets and drivers. There are many of these on the
market which are counterfeit and the chipsets are of poor quality. The
drivers are also poorly written and will not work properly with HRD,
especially if trying to use them on a Windows 7 or 8 system.

Some of the problems you may experience with these chipsets and
drivers are system crashes, BSOD, program lock-ups, drivers won't
install properly, comports disappear for no reason, just to name a few.

If in doubt as to what you need to connect your radio to the computer
running Ham Radio Deluxe, contact support@hrdsoftwarellc.com or
Timewave either through their website at www.timewave.com or phone
them at 1-651-489-5080. They can provide you with cables and
connectors to meet your needs.

The future trend in radio control and interfacing is the USB connection. More and
more radios will only have USB ports and not Serial or Parallel ports. The USB
port will even pass audio as rig control with a few of the radios.

For the majority of the radios listed above, you will need to have a more robust
interface if you need to send or receive audio. The audio recorder and PSK31 are
two examples of this need.

For more interfacing information visit the Downloads page at http./www.ham-
radio-deluxe.com/ for A basic guide to CAT and Audio interfacing which contains
many designs for both CAT and audio interfaces for use with Ham Radio Deluxe.

Check out the cable and interface solutions from:

* Timewave hitp://www.timewave.com

o Tigertronics http.//www.tigertronics.com
e ZLP Electronics _http://g4zlp.ham-radio.ch/

Ham Radio Deluxe
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Public
Interfaces

Installation

¢ West Mountain Radio Attp.//www.westmountainradio.com/.

Other (non-Ham Radio Deluxe) programs are supported via a DDE interface (see
DDE Support) and a serial port (see 3rd-Party Programs).

Logbooks typically use these interfaces; for example - contest-oriented logbooks.

Installation

Introduction

Ham Radio
Deluxe

Ham Radio Deluxe

Ham Radio Deluxe is designed for Windows XP, Vista and Windows 7) and 8,
Internet Explorer 6.0 (or higher) is required. The policy is to support Windows
versions which are supported by Microsoft.

The Logbook uses MS Access by default or you can use MySQL, see Database
for more information.
Ham Radio Deluxe can be installed in under a minute. Special knowledge is not

needed — the kit does everything for you!

You will not need to reboot your computer, Ham Radio Deluxe does not update
your system files or change your system’s configuration in any way.

You may or may not see the following screen depending upon the update status of
your machine.

Ham Radio Deluxe - InstallShield Wizard _

mEw| Ham Radio Deluxe requires the following items to be installed on your computer. Click
Install to begin installing these requirements.

Status  Requirement
Pending Microsoft Visual C++ 2013 Redistributable Package (x86)

[ Install l ’ Cancel ]

You will see this or an updated version of this screen to get you started with the
installation.
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Ham Radio Deluxe > e

Installing Ham Radio Deluxe 6.2.3.241 Public BETA
21241

Copyright 2012-2074 HRD Software, LLC

Created, March 13, 20141300 UTC

Alwayes rernember to backup your data before

< Back [ Next » ] ’ Cancel ]

When you start the installation the first screen shows the release and build you are
installing.

Ham Radio Deluxe _ InstallShiel

License Agreement

Flease read the following license agreement carsfully.

IMPORTANT: Befare commencing using this Product, carefully read the following terms and
conditions which hawe been accepted by your company ("Licensee"). =

1. DISTRIBUTION. This Product may be distributed by HRD Software, LLC or its agents for use

by Radio Amateurs. It may notbe sold. The maximum charge allowed for the distribution medium
is $0.

2. GRANT OF LICENSE. HRD Software, LLC hereby grants to Licensee ("v'ou") and Y'ou accept

anonexclusive license ("License") to use the this Product delivered pursuant and subjectto this
Agreement.

You agree thatvou will not assign, sublicense or otherwise transfer your right under this

) | accept the terms aof the license agreement

(")l da not accept the terms of the license agreement

InstallShield

l < Back [ MNext > ] l Cancel l

You must accept the licensing conditions.

Ham Radio Deluxe
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Ham Radio Deluxe

Installation

De

Choose Destination Location

Select folder where setup will install files.

Setup will install Harm Radio Deluxe inthe following folder.

Toinstall tothis folder, click Mext To install to a diffterent falder, click Browse and select another
folder.

Ciestination Falder
Ch U AHRD Software LLCAHam Radio Deluxe

InstallShield

l < Back [ et > ] l Cancel l

Select the folder where Ham Radio Deluxe will be installed, the suggested default
is usually sufficient.

Ham Radio Deluxe - InstallShield Wiza_

Select Program Folder

Flease selecta program folder.

Setup will add program icons to the Program Folder listed below. *ou may tvpe a new folder name,
or select one from the existing folders list. Click Next to continue.

Program Folder:

Administrative Tools El
Adohe

Adobe LiveCyole ESZ

Adobe Production Premium C35.5

Adobe Technical Communication Suite 3

ASUS

Brather Administrator Ltilities

Brother HL-4040C0OMN il

InstallZhield

l < Back [ Nt > ] ’ Cancel l

Select the folder in the Start menu where the Ham Radio Deluxe entries will be
added, the suggested default is usually sufficient.
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'Ham Radio Deluxe - InstallShield Wizard

Ready to Install the Program

Thewizard is ready to begin installation.

Click Install to begin the installation.
If wou want to review or change any of your installation settings, click Back. Click Cancel to exit the
wizard.
InstallZhield
< Back I Install I [ Cancel

Click Install to start the installation.

Setup Status

Harn Radio Deluxe is configuring wour new software installation.

Installing

ChOAHRD Software LLCYHam Radio Deluxe\HamPadioDeluxe. exe

InstallShield

Canceal

The progress of the installation is shown while the software is being installed.

8 Ham Radio Deluxe
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InstallShield Wizard Complete

Ham Radio Deluxe Setup is almost complete.
Choose the options you want below,

Iwould like to start Ham Radio Deluxe.

Fress Finish to complete Ham Radio Deluxe Setup.

< Back Cancel

When the software has been installed select the programs to be started, then press

Finish.
First Steps
Product Registration
Activation Ham Radio Deluxe has an improved registration system. The following instruc-

tions should get you up and running without any problems.

When you first start Ham Radio Deluxe you will be presented with the following
welcome screen.

Ham Radio Del

Welcome o |
Ham Radio Deluxe Setup

Welcome to Ham Radio Deluxe!

Since this is your first ime using HRD. a full license needs to be obtained for your callsign
The purchase key (the 16 digit code) that you purchased and your callsign will be needed

Please click on [Next] when ready

< Back I Next > | Cancel |

Pressing Next at this screen will continue on with the registration process.

Ham Radio Deluxe 9
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Callsign
Setthe License Callsign

Please type in your Callsign.

Do NOT use any slashes or other formatting! Only use your primary calls

Chapter 1 - Introduction

T—Iam Radio Delux

i,
‘;!n;

ign.

Callsign: ||

Click on [Next] when finished.

1 This screen asks for your call sign. Enter ONLY your assigned call sign. DO

NOT enter any prefix such as KR6/N4XXX or modifiers li
After you have entered your call sign press Next.

Activation Key
Setthe Activation Key

Enter the 16 digit Activation Key that is either on the CD that you bought or that you received online from
HRD.

ke /P or /?.

'I_-Iam Radio Delux:

Activation Key: ||

Click on [Next] when finished.

e BN

Cancel |

2 Ifyou purchased Ham Radio Deluxe from a distributor and received a CD or

if you purchased online and were sent a key, here is where
character Main Activation Key. The activaton key may be ¢

you enter the 16
opied and pasted

from the e-mail you received to avoid any mistakes in entering. Just
highlight the entire purchase key in the e-mail, right click and select Copy.

Place your cursor in the first box of the above screen, right
Paste. Once the key is entered, press Next.

click and click

If you do not have a Activation Key and would like to continue with the 30-day

trial subscription, just press the Next button when you reac

h this screen.

Note: If you already have a registered subscription and are installing Ham

Radio Deluxe on a second computer or re-installing Ham
for any reason, entering your call sign in step 1 and just ¢

Radio Deluxe
licking next on

the above screen will also bring up the following screen. However, when
you click Finish it will automatically change to a full registered version.

Ham Radio Deluxe
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2
Confirm the Activation Key and Callsign

Your Callsign is:

NOZRD
With a

Free 30 Day Trial

Click on [Finish] if correct

Click on [Back] to change.

< Back I Finish I Cancel

If running the 30-day trial you will now see the above screen.

2
Confirm the Activation Key and Callsign

Your Callsign is:

N@ZRD

With the Activation Key:

X1Y2-CQ73-KIOD-4RGC

Click on [Finish] if correct.

Click on [Back] to change.

<Back I Finish I Cancel |

If you entered a activation key you will now see the above screen with your call-
sign and activation key. Just click the Finish button to continue to the next screen.

Ham Radio Deluxe 11
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License Manager

Ham Radio Deluxe

License Manager

Version 6.2

(2

The Support License is current.
Support Expires 12/6/2020.

Free Trial and Paid Support Options:
Phone 813-434-4650
email: support@hrdsoftwarellc.com
Tickets: http://tickets.hrdsoftwarellc.com

? N@ZRD

Subscription License Expires: 12/6/2020 (5.20)

Submit Activation Key Manually Add a License Remove Selected
License

| Continue ‘ Exit I

Those who have purchased the software with the support will see a screen like
this, showing your call sign, telling you that you have a Subscription License and
indicating the expiration date.

Those running the Trial version will show have their call sign, Trial Subscription
and an expiration date 30 days from the date installed on your computer. At this
screen, just click on the Continue button at the bottom of the screen to continue
on to the Rig Control setup screen.

If you have any problems or questions about the registration please contact sup-
port either by phone at (813) 434-4667 or send an e-mail to support@hrdsoft-
warellc.com

You can dive into Ham Radio Deluxe using a demo radio or your radio. A good
way to explore the program is with a demo radio first and then connect your rig.

Demo-o-matic Radio
Now that you have installed Ham Radio Deluxe you can try it out using a Dem-o-

matic radio. This is a reasonably accurate simulation of the real thing, designed
for use during presentations and while developing Ham Radio Deluxe when a
radio is not available (on the train, in a plane, in an airport, stuck in a hotel room
in Finland etc.).

From the Start menu select Programs > Ham Radio Deluxe. Once the splash
screen has closed you see the Connect window. If you do not have the correct con-
nection cable, select one of the Dem-0-matic radios so that you can open Ham
Radio Deluxe.

Ham Radio Deluxe
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Configuration
Options

Ham Radio Deluxe

First Steps

Dem-o-matic

The Dem-o-matic radios do not need cables — simply select Dem-0-matic in the
Company drop down, select an option in the Radio drop down, and then press
Connect.

New | Preset I Serial Ports I Help |

Campany: |® Dem-o-Matic® LJ Status

Radio:  [TS-2000: Demo

FT-2000: Demo
FT-450: Demao
FT-950: Demao
k2: Demo
Orion: Demo
T5-2000. Demo
TS-480: Demo
TS-570: Dema
T5-590: Demo

I il o= G

They are ideal for demonstrating Ham Radio Deluxe when you do not have a suit-
able radio available. It is also the only way that you can open Ham Radio Deluxe
if you do not have a supported radio or the correct connecting cable.

Your Radio
PLEASE DO SOME HOMEWORK!!! Read your radio's manual to find out

exactly how it is supposed to be connected to a computer for CAT control. Some
radios require special drivers to be loaded in the computer to access certain model
radios. These drivers can usually be downloaded from the manufacturers website.
All this information is in your radios user manual or from the radio's manufactur-
ers tech support system.

Please refer to See “Radio Interfacing” on page 3. to review the requirements for
Ham Radio Deluxe interfacing.

To connect your radio you will need to connect the necessary cables and install
drives if needed. You must also do some configuring within Ham Radio Deluxe.
This is usually a one time exercise.

Once you have all your cables in place it's time to turn on your radio, boot up your
computer and start Ham Radio Deluxe. The next screen you should see is the
radio connection setup screen. This is where you select your radio and set some
parameters to allow the Ham Radio Deluxe Rig Control software to connect to
your radio.

13
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The New Tab
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New | Preset | Serial Ports | Help |

Company:  |EEEE

Radio:  [Ts-2000

COMPort |COMS

Speed:  [19200
-

- Flow control f Interace power -

[v CTs [ DTR [+ RTS

| | Status |

Connect HRD Rig Contral,

—Auto Exit

Start HRD Rig Caontrol in [ H
L Full Screen mode r

[ Always connectto this radia whan starting

[ Ertire HRD Suite

—Auto Start-

[~ HRD Digital Master
[~ HRD Loghonok

[ HRD Raotator

[ HRD Satellite Track

Notice there are four tabs at the top of this display. The one currently showing is
the NEW tab. This is where you configure the setup for any new radio you want to
connect to the Ham Radio Deluxe software. We will continue with this setup in

the next section.

This is where you actually configure how Ham Radio Deluxe connects to your
radio. It also allows you to configure what modules Ham Radio Deluxe loads, by

default, on start-up.
The Preset Tab

New | Preset | Serial Ports | Help

Company Radio Port
@ Dem-o-Matic ® FT-2000: Demo None
ICOM 1C-7000 COM3
ICOM 1C-706MKkll COM3
Kenwood TS-2000 COMS
@ Dem-o-Matic ® TS-2000: Demo None
@ Dem-o-Matic® TS-480: Demo  None

X Remove

Speed| CI-V Address | CTS | DTR | RTS

0
19,200
19,200
19,200

0

0

70
4E

Connect r

Ham Radio Deluxe
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Once you have a radio configured properly and it starts from the NEW window,
the configuration is saved in the Preset page. As you can see here, there are sev-
eral radios configured both real ones and demo-o-matic ones.

Serial Ports Tab

MNew | Preset | Serial Ports |Help|

Port Manufacturer Location Description

"ZCOM1 (Standard port types) Intel(R) ICH10... Communications Port

"ZCOM3 Timewave Technology U232 USB to UART Bridge
"ZCOM4  Prolific Pralific USB-to-Serial Comm Port
"ZCOM5  Prolific Pralific USB-to-Serial Comm Port
"ZCOM6  Prolific Pralific USB-to-Serial Comm Port
ZFcom7? FTDI USB Serial Port

ZFcoms FTDI USB Serial Port

Refresh Show @ Allports Only ports connected to PC

-

Connect

The Serial Ports tab displays all the comports available on your computer. You
will notice just below the window near the center it has two radio buttons. One
says Show All ports and the other says Only ports connected to PC. These buttons
come in handy when you are trying to figure out which ports are actually being
used by the Ham Radio Deluxe Software and which are just available for use.

The Connection Process
Each radio must be on a different comm port from the computer. This allows you

to actually operate two or more radios at the same time and switch between them
with a couple clicks of the mouse. We will also show that in another section of this
manual.

If you have a radio configured in this screen which you no longer own or have
connected to Ham Radio Deluxe, you can easily remove it from the Presets by
clicking on the setup line in the display window, to highlight the unwanted config-
uration, and click on the "X Remove" located on the left just below the slider near
the left center of the dialog box.

Company
Select your radio manufacturer from the drop-down list. The Dem-o-Matic radios

do not require a COM port, they are for demonstrating Ham Radio Deluxe when
you do not have a suitable radio available.

FlexRadio: you must install the vCOM virtual serial port drivers from Philip Cov-
ington (N8VB). These are used to provide the connection between Ham Radio
Deluxe and the PowerSDR software that must be running before you try to create
the connection with Ham Radio Deluxe.

15
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Note: It seems that vCOM will not run on Vista/Windows 7 64bit because
the 64-bit version is very insistent on having signed drivers. A signed 64
bit versions might be available for a few dollars from VSPE. More
information is available from Attp.//www.flex- radio.com/, to install the

vCOM drivers see N§VB vCOM

New ‘ Preset | Serial Ports | Help |
Company.  |Kenwood Status
: DZ Company
Radio Elecraft
SO
FlexRadio
GO P hicrotelecom
Spead: SOR-RADIO
pes Ten-Tec
aesu
® Dem-o-Matic ®
Flow control { Interface power
[+ CT8 [~ DTR [+ RTS
Always connectto this raclio when starting
Connect I
HRD Rig Contral Auto Start
Auto Exit [ HRD Digital taster
r Start HRD Rig Contral in - [ HRD Loghook
Full Screen mode
| [~ HRD Rotator
| Entire HRD Suite [~ HRD Satellite Track

ICOM: disable the CI-V Transceive option for best performance.

Kenwood: make sure Packet communication mode is switched OFF (if sup-
ported). Most Kenwood radios require CTS and RTS to be ON for flow control.

Radio
Select your radio model from the drop-down list.

Ham Radio Deluxe
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New | Preset | Serial Ports | Help ‘

Company: |® Dern-o-Matic & ﬂ | Status |

Radio:  |TS-2000: Demo

FT-2000: Demo
FT-450: Demo
FT-350: Demo
K2: Demo
Orion: Demo

T5-480: Demo
T5-570: Demo
T5-690: Demo

[HErs [hTrR IR

Chirea [~ Always connectto this radia whan starting

HRD Rig Contral. -Auto Start-

Auto Exit || [~ HRD Digital Master
— Start HRD Rig Contral in [~ HRD Digital kaster [~ HRD Loghaoaok
[~ HRD Rotatar
[~ HRD Satellite Track

Full Screen mode [~ HEL

[ Entire HRD Suite

MNew | Preset | Serial Ports | Help ‘

Company: ,m Status
Radio: R-5000 =

COM Port:

Speed

Flowr cantrg

[+ cTs [Remate

Always connect to this radio when starting
Connect r .
HRD Rig Contral. ] Auto Start
Auto Exit [ HRD Digital Master
r Start HRD Rig Contral in = [~ HRD Laoghaok
Full Screen mode
= [~ HRD Rotator

[ Entire HRD Suite [~ HRD Satellits Track

First Steps

If your radio does not appear in this drop-down list there is a chance it can be sup-
ported by the commands of a different model from the same manufacturer. Con-
tact HRD Support or the manufacturer of your radio for information on about
compatibility with another models firmware CAT command set.

COM Port

The COM port on this computer where you have connected the radio interface
cable. Make sure that you do not have other programs using the same port, for
example mobile phones and personal organizers. It is recommended you NOT use
the Auto-Detect. The Auto-Detect can sometimes fail to detect the port. To see the
COM ports on your computer select the Serial Port tab to see a display.

17
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Speed

The speed used for communicating with the radio, check the speed setting via the
radio's configuration menu. Again, it’s not recommended to use the Auto-Detect.
Also remember that “FASTER IS NOT ALWAYS BETTER”. Sometimes faster
speeds can cause timing problems when sending commands back and forth
between Ham Radio Deluxe and the radio. The important thing is that you set the
speed in Ham Radio Deluxe and the port speed in the radio the same. Check your
radio manual to find out how to set the com port speed. A 4800 baud connect
speed is normally plenty fast enough to support most radios.

CIl-V Address

ICOM only: the address assigned to the radio, consult the radio's documentation
for the default address. This can also be configured via the radio's configuration
menu.

CTS
Enables the CTS flow control, required for Kenwood radios.

DTR

Enables the DTR line when the COM Port is opened and leaves it on, usually to
provide power for an interface cable. For Yaesu CT-62 and ICOM CT-17 inter-
faces this can be left unchecked (off).

RTS

Enables the RTS line when the COM Port is opened and leaves it on, usually to
provide power for an interface cable. For Yaesu CT-62 and ICOM CT-17 inter-
faces this can be left unchecked (off).

Next, put a check in the boxes for DTR and RTS. Some radios don’t require both
of these settings checked so they can be unchecked if there is a failure to connect
to the radio.

Note: If you will be connecting more than one radio to Ham Radio Deluxe
and you would like the current one to be the default radio, place a check
in the box where it says “Always connect to this radio when starting
HRD Rig Control”.

Connecting
Press Connect to connect to the radio. If you see the error below then the COM

port is currently held open by another program or the radio is not turned on.

Errar - —— o

6 IC-7000, COM3, 19200, Access s denied.
Make sure your radio is switched on and not in memorny mode.

If you are using a hamemade/non-standard cable you may need
to select RTS and/or DTR.

|
aK |

Check that you have not started another radio control program. Other culprits are
PDA and mobile phone connections. Even if you have disconnected a device from
a COM port you must make sure that the software is no longer running.

Ham Radio Deluxe
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Ilcom CI-V
Details

Ham Radio Deluxe

First Steps

Once connected Ham Radio Deluxe reads the radio’s frequency to ensure that the
options you selected are correct. If you see the error below then Ham Radio
Deluxe failed to read the radio’s frequency:

Error - _—— ﬁh

Q IC-7000, COMS3, 19200, Failed to read frequency
Make sure your radio is switched on and not in memaory mode.
| It you are using a homemade/non-standard cable you may need
to select RTS andfor DTR.
ok ||
|

If Ham Radio Deluxe can read the frequency the Connect window is replaced
with the main radio display — you are now using Ham Radio Deluxe!

If Ham Radio Deluxe cannot read the frequency then check:

» Correct COM port is selected,

* Speed on radio is the same as the speed selected in Ham Radio Deluxe,

*  Your cable — you may have a NULL modem cable when a normal serial
cable is needed,

* (Cable is connected correctly to your PC (you may have more than one COM
port),

* DTR/RTS are selected if required to power an active cable such as CT-62
or a cable from third-party provider.

If you still can’t get started refer to:

¢ Command Tester, and
e Portmon.

Icom's CI-V Protocol
ICOM's CI-V protocol is based on a relatively simple bi-directional, single-wire

TTL level signaling system. The single wire consists of a communications line
(DATA) and a ground reference (GND). The DATA line is held high when there is
no traffic. As long as the DATA line is high, any device can initiate communica-
tion by pulling the line low and sending the Icom attention command (FEFE).
When the line goes low, the other devices see this as a BUSY indication, allowing
the single DATA line to offer some amount of basic flow control. Multiple devices
may connected across the CI-V port in parallel, as long as each device is set up
with a unique hex address. All in all, it's quite elegant in it's simplicity.

Default Icom CI-V Addresses
Each Icom model has it's own, distinct default address. As a general rule, [com

used only even addresses ($02, $04, $06 ...). Each model was given a new default
address when it came out. The user can change the default address if required. On
older rigs this was done by (re-) soldering some diodes, on newer rigs the adress
can be changed by setup through the front panel or even by CI-V commands.
Addresses can be selected from $01 to $EF, giving 239 distinct addresses. The
following is a nearly complete table of all known addresses from CI-V capable
rigs, not only by Icom.
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Icom Model |Addr |Memories|Band Edge Type

IC-271 $20 (32 1,2 VHF All mode

IC-275 $10 |99+3 P1,P2 VHF All mode

IC-375 $12 |99+3 P1, P2 220MHz All mode

IC-471 $22 (32 1,2 UHF All mode

IC-475 $14  |99+3 P1,P2 UHF All mode

IC-575 $16  |99+2 P1,P2 10m & 6m All mode
IC-7000 $70 |500+2 6 HF/VHF/UHF All mode
IC-703 $68  [99+2 P1, P2 HF All mode QRP

IC-706 $48  199+3 P1, P2 HF/VHF All mode
IC-706MKII |$4E |99+3 P1, P2 HE/VHF All mode
IC-706MKIIG |$58 |99+3 P1, P2 HF/VHF/UHF All mode
IC-707 $3e |? ? HF All mode

IC-718 $5E  |99+2 ? HF All mode

IC-7200 $76 200 P1,P2 HF All mode

IC-725 § 28 26 25,26 HF All mode

IC-726 $30 |24+2 P1, P2 HF/6m All mode

IC-728 $38 |26 25,26 HF All mode

IC-729 $3A |26 25,26 HF/6m All mode

IC-735 $04 (12 11,12 HF All mode

IC-736 $40 |? ? HF/6m All mode

1C-737 $3C |99+3 P1, P2 HF All mode

IC-738 $44 |2 ? HF All mode

IC-7400 $66 |99+2 P1, P2 HF/VHF All mode
(IC-746Pro)

IC-746 $56 |99+2 P1, P2 HF/VHF All mode
IC-751A $1C (32 1,2 HF All mode

IC-756 $50 |99+2 P1, P2 HF/6m All mode
IC-756Pro $5C |99+2 P1, P2 HF/6m All mode
IC-756Proll  |$64 |99+2 P1, P2 HF/6m All mode
IC-756Prolll |$6e |99+2 P1, P2 HF/6m All mode

IC-761 $1E |? P1, P2 HF All mode

IC-765 $2C |99+2 P1, P2 HF All mode

IC-775 $46 |99+2 P1, P2 HF All mode

IC-7700 $74 1100 P1, P2 HF All mode Contest
IC-78 $62 |? ? HF All mode

IC-7800 $6A (99 P1, P2 HF All mode

IC-781 $26 |99+2 P1, P2 HF All mode

IC-820 $42  [2x80+3 |P1,P2 VHEF/UHF All mode
IC-821 $4C [2x80+3 |P1,P2 VHF/UHF All mode
IC-910 $60 [2x100+1(2x6 VHF/UHF All mode
1C-970 $2E  |99+3 P1, P2 VHF/UHF All mode
IC-1271 $24 (32 1,2 SHF

IC-1275 $18 |32+3 P1, P2 SHF

I1C-X3 ? P1, P2 Commercial HF Transceiver
IC-R10 $52 |? ? Handheld scanner

IC-R20 $6C |1000+200 |50 Handheld scanner

IC-R71 $1A (32 ? General Coverage Receiver
IC-R72 $32  [101 ? General Coverage Receiver
IC-R75 $5A (100 P1, P2 General Coverage Receiver
IC-R7000 $08 |? ? General Coverage Receiver
IC-R7100 $34 199 10xP1,P2 General Coverage Receiver
IC-R8500 $4A (800 n/a General Coverage Receiver

Ham Radio Deluxe
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What's Next

Type
General Coverage Receiver
General Coverage Receiver

Icom Model |Addr |Memories|Band Edge
IC-R9000 $2A (99 10xP1, P2

IC-R9500 $72 (1000 Auto: 100, Skip: 100,
Scanedge: 20

Organized by Category, |Handheld Scanner
Group etc.

IC-RX7 $78 1600

What's Next

Appearance

It is time to play a little Ham Radio Deluxe to see what it does. Even if you can
connect to a radio, let’s start by connecting to a Kenwood TS-2000 through Dem-
o-matic.

You should now have something that looks like the display below. The Rig Con-
trol Display (GUI) is a generic representation of an HF radio's front panel. It con-
tains most of the operating functions and controls of the actual radio it is
connected to. This display does not in any way and can not be made to actually
depict the front control panel of your actual radio.

Below is a screen shot of the Rig Control Display representing a Kenwood TS-
2000 all band, all mode radio.

O P @ -
T5-2000: Demo %

Main busy —_—

Memory: 123 =6

TX-B

14.000

AP gain (main) 20
Squelch (main): 0
DSP low cut: 0 Hz.

Bandscope

File Edit View Bands Favorites Quick Save Macros Logbook Radio Options Scanning Tuning Tools Voice Window Help

&% I @

Full Screen Luglmok Satellites SW Data

Connect Selection Favorite Quick Save

Scanning VFOB  CH-

1

- el 5 1
B &£ v B S w =
Sliders Customlze Options Forums Add . Satellites Logbook Rotator Display DM780 .

Auto Comp Fine
BC Ctrl-M MBC

Band+ | CulS | NB

"Band- | DCS NR 1 | implex
NR 2 c | Various

Notch

142 -l-l

ALT BSP 160m 75m 60m 40m 20m 17m 15m 12m 10m

AR gain (sub): 10 RF gain: 25 RF-power 1

Squelch (sub) 0 Mic gain= 19 AGC constant: 1

DSP high cut: 1400 Hz Noise blanker: 0 Noise reduction: 0

¢
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Chapter 1 - Introduction

This is the default appearance for Ham Radio Deluxe. For the sake of quality doc-
umentation we will change the appearance to LCD which is a reverse of what we
Nnow see.

Multiple Radios
HRD has the capabilities to display an operate multiple radios from one screen. In

the image below we see a Kenwood TS-480 displayed and controlled by the top
pane while a Kenwood TS-2000 is being displayed and operated from the bottom
pane.

Each radio can be accessed and operated with just a few clicks of the mouse but-
ton.

HamRadioDeluxe

| —— - =

File Edit View Bands Favorites QuickSave Macros Logbook Radio Options Scanning Tuning Tools Voice Window Help

</

Connect Selection

Favar;te Quick Save

Full Screen Logbook Satellites SW Data

] > Lt .
B A w B S w @
Sliders | Customize Options Forums . Add . = Satellites Logbook Rotator Display DM780 .

£ TS-480: Demo

" vrFoa

VFO B

" 1000Hz Ant 2 Menu A Nar 2

1500Hz BC1 MenuB | Norm
i 2210Hz c2 ! re

] L} .
- CTC; roc

Scanning
Filter:

Memory: 1-23

VFOA

VFO B CH-

CTA

"m™-B

Comp
Ctr-M Y
i

Ctrl-5

Notch Sub-RX

160m - 10m

0 142
ALT BSP 75m 60m 40m 0m 20m 17m 15m n Om

Each radio must have it's own dedicated comport on the computer. It can be either
through USB/Serial connections or you can have a multi-port serial card installed
in your desktop.

To configure your setup for multiple radios, once you have your first radio
installed and connected via the connection manager, adding a second or third
radio is quite simple.

In the main Rig Control screen of the first radio installed either click on Files >
Connect or click on the icon that has the round green circle with the white arrow
in it. This brings up the Radio Connection screen that you have seen before when
you set up your first radio.

Ham Radio Deluxe
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In this screen you configure the second radio, just like you did for your first in the
initial setup of Ham Radio Deluxe. You select the Manufacturer, the radio model,
the comport and the comport speed. You also select the flow control used to com-
municate with this second radio.

Note: Make sure you don't have a check mark in the Always connect to this
radio when starting HRD Rig Control. This will allow you to select
which radio you would like to connect to first.

Click on the Connect button to allow Ham Radio Deluxe to connect to and control
this second radio. Once in the Rig Control screen you can click on the Windows
menu option and select with radio window to display or configure the display to
show both radios in the same window, as we did earlier in this section.

After you shut Ham Radio Deluxe down, and restart it, when the Connection win-
dow opens, select the Preset tab on the window. This shows you the radios you
have connected to your computer and allows you to select which radio you would
like to start first.

To change the appearance:

& Customize Layout ‘

1IET ANnA - SR,

SChemEgaycutl Buttons I Faceplate I Frequencyl Meters I Sliders: Appearance I Sliders: Layou‘tl Tuning Dial‘

(S

‘ Your Ham Radio Deluxe schemes and settings are stored in:
C\Users\ghanson APT TRAINING\AppData\Roaming\Simon Brown. HBSDRVIHam Radio Deluxe)

Defaults Schemes
TRl AKIG Peter's Persuasion
@  Scheme#l Army Surplus Plastic Blue
T | Danielle's Amberglow Plastic Green
° Schemed Danielle's Elues Plastic Kahki

Danielle's Borgcube
Danielle's K2
Danielle's Liguorice
Danielle's Redeye
Danielle's Ultraviolet
Danielle's ts-2000
Danielle's ts-480
‘ Dark

[ Save to File J Default

Ginger

Grey Scale
Greyfriars

\ 46 Thpethial \
<LCD > ‘

Matt. NBQQF
NB8PVZ's HRD Colour Scheme |
Night Vision

Naowt

Oranges and Lemons
PD50OP Blues

PG5S lcom

Save Rename Select Delete

‘ oK I | Cancel Apply |

Plastic Orange
Traditional |

@  Scheme#3
@ System Default

[@ Load from File J

From the View menu select Color Schemes,
Select the Schemes tab if it is not selected.
In the Schemes list locate LCD and double click on it.

Your display should have changed to a white background with black text. If
you want to keep the change, press OK otherwise press Cancel and your
display will revert back to the default appearance.

A W NN =

Congratulations. You have made your first of many modifications of Ham Radio
Deluxe.
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Like many features of this and other well designed programs there a several ways
on doing the same task. For example, you can get to same customize menu by any
of the following methods.

* From the View menu select Customize and then Radio Layout.
* From the Toolbar select Customize.

* Right click over most locations except the frequency display and select
Customize Layout.

* Press [CtrI+F8]
You will find this to be true for most of the functions within Ham Radio Deluxe.
Use whatever process that you like the most. That’s it for the introduction. Let’s
move on to learning more about Ham Radio Deluxe.

24 Ham Radio Deluxe



Ham Radio Deluxe

! ﬁQRadlo Deluxe

Take Cantrol '

Rig Control

|011u0D Bry


http://www.qrz.com/ 




Chapter 2 - Getting Started

2 Getting Started

Rig Control Tour

Rig Control Tour

The Ham Radio Deluxe program has many, many features. This section attempts
to describe the essentials you need to know to get started. Ham Radio Deluxe is
designed to be intuitive; nevertheless even the most experienced user has prob-
lems remembering all the available options!

To aid in the clarity of the screen shots the LCD Scheme is used and we will con-
tinue to use the Dem-o-matic TS-2000 so that you can follow along if you like.

TS-2000: Demo X I > B
VFoA | cH+ 67Hz | Auto | Comp | Fine Pre Mode: USB | w
. VFOB | CH- ALT BC culM | mBC Pri RX Fiter -
R WAl A-B 1 4 2 AT | Band+  CtlS NB | Rxtone|  QuickMem Of |
e a1 s ® ®
CTCSS: 1318 Hz ™X-B | B>A - ATU | Band- | DCS NR 1 SAT Offset: Simplex | ¥
Tone: 131.8 Hz
DSP Main Sub 89+10 - Ant 1 CTCSS Ex:A NR 2 Scan Various -
Mem s 3‘789‘000 Ant 2 Call Ex: B Notch | Sub-RX
(2] Tuesday, March 25, 2014 160m - 10m (Region 2) 16:48:12 2]
a
Fine ¢ 1 | o Fine
142338 142340 142342 142344 142346 142348 142350 142352 14.235.4 142356 142358 142360 142362
a
20m L o | | 20m
14,000 14025 14,050 14075 14100 14125 14.150 14175 14,200 14225 14.250 14275 14.300 14325 14.350
30m I ] 30m
10.100 10105 10.110 10115 120 0125 10.130 10135 10.140 10145 10150
40m I ] 40m
7.000 7.025 7.050 7075 7.100 7125 7.150 7175 7.200 7.225 7.250 7.275 7.300
6om I ! som
5250 5275 5500 5325 5350 5375 5400 5425 5450
75m ; ! 72
3500 3550 2600 2650 3700 3750 3800 3850 3.000 3050 4000
Squelch {main) 0 Squelch (sub) 0 AGC constant- 1
- DSP low cut- 0 Hz DSP high cut: 1400 Hz Noise blanker: 0 [T E—
Bandscope

:I'uning the Radio

Frequency
Selection

Ham Radio Deluxe

OK! We know you want to find if this software works. Take a few minutes to
search the bands to see if you can hear anyone. Please come back and we will help
you get more comfortable with the many features and benefits of Ham Radio
Deluxe.

You can adjust or select a frequency in several different ways. The currently

active digit has a bar above and below the digit. Our example above has the active
digit, which is 3, for the main band and for the MHz “5” on the sub band. You can
change the active digit by either clicking on it or using the left or right arrow keys.

27
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Mouse Wheel
When you rotate the mouse wheel in the frequency display the currently active

digit is incremented / decremented depending on the scroll direction.

If you rotate while the cursor is over an inactive digit then the digit is activated.

Up/Down
The up-arrow, down-arrow, - and + keys increment / decrement the active digit.

Mouse-click
Select a digital by clicking over the digit. To increment / decrement click above /

below the center of the digit and keep the mouse button pressed.

Direct Entry
You have two ways to do direct entry of a frequency.

Choice A

To enter values just press a numeric key (0-9). The active digital is updated and
the next digit to the right is made active.

Choice B

1 With your cursor placed anywhere with the rig control window press Enter
to display the Enter Frequency window.

& Enter Frequency @

A |__13.231.000 MHz

B |___3.780.000 MH=z
[ Jauto-apply [ ]Track
[ Apply l l Cancel ]

2 Enter the new frequency, and then press Apply.
If you check Auto-apply then the new frequency is applied every time you make a
change.

If you check Track this window is updated with changes made to the frequency
display — for example when you tune the radio manually.

Griffin etc.
Support for third-party devices such as the Griffin Powermate is available — see

Keyboard Accelerators on page 46.

Fine Tuning

2375

M.2380 MH.2385 42320 H2305 M.2400 142405 2410 H2MLE 14.242.0 42425

Fine IT

142306 142308 14.240.0 142402 142404

28

There are two fine tuning ranges — Fine I and Fine II. In the Tuning menu select
Show Fine II to show the second range. (If you are only showing the default Fine
I, then the title is Fine.)

Set the range from the Tuning menu or by clicking the ® button.

To change the mouse wheel step, click the & button (also set with the Mouse
Wheel pane of Program Options on page 50).

Ham Radio Deluxe
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This allows you to easily make small adjustments in the frequency. To change the
frequency either:

* Drag the marker with the mouse (and keep on dragging — the bar will scroll
to the left or right),

* Rotate the mouse wheel (press Shift to increase the mouse wheel step by a
factor of 2, press Ctrl to increase by a factor of 5),

* Click in the tuning bar or on frequency text such as 14.235.0.

Main Tuning

" o]
20m L N | 20m
14000 14025 14050 14075 14100 14125 14,150 4175 14200 14225 14250 @ 14275 14300 14325 14350

The differences between a main tuning bar and a fine tuning bar is that the main
tuning bar shows the whole band range as defined by the band layout.

Band Selection The Band Section buttons are shown between the Fine and Main layouts.

Poir L o> T icom § 7on § et ion § som § zom 1 im § em § on 4 om |

The buttons currently displayed are:

« ALT,

* BSP,

« Band buttons — 160m, 80, ... and 10m.
ALT — only displayed if you have two VFO’s displayed (for example Kenwood
TS-2000), switches between the main and alternate (second) VFO. When high-
lighted you are tuning the second VFO with the tuning dial.

BSP (bandspread) — when you press BSP a new layout is dynamically created.
The current band is split into multiple segments, for example the 20m band (14
MHz — 14.350 MHz) can be split into 7 segments, each of 50 kHz. To restore the
previous layout press BSP and select Off.

|011u0D By

by 14.050 § 14.100 § 14.150 § 14200 § 14.250
a

14.200 L (o} ] 14200
14.200 14.205 14210 14215 14.220 14.225 14.230 14235 14.240 14.245 14.250

HI50 14156
14.150 14155 14.160 14165 14.170 14175 14.180 14165 14.290 14.105 14.200

M0 I 14.100
14.100 14105 14110 14115 14120 14125 14130 14135 14.140 14145 14.150

HO50 14.05¢
14050 14055 14.060 14.065 14070 14075 14.080 14085 14000 14005 14.100

The band buttons select the corresponding band; the last used frequency and mode
for the band are restored. They also show which bands are currently displayed.
The displayed bands have the text in white while the hidden bands text is dis-
played in grey.
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Display Scroll
E If there is not enough room to display all the frequency ranges defined in the

current band layout use this button to scroll the frequency ranges (bands) up
or down

As you would now expect, there are several ways to select your operating mode.
The most obvious method to click on the small mode display above your dis-
played frequency.

UsB
Hode
LSB

14.23=00

= 80.000

25,2014 20m

Select...
Close

A small button just above the frequency display shows the current mode. To select
or change the mode click on this button. A drop-down menu will come up where
you can choose which operating mode you want to use.

Another method of selecting an operating mode:

1 Select an operating mode is to press the Selection buttonin ~  Connect |Selection| Faverite

the toolbar. |Se|ection - (@ |
2 In the drop down that opens select Mode. Bands
. Favorites
3 Select the desired mode. Quick Save
4 If you would like to close the selection window press the X Ailwanced
in the top right corner of the selection window. Check the o TAZ:S:
| s

next page for more information on the selection window.

Your rig configuration may have a list button displayed to ~ LSB

allow to change the operating mode. This button is usually v g\ff

located in the upper right corner of the button display at the M

Mode

top of the screen. Press the selection arrow and make your : ':‘S'T(
choice. " CWR
* FSK-R

Controlling Your Radio’s Features

Buttons

30

One main reason you have obtained Ham Radio Deluxe is to control your radios
many features from one location. You have already seen how easy it is to tune
your radio and select the operating mode without touching the radio. Let’s explore
how to access the other features.

Located on each side of the frequency window are buttons. All kinds of buttons.
The first impression is, wow this is great. Then the cold reality hits you that you
need to figure out what they all do. The good news is they are laid out with a plan.
You can change the layout to suit your needs add operating style. We will get to
that later.

Ham Radio Deluxe
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Drop Downs

Sliders

.Menus and Toolbars

Tuning Control
To the left of the frequency window is a group of [yFoa | cH-

buttons that aid in tuning your radio.

VFOB | CH-

Press a button to activate the option. If it is a but- 1
: X-A | A>B

ton where the option state can be read from the J g

radio — for example the selected VFO A— the but- TX-B  B=>A
ton indicates whether the option is currently

Mai Sub
selected. an . S%+20

The buttons displayed will depend upon the radio
that is connected to Ham Radio Deluxe.

Radio Feature Control
To the right of the frequency window

is a group of buttons that control fea-
tures of your radio. This display will ALT BC Ctrl-M I MBC Pri
be different for each model of radio.
The Kenwood TS-2000 is used for

this example. ATU Band - DCS NR 1 SAT

We see buttons for antenna selection, Ant 1 I CTCSS Ex A MR 2 Scan
noise reduction, attenuation and pre-

ETH& Auto Comp Fine Pre

ATT Band + Ctrl-S MNB RX tone

amp control to mention a few. A”tz . el el e

Drop downs are multiple choice buttons and are most often Mode- UsE v | 2
located in the top right portion of your screen. . When to press a XFiter v «
drop down button a popup menu is displayed. Select an option or _ @)
press escape. If possible the drop down displays the current QuickMem: Ch 5 |¥ |
selected option. Split: Simplex | w 2
The drop down buttons displayed will depend upon the radio Varous ¥ 8

that is connected to Ham Radio Deluxe. The layout for your
radio can be changed in the Customize Layout. More on that later.

If your radio has the option for slides, they can be AF gain (sub): 10
displayed either by pressing the Sliders button on F——
the tool bar or by clicking on View in the menu bar
and and selecting Slider controls at the bottom of
the list.

DSP high cut: 1400 Hz

Use the mouse to adjust a slider value.

To select the sliders that are displayed with the Sliders — see Sliders: Appearance
on page 44.

Menus and Toolbars

E HamRadioDeluxe - [FT-2000: Dema

D;le Edit View Bands Favorites Quick Save Macros Logbook Scanning Tuning Tools Woice Window Help =[]

© ¥ @ H

Connect Selection Favorite Quick Save

Ham Radio Deluxe

Full Screen Logbook Satellites SW Data

S| B ¥ »m  ww BO @< K.

Sliders | Customize Options Forums . Add . DM780 Synch Remote Serial | Programs .
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Menu Bar

Toolbar
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The menu bar is very similar to any other program that you have used. You can
find all the commands available somewhere in the menu bar. This bar also shows
you keyboard shortcuts when they are available. We will refer to the menu bar
many times as you read through this manual. Take a moment and look in each of
the menu item by clicking on the item.

The toolbar hold the tools that you will need most often when using Ham Radio
Deluxe. Each icon displayed is a functional button for selection of that task.

L} © The Connect tool, which you have already used, is for connecting your
radio to Ham Radio Deluxe. You can have more than one radio con-

Connect

nected at a time. This could easily happen when working a satellite or

connecting to a dx cluster.

—~ The Selection tool toggles a menu pane along the left side of your screen

|-/ that allows you to have many selections available quickly.
Selection
[ Fle Edit View Bands 1 Press the Selection Bl.ltton. .
: ) ~—— 2 Select Menus. You will see a list of the
v ( - possible signal modes displayed.
Connect |Selection | Favori .
Onr_]ec - e, =" 3 Select Advanced. You see a list that does not
Selection ~ (& E
mean much yet partly because you can see
Bands ALC  only a small portion of the window.
Favorites SWR X
— pwr  You need to move your cursor onto the right edge
Advanced of the selection menu. Press the left mouse button
ilacas and drag the window wider.
Menus Busy:
Main Mode plLy  You now see both the option and the value. For this
Sub Mode Hight  radio, you have a set of sliders that do the same
v LSB = function as the slides at the bottom of your screen.
- UsB
W s Your screen should now low something like the
- FM i image below. Place you mouse on the grey area
AM Fme  of the slider and move it to the right. You should
: Ef:_R see the value changing in the middle of the
. PKT-L slider.
. ESK-R N
CW Keying
Mode Key
Receiver -

Ham Radio Deluxe



Chapter 2 - Getting Started .Menus and Toolbars

Selection >~ @E
[ Bands E
L) Favorites SW
Quick Save Pw
Advanced -
Basic | Bus
Option Value 4 | Bus
* Refresh P'_-l
@ AF gain (main) B -
@ AF gain (sub)
@ AGC (main) Mid — E
@ AGC (sub) Auto-Fast
@ Break-in delay )
@ Contour Fin
@ Filter width
@ IF shift
& Key pitch
& Key speed
Macros | =

The Selection menu is also available by selecting Favorites > Display from the
menu bar.

played from the Selection tool that we just discussed or by selecting

Iﬁ Select Favorite to add a selection to your favorites list. The list is dis-
Favorite| Favorites from the Menu Bar and choosing Display.
When you press Favorite, a dialog appears that allows you to add a new favorite.

1 Press the Favorite button.

The current selection will be added to your Favorites list Use the 0K
'New Folder' option to create new folders as necessary.

Title: @ AN 10.000 MHz

i () 14.153.608 AM
Freg: 10.000.000) Mode:[AM ]
Enahle Edit < <- Mot Vet Implemented
Where:

| MNew Folder

In the field labeled Title enter [WWYV 10.000 MHZz]
In the field labeled Freq: enter [10.000.000]

Click on the Mode box and select AM.

Click on OK to save your new favorite.

AN W B W N

Look at the bottom of your Favorite list and you should see your latest
creation.

Ham Radio Deluxe 33

|011u0D By



.Menus and Toolbars

34

[

Quick Save
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|Seﬁ?ction - |
Bands
Favorites
1 80m -
1 60m
1 40m
1 20m
1 15m
1 10m
1 6m
£ 2m
1 70cm
1 Air
£1 QRP
C1 PSK31
1 Satellite
@@ WWV 10.000 MHz

m

—

Quick Save |

Quick Save tool as the name implies is a way to rapidly save marker so
you can move between the selections with a click of the mouse. The
markers are displayed above the frequency band at the designated fre-
quency.

We will discuss this more later. Please see Quick Save on page 59

=

Full Screen

>
=
Logbook

b

Satellites

@
[ﬁﬂ! Data

Sliders

=

Customize

page 37.

The Full Screen tool toggles Ham Radio Deluxe into an out of Full
Screen Mode.

Try clicking it and view the results.

The Logbook tool starts the Ham Radio Deluxe Logbook application.

The Satellites tool starts the Ham Radio Deluxe Satellite Tracker appli-
cation. This application show the current location of many satellites and
will run without a radio attached.

The SW Data tool toggles the Shortwave Database which displays at
the bottom of your screen.

The Sliders tool toggles the slider controls at the bottom of the screen.
This button will be grayed out for radios that do not have this option
available for controlling functions.

The Customize tool opens the Customize Display dialog where you can
modify you display. We touched briefly on this in the last chapter and
we will cover it in detail later. Please see Customize Layout on

The Options tool opens the Options dialog where many settings can be
made. The dialog is a chapter all by itself. Please refer to Program
Options on page 46/

The Add tool adds an entry to the Logbook. This will open a dialog
window if you have Logbook open.

Ham Radio Deluxe
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pm | The DM780 tool starts Digital Master 780 which is a Ham Radio

7 Deluxe application for operating in the digital modes. To use this appli-
cation you must be able to pass audio to and from your radio through an
interface. Please refer to Digital Master-780 on page 159 for more information.

DM780

There a few other tool in the tool bar but we will leave them for later as they are
for advanced features not used to get started in Ham Radio Deluxe.

Frequency Display

USB

14.153.608

145.050

S
S9+40

The image above shows the default view of the frequency display. We have the
mode for the main band at the top enter of the display. Below that is the frequency
setting for the main band.

The lower right area displays the sub band if it is available. Not all radios have the

1 Click on the Customize button on the tool bar. This opens the Customize
Layout dialog.

2 Select the Frequency tab.

F >
| Schemes | Layoutl Buttons | FacepIaIé| Frequency ters | Sliders: £
\

‘ Defines the appearance ofthe frequency readout

sub band available. The lower left displays the meters if the radio sends that data (;50

out.
| N . | 0
En hanced You have the option to add additional information to the frequency display by @
Display changing your Customize Layout Options. To do that: 2
=
O

[usB]| [s500Hz]| [Ant1]

' ¢ 14.070.150

Main

. . —
I
Cropdowns
(INone  ()Mode @Al
[¥] Add border \
[Tinclude title
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Configuration

Band Layout
Selection

Date & Time
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3 In the Dropdowns area of the dialog select All.
You should see additional items displayed at the top of the sample main display.
The actual items that will be displayed depend upon the radio you have
connected. With the Kenwood TS-2000 that we are using for our examples we
have several items that will display.

4 Click on OK to accept the change.
Your frequency display should now look something like this:

S9+20
3

[LSB |

[ RX Filter |

[chs|

| Simplex| |Vari0us |

14.235.000

145.050.000

You can click on any of these drop downs and change their settings from a list. If
that is too much information, you can go back and select Mode.

See Frequency Display on page 43.

ngm - 10m (Region 1) | The current band layout is displayed below the frequency

display and able the fine tuning bar.

Click here to select a different layout from the Bands
menu. If you reside in the americas, select Region 2.

Bands

160m - 10m (Region 1)
160m - 10m (Region 2}
160m - 10m (Region 3)
160m - 70cm

60m (5 MHz)

6m (Detail)

Broadcast

Low Freg

Shortwave

WHF - UHF

Manager
Close

By default the date is displayed to the left of the Band Layout and the time is dis-
played in local format to the right of the Band Layout. This can be changed by
clicking on each to set the clock and time format.

——
Clock Format: Right X
Format Date Time
GMT @ Mane Mane 15:31
UTC Laong Laong @)15:31:32
@) Local Short (150) Short [} ‘
Show Clocks
I Lett 15:31:32 |
Right
Q) Left and Right oK. ] | Cancal |
| |
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3 Configuration

Customize Layout

Customize Layout

Introduction

Schemes

Ham Radio Deluxe

In the previous chapter we explored the layout as delivered. We did do some small
acts of customization We will now explore most of the items that can be changed,
modified, or even removed. The final layout is up to the user to define. Just
because it is delivered as the default view, it may not be what you want or desire.
Before you start making wholesale changes, make sure that you have your radio
connected and working.

There are, as usual, several ways to navigate to the Customize Layout dialog win-
dow which is used to define the appearance of the radio display. Your choices are:

on Customize Layout.

Press the

Press Ctrl+F8 keys.
Customize button on the tool bar.

]

|I|'

Customize

<& Customize Layout

From the menu bar select Tools. Near the bottom of the selection box, click

Schemes ‘Layoull Buttons | Faceplate | Frequencyl Meters | Sliders: Appearance | Sliders: Layoutl Tuning Dial

YourHam Radio Deluxe schemes and settings are stored in:
C\Users\ghanson AP T TRAINING\AppData\Roaming\Simon Brown. HBSDRV\Ham Radio Deluxel

Defaults
@ Scheme #1
@ Scheme #2
| @ Scheme #3

@ System Default

Schemes

AKIG

Army Surplus
Danielle's Amberglow
Danielle's Blues
Danielle's Borgcube
Danielle's K2
Danielle's Liquarice
Danielle's Redeye
Danielle's Ultraviolet
Danielle's ts-2000
Danielle's ts-430
Dark

’ Saveto File

] Default

Ginger

’Ei-q' Load from File

] Grey Scale

Greyfriars

Igar'th Thpethial

LCD

Light

Mat, N8QQF
N8PVZ's HRD Calour Scheme
Night Vision

MNowt

QOranges and Lemons
PD5DP Blues

PG5S lcom

Peter's Persuasion
Plastic Blue
Plastic Green
Plastic Kahki
Plastic Orange
Traditional

Save Rename

Select

Delete

[

OK

) {

Apply

Cancel ]

The first tab on the display is Schemes. Schemes are pre-defined customizations
created by the Ham Radio Deluxe software creative team and other Ham Radio

Deluxe users. There are four default schemes shipped with Ham Radio Deluxe:

Scheme #1 - #3 and the System Default. You can not change the look of the

default schemes.

37
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Note: The scheme that you choose applies to all radio windows.

You can add or modify schemes displayed in the large Schemes list. The Ham
Radio Deluxe team and the Ham Radio Deluxe users have already created the
schemes that are there. Special thanks to Danielle in Northallerton, UK. for his
contributions.

* Select a default scheme by pressing the scheme button (or select an entry
and press Select);

* Select one of the other schemes by double-clicking on the entry in the
Schemes list.
If you have modified a layout scheme and wish to save it with a new name press
Save and you will be prompted for a Scheme name. Use Rename and Delete to
organize the available schemes.

If you need to save the file to a location different than the default location press
the Save as File button. This allows you to save your options file to any location.

If you receive a options file from someone else, you can add it to your copy of
Ham Radio Deluxe by pressing the Load from File button and navigating to the
options file location and selecting the file.

Layout

| Schemes‘ Layout IButLons I Faceplate I Frequencyl Meters I Sliders: Appearance I Sliders: Layou‘tl Tuning Dial

‘ Click on a button to select new text, change the color and / or move the button to a new position. ‘

{j Hide dropdowns El Hide status texts

SR T
2 T

BB TITTTTT
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Define Button Button Styles Dropdowns Unassigned
Click on an entry, drag over a button. release
Standard: o
=, TF set
VFO A -] [ Clear 3 Mode ki
ey 25 [ LSE TX tone
or usB Tone
Dropdown Button [/ CAT Command | Macro: E\h‘: PREV
race
-not mapped - AM Tune
2 iylad FSKR o
@
o Style 5
Pl m-
Style 3 Style 6
S o

The next tab is the Layout tab. This is where we can modify the screen layout for
our buttons and drop downs. This is one place where personal preference will
cause you to pull your hair out because things are not where YOU want them. Re
mapping the layout is really quite easy.

Ham Radio Deluxe
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Ham Radio Deluxe

Customize Layout

Ham Radio Deluxe is a data-driven program. For each radio there is a table of
supported commands and associated button / drop down / slider names. The lay-
out order is more-or-less alphabetical. Don’t be put off by the amount of informa-
tion in this window — take it slowly and read the information here.

Note: The layout definition is saved on a per-radio basis in the registry. For
your sanity only have a connection open to the radio that you plan to
modify the layout. Close any other radio connections.

L??eﬁne Button

Standard: e
[VFO A v [ cea | [« [+]
-or- Iﬂ

Dropdown Button / CAT Command [ Macro:

-notmapped -

Select Clear Mapped: 0

This small portion of the dialog allows us to do amazing things.

Clear Entry

If we click on a button above the area such as the VFO A button, we can clear the
button so we can use the location for some other function. This is done by clicking
the Clear button. We can also remove an entry by dragging it into the Unassigned
list on the right side of the dialog box.

Moving Entries
Ly We can move the selected entry by simply dragging it with the mouse
«| [»] orby using the four arrow-buttons.

=)

Dropdown Button / CAT Command / Macros
You can create new buttons - for example, to create a USB button from the Mode
dropdown:

1 Open the Customize Layout dialog and click on the Layout tab.

2 Select or create an empty button position — the selected entry will start to
blink (you can reposition this button later),

3 In the Define Button area of the dialog, press Select (above the Save and
Load buttons), This will open the Configure Button dialog.

4 In the Configure Button dialog window select Mode: LSB and enter the text
to appear on the new button.

5 Press OK.

39
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Configure Button Mapping

Chapter 3 - Configuration

e S

which itis mapped.

Enter the text displayed on the button, then selectthe option to

The button text must not be in use by another button.

Mapped entry: Mode : LSB VI
‘ Button text: LSB Max. 10 characters
|
[ oK l l Cancel ‘

6 Press Apply in the lower left corner of the current screen.
7 The previously empty button position now has a new value — LSB!
If you had previously created a macro or created a custom CAT command, you

would have had the choice of applying one of them to your button. We will cover
macros and CAT commands later in this manual.

Hiding Dropdowns

[ Hide dropdowns

[ Hide status texts

" CH-

Hide dropdowns hides the dropdown buttons
on the top right edge of the layout window,
releasing two columns where you can assign
new button definitions.

: AlB U| Hide status texts hides the three top-left

meters (-1-, -2-, -3-) and the status text area
underneath, releasing two columns where you

Dropdowns

Dro&iowns
Click*on an entry, drag over a button, release.

Unassigned

Various -

Quick Save Mas
ClearRIT

Scan Off

Scan On

MHz Scan On
Visual Scan On
Tone Scan On
CTCSS Scan ...

DCS Scan On
VFO Reset

<« [ 3

TF set
T
TXtone
Tone
TrRev
Trace
Tune
VOX
AT
Zero

can assign new button definitions.

Select the dropdown menu, and then simply drag
an entry to an unused location in the display.

If you drag to a location that already has a defini-
tion the current definition is removed, if a stan-
dard button it is returned to the unassigned list.

Unassigned

Entries in the Unassigned list are standard but-
tons that are not currently displayed. Simply
drag an entry to an unused location in the dis-

play.

If you drag to a location that already has a definition the current definition is
removed, if a standard button it is returned to the Unassigned list.

Ham Radio Deluxe



Chapter 3 - Configuration

Customizing
Buttons

Ham Radio Deluxe

Customize Layout

Styles

Button Styles

In the Buttons tab you can define up to seven button styles,
shown here in the Button Styles group. The Buttons tab is
the next tab we will visit.

To assign a style to a button either:

—— Normal ——

*Drag the style over the button, or

*Click a style to apply it to the currently selected (blinking)
button.

—— Selected ——

Save / Load
(@ swve || cearm | To distribute your layouts with other users of your radio
model use the Save and Load buttons. You can also clear
[ toas [[ Defouts | the deck and start over fresh or revert back to the default
button layout.

| Schemes | Layout| Buttons |Faceplate | Frequency | Meters | Sliders: Appearance | Sliders: Layoutl Tuning Dial|

‘ Defines the appearance of buttons on the radio display. ‘

! .
il
Button size: '.é.‘SmaII thMedlum '.?JLarge '.?JXLarge

Cancel

ok ]

Apply

Within the Buttons tab you can define:

¢ Seven button color combinations,

¢ The font, and

e The button size.
The default button size is small; this is so that users with low resolutions such as
800 x 600 still have a usable configuration. There are no rules when using the but-
ton size; select the size which pleases you most.
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For the technical readers the button size is tied to the font size of the radio display
form (font is Microsoft Sans Serif, size is 8, 9, 10 or 12 point).

Changing the font size simply changes the font assigned to the form.

The button size can also be changed by selecting View on the menu bar and then
selecting Layout Size. You can also [right click] on any button on your display
and select Layout Size.

% Customize Layout B &

f:Schemes Lay_om Buﬁdﬂs_i Faceplate irFre_quenc_:y_j Meters fVSVI'\ders:.ﬂ;p_pearance ?S\iders: La_yout:i 'I:uni'ng:li)ri'a_\h

Defines the background and status window on the radio display.

Status Window Duplex

Receive

Background

Slow

Background H Text I | Background H On H Ooff

Clock Position
Left
_Right
@ Left and Right

oK | | Cancel

Background

These colors are applied to the background area of the display and to the transmit
meters (if any) such as PWR, SWR and ALC.

Status Window
The status window displays information which you cannot normally change using
buttons or sliders in Ham Radio Deluxe.

Typical examples are Scanning status, Split mode and Memory channels.

Clock Position
The clock is displayed to the left, right or both sides of the band title.

Ham Radio Deluxe
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Frequency
Display

Ham Radio Deluxe

Customize Layout

& Customize Layout e
:Iéc.hemes Lay_ou.t.;.BJm;ns .;.Iéace_plz.ate":. Frequency [ Meters ] Sliders: Ap] };ranne Sliders: La}'ou.t";"'i'—un.i-qg-__.D-i;aul.__
| Defines the appearance of the frequency readout on the radio display. ‘
UsB Display:
- —_ [ Man ][ s |
m
=
= = Colors
| Background | | Active Posn ]
| Frequency | | Inactive Posn ]
(7] ;
- -
— | Font || Main > Sub ]
| Sub>Main
Dropdowns
None (@ Mode Al
V| Add border
Include title
| 0K | | Cancel |

If your radio supports simultaneous access to two VFO’s (Kenwood, some Yaesu)
then Ham Radio Deluxe will display two VFQO’s, otherwise just one VFO is dis-
played.

First select the VFO you are updating — main or sub. The colors you can set are:

|011u0D By

* Background,
* Frequency — the digits,
* Active Posn — the bar above and below the current digit,

* Inactive Posn — the bar above and below the other digit. Default is the same
as the background color.

The Font can also be set, use the Main > Sub and Sub > Main buttons to copy
settings between VFO'’s.

Dropdowns

The dropdown buttons (Mode, Filter...) can be displayed at the top of the main
frequency display.

Select:

* None (no dropdowns),
*  Mode (only the mode dropdown) or
* All (all dropdowns).

If Mode or All is selected you can check Add Border to add a border around the
text.

If All is selected you can check Include Title to add the Dropdown button’s title
(if there is room).
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Meters 4 o o ——
| | Schemes i Layouti Buttons i Faceplate i Frequggy_! Meters | Sliders: Appearance i Sliders Layouli Tuning D\al}
Defines the appearance of the bar meters on the radio display. ‘
S6 LLLLLLLLETT LT L\E}Show peak reading
S+20 HNNRRRNNNNANRRRRRRRNNNRNnnAnnm
S+60 NRRRRRNNNNRNRRRRRR NN RUNNRRRRRRRRARERn
& S Meter- TX mode
Main:  |PWR -| The value must be supparted by the radia.
High Position e —
Sub |REF '| Kenwood radios display the value selected with the
Meter slider (TS-480. TS-2000) orthe SWR / Comp /
4] ALC / d buttons.
Colors S-Meter- Updates
[ Background J [ T I [] Aways update when changing frequency (slower performance)
[ Bars: Low I [ Bars: High I [ Bars: Free
‘ QK I ‘ Cancel |

The Background and Text colors should be obvious. There are three graduation
colors:

e Bars: Low — the first bar color,
* Bars: High — the color at the position set by the High Position slider, and
» Bars: Free — the color for the free (empty) bars.

If you check Show peak reading the recent peak value is displayed.

When Ham Radio Deluxe is in TX mode the S Meter value is replaced by the
value selected in the Main and Sub dropdowns, the value you select must be dis-
played by Ham Radio Deluxe in the upper right hand corner of the display. For
Kenwood radios the value to be displayed is selected with the meter slider or the
individual buttons (SWR / Comp / ALC / dB).

If you check the Always update... option then the S Meter is updated when you
change frequency — this results in slower performance.

Sliders: If supported by your radio, sliders are displayed at the bottom of the display. Here

Appearance you define the appearance of the sliders. These colors are optionally applied to the
sliders in the Advanced selection windows (select Advanced from the View
menu).
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Sliders: Layout

Tuning Dial

Ham Radio Deluxe

& Customize Layout

Customize Layout

e S

[ schemes Layout :.Bu.nons :.F.aceplz.ate Frequency Meters | SIiders‘Appearance: Sliders: Layout .'i'uning Dial

Defines the layout of slider controls on the radio display.

Radio: |TS-EDDD v‘ (If your radio is notin the listthen no sliders are available)

Layout (@ Defaut (ART (a2 (O AR3  (CAR4 () ARS

|AF gain (main) vHP\F gain (sub) vHRF gain vHRF power v‘
|Sque|ch (main) > HSqueIch (sub) - HMic gain > HAGC constant v‘
|DSPIowcut vHDSP high cut vHNmse blanker vHNmse reduction v‘
| 3l A 3l i
| x| z)| x| z)
| 2| x| 2| x|

Notes

Changes are saved immediately
Empty rows are not displayed Clear All |

Show [ hide sliders - use 'View' menu | A mlrad Belaiils |

Lok ]

Cancel |

Here you select the sliders to be displayed. Define up to six layouts, for example

one layout for SSB and another for CW.

& Customize Layout

[ schemes Laycut :.Bu.rtcns :.F.acep\ate | Frequency Meters | S\iﬁers‘Appearance | Sliders Layou.l: Tuning Dial

Colors - Thursday, May 2 0 s 10
Background

Title: Clock. Frequency

Band Button: Text
Band Button: Face

Fine Line
Fine Text
Fine Inside
Fine Hotspot

Normal (80m) Line
Normal (80m) Text
Normal (80m) Inside

Active (40m) Line

Active (40m) Text -
« 11 }
Fonts

Title: "Options"

Title: Clock. Frequency
Band Buttons

Band Titles

Band Frequency

Align band buttons.. Horz: | Center '| Vert|Cemer '|

Title: "Options" ; V7 s i . i o

|BSF‘ 10m | 16m | 20m |-’-1l]m | 80m

I
@

Lok |

Here you define the colors, fonts and band button positions.
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Program Options

Introduction

Keyboard
Accelerators

46

Used to define various Ham Radio Deluxe features, Program Options can be

selected in three different ways:

» From the menu bar, select Tools > Program Options at the bottom of the

list.
* Press F8

+ Press the % Options icon on the toolbar.

Most users will find that they can live with the defaults that can be modified in

this dialog.

Accelerators

Custom Table i
Comms

»

Accelerators

Comms |

] Out Of Band | Mouse Wheel I Selection Window | Theme | Updates I Yaesu
COMPort TX

| ICOM Calibration | Internet

Dual VFO Tracking
RX Timeout
Switch Off

Polling

Custom keyboard mappings, changes saved immediately

COMPort TX

RTS/DTR/Bath/Mane Keystroke | Radio Button

ICOM Calibration
S-Meter
Internat
Enable
Out OfBand
Enable
In band
Outofband
Mouse Wheel
CW Fine
CW Hot
Other Fine =
Other Hot
Selection Window
Advanced values

m

Tree expand Add Edit

Remowe

Theme =
Main Tabs
Appearance

Save to File

~

[ LoadfromFile

2014.070.150

The digitindex ranges from 0 (Hz) to 9
(GHz)

Increment (+): Alt+Ctrl+Shift+<digit>
Decrement(-): Alt+Cirl+<digit>

Example: Al+Ctri+Shified = +1 kHz
Example: Al+Cir+Shift+7 = +1 MHz

oK | Cancel | Apply |

Define accelerators for use with the Keyboard or with programmable interfaces

such as the Griffin Powermate.

When you press Add the definition window is displayed.

Accelerator M

Define a keyboard combination

Keyboard Combination

Key: W W] Ak Cirl

= Ham Radio Deluxe Option

Arrow Keys
(Up  (ODown (CILeft () Right

HRD Button

@ Text  Tune

Ok ] ’ Cancel

— Assigned

—— Reserved

Alt+ A -
Alt+ Cirl+ D i
Alt+ Cirl + F1

Alt+ Cirl + F2 =
Alt+ Cirl + U
Alt+ K

Ctrl + A
Ctrl+ B
Ctrl+F

Ctrl + F&

Ctrl + FB

Ctrl + F&

Ctrl + M

Ctrl + M

Ham Radio Deluxe
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Keyboard combinations are assigned to display buttons and arrow keys. As an
example, we will assume that we want tot assign the key combination
Ctrl+Alt+W to the Tune button. To do this we would do the following steps:

In the Key field we would enter the letter W.

Place a check mark in the boxes preceding A/t and Ctrl.
In the text box below HRD Button enter the word Tune.
4 Press OK to save your new accelerator.

W N =

You will now see your new accelerator listed.

COM Port TX
RTS/DTR/Both/None Keystroke ‘ Radio Button |
ICOM Calibration Crl+Alt+W  Tune
S-Meter

2014.070.150

Enable

m

The Ham Radio Deluxe menu has pre-assigned accelerators; these cannot be rede-
fined. These are listed in the Reserved window.

Comms
_& Options X
p— S —
- Out Of Band Mouse Wheel ] Selection Window } Theme Updates ] Yaesu ]
Dl .VFO Tracking Accelerators Comms I COMPort TX ] ICOM Calibration ] Internat ]
RX Timeout
Switch Off
Polling ‘ Communications options, restartto apply new values. ‘
COM Port TX
RTS/DTR/Both/Nane ; : )
ICOM Calibration Hadd ooyt Specifies the maximum time, in milliseconds, allowed to |
S-Meter elapse between the arrival oftwo characters onthe
Internet ¥ Use default (500 ms) communications line. | ;U
Enable gy
OLt Of Band | 500ms > T (@)
Enzble £ isplay timeout warnings
In band O
Out of band Switch Off Dual VFO Tracking
Mouse Wheel O
| CW Fine [+ Promptio switch off the [ Track dual VFOs every refresh (not suitable for | 3
CW Hat radio when closing (if slow comms connection). Recommended for +
| | Other Fine supported by the radio) satellite tracking. —_—
Other Hot
Selection Window o
Advanced values ik e
Tree expand -Polling | -Refresh Interval (milliseconds)
| Theme
Main Tabs [~ Only poll radio it HRD is ("0 @300 500
Appearance the active program. " 200 (" 400 (" 1,000
| Color |
| Layout T |

oK | Cancel

Normally you will not have to change the default settings.

* Read timeout — serial port timeout.

* Switch off — some radios such as the FT-817 or the Kenwood TS-2000 can
be powered down using a CAT command. If this option is selected you are
prompted to switch off the radio.

» Polling — to reduce CPU load for slower systems.

* Dual VFO tracking — if selected both VFO’s are tracked on every refresh.
Only of use with Satellite Tracking ( Satellite Tracking on page 209).

* Refresh interval — the interval between consecutive refreshes of the display.
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RTS/DTR/Both/MNaone
ICOM Calibration
S-Meter
Internet
Enable
Out Of Band
| Enable
In band
Qutofband
Mouse Wheel
CW Fine
CW Hot
Other Fine
Other Hot
| |Selection Window
Advanced values
Tree expand
Theme
Main Tabs
Appearance
Color
Layout
Position
Menus. Toolbars
Theme
Updates
Reminder

COM Port TX

m

Out Of Band i Mouse Wheel i Selection Window l Theme I Updates i Yaesu

Accelerators | Comms COM Port TX | ICOM Calibration | Internet

‘ COM Port TX Configuration ‘

Some early radios do not support switching TX/RX via CAT commands, so the only option is to
use a pin on the CAT control COM port (this requires a special CAT cable).

— Radios — —COM Port Pin-

ic706

IC-706MKIG ® None

IC-725

Ic-735 (RIS

IC-736 ~ DTR

IC-738

IC-751A ( DTR+RTS

IC-756

IC-765

IC-775D8P

ICc-781 —West Mountain Radio: RIGblaster-

IC-821H ) )

TT-OMNIVI [~ Always use RTS instead of sending
CAT commands

o |

Cancel | Apply l

Some early ICOM radios do not support switching between TX and RX using
CAT commands. The only way to enable computer controlled TX/RX this is by
toggling a COM port pin.

You require a special CAT cable if you select this option.

ICOM
Calibration
| T —

S-Meter
Internat
Enable
Out Of Band
Enable
In band
Outofband
Mouse Wheel
CW Fine
CW Hot
Other Fine
Other Hot
Selection Window
Advanced values
Tree expand
Theme
Main Tabs
Appearance
Color
Layout
Position
Menus, Toolbars
Theme
Updates
Reminder

m

Yaesu
FTDX-9000

i

T ——————

Cut Of Band i Mouse Wheel ] Selection Window | Theme | Updates | Yaesu

Accelerators | Comms | COM Port TX ICOM Calibration | Internet

S-Meter calibration - ICOM only. The value read from the radio is between 0 and 255, this must
be calibrated for the radio model selected below.

T T e

Radio IlC-?DDD vi
ofset [0 :
Scale: |12 3: per s-meter unit (6db)
[l mese [P0 AR e
95
]

< Restore Default

MNote:  Changes are applied immediately.
The IC-706 and IC-706Mkll do not support the S-meter.

oK I Apply l

Cancel |

ICOM radios return a S Meter value between 0 and 255, normally 0 is SO, 12 is S1
and so on. As a S Meter unit is 6 dB the algorithm applied is to divide the returned
value by two to get dB, then divide dB by 6 to get S units.

Some radios such as the IC-706 have a different logic — use the Offset and Scale
values to adjust the returned values so that the S Meter in Ham Radio Deluxe cor-
responds to the S Meter on your radio.
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Internet

Out Of Band

Ham Radio Deluxe

ICOM Calibration
S-Meter

Enable
QOut Of Band
Enable
In band
Out of band
Mouse Wheel
CW Fine
CW Hot
Other Fine
Other Hot
Selection Window
Advanced values
Tree expand
Theme
Main Tabs
Appearance
Color
Layout
Position
Menus, Toolbars
Theme
Updates
Reminder
Yaesu
FTDX-3000

11

Program Options

X
Out OfBand l Mouse Wheel | Selection Window | Theme Updates | Yaesu |
Accelerators | Comms | COM Port TX | ICOM Calibration Internet
‘ Internet Access Options
f
[¥ Enable intemet access (DX Cluster. Check for Updates. etc)
OK | Cancel | Apply |

Ham Radio Deluxe is able to detect whether you have an Internet connection with
Internet GetConnectedState(). Uncheck this option if you do not want Internet
access.

ICOM Calibration
S-Meter
Internat
Enable
Enable
In band
Out of band
Mouse Wheel
CW Fine
CW Hat
Other Fine
Other Hot
Selection Window
Advanced values
Tree expand
Theme
Main Tabs
Appearance
Color
Layout
Position
Menus, Toolbars
Theme
Updates
Reminder

m

Yaesu

FTDX-9000

<]

Accelerators i Comms ! COMPort TX I ICOM Calibration l Internet
Out Of Band | Mouse Wheel | Selection Window | Theme Updates | Yaesu
‘ Defines the Out Of Band warnings
[ Enable

In band wave file:

1011u00 By

idmg.wav

Change... | Play |
Out of band wave file:
chord.wav

Change... | Play |

Apply |

If you like to know where your band limits are when you are scrolling through a
band and not watching the frequency window you can enable the optional sound
files played when you tune in / out of band. You also have the ability to use a

sound file of your choosing.
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ICOM Calibration - Accelerators Comms COM Port TX | ICOM Calibration l Internat
5 Meler Out Of Band Mouse Wheel Selection Window | Theme | Updates | Yaesu
Internet
Enable
QOut Of Band Defines the tuning step when rotating the mouse wheel . ‘
Enable |
In band
Gk ot bani | Marrow Modes Wide Modes
—— Fine —— —— Hot —— —— Fine —— —— Hot ——
LW Fine 10Hz 10Hz 10 Hz 10 Hz
LW Hot 20 Hz 20 Hz 20 Hz 20 Hz
Other Fine 50 Hz 50 Hz 50 Hz
ther Hot. 100 Hz 100 Hz 100 Hz
Selection Window 200 Hz 200 Hz 200 Hz 200 Hz
Advanced values 500 Hz 500 Hz 500 Hz 500 Hz
Tree expand 1.000 Hz 1.000 Hz 1.000 Hz 1.000 Hz
Thema = 2,000 Hz 2,000 Hz 2,000 Hz 2,000 Hz
Mzin Tabs 5,000 Hz 5,000 Hz 5,000 Hz 5,000 Hz
Appearance 9,000 Hz 9,000 Hz 9,000 Hz 9,000 Hz
Colof 10.000 Hz 10.000 Hz 10,000 Hz 10,000 Hz
Layout 12,500 Hz 12,500 Hz 12,500 Hz 12,500 Hz
Besimon 25,000 Hz 25,000 Hz 25,000 Hz 25,000 Hz
Mf;’;zﬁhzﬂﬂ'bafs 50,000 Hz 50,000 Hz 50.000 Hz 50.000 Hz
Updates Hint Pressing Shift or Ctrl accelerates the selected step
Reminder
Yaesu - [ Invert frequency scrolling direction
FTDX-9000 ¥
OK | Cancel | Apply |

You can define the tuning step when rotating the mouse wheel over the active tun-
ing bar here.

Selection
Window

ICOM Calibration - Accelerators | Comms COM Port TX | ICOM Calibration I Internet
5 Meter Out OfBand | Mouse Wheel Selection Window | Theme Updates | Yaesu
Internet
Enable
QutOfBand
Enable
In band
Out of band —
Mouse Wheel [+ Show numeric value in Advanced options
gw Egte [~ Showthe Options icon in Advanced lists (restart to see changes).
Other Fine
Other Hot
Advanced values
Tree expand
Theme
Main Tabs
Appearance
Color
Layout
Position
Menus, Toolbars
Theme
Updates
Reminder
Yaesu —
FTDX-9000

Defines options affecting the appearance and operation of the selection window. ‘

[ Single-click expandfcollapse in Favorites tree

m

1

0K | Cancel | Apaply |

Defines options affecting the appearance and operation of the selection window.

50

Single-click — normally the Favorites tree folders are opened / closed with a
double-click. Check this option to enable single-click operation.

Show numeric value — the Select Windows"s Advanced slider values are
optionally superimposed on the slider.

Show the Options icon — historical support for the version 2 Advanced slider
look and feel.
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Themes

Ham Radio Deluxe

ICOM Calibration
S-Meter
Internet
Enable
|Out OfBand
Enable
In band
Out of band
Mouse Wheel
CW Fine
CW Hat
Other Fine
Other Hot
Selection Window
Advanced values
Tree expand

Main Tabs
Appearance
Color
Layout
Position

Menus. Toolbars
Theme

Updates

Reminder

Yaesu
FTDX-9000

»

11

Accelerators ] Comms
Qut Of Band ] Mouse Wheel ] Selection Window

|

Program Options

COMPortTX | ICOMCalibraon |  Internet

Theme ] Updates ] Yaesu

Main Tabs. Menus and Toolbars, changes are applied immediately

Clientframe: ]None

~Main Theme System Theme
(" Office 2000 (@ Native XP (" Blue (® Default
(" Office XP " Windows XP " Olive
(" Office 2003 " Metallic
~Main Tabs (Show/Hide from View menu)-
Nl = =Nl  Property Page 2003 vi [v Bold selected [ Static frame
Color IWinXP L] [~ Systemcolars [~ Showicons
Layout ]Size To Fit Li [~ OneNote colors
Position ™ ITop L] [~ Show infull screen
2

* Position is only applied to the Radio and Logbook tabs

Defaults

QK | Cancel ‘

I

Docking panes are used for optional windows such as: Bandscope, Calendar, DX
Cluster, Logbook, Selection, Shortwave Database and WinKey.

Main Theme
Select whichever visual theme you want — Office 2003 is an acceptable default.

System Theme
When you select Office 2003 or Windows XP for Menus and Toolbars you can

select an optional System theme.

Main Tabs

|011u0D By

If you have more than one main window open — for example Radio and Logbook
— then the main tabs are a useful way of switching between windows.

7

Connect Selection F

File Edit View Bands

€

avorite Quick Save

Favorites Qu

I

T5-2000: Demo X IC—?DSMk]]l

inb

Subb

Main tabs can be toggled On / Off by selecting from the Menu Bar View> Main

Tabs.
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Updates

| lcom Calibration - Accelerators I Comms ! COM Port TX | ICOM Calibration | Intemet
S Meter Out Of Band | Mouse Wheel | Selection Window | Theme Updates | Yaesu
Internet
Enable
Qut Of Band ‘ How often you are reminded to check for Ham Radio Deluxe updates ‘
|| Enable |
In band :
Outofband . Remind me to check for updates every:
Mouse Wheel
CW Fine { B
CW Hot " Week
Other Fine
Other Hot " Month

Selection Window
Advanced values Check Now
Tree expand
Theme
Main Tabs
Appearance
Color
Layout
Position
Menus. Toolbars
Theme
Reminder
Yaesu —
FTDX-9000 r

11

OK | Cancel | Applhy |

Select how frequently Ham Radio Deluxe reminds you to check for new updates.

Yaesu

ICOM Calibration - Accelerators | Comms ! COM Port TX | ICOM Calibration Internet |

S-Meter
Internet
Enable ‘

Cut Of Band | Mouse Wheel | Selection Window | Theme Updates ‘Yaesu

QutOfBand
Enable
In band
Out of band — —Iw FTDX-9000 —_—
Mouse Wheel

CW Fine Delay after setting a value (ms) |200 3:

CW Hat
Other Fine Delay before reading a value (ms) o = Defaults |
Other Hot
Selection Window Watch the HRD forums and Yahoo! newsgroups for news of a software
Advanced values upgrade from Yaesu.
Tree expand
Theme
Main Tabs
Appearance
Color
Layout
Position
Menus. Toolbars
Theme
Updates
Reminder
B e
| FTDX-9000 i

Special options to get around Yaesu software oddities ‘

111

OK | Cancel | Apply |

Special options for Yaesu radios. Due to firmware “features” in the FTDX-9000 it
is necessary to wait up to 250ms after writing a command to the radio. With any
luck Yaesu will fix this at some date in the future.
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Band Layouts

Band Layouts

Introduction

Manager

Ham Radio Deluxe

A necessary feature of a fully customizable radio program such as Ham Radio
Deluxe is the definition of custom band layouts.

The TARU regions have own band plans; there is no doubt that these will change
in the future. Consider also the traditionalist who has never owned a microphone
in his life and is only interested in the CW portions of the bands — he wants his
own band layouts.

With this feature you can edit any band so only the frequencies are shown which
are allowed by your License class. You can then activate the Out-Of-Band alarms
to notify you when you tune outside of your allowed frequency ranges.

To start the Manager do one of the following:

* Select Manager from the Bands menu. or
e Press CTRL+B.

Band Layouts ‘ ﬁ
54

=
load Save Defaults

3
New Copy Edit Delete

Define your own band layouts
Each layout contains one or more frequency ranges, example:

1.8 MHz - 2.0 bHz,

3.5 MHz - 3.8 MHz,

7.0 MHz - 7.1 bHz.
Status Lanout Ranges &
-OK- 160m-10m (Region 1) 10
-OK- 160m-10m (Region 2) 10 i
-OK- 160m-10m (Region 3) 10 I
-0K- 160m-70cm 13
-0K- 60m (5 MHz) 1
-0K- 6m ({Detail) 3
-0OK- Broadcast 16 -

o) [ ]

Here you see the existing definitions. In the £dit menu you have the expected
New, Copy, Edit and Delete options.
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Definition
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In this example a band layout is
created for our CW enthusiast.
Select New from the Edif menu to
create a new definition using the
Band Layout Editor.

1 In the Title field enter CW
Only.

2 From the Edit menu select
New to define a new
frequency range.

3 In the Band field enter [160m]

4 In the From field enter
[01.800.000]

5 Inthe 7o field enter
[01.830.000]

6 Ensure Enable is checked
7 Press OK

Chapter 3 - Configuration

Band Layout Editor ﬁ

B
MNew Copy Edit Delete | Up Down

Add atleast one frequency range to the list below, example:
7.000.000 MHz to 7.100.000 MHz.

Title: Ciy Only

Enahled:

Status  Band  FromMHz  ToMHz

[ ok || cancel

Define Frequency Range ‘ M

Band: 160m
Frarm: 1.800.000 MHz
| To: 1.830.000 MHz

Enakle

[ (09 l l Cancel l

When you press OK the frequency range is added to the band layout. Repeat the
steps above for 80m and 40m using the values below:

e 80m, 3.5MHz to 3.55MHz, (Remember the leading zero)

¢ 40m, 7.0MHz to 7.0SMHz.

The band layout now looks like this:

Band Layout Editor

8 B &

+

MNew Copy Edit Delete| Up Down

Add atleast one frequency range to the list below, example:
7.000.000 MHz to 7.100.000 MHz.

Title: G Only

Enahled:

" Enabled 160m
" Enabled 80m
" Enabled  40m

Status Band FromMHz  ToMHz
1.800.000 1.830.000
3500000 3550000
7.000.000 7050000

Ham Radio Deluxe
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Copying A
Definition

Selecting

Ham Radio Deluxe

Band Layouts

+ ¥
Up Down

To rearrange the order of the frequency ranges just select a range and
use the Move menu options or the Move buttons.

8 When you have finished your new layout press OK. The CW Only definition
is added to the band layouts.

9 In the Band Layouts window press OK to save the definitions and close the

window.

= r & %®
Load Save Defaults | New Copy Edit Delete

Define your own band layouts

Each layout contains one or more frequency ranges, example:

1.8 MHz - 2.0 bHz.
35 MHz - 3.8 MHz.
7.0MHz - 7.1 bHz.

Status Lansout Ranges o
-0K- LowFreg 1

-0K- Shorwave 10

-0k - WHE-LIH 13 :|
-0kK- G Only 3 | =
[ oc [ oo

To copy an existing band layout:

Start the Manager,

Select the entry to be copied,
Select Copy from the Edit menu,
Enter the new title,

|011u0D By

Change the frequency ranges are appropriate,
Press OK.

AN N B W N~

To select a band layout either:

* Open the Bands pane in the Selectionwindow Connect | Selection | Favorite

(select Display from the Bands menu) and select an | sejection -0 |
entry in the list, or Bands |
* Click on the Band Title 160m — 10m (Region 1) in @Manaﬁ

the radio display and select a new layout from the

ind k= 160m - 10m (Region 1)
popup window.

k= 160m - 10m (Region 2)
k= 160m - 10m (Region 3)
B 160m - 70cm

160m - 10m (Reaion 2)
Bands

160m - 10m (Region 1)
160m - 10m (Region 2)
160m - 10m (Region 3)

e k= 60m (5 MHz)
0 14245

B+ 6m (Detail)
160m - 70cm
I'l 60m (5 MH2) k= Broadcast

6m (Detail) ¥ Low Freq
Broadcast k= Shortwave
Low Freg

28.750 Shortwave
VHF - UHF
A Dindhe
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Favorites

Manager
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Favorites was introduced in the Getting Started chapter. We will now look at the
favorites manager in detail. Favorite definitions are selected from the Favorites
pane in the Selection window.

Start the manager from the Favorites menu or the Favorites pane in the Selection
window. It is designed to be easy to use — let’s see.

The favorites manager, as the name implies, provides a means to manage your
favorite frequencies. The can be grouped in Root folders my band, mode, topic, or
interest. New Root folders are created using the New Root button. Root folders
can have sub folders to help further group your favorites. These sub folders are
created using the New Folder button. You add your favorite frequency using the
Add button.

Root folders and their associated sub folders can be turned on and off by checking
or unchecking the box in front of the folder. If for example you do not have an
antenna for 160m, you can uncheck the box in front of the folder and 160m will
no longer be listed in the Favorites pane of the Selection window. They will still
be visible, however, in the band display above the 160m band.

Q Manage Favorites (85 entries) * lﬂ

To create a new top-level (roof) folder press 1 160m
New Root. q

|| Root Folder

To create a new child folder press Mew Folder

I
1 20m
To copy, delete, edit or move an entry: (3 15m
[1] selectthe entry, 1 10m
[2] press Copy. Del, Edit or Move. 1 Bm
1 2m |
3 70em
1 Air i
Add 153 0 | Sub Folder
N [ mewFoider |[ Det |[ Ear | | -]

SortFolder +

- E g THZE #— Favorite Freq.
B G 21.285 MHz I
Title:  3.690 MH:z B P 28 360 MHz
| Freq 3590000 07 PEK3T i
bode: LSB 1 Satellites
I State: Enabled I

| load || Defauts |
! F Mege  |[B  save | |
[ o J[ concel |

-

New Root — create a new top-level (root) folder. Folders are not saved if they are
empty (no child folders or definitions). An example would be a Root Folder
labeled JOTA for Jamboree on the Air.

New Folder — create a new folder as a child of the currently selected folder. An
example would be to create a sub folder under JOTA labeled SSB or CW.

Ham Radio Deluxe
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Favorites

Sort Folder — sort the entries in the currently selected folder:

* Bytitle,

* By ascending frequency, or

* By descending frequency.
Add — add a new definition. If you have crated a new empty folder, you can not
add a favorite frequency to it. You need to add the frequency to either a higher
level folder or in a folder that has favorites in it. You can then move the new
favorite to the new folder that you created earlier.

& Edit - | X ]

Enter new walues in the fields below, then click OK,
Repeater offsets are notwet supported.

Title: JOTA 20m
Frequency:  14.290.000 MHz

Mode: USE -

Enable Edit
| [ 0K l | Cancel |
| S T
To add a new favorite frequency to an existing folder:
1 Click on the folder that you wish to add a favorite to.
2 Click on Add.
3 Enter a title for your favorite.
4 Enter the desired frequency without the decimal point.
If you are adding a frequency that starts with a single digit before the first
decimal point, place your cursor immediately adjacent to the left side of the first
digit.
Title: No space
Frecuency: [1.000.000 MHz
hMaode: LzE -
If you are adding a frequency that starts with two digits before the first decimal
point, place your cursor a bit further to the left so there is a small space between
the cursor and the leading zero.
— Note the space
Frequency: |0.000.000 MHz
hMaode: L=B -
For three digits place your cursor a bit more to the left.
5 Select you operating mode.
6 Click on OK and your new favorite will be saved in the selected folder.
You can also select Add from Favorites in the menu bar to add a new defini-
tion.You can also use Cntrl+A keystroke combination to access the add function.
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Del — delete the current folder or definition (depending on which you have
selected).

Move — move an entry to another folder (alternatively drag entries between fold-
ers with your mouse).

W N =

4

Browse for Folder

5

Click the folder that you want to mowe the
selected entry to.

b Favvorites
27 160m
27 80m
- 1 BO0m
27 40m
g 20m
23 15m
7 10m
7 Bm
H- 1 2m
| - [Z1 70cm
-2 Air
|| | B-i3 ORF

o —
fu ]

1

[ (09 l l Cancel

Highlight the folder or definition.
Click on Move.

Select the new folder.

Click on OK.

Copy — make a copy of an existing definition.

Edit — edit the selected folder / definition.

Arrows — rearrange the selected folder / definition.

Load — load a new set of definitions from a file previously created using Ham
Radio Deluxe; all current definitions are discarded.

Merge - merge definitions from a file previously created using Ham Radio
Deluxe. Defaults — restore the default list (hard-coded into Ham Radio Deluxe).

Save — save current definitions to a file.

To display your favorite markers in the Ham Radio Deluxe display select Show
Markers from the Favorites menu. The marker size is selected from the Marker
Size option in the Favorites menu.

Jo

18080 L?’ei QRP\CW 14.060 MHz

14058 14075 14109

14128

The popup text is displayed as you move the mouse pointer over a marker. The
text is constructed from the favorite title and frequency.
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Quick Save

Quick Save

Introduction

Add Entry

Quick Save
Markers

This is a simple way of marking a frequency as being interesting — you are moni-
toring three QSO’s with a single radio and you want to quickly switch between the
frequencies — for example during a 6m sporadic-E opening.

Each definition consists of the frequency in Hertz and mode; definitions are saved
in the registry.

To switch between Quick Save definitions use the accelerator key combinations
for the Quick Save menu options Next (Ctrl+F5) and Previous (Ctrl+F6).

o Select Add from the Quick Save menu or just click the Quick Save but-
Quid; caye tON. An entry is added to the Quick Save pane in the Selection window.
To display Quick Save markers in the Ham Radio Deluxe display select Show
Markers from the Quick Save menu. The marker size is selected from the Marker
Size option in the Quick Save menu. This only toggles the Quick Save markers. It
does not toggle the Favorites markers.

1509 €50 14.080.474, USE I;fg

||

14075 14109

4125 14150

The popup text is displayed as you move the mouse pointer over a marker. The
text is constructed from the frequency and mode.

Macros

Introduction

CAT Commands

Ham Radio Deluxe

Ham Radio Deluxe supports two types of custom

.. Selection - (&
definitions:
Bands
*  CAT commands Favorites
» User defined macros which are a combination of Quick Save
standard Ham Radio Deluxe input fields Advanced
. Macros
Macros are selected from the Macros pane in the
. . CAT Commands
Selection window. =
Macros: Default

A CAT command macro is a command that you define yourself, containing one
CAT commands as describer in your radio’s handbook. The commands you enter
must be supported by your radio.

Use CAT commands to add support not provided by the Ham Radio Deluxe inter-
face.

Manager
To open the CAT Command macro manager do one of the following:
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* Press Manager in the Macros> CAT Commands selection pane
* Select CAT Command Manager from the Macros menu

{# CAT Command Manager: TS-2G_ u

AIRE *x |+ 3| @ =
New Copy Edit Delete | Up Down | Load Save

Define extra CAT commands, these are radio-specific!

Title CAT Command(s) Description

[ QK i ’ Cancel ]

1 Press New to create a new command definition.

In this example a Kenwood command is defined for the TS-2000. The mode is
set to USB and the frequency to 50.150 MHz.

2 In the Title field enter [50.150 MHz USB].
3 Inthe CAT Command field enter the following commands:
# Set mode to USB.
MD2
# Set frequency to 50.150 MHz
FA00050150000
4 In the Description field enter [Change frequency to 50.150 MHz, mode to

USB].

Enter a new definition, then press '0K".

50160 MHz USE

# Set mode to USE.

MD2

# Set frequency to 50.150 MH=z
FAO0050150000

Change frequency to 50,150 MHz, mode to USE|

Elecraft and Kenwood

Each command consists of 2 alphabetical characters (lower or
upper case) and optional parameters. Please read your
operating manual for command information.

The terminating semicolon (;) is not necessary, it is added
automatically.

TS-480
Set mode to LSB

Ok ] [ Cancel
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5 Click on OK. The new definition is added to the list in the Manager window.

Protocols Reference

Each brand of radio has a slightly different protocol for their CAT commands.
Below is are examples of the differences. For complete information, please refer
to the operating manual for your radio.

ELECRAFT AND KENWOOD

Each command consists of two alphabetical characters (lower or upper case) and
optional parameters.

The terminating semicolon (;) is not necessary, it is added automatically.
TS-480, TS-2000

Set mode to LSB .....: MD1
Set mode to USB .....: MD2
Set AF gain to O ....: AGOOOO
Set AF gain to 100 ..: AGO100
Select VFO-B ........: FT1

You can define more than one command; to do this start each command on a new
line.

Special Commands

Comment ..........2 # Some interesting text.
Pause of 250 ms ..: @ 250
ICOM

ICOM radios use the CI-V format to communicate with the radio. Please read
your operating manual for command information.

Each entry defined here consists of:

¢ [1] command,
* [2] optional sub-command and
* [3] optional data.
You must add a - between each byte (each byte is two hexadecimal characters).

1C-7800
Set mode to LSB ..........: 06-00
Set mode to USB ..........: 06-01
Set AF to O ..............: 14-01-00
Select preamp 2 ..........: 16-02-02
MOD 1/P (data off) MIC ...: 1A-05-00-31-00

MOD 1/P (data off) SPDIF .: 1A-05-00-31-07

You can define more than one command; to do this start each command on a new
line.

Special Commands

Comment ..........: # Some interesting text.
Pause of 250 ms ..: @ 250
TEN-TEC

In general Ten-Tec commands are two character commands followed by data and
a carriage return <cr> or <0x0d>. Do NOT add the carriage return - this is added
automatically.

61

|011u0D By



Macros

62

Chapter 3 - Configuration

Some data must be sent in binary format, hexadecimal is used to represent binary
data. To set Split mode on for the Argonaut the documented command is
*0<0x01><0x0d> which is entered here as *Ox01, that is *O (Split mode) + x
(switch to binary) + 01 (Split On). The carriage return <0x0d> is not added.
Please read your operating manual for command information.

When you enter x the format switches to binary mode - two hexadecimal charac-
ters per byte. Only enter x once, even if entering more than one byte of data.

Argonaut
Set mode to LSB .....: *M2
Set mode to USB .....: *M1
Set split mode on ...: *Ox01
Set split mode off ..: *0Ox00
Jupiter
Set mode to LSB .....: *M2
Set mode to USB .....: *M1
Set AF gain to 32 ...: *Ux20

Set filter to 450Hz .: *Wx1D

You can define more than one command; to do this start each command on a new
line.

Special Commands

Comment ..........: # Some interesting text.
Pause of 250 ms ..: @ 250
YAESU

Starting with the FTDX-9000 Yaesu has changed the CAT protocol to one very
similar to that used by Kenwood. So if you are fortunate enough to have the
FTDX-9000 please use the Kenwood commands — See “ELECRAFT AND KEN-
WOOD” on page 61.

Each Yaesu command consists of five bytes. The bytes are defined in the order in
which they are sent to the radio. You must add a - between each byte.

Each command consists of four bytes of data and an OpCode. The order in which
P1-P4 are shown in your operating manual does not matter here - there are differ-
ence between Yaesu radios, just remember that the bytes are defined in the order
in which they are sent to the radio.

FT-817
Set mode to LSB ..: 00-00-00-00-07
Set mode to USB ..: 01-00-00-00-07
Split on .........: 00-00-00-00-02
FT-1000MP
Set mode to LSB ..: 00-00-00-00-0C
Set mode to USB ..: 00-00-00-01-0C
Split on _._._____.__.: 00-00-00-01-01

You can define more than one command; to do this start each command on a new
line.

Special Commands

Comment ..........: # Some interesting text.
Pause of 250 ms ..: @ 250
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User Defined
Macros

Ham Radio Deluxe

Macros

User created macros are combinations of fields on the Ham Radio Deluxe radio
display. Users of Microsoft Office will be familiar with the concept supported
here. When you start out you will see a Macros: Default sub tab in the Selection
window. This name will / can change depending on how you define your macros.
You can also add more sub tabs allowing you to sort your macros in a manner con-
venient to your operating style. Let’s do a couple of examples.

Manager

Select Manager from the Macros: Default menu, and then press New to create
our first new macro. This macro will switch your radio to 50.150 MHz in USB.We
will put it in a new sub folder called “Simple”.

First we will name the macro and where it will reside. We can then set the mode to
USB:

Macro Editor: T5-.

Define macro with standard (non-customized) buttons and definitions

Title: (required)
Group: |Macros: Simple ﬂ (required)
Description: |Change frequency to 50,150 MHz, mode to USE

1 In the Title field enter [50.150 MHz USB].
2 In the Group field enter [Macros: Simple].

3 In the Description field enter [Change frequency to 50.150 MHz, mode to
USB].
4 Press Add to open the Macro Editor.
5 Click on Dropdown Button
6 Select Mode: USB
{# Macro Editor: Add Field ‘ X
Select a definition and value, then press 'OK.
() Frequency 14.145.000 MHz
() Band Layout ’1BDm—1Dm (Region 1) v]
() Standard Buttan Switch: @ON  (JOFF () Always
(@) Dropdown Button ’MDdB (USB v]
() Advanced / Slider ’AF gain (main) v] [_]
() Delay (millisecs) 100
[ OK l I Cancel ]

7 Press OK.
Now we need to set the frequency to 50.150.000:

8 Press Add again to open Macro Editor
9 Click on Frequency button
10 Enter [50.150.000 MHz].
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Select a definition and value, then press 'OK.

(@ Frequency 50.150.000 bHz
() Band Layout ’150m-1ﬂm {Fiegian 1 v]

(7)) Standard Buttan Switch: @ ON  (JOFF () Always
(") Dropdown Button ’MDde :LsB v]

() Advanced /Slider | AF gain (main) -] Q

() Delay (millisecs) 100

[ Ok ] I Cancel ]

11 Press OK. Your definition now contains two entries:

Enable | Twpe | Title | “alue
Dropdown Button Mode : USB
Freguency 50.150.000

12 Press Save, this returns you to the Macros Manager.

& ® = =]
Mew Copy Edit Delete | Load Save

Define macros: settings are radio-specific!

Each macro is a collection of definitions (such as frequency, buttons and sliders) which are
applied when you selectthe macro. Example: define a special filter.

Group Title Description
Macros: Simple 50150 MHz USE  Change frequency to 50,150 MHz, mode to USE

13 Press OK. The window closes.

Macros |
CAT Commands
Macros: Simple
& Manager
Take Snapshot

(£ 50.150 MHz USB

Ham Radio Deluxe
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Another Example

This macro will switch your radio to 14.070 MHz in USB.We will put it in a new
sub folder called “PSK”.

1

~N N B W N

8

Reopen the Macro Manager which now can be found in the Macro: Simple
sub-folder.
In the Title field enter [20M PSK].
In the Group field enter [Macros: PSK].
In the Description field enter [Tune radio to 20M PSK].
Press Add to open the Macro Editor.
Click on Dropdown Button
Select Mode: USB
{# Macro Editor: Add Fieldl - X
Select a definition and value, then press 'OK.
© Frequency 14,145,000 MHz
@ Band Layout 160m - 10m (Region 1) v
(©) Standard Button Switch: @ ON  (JOFF () Always
(@) Dropdown Button ’MDdB (USB v]
() Advanced / Slider ’AF gain (main) '] U
() Delay (millisecs) 100
|
[ QK ] I Cancel ]
Press OK.

Now we need to set the frequency to 14.070.000:

9

Press Add again to open Macro Editor

10 Click on Frequency button
11 Enter [14.070.000 MHz].

Ham Radio Deluxe

| # Macro Editor: Add Fiel

Select a definition and value, then press 'OK.

® Frequency | 14,070,000 MHz
(" Band Layout |1BDm—1Dm (Region 1) ﬂ
 StandardButon  [57Hz v | Switch: ® ON ¢ OFF (" Always
(~ Dropdown Button |MDde:LSEI ﬂ
(" Advanced/ Slider |AFgain (main) ﬂ '\
Walue: m

" Delay (millisecs) 100

oK | Cancel |
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12 Press OK. Your definition now contains two entries:
13 Press Save, this returns you to the Macros Manager.

7 Vacros Vanager

2 ® =
Mew Copy Edit Delete | Load Save

Define macros: settings are radio-specific!

Each macro is a collection of definitions (such as frequency, buttons and sliders) which are
applied when you selectthe macro. Example: define a special filter.

Group Title Description

Macros: PSK 20M PSE Tune radio to 20 PSK.
Macros: Simple 50150 MHz USE Change frequency to 500150 MHz, mode to USE

14 Press OK. The window closes.
You now have two sub-folders of macros

. . . . Macros
displayed in the Selection window. You can
create more to match your operating needs. CAT Commands
Macros: PSK
Macros: Simple
& Manager
il Take Snapshot
Snapshots
The snapshot button creates a (# Take Snapshot [
definition that contains the state of :
all input fields. This is an easy Save current radio configuration in a snapshot macro
way of preserving a known state

. . Title: 14.145.000 MHz, CW (required)
of your radio once you have set it .

up exactly the way you want. You
can add functions as you did pre-
viously to further enhance your | | EditMacioFields |

snapshot. | !
I [ oK l I Cancel ]

Group: ¥ | (required)

Description: Frequency = 14.145.000 MHz, mode = CW, saved = 09

Your snapshots will be found in their own

Macros |
sub-folder of macros.

CAT Commands
Macros: PSK
Macros: Simple
Snapshots

(=

&: Manager

Ham Radio Deluxe
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4 Remote Radio Control

Remote Station Support

Introduction

Ham Radio Deluxe

A popular feature found in Ham Radio Deluxe that is not found in many other
ham radio software packages is the ability to operate your station via HRD’s built-
in remote server software.

There are places, however, where you may not be able to operate your base sys-
tem from remote. These places are, for example, your work environment where
the computers you use are behind a firewall or router that are not under your direct
control. Certain ports need to be available through the firewall and routers in
order for you to connect remotely to your base station and these may be blocked
in a corporate environment due to various reasons.Ham Radio Deluxe is evolving
into a program that supports all the serial port-enabled devices that you control at
your remote station.

For radio control you use the Ham Radio Deluxe Remote Server. For other devices
such as keyers and rotators you use the Ham Radio Deluxe Serial Port server.
Note that the Ham Radio Deluxe Remote Server is highly optimized for use with
Ham Radio Deluxe and should be used to control the radio.

The Ham Radio Deluxe Serial Port Server enables a connection between Ham
Radio Deluxe and serial port-enabled devices (keyers, rotators) connected to a
remote computer that can be contacted via TCP/IP.

Note: The process of setting up these remote servers is not something an
inexperienced computer user should attempt. Find a friend who makes
his living setting up and maintaining computer networks. Be kind to
them and reward them so they will come again and help when something
stops working.

Requirements
The remote computer must be running Windows XP through Windows 8.1. Win-
dows server software is also supported for 2003 and higher.

Technology

A Windows service is installed on the remote service. This listens on a port (usu-
ally 7805) for incoming connections from Ham Radio Deluxe (the client). For
more technical information see Ham Radio Deluxe Remote Server on page 70

External IP Address

When setting up your remote server there is one important thing you need to take
into consideration. If you plan to use the remote server and connect from within
your home network, lets say between the shack and your laptop on the patio out
back, there will be no problem. You will use the “localhost” or 127.0.0.1 address
to connect from the remote computer to the host system.

However, if you are planning on connecting to your system via the internet from
outside your home network you are going to have to know the exact internet IP
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Address of the computer you are connecting to. This connection must be a full
time connection.

ISPs assign a Dynamic IP Address to your computer system. For example, your
dynamic IP address may be 68.74.165.227. This would be the address you would
use to connect from your remote computer to your base system over the internet.
The problem comes in when most ISPs change that address from time to time
without you knowing it. Some change the IP address at random times, others
change your IP address each time you disconnect and reconnect your modem to
the internet while others change your IP address each day.

There are two solutions to this problem. The first is to contact your ISP and
request a STATIC IP address for the system where the remote server is running,
(your shack computer). This is usually inexpensive, around $5.00 or so a month
added to your internet bill.

The second solution would be to use a service such as NO-IP, DYNDNS or any
one of many such services which provide a free solution to the problem of not
having a static IP address. These services monitor your IP address and track any
changes while providing you with a constant connection through their DNS serv-
ers so any change in your IP address will not effect the address you use to connect
to your remote system.If you are installing on a remote computer then the com-
puter must have a static (non-changing) public IP address. If you have a public IP
address which is not static then visit Attp://www.no-ip.com/ and use the free IP
redirection option.

Internal IP Address
There is another IP address that also requires attention if you plan to run the HRD
Remote server on a computer in your shack.

If you have only one computer in your shack and it is connected directly to the
internet via a modem there isn't much problem. A problem arises if you have more
than one computer in your house and they each connect to the internet through a
router, wireless or hard wired.

When connected to the internet via a router, each computer connected to the
router has it's own INTERNAL IP Address. Just like with your Internet IP
address, this internal IP address can change depending on the sequence the differ-
ent computers are booted up and access the router.

It is advised you set an internal STATIC IP address for the computer running
HRD's Remote Server software. You will find instructions to do this in the next
section of this documentation.

Firewall

Make sure you open up ports 7805 (Ham Radio Deluxe Remote Server) and 7806
(Ham Radio Deluxe Serial Port server) for incoming TCP traffic. This will proba-
bly will need to be done on your router where your internet service enters your
home. The port assignments can be changed in the configuration files.

Ham Radio Deluxe
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Example

Ham Radio Deluxe

Remote Station Support

Local Remote

HRD Remate server
(Port 7805)

A4

COM1

WinKey uses virtual Rotator uses virtual
serial port COM20 serial port COM22

Virtual Null Modem
Cables
COM20 <= COmM21
COM22 = COM23

S
Rotator

e

!

ComM4 COMB

COM 21 COM 23

“ HRD Serial Port server
Fi (Port 7806)

r

COM21 {local) mapped to COM4 (remote)
COM23 (local) mapped to COME (remote)

HRD Serial Port client

In this example the remote station uses serial ports as follows:

+ COMI1 -->IC-7800,
* COM4 --> WinKey keyer,
* COMS6 --> AlfaSpid rotator.

Two virtual null modem “cables” are installed (pure software, no hardware
involved). The vCOM driver from N8VB is highly recommended;

See http.//www.philcovington.com/SDR.html. To install the vCOM drivers see
N8VB vCOM on page 243.

|011u0D By

In this example the “cables” map ports as follows:

¢ COM20 <->COM21, and
¢« COM22 <->COM23.
The local station connects as follows:

IC-7800

Remote port selected, TCP/IP connection made with the Ham Radio Deluxe
Remote Server running on the remote computer (port 7805).

The Ham Radio Deluxe Remote Server connects to the IC-7800 using COM1.
Keyer
The Ham Radio Deluxe Winkey interface connects to the Ham Radio Deluxe

Serial Port client on the local computer using the COM20 <-> COM21 virtual
cable.

The Ham Radio Deluxe Serial Port client connects to the Ham Radio Deluxe
Serial Port server on the remote computer using TCP/IP (port 7806).
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Virtual Null
Modem
Software

The Ham Radio Deluxe Serial Port server connects to the KIEL WinKey using
COM4.

Rotator

The Ham Radio Deluxe Rotator interface connects to the Ham Radio Deluxe
Serial Port client on the local computer using the COM22 < - > COM23 virtual
cable.

The Ham Radio Deluxe Serial Port client connects to the Ham Radio Deluxe
Serial Port server on the remote computer using TCP/IP (port 7806).

The Ham Radio Deluxe Serial Port server connects to the AlfaSpid rotator using
COM6.

The vCOM driver from N8VB is highly recommended; see
http.//www.philcovington.com/SDR.html.

This is the same as a null modem cable except it is made using software. The
vCOM software supports up to 10 cables. Each cable is allocated two COM ports.

You simply connect Ham Radio Deluxe to one end and the Ham Radio Deluxe
Serial Port Client to the other.

To install the vCOM drivers see N8VB vCOM on page 243.

Ham Radio Deluxe Remote Server

Gathering
Necessary
Information
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It is very important to setup a static ip address, if you are going to use port for-
warding. When you have port forwarding setup, your router forwards ports to an
ip address that you specify. This will probably work when you initially set it up,
but after restarting your computer it may get a different ip address. When this hap-
pens the ports will no longer be forwarded to your computer's ip address. So the
port forwarding configuration will not work.

What is an IP Address?

IP addresses are four sets of numbers separated by periods that allow computers to
identify each other. Every computer has at least one ip address, and two comput-
ers should never have the same ip address. If they do, neither of them will be able
to connect to the internet.

Dynamic vs Static IPs

Most routers assign dynamic IP addresses by default. They do this because
dynamic ip address networks require no configuration. The end user can simply
plug their computer in, and their network will work. When ip addresses are
assigned dynamically, the router is the one that assigns them. Every time a com-
puter reboots it asks the router for an ip address. The router then hands it an ip
address that has not already been handed out to another computer. This is import-
ant to note. When you set your computer to a static ip address, the router does not
know that a computer is using that ip address. So the very same ip address may be
handed to another computer later, and that will prevent both computers from con-
necting to the internet. So when you assign a static IP addresses, it's important to
assign an [P address that will not be handed out to other computers by the

Ham Radio Deluxe
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Setting Up a
Static IP For
Windows 7

Ham Radio Deluxe

dynamic IP address server. The dynamic IP address server is generally referred to
as the dhcp server.

Windows 7 and 8 set up in a similar manner. Windows XP uses a slightly different
process. If you can, print out these pages of instructions as you will have difficulty
viewing them online while you preform the config task.

1 Open up the start menu, and look for the Search programs and files box.

| Programs |

8™ 8

2 Type cmd in the Search programs and ﬁlesx, and press Enter on your
keyboard. This will bring up a black command prompt window.

#~ See more results

‘ cmd| X |

3 The command prompt may look different on your screen, but it doesn't
really matter. Type ipconfig/all in that window, and then press the enter key.
This will display a lot of information. If it scrolls off the top you may need
to enlarge the window.

yration. All rights res

Family Controller

1{Preferred>

4 Record the following information:
IP address

Subnet Mask

Default Gateway
DNS Servers

You may not have three DNS Servers. Just leave the unused blank. We are only
concerned with IPv4 entries, you can ignore the IPv6 stuff.
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The name server entries are a bit complicated. Name Server is just another name
for DNS (domain name server). Some router's act as a proxy between the actual
name servers and your computer. You will know when this is the case, because the
Default Gateway will list the same ip address as the Name Servers entry.

We need to have the correct Name Server IP addresses. If we do not, you will not
be able to browse the web. There are a couple ways to get these. The first way is
to log into your router's web interface, and look at your router's status page. On
that page you should see an entry for DNS Servers, or Name Servers. Write down
the ip addresses of your Name Servers.

Another way to get the correct Name Servers to use, is to give your ISP a call.
They should know the ip addresses of your Name Servers right off. If they ask you
why you need them, you can tell them you are trying to setup a static IP address
on your computer.

5 Type exit in this window, then press the enter key to close it.

Once again open the start menu. This time click Control Panel.
Click on Network and Sharing Center.

Single click Change adapter settings on the left side of your screen.

You might have more than one Internet connection listed here. You will need
to determine which adapter is your connection to the Internet if this is the
case. If you have a choice of a wired or wireless connection, choose the
wired connection.

10 You can either right click or double click on your network adapter and
choose properties to open up the properties window of this internet

O o0 3

connection.
@ o, L _f‘ o Network and Intermnet ¢ Network Conmections » w | 4y
Organize « Dusable thes network device Diagnose this connection Rename this connectson

‘:. Lecal Ares Connection
o B % Disable
= Intel 21140-Based

Status

Diagnose
% Bndge Conmections

Create Shortout

* PRename

% Properties '

11 Click on Internet Protocol Version 4(TCP/IPv4) and then the Properties
button.
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Ham Radio Deluxe Remote Server

| Local Area Connection Properties

e .

=)

Networking

Connectusing:

:'." Atheros ARB121/ARS113/ARS114 PCI-E Ethernet Controller(NI

This connection uses the following items:

18 Client for Microsoft Networks

gQOS Packet Scheduler

gFile and Printer Sharing for Microsoft Networks
. Internet Protocol Version 6 (TCP/IPvE)

. Link-Layer Topology Discovery Mapper |/O Driver
=& Link-Layer Topology Discovery Responder

/ -
'S Internet Protocol Version 4 (TCP/IPv4)

A

Description

Uninstall q Properties

Transmission Control Protocolfinternet Protocol. The defaultwide
area network protocol that provides communication across
diverse interconnected networks

I

Cancel

12 You will see the following screen:

=

Internet Protocol Version 4 (TCP/IPv4) Properties

General

=

‘fou can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator

for the appropriate IP settings,

() Obtain an IP address automatically

@ Use the following IP address:
IP address:

Subnet mask:

Default gateway:

Obtain DNS server address automatically
@ Use the following DNS server addresses:

Preferred DNS server:

Alternate DNS server:

192 .168 . 0 . 135
255 , 255 , 255 , O

192,168, 0 . 1

216,104 . 64 . 5

216 .104 . 72 . 5

| Advanced. .. i

ok || cancel |

13 Before you make any changes, write down the settings that you see on this

Ham Radio Deluxe

page. If something goes wrong you can always change the settings back to
what they were! You should see a dot in the Obtain an IP address
automatically box. If you do not, your connection is already setup for a
static ip. Just close all these windows and you are done.
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Installing
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Pick an ip address and enter it into the IP Address box. The ip address you choose
should be very similar to the router's ip address. Only the last number of the ip
address should be different. If the router's ip address is 192.168.1.1, I might
choose 192.168.1.10. The ip address you choose should end with a number
between 1 and 254, and should not be the same as the router's ip address. Every
device that connects to your network needs to have it's own IP address.

Put the subnet mask we previously found in the subnet mask section. The
default gateway should go into the Default gateway box. Enter the DNS Servers
we previously found into the two DNS Server boxes. Click okay all the way out
of this menu.

If you find that you can not pull up web pages, the problem is most likely the
DNS numbers you entered. Give your ISP a call, and they will be able to tell you
which DNS servers to use.

That's it you should be done! If you can't connect to the internet go back and
change your configuration back to what it originally was.
The Ham Radio Deluxe Remote Server files are:

¢ Ham Radio DeluxeRemoteSvr.exe — the executable, and
¢ Ham Radio DeluxeRemoteSvr.cfg — configuration file.
To install the service select Remote Service from the Tools> Programs menu.

Remaote Server Configuration i ﬁ

The status ofthe HRD Serial Port Server on this computer.

(Radio Support) (Keyer & Rotator Support)

HRD Remaote Server ‘ l HRD Serial Port Server

Service name: HRD SerialPartSwvr I
Display name: Ham Radio Deluxe Sertial Port Server

Configuration: DiProgram Files (x86)\HRD Software, LLC\Ham Radio I
Logfile:

Il Laststarted:

Status: The specified service does not exist as an installed service.

| Install Femowve Start Stop |
Configure Wiew Log Help

1.0 Introduction

1| »

| The HRD Remote Server enables a connection between Ham |
Radio Deluxe and a radio connected to a remote computer
which can be contacted via TCP/IP. I

| 1.1 Requirements -1
g J

1 Press Ham Radio Deluxe Remote Server to select this server.

2 Press Install to install the service, and then press Start to start the service.
You can start the Windows Services applet (Start > Settings > Control Panel >
Administrative Tools > Services) to modify the properties of the service, for
example disabling automatic startup.
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Firewall

Ham Radio Deluxe Remote Server

Ham Radio Deluxe Remote Server Properties (Local Computer) E]E]

General | Log On | Recovery | Dependencies

Service name HRD RemateSwr

Display name: Ham Radio Deluxe Remote Server

The Ham Radio Deluxe remaote serser, ww.harm-

Description i
radio.ch

Path to executahle:
"ChProgram FileshAmateur Radio\Ham Radio DeluxetHRDRemote Svr.exe"

Startup type: Automatic
Service status: Stopped

“You can specify the start parameters that apply when you start the service from
here.

Start parameters:

Ok } l Cancel

Allow incoming connections on port 7805.

Configuring
Press Configure to edit the file that contains the service configuration. Lines

needing configuration are highlighted in the configuration file below. Each user
who accesses the system must have a username and password. A pound sigh (#)

as the first character of a line indicates the line is a comment and the # must be
removed from the line before it is recognized by the software.

Note: Remote Server Runs on Windows XP/SP3, Windows7 and Windows 8

This file defines the configuration of the Remote Access Server.

A comma-separated list of COM ports that are returned. If not defined then
the server returns a list of all COM ports available on the computer.

# Ham Radio Deluxe Remote Access Server
H
# Copright (c) 2011-2013 HRD Software LLC
#

#

#

#

# The format of each entry is TOKEN = VALUE.
#

#

#  Supported tokens

H & ———————————_—

# COM

# PORT

# USER1 to USER20

#  WELCOME

#

#

#

#

#

#COM = COM1,COM2,COM3,COM4

@COM = COM3 )

Config file continues on next page.

Ham Radio Deluxe
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#

##  The TCP/IP port on which the server listens for connections. If not defined
#  then the default value of 7805 is used. Select any port number you want which
# 1s not in use by other programs.

#

PORT = 7805

Username/passwords, these are case-insensitive. Spaces are removed
from the beginning and end of the username and password.

The format is USERx = username,password

H oHHF R HH

/tﬁERl Simon,SnowTime,restart
USER2 Peter,Uberwald
UKSERZO = Donald,California

#

# Welcome text, displayed on the remote user®s computer. Note that

# \n is replaced with a newline. Enter up to 511 characters on a single line.

#

@ELCOME = Welcome to the HRD Remote Access Server.\n\nPlease don"t break anythin@

The contents of this file should be obvious. After changing the configuration, save
the changes and you should restart the service.

Restricting TX

One special note — to restrict a user’s ability to switch the radio to transmit there
are now optional tokens added with the username and password to disable access
to the TX and any Tune buttons. Add no_tx after the password.

In addition you will want to disable macros as a knowledgeable user can define a
CAT command to enable TX. Add no_macros after the password.

Enable Restart

The RESTART token enables the Restart button on the connection window.
Restarting the service will close all COM ports opened by the service and drop all
connections by Ham Radio Deluxe users.

This should only be allocated to yourself and your friends!

Ham Radio Deluxe



Chapter 4 - Remote Radio Control Ham Radio Deluxe Remote Server

Connecting to Connecting to the host computer from remote is almost like connecting to the
the Remote radio while on the base computer system.
Server

If you don’t already have it done, you will need to

1 Install Ham Radio Deluxe, if you have not done so, on the computer you
plan to use for the remote connection.

2 Once installed, run Ham Radio Deluxe.
3 When the Rig Connection screen appears, you will need to set this up
EXACTLY as it appears on your HOST system, with ONE exception.

Instead of entering a comport number you select REMOTE from the drop
down box as indicated by the red arrow in the image below.

Mew ‘ Preset | Serial Ports | Help|

Cormnpaty: |Yaesu Status

Radio:  |FT-350

COM Port: | (EELELE

Speed: |3340.|]
0-
Flows contral / Interface power

B [~ DTR |+ RTS

c : [~ Always connect ta this radio when
s starting HRD' Rig Contral. Auta Start

Auta Exit [ HRD Digital b azter

Start HRD Rig Contral in - [~ HRD Logbook
- Full Screen mode g
o I HRD Rotator

[ Entire HRD Suite [~ HRD Satelite Track

4 Press Connect and the Remote Connection window will display.

Connect to @ computer running the HRD Remote Access Program ‘

Presiouz Connections Mew Connection
Address User | Pot | PTT Config Address: W
96.50.34.247.7305 Robet COM1 COM1, DTR Pt ,W‘ Disfaulk = 7805
Username: lHUbEll—
Password: I’“"""“‘—‘
¥ Save settings
ferm n Connect @ Load Save
Statuz COM Ports

Select a previous connection or create a new one.

« Ok Cancel @) Help

Ham Radio Deluxe 77
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5 Inthe New Connection area of this window enter the IP address or the
domain name of the HOST system. If you are working from inside your
home through a router, enter the address of 127.0.0.1. The port is the default
port of 7805.

6 Now you enter a valid user name and password that was configured in the
Rig Control Configuration file. You can check the Save Settings box so next
time you connect you just select the connection from the list on the left side
of the display. The user name and password are not case sensitive.

To save these values make sure the Save settings option is checked [X].

8 Press the Connect button. The display will change showing the Com Ports
in the lower right half of the screen.

9 Select the com port from the drop down box that connects to the radio at the
HOST location. You can also uncheck the box for the optional PTT com
port.

10 Press the OK button at the bottom of the window and the next screen you
see should be the rig display from the remote server.

At this point if you have problems connecting to the host machine, you need to
double check all your settings. Check to make sure the firewall or router are not
blocking the ports required. If you are still having problems and can’t find the
answer, feel free to contact HRD Customer support for help.

Load connection information from a file.

Save Save connection information to a file.

Press Connect.

If the connection is successful you will see the confirmation window and the text
Username / password authenticated. Select a remote COM port, then press ‘OK’
is displayed below the Connect button.

’S Remote Connection E|

Connectto a computer running the HRD Remote Access Program

Frevious Connections MNew Connection
Address Usemame COM Fort Aelilizs 152000.no-ip.arg
Incalhost 7805 COM1 Part 7805 Default = 7605
ts2000.no-ip.org: 7505 COM4
yaesu.no-ip.info: 7805 COm1 Usemame:
Fassword: ssssases
F Load ] [ Sawve I Comnel:t Save seftings

Connected ta ts2000.no-ip.org:7805, usemame/password COM Port: COM4 v
authenticated

Selectaremote COM Fort. then press 'OK!
’ Logfile ] ’ Bestart I

[ ok [ cocal |[@ Hel |

Now select the COM port, and then press OK to connect to the remote COM port
and start the Ham Radio Deluxe radio display.

When the connection with the radio has been confirmed a Remote Connection
display window shows you the data throughput and average round-trip time.
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Ham Radio Deluxe

Ham Radio Deluxe Remote Server

Fo 12/03/2006 05:22:32

Found trip: 227ms == f e

Remote Connection

Fo 12/03/2006 05:22:45

Found frip: 227 ms

| 015KBYs
Recv. (NNNNNNNNNNNWNEEEEE ] 022 KBS
Fefrash interval: 100 ms hd
Send frequency: @ Async (O Sync

Fegularly Fead From Radio

[V]Fraguency [ ]Dropdowns
[VIMeters [sliders
[ ]Buttons [ ] Status texts

[ Pefeshal | [@ Helg ]

Use the Remote Connection window to show the status of the remote connection.

* Round-trip time: the time required to send a message from Ham Radio
Deluxe to the remote server and get a response. This will be very similar to
the value shown when you use Ping to interrogate a remote host. Typically
values of 50 milliseconds or less are very usable.

* Refresh interval: the interval between refreshes of the selected Regularly
Read options.

» Send frequency: when the frequency is updated over a link with a high
round trip time (> 100ms) the performance will be less than optimal with
Sync selected so if the round trip is high select Async, otherwise just select
Sync. The disadvantage of using Async is an 'elastic band' effect while
tuning by dragging Ham Radio Deluxe's small tuning marker.

* Regularly Read: the options that are regularly updated. If you are using a
fast link - for example to a local station with a low round- trip time then you
can safely select all options. The disadvantage of selecting options such as
Buttons, Dropdowns, Sliders and Status Texts is that it may take a second or
two before Ham Radio Deluxe detects that you are changing the frequency
by dragging the tuning marker and the current refresh operation cannot be
interrupted.

Slow Link

If you have a slow link - a round-trip time > 100 ms - then select only Meters. As
this is a remote station it is unlikely that anyone else will be adjusting the radio's
controls so you will not need to refresh buttons and dropdowns as you would with
a locally connected radio.

The disadvantage of not selecting Buttons and Dropdowns is that inter-button
dependencies will not be shown - for example you may have 4 AGC buttons Off,
Fast, Medium and Slow, only one of which will be active at any one time. If But-
tons is not enabled for regular refreshes then pressing Fast will not update the
other AGC buttons. In this case you must press the small refresh button to the
right of the Buttons check box.

To refresh all display options click Refresh All.
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Problem Solving
The following steps are recommended to solve problems using the remote server.
1 Run Ham Radio Deluxe on the remote computer to check that you can
actually connect to your radio.

2 When you connect to the remote server make sure you have closed Ham
Radio Deluxe on the remote computer. If you get the error “Access is
Denied” then the COM port is held open by another program.

Ham Radio Deluxe Serial Port Client

Starting Select Port Client from the from the Tools> Programs menu.

File Connections Logfile Server Theme Help

5] 9
Server: Connect | Add Modify Delete Ping Tracing Clear Log

Connections |Log1i|e |He\p |
Enakle Title Local Status Remote Settings Status
Ready Connected | © TX: 0 KB|® RX: 0 KB

You must define the serial port mappings before you connect to the serial port
server running on the remote computer.

Mappings Press Add to define a new mapping.

X

Mapping
Title: | Simon's WinKey

Local port: Comz20 hd
Femote port CORr1 v

Remote Fort Settings

Speed 1200 v [V] Enable DTR
Data bits: |8 v [IEnakle RTS
Parity: MNane hd
Stop bits: |1 A4

| 0K | ’ Cancel

Each mapping consists of:

» Title — whatever makes sense to you. In this case we’re mapping to a K1EL
WinKey on Simon’s remote station in the south pacific.

* The local port — one of the virtual null modem ports. Here the two ports are
COM20 and COM21.

* The remote port — Simon has connected the WinKey to COM1 on the
remote computer.

* Remote port settings — WinKey uses 1200,8,none,1.

* [X] Enable DTR and [_] Enable RTS — usually checked to provide power to
a special powered cable or device. For Winkey you must check DTR to
provide power to WinKey!
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Remote Port Settings
Some useful remote port settings are:
*  WinKey — 1200,8,none,1 and [X] Enable DTR.
* AlfaSpid RAS rotator — 600,8,none,1.
» AlfaSpid RAS rotator — 1200,8,none, 1.
¢ Idiom Press rotator — 4800,8,none, 1.

Connecting Press Connect to connect to the serial port server on the remote computer.

 Connect EJIEI@

Connectto: 201.42.12.2496
Username Bobo

Fassword: [ITTTITL]

I Connect H Cancel ]

In the Connect to field enter the remote address, for example 201.42.12.246. If

you are not using the default port (7806) then append a colon and the port number,
for example 201.42.12.246:7808 to connect to port 7808 on 201.42.12.246.

In the Username and Password fields enter the username and password you have
been given; these must also be entered in the configuration file.

When you have finished just press Connect.

Assuming everything works correctly the client will display log information simi-
lar to that below:

X HRD Serial Port Client 1.0 build 48

Fle Wiew Mappings Logfle Server Help

—* ) A D’ )'( _T -| 'd

Disconnect Fing Server Tracing Clear Lag

On | Mapping Local Status Remote Settings Status
[0 Simon's WinKey COM7 COM1 1200,M,8,1

Datestime Mapping Log

16-03-2000 17:49:19.355 Connecting to 201.42.12.246 port 7006
18-03-2006 17:49:19.355 Connected to 201.42.12.246 port 7806
18-03-2006 17:49:20.996 Remote: Serial ports: COM1,COM3,COM4,COMS,COMB
18-03-2006 17:49:20.996 Connecting to 201.42.12.246 port 7806
158-03-2006 17:49:20.996 Connected to 201.42.12.246 port 7306

The client makes two connections; one to send data, the other to receive data. The
remote server returns a list of known serial ports after the first connection is estab-
lished, in this case COM1, COM3, COM4, COMS5 and COM6.

Now check the Simon’s WinKey mapping and you see logfile messages as the
local (COM20) and remote (COM1) serial ports are opened.
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X HRD Serial Port Client 1.0 build 48

Chapter 4 - Remote Radio Control

Eile ‘Wiew Mappings Logfle Server Help
= e 5w [ x m @)
Disconnect Ping Server | Tracing Clear Log
On Mapping Local Status Remote Settings Status
Simon's WinKey COM20 Connected COMI1 1200,N,8,1,0TR Connected

Date-time

18-03-2006
18-03-2006
18-03-2006
18-03-2006
18032006
18-03-2006
18-03-2006
18-03-2006
18-03-2006

.537
.552
. 749
L7449
L7449
.903
.903
.4903
.903

Mapping

Simon's WinKey
Simon's WinKey
Simon's WinKey
Simon's WinKey

Log

Connecting to 201.42.12.246 port 7806
Connected to 201.42.12.246 port 7806

Remote: Serial ports: COM1,COM3,COM4,COMS5,C0ME
Connecting to 201.42.12.246 port 7806
Connected to 201.42.12.246 port 7806

COM1 Connected

COM20 Connected

Starting thread COM20 =»> COM1

Started thread COMZ0 => COM1

Now you can connect to the remote WinKey using COM21 (the other half of the
COM20 <-> COM21 virtual cable).

If you enable = Tracing you see the data sent and received as the WinKey code
runs through the initialization and performs an echoback test.

X HRD Serial Port Client 1.0 build 48

Ele “iew Mappings Logfle Server Help
+— 1
2 o v [ X m Q) 4
Disconnect Fing Server | Tracing Clear Log
On Mapping Local Status Remote Settings Status

¥ Simon's WinKey COM20 Connected COM1

1200,H,8,1,DTE Connected

Datestime

15-03-2006
18-03-2006
18-03-2006
18-03-2006
18-03-2006

15-03-2006
15-03-2006
15-03-2006
18-03-2006
18-03-2006
18-03-2006

TR AN AINNEA

Mapping
. 286
.094
. 148
L161
.215

Simon's
Simon's
Simon's
Simon's

L228
.282

.349
.363
L417

AT

Simon's

Simon's

Simon's

Simon's

Simon's

Simon's
\

Caimen o

Lag 5
Tracing on

WinKey =» 03 bytes: 00 04 48

WinKey <= 01 bvtes: 48

WinFEey =» 03 bytes: 00 04 52

WinKey <= 01 bytes: 52

WinKeny =» 03 bytes: 00 04 44

WinKey <= 01 bytes: 44

WinKeny =»> 03 bytes: 00 04 20

WinKey <= 01 bytes: 20

WinKEey =» 03 bytes: 00 04 42

WinKevy <= 01 bytes: 42

Tald m e =" N2 Thsrtec= N0 N4 EQ A

>

Congratulations — you can now use your remote WinKey.
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Ham Radio Deluxe Serial Port Server

Installing The Ham Radio Deluxe Serial Port files are:

¢ Ham Radio DeluxeSerialPortSvr.exe — the executable, and
* Ham Radio DeluxeSerialPortSvr.cfg — configuration file.
To install the service select Remote Service from the Tools> Programs menu.

The status ofthe HRD Serial Port Server on this computer. {k‘

HRD Remote Server HRD Serial Port Server
(Radio Support) (Keyer & Rotator Suppor)

Service name: HRD SerialPortSyr

Display name: Harn Radio Deluxe Serial Port Serer

Configuration: CAPragram Files (x86\HRD Software LLC\Ham Radio
Logfile:

Last started:

Status: The specified service does not exist as an installed service.

Install |

Canfigure |

|011u0D By

1 Press Ham Radio Deluxe Serial Port Server to select this server.

2 Press Install to install the service.

3 Press Start to start the service.
You can start the Windows Services applet (Start > Settings > Control Panel >
Administrative Tools > Services) to modify the properties of the service, for
example disabling automatic startup.
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Ham Radio Deluxe Serial Port Server Properties (Local Compu... @ '

General | Log On | Recavery | Dependencies

Service name: HRD SenalFPortSwr

Display name Ham Radio Deluxe Serial Port Senser

The Ham Radio Deluxe serial port server, ww harm-

Description
raclio.ch

Path to executahle:
"DiHam Radio\Release\HRD SerialPorSwr exe"

Startup type: Autornatic hd

Service status: Stopped

“r'ou can specify the start parameters that apply when vou start the service from
here.

Start parameters |

[ OK l ’ Cancel

Firewall
Allow incoming connections on port 7806.

Configuring Press Configure to edit Ham Radio DeluxeSerialPortSvr.cfg that contains the ser-
vice configuration.

Ham Racio Deluxe Serial Port Server

Copright <) 2006 by Simon Brown, HESDRV.

Note; this only runs on windows hT/2K/XP. It does not run
on windows 95/98/ME/SE

This file defines the configuration of the rRemote Access server.
The format of each entry is TOKEN = VALUE.

supported tokens

PORT
USERL To USERZO
WELCOME

A comma-separated 1ist of com [Ijorts that are returned. If not defined then
the server returns a 1ist of all coMm ports available on the computer

oM = COML,CoM2, COoM3, ComMd

oM = COML

The TCR/IP port on which the server listens for connections. If not defined
then the default value of 7806 is used. select any port number you want which
is not in use hy other programs.

84F%=k4=% ﬁ:ﬁﬁ:%%ﬁ% FHEFEEEEE R EE TR

RT = 7806
#
# Username/Easswurds, these are case-insensitive. sSpaces are removed
#  from the beginning and end of the username and password
#+
#  1he Tormat 1s UskRX = username,password,optlons where options 15 a
#  Tist of case-insensitive tokens seperated by spaces (hot commas).
#
# The supported options are:
# RESTART
#
#  RESTART allows the user to restart the service, usually reserve this for only
#  for yourself and friends you trust!
#
USERL =imon, snowTime, restart

USERZ = Peter,Uberwald
= ponald,california

optional welcome text, displayed on the remote user's computer. Note that
“hnois replaced with a newline. Erter up to 511 characters on a single Tine.
remove this Tine if you do not want a welcome message

ELCOME = welcome to the HRD Serial Fort Server.nwnPlease don't hreak anything
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Passing Audio

\Voice

Ham Radio Deluxe

After the completing of the rig control portion of a remote station you will need to
setup the ability to pass audio to and from the remote station. If you are only
working the digital modes like PSK31 you will not need to worry about this. Cw
was discussed previously in this chapter.

Skype has been a tradional method of passing audio in both directions. A great
new option has been added to DM-780 in Ham Radio Deluxe Version 6.2. This
new option brings us one step closer to being able to provide fully integrated
audio within the Ham Radio Deluxe suite of programs for remote operation, with-
out having to rely on 3rd party software such as skype.

HRD has added an option which allows you can operate voice communications
using a standard, inexpensive computer headset.

This Option Will Not Work On All Radios!!!
This option will NOT work on some radios due to the following conditions.

This failure to work is NOT a fault of our code but rather caused by variations in
the implementation of PTT on different radios. VOX won't work on some radios,
PTT won't work via rig control on some radios, there may be no audio out if an
external PTT foot switch is used with a back-panel ACC connection, some radios
will have to be programmed via their menus and there are a variety of other possi-
bilities. Some radios have at least six different methods of PTT and each PTT
input has it own foibles! This makes it almost impossible for Ham Radio Deluxe
to cover ALL the different ways in which PTT is handled. Therefore, this option
is available ONLY for those radios that can handle it, and those that can't, it's the
fault of a "non-standard" implementation of the PTT function in the different
manufacturer's radios.

|011u0D By

Configuration
The Ham Radio Deluxe Voice option is easily activated from within the DM-780
module.

1 Open DM-780.
2 Click on Program Options and open the sound card dialog as indicated

below.
Program Options " e
|
Appearance Soundcard |'
Callsign (My Info} . |
i nout (Receive) eadset Monio
Clock out (Recerv Hex: orior
Legbook Devce | Micmphene (4 USE Audo CODEC ) v V| Enable ool be graved f ol avaisbie)
Modes + IDs Mcmorore
PTT e
Redio Mouphone (gh Definton fud. =~ =
Q50 Output (Traneme) y
Eamhone
Soundcard S E— -
Devic 4-USB A CODEC - "
Sounds sice s 8 00EC) b Headohones (High Defintion Audo  ~
Storage
SuperSwesper Monkor Voice [acho to headse!
Waterdall o -
Output (Transmi)
Input (Receive)
Alarms.. @ dB 2548 ) 5B 10dE 1548 ) 2dB 't‘-e,-':c: Select the zc-J_r:t-:af: used
Favorit fo wving signals, the line in is
avorites.. Kchorsatic il control connactad to the audio cutput from
Macros VOur
Modes Increzse sgral level to 1007 < A
Smuwrrar adact rha snut cnusrre «
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You will notice on the right side of the dialog a new section has been added.
You will also notice the note that states the enable function will be
"GRAYED OUT IF UNAVAILABLE". To activate this function, place a
check-mark in the enable box.

Next, select the Microphone you intend to use, which is normally the default
microphone for the computer sound card.

Next, select the Headphone, again normally the default. Once these are set
your almost ready to go.

The next step is to select the VOICE mode from the modes listing as shown
to the right.

Once this step is complete you will notice a change n the Transmit Toolbar.
Instead of seeing the normal "SEND (F4)" you will see instead "PTT (F4)"
This is your PTT button for the microphone. Just click the PTT button and
start talking and click the "STOP" button to return the radio to the Receive
mode.

= |voicer| H D |2 2 - [ & ([

y [ cw »
RTTY »
PSK »
QPSK »
CONTESTIA »
DominoEx »
3 Hell >
MFSK »
MTE3 »
OLIVIA »
RTTYM »
THOR »

b QSO | pBTU | MIRST(Q) | P Nar
Throb »

q . e — Epz—z

V >

T mie H Vq&? —| PH PSE <erase

CQ CQ CQ de KB3NPH KB3NPH KBE3NPH
CQ CQ CR de KB3NPH KB3NPH KB3NPH PSE <erase

This new function has been tested with the FT-857D using the Timewave Naviga-
tor interface. It seems to work great on Upper Side Band, however, on this partic-
ular radio, if you plan on using the function to communicate on any 2-meter FM
repeaters, you MUST put the radio into the PKT mode. The reason for this is the
FT-857D can only accept audio through the DATA plug on the back of the radio
with the rig set to USB or PKT and not set to any other mode.

When tested with some contacts on a local repeater, I received very good audio
reports using an inexpensive, $14.00 computer headset purchased from Walmart.
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5 Advanced Features

Audio

Introduction

Audio Grabber

Ham Radio Deluxe

Ham Radio Deluxe has a built-in audio grabber and audio playback. This feature
requires a connection from your radio the your sound card in your computer or an
external sound card interface.

The audio grabber stores incoming audio in MP3 files using the MP3 tags to store
information about the radio settings (or any other information you feel to be
important).

An alternative to MP3 would be Windows Media format (WMA) but the pro-
gramming of WMA files is rather complex.

To display the audio grabber select Audio Grabber from the Tools menu.

By default the Audio Grabber is docked at the bottom of your Ham Radio Deluxe
Screen. By grabbing the top bar o the Audio Grabber you can undock it and make
it a separate window. To redock the wind grab the top bar of the Audio Grabber
and start moving it into your Ham Radio Deluxe window. You will see arrows at
the four edges plus four arrows in the middle of the screen. Move the Audio Grab-
ber over the desired arrow and it will dock in that location.

Record

Audio Grabber. x|

Record | Folder | Quality | Soundcard | Tags|
(@] 00:05 9KB 1.8KE/s

File limit: |30 minutes - HRD 2012-05-08 104250.mp3

|011u0D By

Here you have the standard recording buttons. From left to right:
¢ Record,

*  Stop,

* Reset current recording,

* Restart (close current file first),

* Browse for MP3 files.
You also set a file limit — a downside of MP3 is that the tags are written at the end
of the file when it is closed, so to avoid losing information in the event of an unex-
pected event it is best to use more, smaller files.

Folder

Audio Grabber X
Record | Folder |Qua|ity | Soundcard |Tags|

|‘% Select || Default ||® Browse |

E’audio Files

Changes are applied when vou start recording

Here you select the folder where the MP3 files are stored.
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Audio Browser
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Quality
Audio Grabber =N S
_ Quality | Soundcard | Tags
Bandwicith: [4.5 kHz (2 KB{s) VI Higher bandwidth = larger file
Quality: [\-’ery high VI Better quality = more CFU
Changes are applied when you start recording Defaults

Here you select the bandwidth and quality. Modern computers have more than
enough CPU power to support a very high quality. A bandwidth of 4.5 kHz is usu-
ally acceptable unless you are recording a WFM broadcast.

Soundcard

Audio Grabber L x]

| Record | Folder | Quality| Soundcard |Tags|

Record frorm:

| Steren Mix (V14 High Definition v

Changes are applied when you start recording

Select the soundcard that you are recording from.

Tags

Audio Grabber . = W]

| Record | Folder | Quality | Soundcard | Tags |

Artist  [TS-2000 Apply
Album: 5/8/2012 4:42 PM UTC
Tile:  14.200.000, USE

Here you see the values stored in the MP3 tags. To change the values just add the
new text and then press Apply.

Use the audio browser to playback MP3 files. To open the Audio Browser, select
Audio Browser from the 7ools menu. You can also start the Audio Browser by
clicking on Browser in the Folder tab within Audio Grabber.

Ham Radio Deluxe
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Peter PH1PH came across IrfanView — an excellent freeware utility.

MP3 Player Options

Player
Select MP3 player — a basic MP3 player is built into Ham Radio Deluxe, however

Audio

'3 Audio Browser (MP3 Files) s | E] |

I Planser &

IHam Radio Deluxe vl

[|speed ' D I
| V]valume U
Fepeat [ |Play as Wave

. (]2 O
To: @ | U

0:00.000

» n | |

Foder [ @ | @ || & ] ‘E:\Audiu Filas\HRD

Copy Delete kowve Fename 3 Grabher
Aist Album Title Description s} Irfan'yiew
File Size  Arist Alburm Title
« HRED 2012-05-08 104250.mp3 GKE TS-2000 5/8/2012 442 PMUTC  14.200.000, LIS

« HRD 2012-05-08 105627, mp3  30KB TS-2000  5/8/2012 456 PM UTC  14.200.000, LIS
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you can select an alternate player such as the excellent Windows Media Player.
Press Default to select the default player.

Folder

Select the folder to browse

Select default folder

m Refresh the current folder
s

Audio File
Select a file to play from the list at the bottom of the window.

Ham Radio Deluxe

Play currently selected file
Pause

Start again

===

Stop
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From
E Start at beginning of file

Set From at the current position

To

E To end of file

Set To at the current position

Use the From and 7o slider positions to select the part of the file to repeated over
and over and over again. This is useful for determining exactly what the station
was sending.

The other options are:
* Copy — copy the selected files to another folder.
» Delete — delete the selected files.
* Move — move the selected files to another folder.
* Rename - rename the selected file.
» Artist/ Album / Title / Description — change the MP3 tags.

DDE Support

Introduction

Available
Support

Commands

90

Ham Radio Deluxe uses dynamic data exchange (DDE) for inter-process commu-
nication. DDE allows two or more applications running simultaneously to
exchange data and commands.

For more information See “3rd-Party Programs” on page 94.

Select DDE Monitor from the 7ools menu to display the supported DDE items.

DDE Monitor e

All currently supported DDE items (for software developers)

Service:  HRD RADIO

Topic: HED CAT

Ttem Value -
HED_ EBAND 20m
HED_BUTTON_STATUS

HED DOFPLER_DOWHNLINE
HRD_DOPPLEERE_UPLINK I
HED DROPDOWH_LIST

|| | BRD_EXEC_RESULT

HED FREQUENCY 14,235,000 -
« 1 L4
E

111

The commands below are supported by Ham Radio Deluxe.

Add ADIF Record
ADIF <data>

Adds a record to the logbook; the record is supplied in ADIF format. Used by
PSK31 Deluxe.

Ham Radio Deluxe
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Ham Radio Deluxe

Refresh
REFR button_status

Refreshes all buttons.
REFR dropdown_list

Refreshes all dropdown.

Set Button
BUTN button_title=value

Sets a button state. For normal buttons the value is either on or off.
If title starts with @ then it’s a dropdown, the value must be a dropdown value.

Set Dropdown
DROP button _title=value

Selects a dropdown value.

Set Frequency
FREQ <hertz>

Sets the frequency to the value supplied in Hertz.

Set Mode
MODE <mode>

Sets the mode to the supplied value.

Top Window
TOPW

DDE Support

Makes the Ham Radio Deluxe the top-most window in the Z-order, in other words

brings Ham Radio Deluxe to the front of your monitor.

91
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Synchronizer

Introduction

Starting

92

O
O

z * %;%ﬂ:%i:% FHFEFEEFRFEFEFEE R R TR

RT

FHHFEFEEFREEEE S

FHHEHEEH®

Ham Rradio Deluxe serial pPort server

Copright c) 2006 by Simon Brown, HESDRV.

note; this anly runs on windows RT/2K/XP. IT does not run
on windows 95/98/ME/SE

This file defines the configuration of the Remote Access Server
The format of each entry is TOKER = VALUE

supported tokens
com

FORT

USERL to USERZO
WELCOME

A comma-separated 1ist of Com Eorts that are returned. If not defined then
the server returns a Tist of all com ports availahle on the computer

COML, COM2, COM3 , COM4
coM1

The TCP/IP port on which the server Tistens for connections, If not defined
then the default value of 7806 is used. select any port number you want which
is not in use by other programs.

= TEOG
Username/passwords, these are case-insensitiwe. Spaces are removed
from the beginning and end of the username and password

the format 1s userx = username,password,options where options 1s a
Tist of case-insensitive tokens seperated by spaces (not commas)

The supported options are:
RESTART

RESTART allows the user to restart the service, usually reserve this for only
for yourself and friends ywou trust!

Siman, ShowTime, restart

2 - Feter,Ubherwald
= ponald,california

optional welcome text, displayed on the remote user's computer. MNote that
“nods replaced with a newline. Erter up to 511 characters on a single Tine.

remove this Tine if you do not want a welcome message.

WELCOME = welcome to the HRD Serial Fort Server.\mywnPlease don't break amything!

The synchronizer is used to control two or more radios where a common fre-
quency is shared by using the Dynamic Data Exchange (DDE) mechanism.
For each radio you are using you start an instance of Ham Radio Deluxe, one
instance is the Master, the rest are the Slaves, the slaves receive frequency and
mode information from the master.

Start the Synchroniser from the 7o0ls> Programs menu, then press Scan to find
the active Ham Radio Deluxe instances.

Ham Radio Deluxe
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& HRD Synchroniser

—Active HRD Instances

5
ODBEEEEEEE s |
—HRD Master
Master: ID:TS—4BD:DemD j .
T = -
—HRD Slaves
Fo 1 Tzl rC4rs e 7 e s

Befresh | Clear | Help | Close |

Freg ...: 145.793.379 ~

Mode .. .: USE
Slave -- Connected to instance 1

Radiao ..: EZ2: Demo

Freg ...: 145.793.379

Mode .. .: USE
Slave -- Connected to instance 2

Radia : TE-2000: Demo

Freg ...: 145.793.379

Mode .. .: USE
Master - Disconnected from instance 0O |

Synchronizer

Select the master instance (supplied the frequency and mode), and then press

Start.

ol HRD Synchroniser,

—Active HRD Instances
=
OopEEEEEEE - |
—HRD kaster: T3-480: Dermo
haster: ID:TS—4BD:DemD j n Stop |
Frequency: IRadio j 145.798.635
hode: IRadiD j
—HRD Slaves
Fomi1 ve 3 406 FC6 7 8 [
Befrash | Clear | Help | Close |
Radia : TE-480: Demo ~
Freq ...: 145.798.879
Mode ...: USE
Slave -- Connected to instance 1
Radiao ..: EZ2: Demo
Freq ...: 145.798.879
Mode ...: USE
Slave -- Connected to instance 2
Radia : TE-2000: Demo
Freq ...: 145.798.879
Mode ...: USE |

In the Frequency and Mode dropdowns you select the corresponding source from
the Ham Radio Deluxe master instance:

Ham Radio Deluxe

Radio — as seen on the main Ham Radio Deluxe display,
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3rd-Party Programs

Dual Radio
Satellite
Tracking

Chapter 5 - Advanced Features

* Transverter — frequency is taken from the Transverter window (selected
from the Tools menu).

» Satellite uplink — the uplink frequency and mode (see Ground Control on
page 213).
» Satellite downlink — the downlink frequency and mode (see Ground Control
on page 213).
In the Ham Radio Deluxe Slaves group box check the instances to be controlled
by the Synchroniser.
As soon as you check a slave the slave®s frequency and mode are updated with the
current values from the master; every time the master frequency and / or mode
change they are sent to the slave for so long as the slave option remains checked.

Refer to Satellite Tracking on page 209, specifically Ground Control on
page 213.
If you are using two radios for satellite tracking (for example two FT-817 or IC-
7000):
1 Start an instance of Ham Radio Deluxe for each radio; connect to the radios.

2 Select an instance to use as the master, in this example the radio used for
receive.

3 In the master (receive) instance:
* Start the display.

 Enter transmit and receive frequency information for the satellite you are
tracking.

¢ Check the RX VFO, do not check a TX VFO as this instance will not be
used for transmit.

4 Start the Synchroniser:
¢ Master is the receive instance,
e Slave is the transmit instance,

* Select the Satellite uplink option for Frequency and Mode so that the
slave receives the frequency and mode used for transmit as computer by
the Master instance.
The slave will now be updated with the transmit frequency and mode for transmit
every time it changes in the master instance.

3rd-Party Programs

Introduction

94

Ham Radio Deluxe supports 3rd-party programs such as logbooks via a virtual
serial port. See also DDE Support on page 90.
An example of a virtual serial port is available from Phil Covington N§VB. His
homepage is http://www.philcovington.com/SDR.html look for the N§VB vCOM
Virtual Serial Ports Driver download.
To install the vCOM drivers see N8VB vCOM on page 243. The N8VB driver
works with Windows 2000, XP and higher.
N8VB's solution creates a pair of virtual COM ports (virtual because there is no
hardware associated with a virtual COM port). The ports are effectively connected
back-to-back — just like a normal serial cable.
In the description that follows two ports are created during the installation, COM7
(used by Ham Radio Deluxe) and COMS (used by the 3rd-party program).

* Ham Radio Deluxe opens and listens on COM?7 port for incoming requests.

* The other program opens COMS in exactly the same way it would connect

Ham Radio Deluxe
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Configuring

Testing

Ham Radio Deluxe

to a radio using a hardware serial port.
The connection parameters used by the 3rd-party program to connect with COMS8
are:
* Speed — any (9600 by default but this really doesn't matter),
* Stop bits — 2,
* Parity — none.

The protocol supported is Kenwood, the command set current supported is:

* FA —Get/set VFO-A.

* FB - Get/set VFO-B.

* MD — Get/ set mode.

* IF —Read status, currently frequency, TX status, and mode are supported,

* SM — Read the S-Meter.
To use this option Ham Radio Deluxe must be connected to a radio, otherwise the
standard Kenwood error response?; will be returned. The radio does not have to

support the Kenwood protocol as Ham Radio Deluxe makes the necessary conver-
sions.

Select 3rd-Party Serial Port from the Tools menu.

Introduction

Ham Radio Deluxe supports 3rd-party programs such as
logbooks via a virtual serial port.

An example of a virtual serial port is available from Phil
Covington MN8WE, this will be available from the Ham Radio
Deluxe downloads page http:/fhrd ham-

radio.chidownloads . html when it has finished beta testing. o,

[V] Connectwhen Ham Radio Deluxs starts

Bort: COr7 ~| PBeads: 0
Mode: Default | Whrites: 0
Status:  27-Dec-200517:43:04 [COM?] Closed

l oK ” Apply H Cancel ]

1 Enable opens the connection on the selected port — in this case COM?7.

Check Connect to automatically open the connected everything Ham Radio
Deluxe starts.

3 In the Port dropdown you select the COM port to use
4 The Mode dropdown is reserved for future use. The only option is Default.
5 Press OK

And that“s all there is to it.

[\

To test the connection:

1 Start HyperTerminal (supplied with Windows thru XP. If you are using Vista
or Win7 download Teralerm which is a free app and is better than
HyperTerminal).

2 Connect to COMS (the virtual serial port used by the 3rd party programs).
3 Enter FA; you will see a value such as FA00050100000; returned

95
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(50.1 MHz).
Command FA Reads and sets the VFO A frequency in Hz
Detail Set FA<11 digit frequency>;
Read FA;

Answer FA<1l digit frequency>;

FB Reads and sets the VFO B frequency in Hz

Set FB<11l digit frequency>;
Read FB;
Answer FB<l11l digit frequency>;

IF Retrieves the transceiver status

Read 1F;
Answer 1FP1P2P3P4p5P6P7P8POP10P11P12P13P14P15;

Where:
P1 = 11 digits, frequency in Hz
P2 = 5 digits, not used
P3 = 5 digits, not used
P4 = 1 digit, not used
P5 = 1 digit, not used
P6 = 1 digit, not used
P7 = 2 digits, not used
P8 = 1 digit, 0: RX, 1: TX
P9 = 1 digit, see MD above
P10 = 1 digit, not used
P11 = 1 digit, not used
P12 = 1 digit, not used
P13 = 1 digit, not used
P14 = 2 digits, not used
P15 = 1 digit, not used
MD Recalls or reads the operating mode status
Set MD<mode>;
Read MD;

Answer MD<mode>;
Where mode is one of:

: None
- LSB
2: USB
3: CwW
4: FM
5: AM
6: FSK
: CWR (CW Reverse)
- Tune

9: FSR (FSK Reverse)

SM Retrieves the S-Meter value

Read SM;

Answer IF<4 digit value>;

Where the returned value range is from 0000 to 0030. Each
unit 1Is 1/2 an S-unit. S5 i1s 0010, S9 i1s 0018.
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Chapter 6 - Logbook

Introduction

6 Logbook

Introduction

Setup

Ham Radio Deluxe

It is time to be impressed! Ham Radio Deluxe Logbook is probably the best log-
book program and it keeps getting better. As you will see later, the awards track-
ing capability is second to none.

You will need to go through a few steps to configure logbook.

Database

Ham Radio Deluxe Logbook is built on Microsoft Access. The driver normally
used is the Microsoft Access Driver (*.mdb)ODBC driver. You do not need a
license to use Access databases - the runtime DLLs are included in Windows XP
or newer.

You can create and manage additional databases for use within Logbook. You can,
if you desire, create a separate database for contest work or a special event.
Beware that this can create issues if you are interested in awards tracking.

To manage your database(s), select Manager from the Toolbar.

i o
» HRD Logho s T go ook S

File Edit View Browser Calendar Countries Logbook

5| [ @

Tools Window Help

7| a a @ |
Open || Layout A Layout B | Rig Control Digital Master Rotator | Tune-Main Tune-Sub | Add\ Manager

This opens the Logbook Databases window.

= Logbook Databases

)

¥00qgboT

B

s
Add Open Modify Delete | Move Up Move Down | ODBC Administrator

Title Data Source Username | Password | Lookups | Description

My Loghook HRD My Logbook - Access Yes Default HRD Loghook using a Microsoft Access database

ok || concel

Within this window you can add new or modify existing databases.

Other Databases

Logbook can be built on MySQL if you choose. Support for MySQL is beyond
the scope of this document.

Other (non-Ham Radio Deluxe) logbooks are supported via a DDE interface (see
DDE Support on page 90) and a serial port (see 3rd-Party Programs on page 94).
So you can use the logbook of your choice with Ham Radio Deluxe provided it
supports DDE or the Kenwood protocol via a COM port.
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My Station
If you have not already set up the necessary information within my station you
will need to do that now. This will prove to be critical later so best do it now.

1 From within Logbook select from the Tools menu, Tools > Configure > My

Station.
- — = = == — —
™, HRD Logbook - [My Logbook] DA g = — T G o —— - b P Py —-—
J File Edit View Browser Calendar Countries Logbook | Tools Window Help
= = ] @ M Digital Master 780 @ &N 7
Open | Layout A Layout B | Rig Control Digital Master Rotats B8 Ham Radio Deluxe About Home .|| Full Screen
ES My Logbook x| @ HRD Rotator
@ s x B ¥ @ B @ Satellite Tracking o8 [=] 4
i Add Contest Delete View | Cut Copy Paste | Refresh vards Tracking Backup More...~
w Disable Screen Saver
S * & i
3 | LOTW Upload LOTW Download #' ODBC Administrator
= - C Repair A Datab
= o QSO date | e em | call |Mode | Sen: ompress ar hepair Access Database
= License Key Manager
> T 1@/17/2p13 21:34:58 N4QEZ PSK31 578&
gx. 12/2/2ppée 17:@6:54 KBSYLG PSK31 599 Global HRD Settings
§  7/26/1998 21:0p:59 SXIT  SSB 59 Logbook s
5 7/26/1998 16:55:13 ONJDU SSB 59 58 17m Johann Belgium A
& | 6/19/1998 21:15:4p FBC2YT SSB 59 58  17m Paul  France AR
6/2/1998  ©2:35:@6 G3HOG SSB 59 59 17m England Backips
5/18/1998 2@:52:46 CO2WF SSB 59 59 17m Cuba Eay
5/17/1998 @3:2@:1g CP50C SSB 59 59 2¢m Ed Bolivia Callsign Lookup
5/17/1998 ©3:83:59 IZ2ZLG SSB 57 57 17m Guy Italy ClubLog
5/15/1%88 15:36:42 WEOQX SSB 59 59 17m Bill United State DX Cluster
5/15/1998 @3:17:31 KJ6EO SSB 59 59 17m Bill United State eQSL.cc
5/13/1998 @1:53:87 PYZMNL 55B 56 57 17m Brazil ErEriEs
4/15/1998 19:22:p4 ONEZK SSB 59 58 17m Belgium # HRDLog.net
| Modes

DX Cluster: NOZRD not connected My Statian '

b Connect Node HBIDRV-2 = Show- ALL = |11 (3| & Alarms~ & Options | @QRZ.com | @4 Network Server
g QS0 Forwarding —
‘ TJ_me| Freq| DX Call| Spotter‘ Con'cment| Worked Modes| )
Radio Pane

Radio Screen
Rotator

RST Options
Sharing S

30 Day Solar Data  Solar Cycle Progression  Audio Monitor | DX Cluster: NOZRD not connected . B
Tuning Dial

Configure my station - location, equipment etc.
=

2 Information in the My Station screen is used by Ham Radio Deluxe Logbook
and DM-780.

Note: Ifyou have already set up the DM-780 portion of the suite, this screen
should be populated with the required information and you can just close
it out and continue with the set up.
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Ham Radio Deluxe

B My Station

Introduction

KBINPH | Guest

. Callsign:
Owner:
Operator:

B Name:
Street:

B City:
Courty:

State/Province:

eMail:

License Club:

Equipment:
Antennas:

Power:

ZIP/Postal Code:

These values are uzed in the Add b odify Logbook window.

B = Required by DX Cluster for Connection in Logbook

————

SIG: Copy Al
S1G info:
%Locator:
=[]
Latitude: 0.000000 rFoorN
. Longitude: [0.000000 | rorE
CQ zone: 0 ITu: |0
IOTA: ] ]
Country: |v |
Web Page:
Watts I}

My Station Set Up

Ham Radio Deluxe allows you to set up multiple QTH locations. This allows you —

to have a Home location as well as other locations such as a vacation home or

favorite portable locations.

Multiple Callsigns

If your License Manager shows more than one callsign
such as for parent and child or husband and wife, you
are able to enter station set up information for each call-
sign. You can also set up “Guest” accounts for club or

special event stations.

If you haven’t already set up the My Station data, in the
Description field you see the word HOME for a profile of your Home QTH. This
generates your main location. Then go ahead and fill in all the rest of the informa-
tion for this location. Please note which fields are required if you use one of the

DX Clusters.

¥ooqgbo

o

NOZRD | KDOHUV | Guest

[ Add Location l

l Remove Location l

Most of the fields are self-explanatory. A couple of the fields do need a little
explanation. The field SIG stands for Special Interest Group. This could be a club
or any organization you belong to. The SIG Info field could be a website address
for a group. You could leave these fields blank if you like.
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% Locator EN36QR

Latitude: 0°0"0'N
Longitude: 0.000000 00"0'E

CQ zone: 0 ITU: 0

Another spot you might need help is once you enter your Locator, for example
EN36QR, if you hit the little arrow that points downward, that will automatically
fill in your Latitude and Longitude fields.

% Locator: EN36AR
Latitude: 46.729167 467 43" 55' N
Longitude:  -92.625000 92°37"30'W
CQ zone: 0 ITU: 0

By the same token, if you know your Latitude / Longitude, enter them and hit the
upward pointing arrow to fill in your Locator.

If you operate from mobile or maybe have a vacation
home, you can generate My Station profiles for those i My Static] ‘
locations as well by clicking on the Add Location but-
ton. You can copy the data from the Home location to
be placed in an additional location then just edit any-
thing that is to be different for that profile. Each profile
is auto-saved when you exit the screen by clicking the
red X in the upper right corner.

NOZRD | KDOHUV | Guest
Add Location )

Remove Location l

Once you’ve completed configuring your Tags and My Station, your almost home.
Just a couple more things before you can go on the air live with DM-780.

Note: This chapter is currently being totally re-written. The many new
features need to be discussed in detail. Some are covered in the
next two chapters. The outline below lists what is coming in this
chapter. Watch the website for updates.

Setup topics
How Logbook works
MS Access based or MY SQL if you dare
My Station setup
Manual data entry
Auto entry

General features

Ham Radio Deluxe
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Ham Radio Deluxe

Allows you to easily store QSO info and track awards

Integrated call sign lookup
Adding entries from paper logs

Interfacing with DM-780

Logbook — A Tour

Menus

Toolbar

Radio pane

Audio monitor and recorder
Browser

Monitor

Digital clock

Favorites

Greyline

Logfile

Radio Pane, Radio Screen
Solar data

Rig tuning (Main and Sub)

Layouts — tuning the product to your style

Introduction

As you can many great improvements are forthcoming. Everything from

here to the end of chapter is old and highly suspect for accuracy.

NOZRD - The Work Wacker

103

¥ooqbo



Main Display Chapter 6 - Logbook

Main Display

™%, HRD Logbook - My Logbook] %) ] o~ = )
File Edit View Browser Calendar Countries Logbook Tools Window Help -8
B s i 1 e e s e ] e R Y
Open | Layout A Layout B | Rig Control Digital Master Rotator | Tune-Main Tune-Sub | Add Manager | About Home | | Full Screen NBZRD 14.235.000
1My Logbook x| -x[m
9 » ( @ a " | Q o o B @ @& @ g
I)_‘ Add Contest Delete View i [ aste | Refresh Width Layout Edit Selections ORZcom | Awards Tracking Backup More..= | Filter QSL Award
> 1w LOTW Download
,3 O| Q50 date Time on | Call Mode | Sent | Rcwd Band | Name Country =
= 579 579 2¢m United States
& = 599 599  2@m United States
2 5% 59 17m Uganda I
£ 59 59 Tm Johann Belgium
3 59 59 17m Paul France
| 59 5% 17m England
5% 59 17m Cuba
5% 59 2Pm Ed Bolivia
a7 57 17m Guy Italy
39 59 17m Bill United States
59 59 17m Bill United States |
56 57 17m Brazil I
ONEIK 39 59 17m Belgium - [l
All | Default |ACCESS |22
DX Cluster: MOZRD nat connected x| Greyline PO x I
F Connect Node HBSDRV-9  +  Show-~ Al v [ [ | o Alarms~ FOptions | @ QR !
Time Freqg| DX Call| Spotter Comment | Worked Modes
| 30 Day Solar Data  Solar Cycle Progression  Audio Monitor | DX Cluster: NOZRD not connected ‘
| Ready 0
When you start Ham Radio Deluxe a default logbook is created in the default files
folder, see Files on page 84.
Options Selection fields:
Entties [Date [IEitter [Exact [1Summarise Sort
kiax: 10000 A By: | Date = -
And: = R

Select the entries that are displayed:

Entries — the maximum displayed in the main list. The fewer you display the
faster they are loaded. The maximum you can display is 25,000 — if you have
more than 25,000 entries in your database then only the first 25,000 that match the
selection criteria are displayed.

Date — display entries since this date. Typically you will only display entries from
the last few days.

Filter — filter by any field (except dates) — for example mode or callsign. Check
Exact for an exact match.

Summarize — display the first entry that matches the selection. For example, if you
select Country and Band you see the first entry for each country and band.

Sort — select the sort criteria (alternatively click the column headers).

i\ Print the logbook (page 90). Select Print Setup from the File menu to select
S paper size, layout, etc. Use Print Preview first to see what it will look like.

(_Ll Print preview — see what your logbook looks like before you print it. Print
preview can be very CPU intensive with a large logbook (25,000 or more
entries) so be prepared to wait a few seconds before it starts drawing.
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Adding An Entry

Add a new entry (page 76).
Edit the currently selected entry.
Delete the selected entries.
Start the logbook analyser.

Plot selected entries using Mapper. To be plotted an entry must have a valid
=" Jocator.

K @X Qs

IELI Reload the database and refresh the display.
£ Auto fit the column widths to their contents.
I@ Define column layout.
@ Backup the database.

— Database configuration.

&

Lookup station using QRZ.com.
@ Plot station locations using Google Earth.

Adding An Entry

Main

Ham Radio Deluxe

Select Add Entry from the Logbook menu. Here you see many more fields than
those in a paper logbook; only a few are mandatory.

—
@)
Q
The entry window is divided into two sections: Main and Tabbed (for want ofa O
better description). 8

>~

The Main section contains the frequently used fields whereas the Tabbed section
contains the less-frequently used fields.

Contact

(F2) Start: ‘19/02/2005 v‘ 13:10 |2 -
(F3y End: [ Same as start 13:10 - Band:
(F5) Sation: |HBQD]w H oRz ) | MEen |_3.785.Dnn |

retresy [o o [ 827 [a]
RST Sent: |599 CigTA oo ]

Locator: —_ Address: |Postfaoh 158, Laa, SWITZERLAN[‘

Marme: |S\mon Brown QTH: |Laa>< ‘

Bermark: |Ultra—coo\ ‘

[E

The buttons [=2) and [>*] respectively hide and show the tabbed fields, ideal for sim-
ple contest operation when you want the minimum of visual “noise”.
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[Field

Start

End

Station
QRZ
RST
Recv

RST
Sent

Locator

Name
Remark
Mode

Band

Freq

Cnty

I0TA
Address
QTH

[Description ]
The QSO start date and time. With the Options you can:
* automatically set the start (and end) time to the current time when
pressing the Reset button, and

+ Set the start time when a callsign is entered in the Station field (the
time is set when the Station field loses focus).

The end time. The date is taken from the start date, if the end time is less
than the start time then it is assumed that the QSO ends on the next day.
With the Options you can:

+ automatically set the end (and start) time to the current time when
pressing the Reset button,
* set the end time when you add the QSO.
The callsign of the other station.
Press QRZ to retrieve information from QRZ.com (see below).

The report received from the other station. With the Options you can select
the default value (if any) entered in this field when you press Reset.

The report sent to the other station. This field is divided into two parts:

1 the RST sent, and
2 the additional information sent, for example a serial
number.
With the Options you can select that the RST sent count is automatically

Maidenhead locator square. If a valid 4-character (major) or 6-character
(minor) square the distance and bearing from you locator in the My Station
tab is shown.

Filled in by you or via a QRZ.com lookup.

The other station“s name, filled in by you or via a QRZ.com lookup.
Whatever you want; filled in by you or via a QRZ.com lookup.

The mode — if you enable the option track radio mode then the value here
is taken from the Ham Radio Deluxe display. If this option is not enabled
then pressing L% loads the current Ham Radio Deluxe mode.

The band — determined from the Ham Radio Deluxe frequency is the
option track radio frequency is enabled. If this option is not enabled then
pressing =l loads the current Ham Radio Deluxe band.

The frequency — determined from the Ham Radio Deluxe frequency is the
option track radio frequency is enabled. If this option is not enabled then
pressing L= loads the current Ham Radio Deluxe frequency.

[X] Freq: Make sure this checkbox is checked otherwise the frequency is not added.
Country — selected from the dropdown list or determined automatically if
the option find callsign from callsign prefix is enabled.

[X] Cntry: Make sure this checkbox is checked otherwise the country is not added.
Islands on the Air - http://www.rsgbiota.org/.

The address field, filled in by you or via a QRZ.com lookup.

The station location, as in ,,my QTH is...”. Filled in by you or via a
QRZ.com lookup.

An excellent Internet resource, http://www.qgrz.com/is used by Ham Radio Deluxe
to find station information. The fields supported are shown below. Ham Radio
Deluxe extracts information by parsing the detail field for a station, for example
hitp.//www.qrz.com/detail/HBIDRV.

In the Options window you can enable automatic QRZ lookups.

Ham Radio Deluxe
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Log

Contact

Ham Radio Deluxe

Adding An Entry

QRZ Lookup E3]

Double-click to copy a field

Field “alue

Callsign HB3IDRY

MHarne Simon Brown

Address Postfach 159, Lasx. SWITZERL
CTH Laax

Country SWITZERLAMD

Locatar JHAGpt 0.0° 0.00 km

Horne Page  hitp:f fveeewe hb 3d e ch

Q5L wia Swiss Bureau

Latitude 46.812545

Langitude 9291418
Biography Authar of Ham Radio Deluxel A

< >

[ Itdatch exact country name

’ Home Page l l QRZ Page l

| copvangr] || Close |

Log Contact | Location | GSL | eQSL | Ant/Sat | Contest | Propagation | My Station | Custom

Last 100 " Partial match ” Exact match

Date Start | Station Sent Recv Locator Band Mode MName -

22/05/2004 1063 OMN4AGE  BA ] 400 SSB Walther

06/05/2004 04:14 G30ORE 59 59 160M SSB Peter

0B/05/2004 03:53 FEHUM ] ] 80M SSE Jacoues

0B/05/2004 0353 FEWL ] ] B0M SSB Edouard

06/05/2004 0353 FBTXT 59 59 aih 38B Jean I

0B/05/2004 03:53 FBGFM k] k] 8on SSB Bernard o

05/05/2004 21:07 FEBWO 58 =] 160M SSEB - Jeff v

< > (@)
|Field | Description | o
Last 100 Shows the most recent 100 entries from the logbook. ~

Partial match |List the most recent 100 entries from the logbook that partially match
the currently entered callsign.

Exact match |List the most recent 100 entries from the logbook that match the
currently entered callsign.

Log Contact | Location | QSL | e@SL | Ant/Sat | Contest | Propagation | My Station | Custom

Age 48 3IG: Foc

Email simon@hb3dry.ch SIG info:  |Fourth class operator's club
URL: hitp:févenni. hb8drv.ch 10-10:

Equipment: Far too many toys

Biography: Author of Ham Radio Deluxe! Also known as GD4ELL

More information about the station you have contacted.

Field | Description |
SIG The name of the contacted station™s special activity or interest group.
SIG info | Information associated with the contacted station's activity or interest

10-10 Ten-Ten number
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Location
Log Contact| Location | QSL | eQSL | Ant/Sat | Contest | Propagation | My Station | Custom
County: CQ zone:
Statefprovinee:  GR ITU zone:
ARRL sect: v Distance:  |1316] kms
Continert: OaF OaN Oas LatLon 46.612500 9.291667
®EU OnNa Ooc
Osa O Unknown
[Field [Description ]
County The contacted station's Secondary Administrative Subdivision of
contacted station (e.g. US county, JA Gun).
State/ The code for the contacted station's Primary Administrative

province Subdivision (e.g. US State, JA Island, VE Province).
ARRL sect |The contacted station's ARRL section.

CQ zone The contacted stations CQ Zone.

ITU zone The contacted station”s ITU zone.

Distance The distance between the logging station and the contacted station
in kilometers.

Lat/Lon The contacted station“s latitude and longitude. Press L] to

determine the latitude and longitude from the Locator field value in
the Main part of the window.

Log | Contact| Location| @SL  eQSL | Ant/Sat | Contest | Propagation | My Station | Custom

@SL Sent  |Mo ~ || namzr2008 v
QSLRecy  |MNo | 1810272008 -

QSL Via Swiss Bureal

Standard QSL information.

eQSL

Log | Contact | Location| QSL | eQSL | Ant/Sat | Contest | Propagation | My Station | Custom

e@SLSent |Mo  v|[Dgmzz0s v eQSLUser  Simen
eQSLRecy: Mo ~ || 18/02/2008 v cQSL Pl eessse
eQSL Status: V] eQsL co real-time uploads

Not supported by ADIF, these are fields for use with eQSL.cc.

Field | Description

eQSL status Status of the most recent upload.
eQSL user Logon username

eQSL pwd Logon password

eQSL.cc real-time |If checked then an upload is made every time you add a QSO.
uploads This is also known as real-time uploads.
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Ant/Sat
Log | Contact | Location| QSL | eQSL | Ant/Sat | Contest | Propagation | My Station | Custom
Antenna Satellite
Azimuth: 1o Path; () Short Marme:  |AO0-51
Elevation: |21 Olleny Mode |UsE]
() Grevline
O Other
Reset fields after adding an entry
[Field  |Description
Azimuth |The logging station's antenna azimuth, in degrees.
Elevation | The logging station's antenna elevation, in degrees.
Path The signal path.
Name Name of satellite.
Mode Satellite mode.
Contest
Log Contact | Location | QSL | eQSL | Ant/Sat | Sontest | Propagation | My Station | Custom
Check:
Class:
Precedence:
Contest: CA-QSC-PARTY v

Reset fields after adding an entry g
) «
If you check [X] reset fields after adding an entry then the fields are erased when o
an entry is added. If not checked then the fields are not erased. 8
_ ~
[Field [Description
Check Contest check (e.g. for ARRL Sweepstakes).
Class Contest class (e.g. for ARRL Field Day).
Precedence Contest precedence (e.g. for ARRL Sweepstakes).
Contest QSO Contest Identifier.

Propagation

Log Contact | Location | @SL | eQSL | Ant/Sat | Contest| Propagation | hy Station | Custom

Aindex: 3 Murm bursts:

K. index 1 Furm pings:

Solar flux 78 hax bursts:

M3 shower: Prop mode Sporadic E '

Wi Diowenload Last updated: 2006 Feh 19 1208 UTC

Basic propagation information, press WWYV Download to load the latest informa-
tion from http.//www.sec.noaa.gov/fipdir/latest/wwv.txt.

[Field [Description
Aindex |The geomagnetic A index at the time of the QSO.
Kindex |The geomagnetic K index at the time of the QSO.
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[Field [Description ]
Solar flux |The solar flux at the time of the QSO.

MS shower|For Meteor Scatter QSQO’s, the name of the meteor shower in
progress.

Num The number of meteor scatter bursts heard by the logging station.
bursts

Num pings | The number of meteor scatter pings heard by the logging station.

Max bursts|Maximum length of meteor scatter bursts heard by the logging
station, in seconds.

Prop mode | QSO propagation mode.
A description of your station at the time of the QSO. These fields are the same as
those in My Station on page 85.

Select a profile by pressing the corresponding button; press Save to save any
changes you make.

[Field |Description |
Callsign |The logging station's callsign (the callsign used over the air).
Operator | The logging operator's callsign.

Owner |The callsign of the owner of the station used to log the contact (the
callsign of the Operators host).

SIG The logging station®s special activity or interest group.
SIG info |Information associated with the logging station's activity or interest
group.

Log Contact | Location | QSL | e@SL | Ant/Sat | Contest | Propagation | My Station | Gustom
Erewery # Senior Citizen #:

Lighthouse: Custom field 4:

Custom field 5:

Custom field B:

[JReset fields after adding an entry

Here are six totally customizable fields, use them as you wish. If you check [X]
reset fields after adding an entry then the fields are erased when an entry is added.
If not checked then the fields are not erased; the values are stored in the registry
and loaded the next time you start Ham Radio Deluxe.
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Options

Ham Radio Deluxe

Adding An Entry

“ Options: Add @
Loghook Fields Appearance Behaviour (Add Only)
| Field Status Show S-metar Autn-mcrement RST Sent count
Address  On Show current date and time Find country from callsign prefix
Country On
Frequency On [ =end locators to Mapper
Locatar On Layout Size (Restart Required)
10T A on [¥] Track radio frequency
MName Qn { Smmall ” hedium “ Large 1 Track radio madea
QTH On
Remark On
QRZ on Reset (Add Onby/) Audio Grabber (Add Only)
Resetfields after adding an entry Dlsplayret:urdmgpanel
[ Set start & end time o current time If audio iz heing recorded
[ Auta-restart when new entry added
Default RST sent 533 When recording is stopped:
Default BST recy 549 [ Add callsign to filename
=l I l blang ] Put callsign in MP3 Artisttag
Start / End Times (Add Only) QRZ (Add Only)
Set startwhen callsign entered [¥] Auto-load fields from QRZ.com
I oK 1 [ R I [ Set end whan adding 050 [+#] Only cverwite empty fields

Logbook Fields
Select the fields that are displayed — reduce clutter during a contest when you only
want the bare minimum.

Appearance

The current S-Meter and date/time are shown at the top of the window; remove
these if you don’t want them.

Reset (Add Only)

Select what happens when you press Reset or when you add a new QSO and the (S
[X] Reset fields... option is checked.

07

Layout Size (Restart Required)
For tired eyes — set the window size to Small, Medium or Large. You must reset
Ham Radio Deluxe for the change to take effect.

4004

Reset (Add Only)

Select what happens when you press Reset or when you add a new QSO and the
[X] Reset fields... option is checked.

Start / End Times (Add Only)
As part of the QSO automation enable these options to set the start time when you
first move out of the Station field and the end time when you add the QSO.

Note — the start time is not updated if you edit the callsign. It is set only when you
move out of the Station field for the first time.

Behavior (Add Only)

During a contest you will want to auto-increment the RST sent counter — the first
numeric part of the RST sent field is updated, for example 042GR is updated to
043GR.

The country is determined from the callsign prefix using the logbook’s country
data (List - Countries on page 87).
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Audio Grabber (Add Only)
Enable display of the Audio Grabber so that a new audio file is created for each

QSO.
QRZ (Add Only)

Chapter 6 - Logbook

QRZ.com is an excellent resource — here you enable automatic lookups.

Appearance

Date
17/12/2004
22/06/2004
22/06/2004
22/06/2004
20/06/2004
20/06/2004
15/06/2004
15/06/2004
1z/06/2004
1z/06/2004
1z2/06/2004
05/06/2004
05/06/2004

07/06/2004
n7/neAs7nna
<

Colour

Appearance

Start
19:
17:
ov:
07:
17:
14:
22:
13:
Oo:
05:
05:
20:
20:
20:
70 -

03
29
33
33
31
an
a5
25
an
59
24
51
43
58
55

V] &dtemate colours eveny

List Calours and Fant

End

19:
17:
0
07
17:
14:
22:
13:
0a:
05:
05:
06:
20:
20:
20 -

2

[ Select

J

Default

03
29
33
33
31
oo
05
17
oo
59
24
05
48
58
55

v

Station Band
ASDF 2190m
FADHT 40M
F4EEU/P a0mM
F1INT g0M
PA/G3IIC/P 40M
F4DCG/ P 401
Klgs 20M
FSEYT/M 2M
FOCz a0M
FI1CZS a0M
THTORR 80M
F4DgM 80M
FAESF 160M
F1TF 160M
F AT T AN
Font

Mode

L5B
55B
55B
358
L3B
L3B
FIM

FIM

35B
35B
35B
S55B
55B
55B
con

Default

Sent &
551 §!
59
59
59
59
59
59
50
59
59
50
50
56
58
cA

Adjust the appearance of the display to suit your own taste. Using alternate colors
makes reading copious data much easier. Using a larger font helps with tired eyes

Custom Fields

Custam field 1:
Custom field 2:
Custom field 3:
Custom field 4:
Custom field &:

Custom field 6:

Lighthouse:

ltalian caste

‘Warked all brewery #

Custom field 4:

Customn field 5:

Custom field &

Custom Fields

Custom field fitles (you may need to restart HRD)

Define the titles for the six custom fields available in the logbook windows. Use
these fields for values not supported elsewhere.
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Yarious
“arious options
Rerark: Locator (small display) Fermark: Frequency (Add)
Insertlocator + distances * DApp_end_frequencyto Remark field
T (radio window must be stared)
*From my locator (if defined) Prefic  |Frequency =
Distances tapper
Units: @ kms (O miles [T 2end any locator and callsign to Mapper (f
Mapperis running)
Toolbar lcon Toggles Time Zone [Display)
.:;-. Main .-::. Srnall Times are always stored using GMT /UTC,
this option determines haw they are
displayed.
@GMT/UTC (O)Local
The options here should be self-explanatory.
List- Bands
Band Definitions I—
Title MinFreg MexFreg ADIF - Comment e o
2190m 130.000 140,000 2180m ADIFZ.0 (Q
160m 1.800.000 2.000.000  160m ADIFZ.0 U
80m 3.500.000 4.000.000 80m ADIFZ2.0
B0 5.200.000 5.500.000 E0m  ADIF 2.0 O
40m 7.000.000 7.300.000 40m  ADIFZ.0 o
30rn 10.100.000 10.160.000 30m ADIFZ.0
20m 14.000.000 14.350.000 20m ADIF 2.0 ;:
17m 16.000.000 16.200.000 1?m ADIF2.0
16m 21.000.000 21.450.000 16m ADIFZ.0
12m 24.850.000 26.000.000 12m ADIF 2.0
10m 28.000.000 30.000.000 10m ADIFZ2.0
Bm 50.000.000 54.000.000 B ADIF 2.0
4m 70.000.000 70.500.000 4m ADIFZ.0
2m 144.000.000  148.000.000 2m ADIFZ0
1.25m 220.000.000 225.000.000 1.25m ADIFZ.0
0cm 420.000.000 460.000.000 flcm ADIF 2.0
33cm 33cm ADIFEZD

23cm 1240.000.000  1300.000.000 2icm ADIFZ.0
13cm 2320.000.000  2450.000.000 13cm ADIFZD0

9cm Gcm ADIF 2.0

Bcm Bcm ADIFED

3cm Jocm ADIFED

1.25cm 1.25cm ADIF20

Cormien Civenimn ATIE 2 N ¥
[ Beset ] i YWiewear ]

The band ranges. This information is taken from the ADIF specifications; it is
used to determine the correct band from a frequency.

Resets the table and loads the latest values built into Ham Radio Deluxe.
Display this data with the default text file viewer.
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List- Countries
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Country Definitions

Country DxCC  Comment  Prefic w
Aaland Isl. 005 ADIFZ0  OHO,OHOAROJD

Abu il [deleted] 00z ADIFZO Al4

Afghanistan 003 ADIF20  YATE

Agalega/St Brandon o004 ADIF20 366367

Alaska 006 ADIFZ0  KLZMLZWLZ ALTKLWLALMNL
Albania 007 ADIFZO 24

Aldabra [deleted] 008 ADIF2.0  wQg/A

Algeria 400 ADIF20  ZHFRFT.IU Y. W 7Y

American Samoa g ADIF20 KHEAHBMNHEWHE
Amsterdam/St.Paul | 010 ADIF2.0  FT2ZFT4ZFTRZFTELFTOZFBEZF
Ancaman & Micobar | 011 ADIF20  YU4NVUTGY

Andorra 203 ADIF2OD  C3

Angola 401 ADIFZ0  DZD3

Anguilla 012 ADIFZ0O  wPZE

Annaobon | 185 ADIF2.0  3C0

Antarctica 013 ADIF20  4K1 FBSY.CESA ZL5 Z58BBE.Z58A4
Antigua & Barbuda 094 ADIFzO w2

Argentina 100 ADIF20 LULY LWAZAY

Armenia 014 ADIF20 EKUGRGUBGREGEKEGEMBGEN
Aruba 031 ADIF20 P4 3
< >
[ Beset ] i Load fram file ] i Browse \Weh ]
[ Viewer ] i Update Loghook Entries ]

The data used to determine country from the callsign prefix.

Resets the table and loads the latest values built into Ham Radio Deluxe.

Display this data with the default text file viewer.
Loads new data from a text file.

Browse the web for a new countries file, default URL is fip:/
www.ham-radio.ch/countries/ .

Update logbook entries with the latest countries file data.

% Lpdate Country Names

Update all loghoaok entries with the latest country names hased on
DHCCwalues,

Fress '0K' to load and analyse the loghook.

()

l

| [ Cancel
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List — Modes

Title ADIF Caomment
L3B 558 ADIFZ.0
LISE 356 ADIF 2.0
S5B 556 ADIF 2.0
i O ADIF 2.0
Fid Fid ADIFZ.0
Aibd Abd ADIF 2.0
ASCI AZC ADIF 2.0
AT ATV ADIF 2.0
CLO CLO ADIFZ.0
Fa [ ADIF 2.0
FSK FSk ADIF 2.0
GTOR GTOR  ADIF20
HELL HELL ADIFZ.0
HFSE HFSK ADIF 2.0
JT44 JT44 ADIF 2.0
MFSKB  MFSKE  ADIF20
MF3K16  MFSKIE  ADIF2.0
MTTY MTTY ADIF 2.0
MTE3 MTES ADIF 2.0
PAC PAC ADIF 2.0
FAC2 PACZ ADIFZ.0
FAC3 PACS ADIF 2.0
PO PCW ADIF 2.0
DT DT ADIE2 N
’ Beset I [ Wiewer I

The supported modes; this information is taken from the ADIF specifications.

List-Modes

Mode Definitions

Appearance

Resets the table and loads the latest values built into Ham Radio Deluxe.

Display this data with the default text file viewer.
Resets the table and loads the latest values built into Ham Radio Deluxe.
Display this data with the default text file viewer.

Refresh this window.

Logfile

Status
Warn
Warn
Warn
Warn
Warn
Warn
Warn
Warn
Warn
Warn
Warn
Warn
Warn
Warn
[8):
[8):8
CE
CE
[8):
[8):8
CE
CE
[8):

Loghook database logfile entties since starting Harn Radio Deluxe

Text

Country
Country
Country
Country
Country
Country
Country
Country
Country
Country
Country
Country
Country
Country

prefix
prefiz
prefiz
prefix
prefix
prefiz
prefiz
prefix
prefix
prefiz
prefiz
prefix
prefix
prefiz

ZH0S
ZZ08
ZV0s
ZW0S
ZY0s
PPOS
PQOS
PROS
p20s
PTOS
PLIOS
pvOsS
PWOS
PX0S

allocated
allocated
allocated
allocated
allocated
allocated
allocated
allocated
allocated
allocated
allocated
allocated
allocated
allocated

Added RC4Q to TBL_QRZ
Added W4RX to TEL_QRZ

Added W2GDJ to TBL_QRZ
Added RMGAM to TEL_QRZ
Added PPSAR to TBL_QRZ
Added LUTEFA to TBL_QRZ
Added W3FV to TEL_QRZ

Added JR7VHZ to TBL_QRZ

Wiewer

to
to
ta
to
to
to
ta
to
to
to
ta
to
to
to

DXCC
DXCC
DXCC
DXCC
DXCC
DXCC
DXCC
DXCC
DXCC
DXCC
DXCC
DXCC
DXCC
DXCC

253
253
253
253
253
253
253
253
253
253
253
253
253
253

All database activity since starting Ham Radio Deluxe.

Ham Radio Deluxe

and
and
and
and
and
and
and
and
and
and
and
and
and
and

ooooooDooooooOoo

Logfile

¥00qgboT
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There’s nothing better than a paper log for reviewing your on-air achievements.
Before you select the Print option < you should first use the Preview option ! to
review what you will be printing before committing another rain forest to the

recycling bucket!

4 Print Options

[+ Title:

‘HEIQDRV'S Laghoak

Options
[v]cover page
DQSO counter
[¥] Alternate background

Frint range

@ al

[V] Add Blank lines betwesn days

|

ok |

Cancel |

X

When you select Print or Preview the Print Options window is displayed.

When reviewing a contest or QSO’s selected for an award you will usually enable
the QSO counter option.

The alternate background option makes the log easier to read (just try it), adding

blank lines between days is very much a personal preference.

HBSDRV's Logbook

Callsign
Name
Country
Locator
Equipment
Antennas
Power

Date
Filter
Summary
Sorted

Entries
From
To ..

HBSDRY
Simon

Switzerland

on 3.3 buikd 1030, Copyright @ 2003 - Z006 by Simon Brown, HEADRY

Ham Radio Deluxe
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Performance

Errors

Ham Radio Deluxe

Printing

Ham Radio Deluxe HBIDRV's Logbook Logbook Entries
Start End  Station Band Mode Semt Recv Hame Address
31052005 1711 1711 LZIPEP 59 55 PETER PETROV RAZORAD, P.O.BOX %, 7200, BULGARIA

IUSA008 1707 LT0T YTIAU m USE 59 “ ZIVICA JOVANOVIC POS. PARTIZANSK] ODRED (74, 11500 ZVECKA - OBRENOY
35005 1702 1702 SVIDFA 6m USB 59 58
V005 1628 1629 LZIRX dm USB 59 5 PLAMEN EODUROV P.0.BOX 126, SOFLA 1330, BULGARLA
3V0S005 1521 1521 LISUKA om USE 55 'l See LASUKA
IVISR00S 1512 1802 TETQMI ém USE 53 £ GIANCARLO MORCLANG V14 UDINE 24, 72100 BRINDISI BR, ITALY
V005 1428 1429 UTAUD dm USE 59 5 VALERY GOYKO P.0. BOX 25, KIEV-201, 234201, UKRAINE
IVSR005 1406 1406 DCTOH 6m USB 53 56 Esic Disterie Beriepschatr. 3, 14165 Beclin, GERMANY
IS005 1404 1404 SPIFPG dm USE 57 59 Heary
WMS005 1150 1150 LZIHM m USE 59 59
A0S 0928 B SVITP ém USB 55 58 Dinitris:
30052005 0555 0359 [TBRZR 6m USB 53 58
005 0720 0T GMANFC ém USE 59 58
/152005 2042 2042 EHSASF 6m USB 59 59 will
/52005 1755 1755 LYIBAW m USE 59 ol TADAS VYSNIAUSKAS P.0. BOX 4, SIRVINTOS, 4100, LITHUANIA
1645 1645 [TSNGIM 6m USE 59 58 VINCENZO GALLARIZZO VICO 1 ROSMARINO 10, 98070 TORRENCVA ME, ITALY
L6/05/2005 1318 1318 YUIFW 6m USE 59 58 BRANKO DRLIACA KRAGUJEVACKA 4, 11160 BEOGRAD, SERBIA AND MONTE}
L6/5/2005 1300 1300 LZIUQ 6m USB 53 55 DIMITAR RUSEV RAITCHEV 6 IVAN YONTCHEV STREET, BLOCK 2 AFT 35, 1615 SOFIAF
16052005 1225 1229 LZIHM ém USB 59 58 ANDY SATCHKOV F.0 BOX 40, DRYANOVO 5370, BULGARIA
3110/2004 194D 1940 GW4BLE i LEE 5914 5314
3VI0004 1723 1723 HBUHBYAND  §0m LSB 5914 5814
31100004 1721 1721 DFOCG Skn LEE 5914 5814
IVI004 1630 1630 OKZRZ m LSB 5014 S5
31102004 1616 1616 ES6Q 2om USE 914 5915
02004 1557 1557 IISL 4 LSB 5914 515
300004 1553 1553 OEST 4lkn LSB 5914 5015
3102004 1550 1550 DFOCG 4m LSE 5914 514
30004 1536 1536 IRSP A USE 5914 5915
02004 1531 1931 DFEAE alkn LB 914 S804
3100004 1526 1526 EASKR 4n LSB 5914 5814
04 1521 152 UUT 1% USE 5014 S016
IVIN004 1453 1453 UWZM m USE 5914 S I6
V0004 1443 1648 CHIR e USE 514 5831
30004 1447 1447 YOICTRIP 2m USB 914 S8 70
IVIN2004 1445 1445 EAGAZ m USE 914 5B I4
U004 1444 1444 UAICLE A USE 5914 51T
3102004 1443 1441 C4OM anm USE s9l4 5820
V02004 1438 1438 CQIK i USE 5914 5831
004 1431 1431 VEIM 1k USE 5004 582

200022008 18:29

Page20f3

Now press [ mswomee | to save the displayed entries in your database.

Select the fields and entries to be exported.

If you are only uploading to the ARRL’s Logbook of The World then there is no
need to export unnecessary fields — this just makes the whole LoTW experience

Problems

If you find that the database is exceptionally slow make sure that ODBC tracing is

switched off.

From the Start menu select Settings / Control Panel / Administrative Tools /
ODBC Data Source Administrator select Tracing. Here you stop tracing (if

started).

¥00qgboT

#10DBC Data Source Administratar

UserDSN] System DSN] File DSN] Drivers Tracing ICDnnecmn Fooling ] Abaut]

When to trace

‘ Start Tracing Mow | Start Yisual Studio Analyzer ‘

[v Machine-Wide tracing for all user identities;

Log File Path Custom Trace DLL

CADOCUME™1\Siman\LOCALE™ 1\ Ten |C\WINDOWS\system32\c|dbctrac.dll

Browse.. EelectDLL...

ODBC tracing allows wou to create logs of the calls to ODBC drivers far use by
suppon personnel or to aid you in debugging vour applications. “isual studio
tracing enables Microsoft Wisual studio tracing for ODBC.

Ok | Cancel | Apphy ‘ Help

If you get problems using the Logbook — for example a window such as:

HamRadioDeluxe

x

@ The SELECT statement includes a reserved word or an argument name that is misspelled or missing, or the punctuation is

incorrect.
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then follow the steps below to generate a trace file which provides all information
required to diagnose the problem.

1
2

5

Close Ham Radio Deluxe.

From the Start menu select Settings/Control Panel/Administrative Tools/
ODBC Data Source Administrator select Tracing.

Press Start Tracing Now.

Start Ham Radio Deluxe, open the Logbook, and perform the steps
necessary to generate the error.

Stop tracing.

Save the logfile to a ZIP archive and forward to the Ham Radio Deluxe develop-

€1S.
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/ Logging and Managing QSO
Records

Add Logbook Entry (ALE)

Ham Radio Deluxe Logbook has a number of powerful features for tracking QSO
data. This information is contained within the Add Logbook Entry (ALE) window
and its fifteen tabs. This section will describe these areas. The ALE window is
opened by clicking on the Add button in the toolbar.

Menu Bar But first, it’s necessary to understand the options for the ALE. The ALE’s menu
bar has a number of menu items.

Modify: WASPIE Logbook

|Fi|e Edit Options Tracking Show:Fields Show:Tabs

Options
Clicking the Options menu renders the following choices:
o Add: WASPIE Logbook
File Edit | Options Tracking Show:Fields Show:Tabs
I S | .t Time
Font... End ¥ Set by User
4 Callsign Lookup... v UTC (Standard GMT) No Change
QSL Defaults Lecal [ —
Add Spat

RST Rewd / Sent...

{F5) Call: @

[
Button Position... 4 .
! [ hudic Rec.

RST Sent: Menu Position... 2 |

RST Revd: Show Tooltips W

Name: Save VFO B (Sub-Frequency) in the Database

- ¥ Keep Propagation Mode

Comment: Mirror Locator on Location Tab
Show Worked Status 3

Courttry: E Show Callsign Parse (for debugging lookups)

- e |

The Times option can be selected for UTC or Local time.

The Start and End times can be set according to the operator’s operating style.

Recommendations

» DXers and Contesters should use Current Time in the Times selection. This
uses the time of the computer clock when the QSO is logged. Because DX
and Contest exchanges are so short — lasting for only a few seconds — there’s
an increased likelihood of making a QSL match to services like LOTW if
the QSO is set to Current Time.

» Rag-chewers may want to use Set by user. This accommodates QSOs of
longer durations.

Ham Radio Deluxe 119
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Font Option
This enables the operator to change the fonts used in the dialog ALE.

QSL Defaults

This enables the operator to choose the initial values for the three QSL fields. This
is helpful when using a value like Queued to set the LOTW value so that it’s easy
to do a search for QSLs that need to be uploaded to LOTW.

i -

Add Log Entry ' 2

Q5L Defaults
[ Paper |Ma
[(edsL |Ma
FILotw [No

RST Rcvd / Sent
This provides options for canned values of RST.

Button Position

The operator can select from bottom, middle, and right side location of the
Update, Cancel, Reset, and Add Spot buttons. This is useful when vertical or hori-
zontal space is restrained.

Menu Position
The choices of positioning the menu on top or bottom are provided.

Other options
Toggle on/off options
*  Show Tooltips
* Save VFO B in database
* Keep Propagation Mode
* Mirror Locator on Location Tab

Show Worked Status

This option enables a W icon to display for Call, Country, and Locator fields. This lets the
operator know that these items have been worked before.

Tracking

The Tracking menu enables the ALE to use the data coming from the rid for fre-
quency or mode and automatically populated into the ALE. (Default is ON for
both.)

Show:Fields
This option enables the operator to choose which of the thirteen fields will be dis-
played in the ALE. (Default is all ON.)

Show:Tabs
This option enables the operator to choose which of the fifteen tabs will be dis-
played in the ALE. (Default is all ON.)

Ham Radio Deluxe
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Logbook Tab

Worked Tab

Country Tab

Contact Tab

Ham Radio Deluxe

Logbook |Worked | Country | Contact | Location | I0TA | Ant/Sat | Award | Contest | Custom | My Station | Propagation | Q5L | e5l.cc | LOTW|

Madify: WAIPIE Logbook

File Edit Options Tracking Show:Fields Show:Tabs

Date: 4-25-2014 [ Freq: 21.034.050 Update (F7)
(F2)Sta:  20:32:00 = Band: [track

16m

FHEnd:  20:32:00 | Hode: [irack e
(FE)Cal:  W1AW~2 @)=

ota [ audic Rec.

RST Sent: 599 - = |

RST Revd: 599 - locator:  FH3lpr

Name:  ARRL HQ OPERATORS CLUB State: N
Comment: * QTH:
- WRX: Wi
Country: | United States - B @ Cortact () SWLreport
Rotator: 41714783333 7272726666 [53° /239", 1436mi | wLog Coordinates|| Rotator

The Logbook tab which is the first of many tabs at the bottom of the ALE window
provides detail on previous QSOs with the station being logged. Partial and Exact
matches are options

B B | « = oF P | e | £

All QS0s | Partial Exact || 25 100 | Width Layout Copy Refresh | Load Delete View End Now

Q50 date Time on Call Mode Sent | Rovd | Band | Hame Country
4/25/2014 20:32:00 W1AW/2 CW 599 589 15m ARRL. H OPERATORS CLUB United States
1/3/2012 00:41:23 WI1AW/4 LSB 55 55 40m ARRL HQ OPERATORS CLUB United States
1/17/2002 19:23:00 WI1AW MFS5K16 59 53 15m Steve United States
T/9/2000 05:13:00 WI1AW/4 USE 59 59 15m ARRL HQ OPERATORS CLUB United States
12/28/1993 19:57:00 W1AW UsB 59 58 20m Steve United S5tates
2/12/1977 07:25:00 WiawW cwW ST 589 80m ARRL HQ OPERATORS CLUB United States

The Worked tab provides detail about previous QSOs with that callsign, country,
continent, zone, IOTA, or locator... by band and/or mode.

Logbook | Worked | Country | Contact | Location | 10TA | Ant/5at | Aoward | Contest | Custorn | My Station | Propagation | QsL | eQSL.cc | LOTW|

Autgmatic Ref:esh Band Mode Band+Mode

Field Value -1160m |80m| 40m|30m| 20m 17m|15m|12m|10m &m -|Phone| CW FM| MFSKIG| PKT PSK31 PSKG3| RTTY
Callsign  WLAW/2 Ko W W W W oW W WX oW K W W K K X

Country  United States I Y I G Y R Wwooow W W S

Continent NA R AR R R AR AR AR v, W W W W " S

CQ Zone XX X W W W X X X X = X X X x X x X

10TA HWoOW oW W W W W W WX oW HK O OXK W oW WX W

Locator  FN31 K XK ¥ HE XV X XY & XX XK XK X X

Locator  FN31PR HOXE & W W W v X XX VARV EY S 4 x X x X

The country tab contains the DXCC information about the country being logged.
This data is ‘display only” and is not saved in the QSO record.

Logbook | Worked | Country ‘ Contact | Location | 10TA | Ant/Sat | Award | Contest | Customn | My Station | Propagation | QsL | eQSLcc | LOTW|

Active | Country DXCC | Start | End| QSL Mgr

Yes United States 2391

The Contact tab provides a place to store information about the station operator’s
age, Special Interest Group (SIG, or club), SIG website, email address, website

121

¥00qgboT



Add Logbook Entry (ALE)

Chapter 7 - Logging and Managing QSO Records

URL 10-10 number, equipment, and biography. Callsign Lookup sources often
provide much of this information.

| Logheook | Worked | Country | Contact | Location | I0TA | Ant/Sat | Award | Contest | Custom | My Station | Propagation | QsL | eQ5L.cc | LGTW|

Age: 5IG:

Email: W1AW@ARRLORG 51G infa:

URL. 10-10;

Equipment :

Biography: http://xmldata.grz.com/xml? -
s=aeaadd0e9d2410b43e 8 3c319ca 1067cdhtml =W 1AW

Location Tab

The Location tab provides a place to store information about the station operator’s
location — including State/province, City (QTH), County, ARRL Section, postal
address, CQ and ITU Zone, continent, distance, and polar coordinates. Callsign
Lookup sources often provide much of this information.

| Logbook | Worked | Country | Contact| Location |IOTA | Ant/Sat | Award | Contest | Custom | My Station | Propagation | QsL | eQSL.cc | LOTW|

IOTA Tab

State/province: CT CQ zone: Distance computed
using the

QTH: NEWINGTON ITU zone: Station” locator
County: Hartford Cortinert: |NA
ARALsect: [ ] Distance: 1437 GE Mies
Address: ARRL HQ OPERATORS CLUE - Lat: 41 . 714775

225 MAIN ST

NEWINGTOM, CT 06111 Lon: —-72.727260

United States

The IOTA tab provides a place to store information about the IOTA reference
number and Island name.

Legbook | Worked | Country | Contact | Location | 10TA |Anthat | HAward | Contest | Custom | Wty Station | Propagation | Q5L | eQSl.cc | LOTW|

Antenna/
Satellite Tab

Ref No: | -none-

Island: [ v]

Notes:

The Ant/Sat tab provides a place to store beam heading and satellite information.

| Logbook | Worked

Antenna
Azimuth:

Elevation:

Award Tab

122

| Country | Contact | Location | I0TA | Ant/Sat |Award | Contest | Custom | My Station | Propagation | QsL | eQsl.cc | LOTW|

Satellite
Path: @ Short MName:
© Long Mode:
() Greyline
() Other

[] Reset fields after adding an entry

The Award tab is for tracking the award credits within the various awards pro-
grams. A QSO record cannot have both Submitted and Granted status for a given
award. Selecting one de-selects the other. More information about the use of this
tab can be found in the Awards Tracking section of this manual. These values are
determinants of what is displayed in the Not Submitted, Submitted, and Granted
columns in the Awards Tracking tab.

Ham Radio Deluxe
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Contest Tab

Custom Tab

My Station Tab

Propagation
Tab

Ham Radio Deluxe

| Logbook | Waorked | Country | Contact | Location | 10TA | Ant/Sat | Award | Contest | Custom | My Station | Propagation | QsL | eQSL.cc | L[}TW|

Submitted: Granted:

CIAIA = CIAlA A
[7]CQ WAZ (Band) [7]CQ WAZ (Band)

[C]C0 WAZ (Mixed) | [F]C0 WAZ (Mixed) |
[C]C3 WAZ (Mode} 3 [C]C3 WAZ (Mode} 3
[]C3 WPX (Mixed) i []C0 WPX (Mixed) 4
[F]CQ WPX (Mode) [F1CQ WPX (Mode)

[C]CaDX {Mode) [C]CaDX {Mode)

[C]CaDX Field {Mixced) [C]CaDX Field {Mixed)

[C]CaDX Field (Mods) [C]CaDX Field (Mode)

[T]DARC DOK (Band) [T]DARC DOK (Band)

[|DARC DOK (Mixed) [|DARC DOK (Mixed)

|| DARC DOK (Mode} || DARC DOK (Mode)

[C]DXCC (Band) [C]DXCC (Band)

[]DHCC (Challenge) []DACC (Challenge)

[] DXCC (Mixed) - []DXCC (Mixed) -

The Contest tab provides a place to store data related to contest exchanges.

| Logbook | Worked | Country | Contact | Location | 10TA | Ant/Sat | Award | Contest ‘ Custom | My Station | Propagation | QsL | eQSl.cc | LOTW|

Check:
Class:

Precedence:

Contest: [ v]

Six Custom fields can be defined and used by the operator. This is useful for
tracking awards that are not hard-coded within Ham Radio Deluxe such as Sum-
mits on the Air (SOTA). Clicking on the Configure button enables the operator to
rename these fields.

| Loghook | Worked | Country | Contact | Location | I0TA | Ant/Sat | Award | Contest | Custom | My Station | Propagation | QsL | eQSL.cc | LOTW‘
Custom field 1 Custom field 3:
Custom field 2 Custom field 4:
Custom field 5
Custom field 6
|| Reset fields after adding an entry
The My Station tab is particularly useful when the operator has multiple operating
locations. The operator can select from profiles (stations) created in Ham Radio
Deluxe Logbook
Logbook | Worked | Country | Contact | Lecation | 07A | Ant/Sat | Award | Contest | Custom | My Station | Propagation | QsL | eQSk.cc | LOTW|
Calsign:  |WASPIE SiG: Ho®CC Profile
Cwner: MICHAEL CAR S1G infao: www hdxcc.ong
Operstor: ~ MICHAEL CAR Locatar EM13Zof
Name: Mike Latitude: 33245054 "Currfigureu,fh?w Station”
Street: 951 Moss Creek Dr Longitude: —96 . 770887 l“;ﬁﬂ;fﬁm’;ﬂggﬂ
City: Prosper, TX CQ zone: g ITU: 8 mtag;;e;;eware
County: Collin Power. 1000 Watts
State: s I0TA: [ - -
ZIP: 75078 Courtry [United States -
Equipment: Yaesu FTcx5000MP; microHAM microKEYER Il
Antennas:  Windom
Club: HDXCC
License BExtra
The propagation tab saves solar data into the QSO record. Be sure to check the
Track box to turn this feature on. The information comes from the most recent
WWYV or WCY information.
123
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| Logbook | Worked | Country | Contact | Location | I0TA | Ant/Sat | Award | Contest | Custom | My Station | Propagation | QsL | eQSLl.cc | LOTW‘

Aindex: 3 Track Num bursts:
Kindex: 2 Mum pings:
Solar flux: 163 Mz bursts:
M5 shower: Prop mode: [ v]
QSL, eQSL.cc, The QSL tab is for tracking paper and electronic QSLs. QSL Sent and Rcvd have

and LOTW tabs the following values:

QSL Rcvd:
Y yes (confirmed); an incoming QSL card has been received, or the QSO has
been confirmed by the online service

N no; an incoming QSL card has not been received, or the QSO has not been
confirmed by the online service

R requested; the logging station has requested a QSL card, or the logging station
has requested the QSO be uploaded to the online service

I ignore or invalid
V (deprecated) verified
QSL Sent:

Y yes; an outgoing QSL card has been sent, or the QSO has been uploaded to,
and accepted by, the online service

N no; do not send an outgoing QSL card; do not upload the QSO to the online
service

R requested; the contacted station has requested a QSL card, or the contacted
station has requested the QSO be uploaded to the online service

Q queued; an outgoing QSL card has been selected to be sent, or a QSO has been
selected to be uploaded to the online service

I ignore or invalid

| Logbook | Worked | Country | Contact | Location | 10TA | Ant/5at | Award | Contest | Custom | My Station | Propagation | QsL | eQSl.cc | LOTW|

Direct Direct

Via: U5 STATIONS PLEASE QSL VIA LOTW

| Logbook | Worked | Country | Contact | Location | 10TA | Ant/Sat | Award | Contest | Custom | My Station | Propagation | QsL | eQSl.cc | LOTW

| Logbook | Worked | Country | Contact | Location | IOTA | Ant/Sat | Award | Contest | Custom | My Station | Propagation | QsL | eQSL.cc | LOTW

Sert: [ Yes v 5/12/2014

Revd: |Verfied (Match) v | 5/ 2/2014  +

Status:
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Logbook
Search

Ham Radio Deluxe

tedsig |

fejdsig

Note: These values are determinants of what is displayed in the Confirmed
and Need QSL columns in the Awards Tracking tab.

The Filter button enables the operator to perform a logbook search, based on
selected field criteria.

] '
@ & X B ¥ @ B @ = = Q @ & =] s @@ @
Add Contest Delete View | Cut Copy Paste | Refresh Width Layout Edit Selections ORZ.com | Awards Tracking Backup More...~ J Filter JQSL  Award

| LOTW Upload LOTW Download

[V] Callsign  4c1F [[]Date [ Field [ [And [ [And

Mateh: e v| Today L Cortaing Matcl Cantaing Matcl Contains

5114204
QS0 date Time on Call | Mode | Band | Country Name LOTW =ent | LOTW received | WPX prefix
57/26/1993 @Z4:32:08 4K1F CW 4@m Antarctica YURA CHERNIKCV Yes No 4K1
Once selected, the operator can find QSOs based on Callsign, Date range, and a
combination of any three additional fields. This is helpful when trying to find
something unique in the log. These types of database queries are also used in dis-
playing awards totals.
QSL Filter
The QSL filter button enables the operator to search and update QSL Status in-
bulk. This is helpful when printing a significant number of QSL cards over a
given date range.
© > %X BR|» 2 m| @ o & Q @ $ d s | Ble|e
Add Contest Delete View Cut  Copy Paste | Refresh Width Layout Edit Selections OQRZ.com | Awards Tracking Backup More..~ | Filter§ QSL BAward
LOTW Upload LOTW Download
B4 &8 § & ] = = -
QsL eQSL Lﬁ?’)w Clublog R I Sl Apply
Revd: Mo + Direct S 5f11/2014 ~ -'l‘*‘rl'
Q50 date | Time on | Call | HMode | Band| Country Name | LOTW sent |
54/25/22‘14 2@:32:90 W1RAW/2 CW 15m United States ARRL HQ CPERATCRS CLUB Yes=
4/75/2¢14 $1:19:16 KTSEL USB 2¢m United States SEL EMATEUR RADIO CLUB Yes
4/23/2014 22:42:0¢ 9L1A cw 17m Sierra Leone Angelo Selva Yes=
4/23/2@14 @$3:83:28 ISEFDW USB 2¢m Sardinia ANGELC FADDR e
Award Filter
The Award filter button enables the operator to search and update award tracking sta-
tus in-bulk. This is helpful when making an award application.
@ & % WM|s W m|l@ » = q @ 2 & & |0 ofe®
Add Contest Delete View | Cut Copy Paste | Refresh Width Layout Edit Selections QRZ.com | Awards Tracking Backup More..~ | Filter QSLJ| Award
LOTW Upload LOTW Bownload
| T~ Verified | Status - | Award Dxcc {Challenge) -
O || Q50 date Time on Call Mode Band| Country Hame LOTW sent
% ;4/25/2@1‘1 2@:32:00 W1LW/2 CW 15m United Stcates ARRL HQ OPERATORS CLUB Yes
= 4/235/2@14 @1:19:16 KTSEL USB Z2¢m United States SEL AMATEUR RADIC CLUB Yes
4/23/2@14 22:42:60 SL1A CW 17m Sierra Leone Angelo Selva Yes
4/23/2914 ©3:03:28 ISPEDW USB I¢m Sardinia BNGELO FADDA Yes
4/21/2@14 ©@:£5:39 PY2VM TUSB 1¢m Brazil Carlos Cararsto Yes
4/2@/2@14 21:3@:15 VE3FFB DPSK31 1fm Australia Dieter Pelz Yes
4/2@/2014 28:36:06 IL1DK USE 1Pm New Zealand DAVID KARRASCH Yes
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Bulk-Editing QSOs

The bulk-editor is a powerful tool for making mass changes to the data in the log-
book. It is highly recommended that a logbook back be made prior to using this
tool.

To use the bulk-editor, first select a number of QSO records where the same
change is desired by using the “Filter” (search) or by selecting some number of
records manually within the log.

There are a number of places to find the Bulk Editor menu option. To use one as
an example, right-click on any of the highlighted QSO records, and select one of
the provided options.

i B Sardinia
Mew Wind
Fw HHindow Brazil
. Edit Australia
2 USE 1fm HNew Zealand
@ Refresh
Ed ) CwW 3¢m San Andres & Providenc
& Auto Width i i
2 ! JIGS 3gm Republic of South Afri
i— Layout ..
2 ' JIa5 3fm Hawaii
E:Q ST 12 JT65  3@m Austria
z:ﬁ Filter [Oldest] Y JT65  3@m Ukraine
Ed \T} Award Tracking M JT&S 3#m Fed. Republic of Germ:
2 ; JT&5 3fm European Russia
>
o  lookup JT65  3Pm Ukraine
(AT oatebeses > fovis
% lgaria

: Layouts [
Options 3 Y =

Edit Selections  »

- ] ==
» —
Jots: WAGPIE-3 on WASPIE-3 Backups
[ eukedtor RN

Jow~ ALL * T Wt

Export ’ Award Fields
ML |Mede | 1 import ¥ QSL Status
W CW 50.0¢ LOTW L4 . .
” sm E— eQSLc R Distance & Heading
v USE 58.1¢  HRDLog.net b} (HE) d
W USB 52.1¢  Clublog v B (XE) Er
W Use 58.1¢ print. y B (EE) E
i W R DE T L] Gema (FMY R

Any Fields is a very powerful choice, as it enables the operator to change anything
in the database in mass (use with care). For this example, Any Fields is selected
and the option to backup the logbook is provided.
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1 Select Any Fields.

2 Next, select the “Add Field”
button.

3 Select the desired field (CQ
Zone, in this example)

4 Enter the desired value (10,
in this example)

5 Click “Ok”
All the selected QSO record
will be updated with the desired
value.

Importing Log Files

[==] Bulk Editor

E=E)

Multi-QSO Bulk Editor

[ H Backup ] [ Add Field Remove

[] Recompute prefis [used in ‘WP award hacking)

Fields | Log | Help |

Ernitries selected: 6

Field Name| Database Field | Database Value | ADIF Name

0K

Cancel |

Importing Log

Files

Logs can be easily imported from other logging programs. To import a log from another

logging program, follow these steps:

1 Export the log into ADIF format from the other logging program. Make sure
that it is configured to provide all available fields.

2 From the menu in Logbook, select Logbook >File > Import, and then
choose the relevant option from the list of five shown. Most often, ADIF 2

is used.
—
"f, HRD Legbook - [WASPIE Logbook] (@)
| File Edit View Browser Calendar Countries | Logbook Tools Window Help (@)
= B B = ] MNew Window ) (&) I ) » I O
Open || Layout A LayoutB | Rig Control Digital Mas — Tune-5ub | Add Manager About - O
it .2
Lookup oo = | w . | a i
= R oghook | <% Award Trackin KI7DG - Cal =
3 & @ Refresh ’ - 9| @
g QRZ.com | (23 Logbook ‘ e . n 2 - -
H & Auto Width & Ga 2 \ = ,
w | Callsign:.  TZ6BB Add | Cut Copy Paste | Refresh Width Layout Edit
@ i— layout
=2
5 - Lom 4 sl
Callsign & [ Filter [Oldest] | | |
i . . ol w Call Made Band | Country
7 LoTW:Yes eQSL: Yes = 4% Award Tracking " :
20m modes ) l - 15m United States
7 4 Lookup F | KTSEL USB 2fm United States
TI . 4 T - |7m Sierra Leone
I osebeses » —
Bands Liae——— ) : R Sardinia
7 4 Options ’ e Brazil
& 4/20/2014 21:38:15 Edit Selections  » pE———
Modes 4/2@/2014 20:36:86 Backups 3 HMew Zealand
+ .- 4/13/2@14 ©23:1:38 Bulk Editor » San Andres & Pr
- 4/12/2@14 @5:89:49 Export N Republic of Souw
4/12/2@14 QS:QJ:QBM ADIF 2
4/12/2@214 4:23:49
Licensee 2 j j eLs @ LoTwW D ADIF 3 (ADX)
471172814 £3:53:11
eQ5L.cc D HRD/DIM780 v4
£ Fernando Arroyo 4/11/2@14 @3:34:52
. HRDLog.net r LOTW
£ Q5L via W3IHNK 4/11/2014 @3:15:55 R
ublo
=1 rumbek@gmail.com 4/11/2@14 @2:32:88 Print g N Ted
rint...
£ http:/fwww.gsl.net/eadbb 3/3@/214 $5:13:17 [aru Latvia

Ham Radio Deluxe

3 Then select the ADIF file for input by clicking the button to the right of
“DIF Filename. The recommended options are shown here:
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- .
£ ADIF Import [

ADIF Filename

Optionz

Duplicates: () Ovenwite (@) [gnore () Add Lines:

Records:
Compute D=CC from callsign if na D=CC in record eeorcs

Duplicates:
Update country name and continent from DCC value Wamning:
Inzert Local Station Information on lmport Ermar:
[T Use Seconds on Time Import
Save To Database Wiew ADIF [ Save ADIF ] [ Cancel ]

4 Once the file has been analyzed, the results will be shown. select Save to

Database”.
F=] ADIF Import ==
ADIF Filename
C:hUzershmearperDocurments My DiopboxhHRDACountyE =port.A01 D
Optionz
Duplicates: () Ovenwite @) |gnore () Add Lines: 32
R de 1
Cormpute D=CC from callzign if no DCC in record Djsﬁzafes 0
|pdate country name and continent fram DECC value Warning: ' i
Inzert Local Station Infarmation an rmpart Errar: 1]

[T Uze Secands on Time Import

Ready

[SaveTDDatabase] [ Yiew ADIF ” Save ADIF ” Cancel ]

Class Status
-@- File CA\Users\mcarper\Documents\My Dropbox\HRD\CountyExport ADI
@ Fie Extracting ADIF data...
© Fie File size 32 lines
© Fie Contains 1 records
© Fie ADIF version: 2.2
'/:' File Encoding: 1S0-8859-1
'”:' File Program ID: HamRadioDeluxe, version Version 5.23.0.19
© Cache Database currently holds 5685 unigue QS0's
@ Database Opening database WASPIE Logbook with DSN=WAIPIE Logbook:UID=1
@© Database Openstatus 1
@ Database Openingtable TABLE_HRD_COMNTACTS_VO01
,. T r

If there are errors in the source ADIF, the operator will see this in the results dis-
played below.
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Exporting Log Files

Note: Be aware of the “garbage-in/garbage-out” scenario. The information
provided in Ham Radio Deluxe Logbook (for awards and QSO fields) is
only as good as the data that comes from the other logbook source. There
will always be some anomalies that the operator will have to sort out.
This is generally because other programs may not have country data that

is up-to-date.

Exporting Log Files

Logs can be easily exported for import into other logging programs. To export a
log from Ham Radio Deluxe Logbook, follow these steps:

1 From the menu in Logbook, select Logbook > File > Export, and then
choose the relevant option from the list of five shown. Most often, ADIF 2

is used.

% HRD Logback - [WAIPIE Lagbaok]

Ham Radio Deluxe

File Edit VYiew Browser Calendar Countries | Logbook Tools Window Help
= = = ™ New Window i (%) = () »
Open || Layout & LayoutB | Rig Control Digital Mas . Tune-5ub | Add Manager About -
it 3
Lookup 1 x ‘ " . ‘ pe -
= R ogbook | <% Award Trackin KIIDG - C:
3 & @ Refresh ’ - il @
g QRZ.com | (&) Logbook @ - - -
E & Auto Width & 53 z _ = _
w | Callsign.  TZGBB Add | _ Cut Copy Paste | Refresh Width Layout Edi
@ i— Layout
=2
5 - Lom Q Quey
Callsign ® Filter [Oldest] g
i . . =19 Call Mode Band | Country
% LoTW:Yes eQ5L: Yes = E:'Ir Award Tracking (Q
20m modes o I United States
¥ - =1'a  Lookup v | x75EL  UsB 20m United States &
1-, . 4 T - J7m Sierra Leone O
BT oabsses » s o
Bands 4 ) X R Sardinia
7 4  Options 4 s Brazil A
b 472072014 21:3p:1s _ Cordelections o Australia
Modes 4/2@/2@814 20:36:06 Backups » Hew Zealand
o 4/13/2@14 @3:1%:38 Bulk Editor b San Andres & P1
Lo 4/12/2@14 95:59:49 ADIF2 o
4/12/2@14 @5:81:48 Import » ADIF 3 (ADX)
4/12/2@814 @4:23:49
Licensee S /12! LoTw b Cabrillo
4/11/2814 2:53:11
/arfams @ eQSL.cc 4 Excel XML
£ Fernando Arroyo 4/11/2@14 @3:34:52 4
) HRDLeg.net 4 Text
ﬁ Q5L via W3IHNK 471172414 $3:15:55 Clubl. ' i:
ublo
=1 rumbek@gmail.com 4/11/2@14 @2:32:088 - - R P Ukraine
rint...
£ http:/fwww.gslnet/eadbhb 3/38/2914 £25:13:17 Latwvia

2 Provide the export filename by clicking the button to the right of “ADIF

Filename”.
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ADIF Expart

ADIF Filename

Fields to Export

@ ADIF anly

() ADIF + Ham Radio Deluxe
() elSLl.co

Use Seconds on Time

Entries

Only fields supported by ADIF 2.0, also required
for the ARRL Logbaak of The World

=

© Al

@ Selected

Cancel

Ewxpart Wiew ADIF file

3 Options are provided to select the field set for exporting.
4 The operator can export All or Selected logbook entries.

» Tip: Exporting selected logbook entries is a great way to update stand-
alone logbook databases located on multiple computers.

Backup & Restore

Operators are encouraged to allow the automatic log backup to keep their log data

safe.
Automatic Backups =
Automatic Backups
Options for Automatic Database Backups
Backup file Backup File -
o . . . . The database backup is saved as an
Save file infolder:  [C:\Users\mcarperDocument ..\ ogBackups E XML file in the folder of your choice,
the filename contains both the
) database name and the current date
Archives and time, for example: Simon- L
MySQL backup 2009-07-17 =
[¥] Compress to folder: 1:\Users\mcamper'OneDrive'LogBackups B 0949.xml .
[#] Compress to folder: C:\Users\mearperBax SyncLogBackups e Check [_J Save file in folder to
B lceep the XML file after it iz added to
an archive (see below).
[¥] Add to archive: E:\Users‘mearper'M.. \Logbook Backups zip B ( )
o " " " Archives
[¥] Add to archive:  IC:\Users\mecamper\Documert...\HR Dlogs ZIP B For absolute safety of your data you |
can compress and copy the file to a |
folder and also add it to an archive file E
Backup databases (in ZIF format). Compressing the file
typically reduces the size by ~95%, |
[]On opening the compression code is built into this
. program so you do not need to
[#]On closing purchase extra compression software!
I:‘ Every |10 Compress To Folder fe
The file is added to a new ZIP
Every Help E!rc:hive which contains ju;t tl'!is i
[ ok ][ cancel |

The “Automatic Backups” is found in the file menu under Tools, Configure,
Backups. Backup files are saved in a proprietary XML format that ensures that
information that is unique to Ham Radio Deluxe Logbook (like user-defined
fields) are safely backed up. Some, but not necessarily all, of the backup loca-
tions should be used.
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Note: For this reason, making copies of ADIF files is not considered a
backup method. Using an ADIF as a backup method could result in data
loss. ADIF is an “amateur radio interface format” and was intended to
interface logs between dissimilar systems by defining common fields.

The Backup file field is the folder where the native XML file is created. This is the
most commonly utilized backup file.

The Archives section provides two options.

» Compress to folder creates a compressed version of the XML for every
backup made. It’s a compressed version of the Backup file and placed into
the folder of the operator’s choosing.

» Add to archive puts the XML into a compressed folder selected by the
operator.

One successful approach is to make use of some of the free cloud storage services
like Dropbox, Microsoft OneDrive, Box, and Google Drive to ensure that a hard
drive failure could not cause a loss of logbook data.

Backup file

[¥] Save file in folder:  C:\Users‘\meaper\Document .. \LogBackups | < Df’gpbg}(

Archives
[¥] Compress to folder: C:\Users\meamper\OneDrive'LogBackups |_| g| <-- Microsoft OneDrive |_
[¥] Compress to folder: C\Users\meamper\Box Sync\LogBackups |_| |I| <-- Box (8
= — ] = U
!f_,.-”«:ldtn archive: E:% Users\mu:arper W, LnghonkBackups zip |_| |i <. GDDE'E Drive S
|| Add to archive: 2N Users‘mcarper \Document.. \HRDlogs. ZIF‘ | | [:J - DT’OﬂbO}{ @)
>~
Backup databases
[C] On opening
[¥] On closing
[ClEvery |10
[¥|Every |8hours |
The Backup databases selections determine the frequency or conditions for which
backups are made to the selected methods above.
Country Data
Ham Radio Deluxe utilizes a country and prefix database that is roughly equiva-
lent to the AD1C list (http.//www.country-files.com). The country data itself
doesn’t require constant maintenance. It is updated when new countries are added
or removed from the DXCC list. The prefix masks contained within this data is
rather complex and it is recommended that operators do not modify it. Updates
will be made as frequently as necessary.
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ountries | Logbook Tools Window Help -8 X
Digital Master Rotator Tuna—‘Mam Tune-Sub | Add Manager About - | 14.235.000 3.780.000

% @ FRadioScreen | ] WASPIE Loghook | % Award Tracking | € KI'DG - Callsign Lookup by QRZCOM (@ Countries (03-May-2014 1807 UTC) x\ %
| | | £
2 B V & A A I Lookup Callsign .| @ =
Load... | New Edit Delete | Unique Calls | Undo Save Changes Help
. | Country | Status | DXCC | CQZone | ITU Zone | Continent | Latitude| Longitude | Start Date End Date | ARRL Prefix | PrEﬁ‘ =
| | Abu Aills, [deleted] Deleted 2 il 29 AF 13.9944N  42.7500E 1991-03-30 23:58:59 Al Al"]rg—l
Afghanistan Active 3 2 40 AS 337667MN  65.T111E YA YAX
Agalega & 5t. Brandon Is. Active 4 39 53 AF 1035005 56.5278E 386 3B[6
Aland Island Active 5 15 18 EU 601944M  19.9000E OHO O[F-
Alaska Active 6 1 1 NA  64.0778M  153.3336W KL [AKT
Albania Active 7 15 28 EU 409722M  19.8889E ZA ZA”
Aldabra [deleted] Deleted 8 39 53 AF 040565  463611F 1976-06-28 23:50:50 VQ9 v
Algeria Active 400 33 37 AF 27T7111N 21722 X T[RT
American Samoa Active 9 32 62 0OC 1412225 168.7000W KHE [AKF
Amsterdam & 5t. Paul s, Active 10 39 68 AF 37806675 T715222E FT/z FT[0
Andaman & Nicobar Is. Active 11 26 49 AS 116611IN 926722 vu4 vud,
Andorra Active 203 14 27 EU 42.5389N 1.5722E o] 3
Angola Active 401 36 52 AF 1293895 17.0111E D2 D[22
Anguilla Active 12 8 u NA 18.2222M  63.0722W VP2E VP2t
Anncbon s, Active 195 36 52 AF 145005 56278E 300 3C0.
Antarctica Active 13 13 67 AN 8099445 0.0000E CE9 ClA-
Antigua & Barbuda Active 94 8 1 NA 173222M  61.8111W v2 var
Argentina Active 100 13 14 SA 3553895 65.6833W Lu AlYZ
Armenia Active 14 il 2 AS 40.0000M  45.0000E EK EK.*
=||| Aruba Active 91 9 un SA 125167M  69.9889W 1986-01-01 00:00:00 P4 P4
Ascension Iz, Active 205 36 66 AF 703895 14.3500W D8 ZDE. ~
| i ] v

The countries information can be seen by clicking on Countries and then Manager
within the Logbook main menu.

From here, users can also access the Unique Callsign Database by
Unique Calls  clicking on the “Unique Calls” button.

This prompts the operator for the Public or Private UCSDB.

Unique Call Database ﬁ

I_L.-;{I Select the Unique Call database to be
7 updated.

The Public database contains definitions imported from
a central source, The Private database contains your
own definitions.

[ Public ][ Private ][ Cancel ]

It is recommended that operators do not add or modify the entries in the Public
UCSDB. These will be maintained and updated as frequently as necessary by
Ham Radio Deluxe Software. Operators can create entries in the UCSDB by
clicking Private and entering specific information about a callsign.

Private Unique Calls - |
] v & v »® ks 4 » @ \
Load... Save#s.. | Add Edit Delete | Active (All) Inactive (All) Previous Next | Help

| Active | Callsign | Country | DXCC | IOTA | Start| End | QslMgr| "

Clicking the Add button provides a dialog box that the operator can use to enter
the information.
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'U-“.qiue Call &r

Enable: [V

Callsign:

County: [ -

[ CLC: -

[T] 5tart:

[]End:

GSL Mgr

) ]

Note: While this method can be very effective, the operator should consider
that using the Logbook as a callsign lookup source provide the same
capability in real-time. That is — if the operator gets a call logged to the
correct country on the first QSO, then the need to maintain a Private
USCDB is unnecessary.

Hint: The lookup methods already use the Public UCSDB to assist the operator in
logging the QSO to the correct country on the first try.

Callsign Lookup sources

It has become very popular to use callsign databases from the Internet or CD to
lookup information about another station. Ham Radio Deluxe supports a number
of callsign databases for lookup sources.

¥00qgboT

Callsign Lockup =

Enable | Lookup Options

When New Callsign is Entered. ..

Logbook can attempt to fill in the available name and location information by several methods. Reset to Defaults
Please enable or disable the methods that you prefer by moving them to the appropiate box.

Set the onder of lookup by using the plus and minus buttons. {Logbook & Courtry File)
Enabled Methods: Disabled Methods:
Logbook +] - QRZ CD
Previous baghodk 0S0s Lockup from data baaded fom & OAZ CT on your compuier
QRZ_com Subscription +] - HamCall CD
Imarnes-bmad XML loskun an QIRZ com Logkup rom dara baaded fom a HamCall D on your compuier
Country List +] - RAC CD
Demuit valuss from the HRD courry Sl Lioaiup from data kaaded srom a RAC CD on your compueer

< Hamcall.net Subscription

kernet-bemed lodkup on buck com

5> SAM CD

Liogieup from dats kaaded srom 3 SAM CD an your computer

callook.info (free)

It=rnet-beed XML lockiup on callock infa

Callsign Lookup options are found under Tools > Configure > Callsign Lookup.
The supported database sources are shown above. Two of them require a subscrip-
tion (QRZ.com and Hamcall.net), four of them require a CD, one of them pro-
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vides free information about US callsigns (callook.info), and the Logbook and
Country List are also used.

When the ALE is populated with a callsign, “tabbing” out of the callsign field or
clicking the QRZ button executes the callsign lookup. At that point, the empty
fields in the ALE begin to populate based on the following logic:

» Ifthe callsign is contained within the Unique Callsign Database (UCSDB),
the Country and IOTA will be populated from this source first. (This is not
operator configurable.)

* Fields remaining empty from the UCSDB (if applicable) will be populated
from the “Enabled Methods” in the order selected by the operator. For
example (using the image above):

» Logbook — If there is an existing QSO in the log for this callsign, then all
populated fields from that logbook entry will be copied to the new QSO
record. Putting Logbook at the top of the list is a good idea, as it turns the
operator’s logbook into a private UCSDB.

* QRZ.com (Subscription) — If there are any remaining empty fields from
the previous sources, they will be populated by this choice if the data is
available in this choice.

» Country List —If the previous sources did not populate the Country field,
the callsign prefix is compared to the Country list and then the country
field is populated. Country list should never be moved to the top spot in
the Enabled Methods and should normally be at the bottom of the list (last
resort choice).

Note: To reiterate, the order of the Enabled Methods is important. The
empty fields are filled from the top method to the bottom method until
the empty fields are filled with “available” data. If the sources in the
Enabled Methods do not provide certain data, the field will be left
intentionally empty.

Operators who use a CD database for lookup options see a performance benefit
from copying those database files to the local hard drive.
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Lookup Options

External Log Interfaces

7 “
Callsign Lookup Iﬁ
Lookup Options
QRZ.com via XML Hamcall via XML (8.0}
e . The callsign lookup sequence follows =
Usemame: | [EfESE Usemiame: the sequence set on the Enable tab.
Pasaword: sessses Password: CD Lookups
The CD's from
Click here for GRZ XML subscription Click here for Hameall subscription <http://www.grz.com/> and L
information, a subscription iz required information, a subseription is =http://hamcall.net/= are =
to uge this option. Flease support required to use this option. supported. Also the CDs from RAC
QRZ com! and SAM. The HamCall CD provides
more data than the QRZ.com CD.
Callook irfo via XML (US Calls) { 6.0) For best performance copy the

files fir CD to hard disk. =
Callook info is completely free, but donations are appreciated! Click here to donate Hes from o e =

and support the service. Internet: QRZ.com Subscriptions

Access to the QRZ data online

CD / Disk: Lookups requires a valid subscriber login

HamCall CD consisting of a username and
E] password, and a current, active
QRZCD E] subscription with QRZ. You can use
your QRZ.com username and
password for seven days from
RACCD 6.0 E] the date of first lookup. For more
information please visit
SAMCD E] <http:/fonline.qrz.com/=.
Help
CD/DVD drive Remember to enable the  Test
detected on: D2\

method you conﬁgure on Enter a callsign, results are shown in a popup window.
the Enable tab.

P

[ OK ][ Cancel ] Apply

The Lookup Options tab enables the operator to provide the login information for
online sources. CD fields provide the ability for the operator to provide the file
path to the CD ROM drive or to the hard drive location where the databases were
copied.

Test Lookup

The Test Lookup button is very important. This enables the operator to test and
confirm that the selected methods are functional. Simply enter a callsign in — such
as the operator’s call — and click Lookup. A file will pop-up that displays the
retrieved information. If information is missing, then there is a problem with
obtaining data from that source. (Commonly, the QRZ or Hamcall subscription
are expired and need to be renewed online.)

External Log Interfaces

Ham Radio Deluxe

Ham Radio Deluxe Logbook has the ability to interface with a number of external

online logging and awards systems. Presently the following systems are supported
- LOTW, eQSL, HRDLog.net, and ClubLog.

Logbook of the World (LOTW) is supported when the TrustedQSL application is
installed (required). Configuring LOTW is as follows:
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Click the LOTW Download button, or access the download function through the
Ham Radio Deluxe Logbook menu by selecting Logbook, File, LOTW, Down-
load. The following dialog box will be displayed.

Note: TrustedQSL is not used or required for LOTW Download.

(Lotw - (i |

Download LOTW QS0s

LOTw URLs
Login: hitps://lotw.anl.org/lotwuser/default
Download:  hitps://lotw.anl.org/lotwuser/lotwreport adi

Usemame:  wa Ipie

Paszword: seseses
Files
ADIF: C\ProgramData\HRDLLC\HRD Logbook\LOTWDownload 2014-0¢

Last Drload: 5/12/2014 12:41:20 AM

Download From:

Chooze the date from which pou want to
4 May, 2014 » update your LOT'w.

Sun Mon Tue Wed Thu Fri  Sat
27 28 29 30 1 2 3
4 5 6 T & 9 10
1 13 14 15 16 17
18 19 20 21 2 23 XM
25 26 27 2 29 30 3
1 2 3 4 5 6 7

D ownload Cancel

1 The LOTW URLSs should not be changed or the download will not work
correctly.
The operator adds the Username and Password for the LOTW account.
3 The ADIF field will populate automatically and it’s rarely necessary to
change it.
4 Select a date range.
Hint: By default, the download will begin where the last one left off.

5 Then click the Download button and the results will be shown after the file
1s downloaded.

[E] LOTW Import =50

ADIF Filename

Feady

| SaveToDatabase | | Coppsnalsic | [ View DIF || SavedDIF || Cancel

Class Status

@ File C\ProgramData\HRDLLC\HRD Logbook\LOTWDownload 2014-05-12 184902.ADI
@ File Extracting ADIF data

@ File File size 35 lines

"t:)" File Contains 1 records

"t} File ADIF version:

"t} File Encoding:

"t} File ProgramID: |, version

Et:)- LOTW 1 entries

@ Logbook 5635 entries

@ Matches 10of 1LOTW entries matched

Ham Radio Deluxe
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LOTW Upload

Ham Radio Deluxe

If there are any errors in the downloaded file, they will be described in the above
dialog box. Most commonly, there is a mismatch between the mode or band for
the data previously uploaded to LOTW and the data in Ham Radio Deluxe Log-
book. This will tell the operator what needs to be resolved. Then a repeated
upload will be successful.

6 Click Save To Database

7 Click Finish
Hint: This is the method that updates the QSL and (some) Award status fields in
the Awards Tracking module. You will have to hit the Refresh button in the
Awards Tracking tab in order to update the totals.

Begin by selecting the QSOs that the operator wants to upload. From within Log-
book, this is done by using the Ctrl button and either left-click or shift-click to
select records.

Then click the LOTW Upload button, or access the download function through
the Ham Radio Deluxe Logbook menu by selecting Logbook > File > LOTW >
Upload.

Note: TrustedQSL is required for LOTW Upload. The following dialog box
will appear:

LOTW 3|

Upload 1 QSO to LOTW

LOT URLs
Logir: hitps://lotw.arrl.org/lotwuser/default
Upload: https://lotw.arrl.orgflotw/upload

Usemame:  wadpie

Paszword  sesesss << Defaults

TAS5L options
TOSL executable: C\Program Files (x86)\ TrustedQSL\tgsl exe

a

Private password. sesssee

Station location:  Prosper

Files

ADIF; (C\Users\mcarpen A \LOTWUpload 2014-05-12 185947.ADI Save..
Ta&: (Cl\Users\mcarpertA \LOTWUpload 2014-05-12 185847.TQ8 Save...

Status

Upload

1 The LOTW URLs should not be changed or the upload will not work
correctly.

2 The operator adds the Username and Password for the LOTW account.

3 The operator must tell Ham Radio Deluxe Logbook what folder TrustedQSL
is installed.

4 1f a Private password is used in TrustedQSL, it must be entered into the
provided field.

5 The Station location must match exactly to the station location created and
listed in the TQSL application under Add/Edit Stations.

HINT: This is the most frequent cause of upload failures.

The file fields will populate automatically and it’s rarely necessary to change
them.
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6 Then click the Upload button and the results will be shown after the file is
uploaded.

Status

I Fiited |

Logir: Submitted OF,

Send: File LOTWUpload 2014-05-12 185347. T2 queued for processing.
Send: Subrmitted OF.

-~

Tip: In order to know which QSOs to upload, it is quite helpful to add the LOTW
sent field to the logbook layout (by clicking the Layout button and adding

LOTW sent). Select the QSOs where LOTW sent is No before clicking the
LOTW Upload button.

QS0 date |Time on |cCall | Mode |Band| cCountry Name LOTW sent

ARRL HQ COFERATORS CLUB

4/25/2@014 20:32:9@ W1BW/2 CW 15m United States
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8 Awards Tracking

The Awards Tracking module in Ham Radio Deluxe Logbook provides the most
complete award tracking features of any software available on the market. It
tracks over 200 awards and endorsements in sixteen awards programs. Addition-
ally, users have the ability to create and track additional awards of the operators
choosing.

Introduction
To open the Awards Tracking tab, click on the Awards Tracking icon in Logbook.

% HRD Loghook - [WASPIE Laghook]

File Edit WView Browser Calendar Countries Logbook Tools Window Help

: (8] ™ w " 2 0 B .| e -
Open || Layout A LaycutB | Rig Contrel Digital Master Rotator | Tune-Main Tune-Sub | Add Manager About &

i# Radio Screen -] WASPIE Logbook x‘ (£ KI7DG - Callsign Lockup by QRZ.COM I
& T ‘“‘\5 ]

@ :

Add Contest Delete View | Cut Copy Paste | Refresh Width Layout Edit Selections QRZ.con Awards:fracking

a s yommlam

The Awards Tracking tab will be displayed. On the left of your screen you will see
a list of sixteen Award Programs that are currently supported by Ham Radio
Deluxe.

To the right of the list of awards programs, you will see the awards totals for the
selected awards program (DXCC, in this example). When the award name is fol-
lowed by “(Ham Radio Deluxe)”, this signifies that the award is hard-coded into
the program and cannot be modified. It is possible to copy these hard-coded
awards and customize them to suit the user’s liking (this will be covered later).

¥00qgboT

The awards totals panel consists of “rows, columns, and cells” — similar to a
spreadsheet. Understanding the meaning of the rows, columns, and cells is an
easy but important step in using the awards feature. All awards programs conform
to this format.

The rows represent awards or endorsements within the selected
awards program.

Endorsements are listed beginning with an asterisk below the related award.
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The columns represent QSO, QSL, and Award credits within the
selected awards program.

Column descriptions are as follows:

Worked

This is the total number of entities within the awards program that have been
worked, regardless of QSL or award credits. This is a QSO status column.

Confirmed

This is the total number of entities within the awards program that have qualifying
QSL confirmations. Each awards program accepts different QSLs (for example,
QSL cards, eQSL, and LOTW confirmations may not be accepted for all awards).
The award is created to only include the QSL types relevant for that award. This is
a QSL status column.

Need QSL

This is the number of entities within the awards program that have been worked
but not confirmed. The information directs the operator to the QSOs that can be
pursued for confirmation. This is a QSL status column.

Entities Needed

This is the number of entities within the awards program that have not been
worked. This is a QSO status column.

Not Submitted

This is the number of entities within the awards program that have been con-
firmed, but not yet included in an awards application. This information will be
used by the operator to make an awards application. QSOs are not included in this
total once they have been included in an application and appear in the Submitted
column. This is an awards status column.

Submitted

This is the number of entities within the awards program that are part of a current
application and awaiting approval. QSOs are not included in this total once they
have been granted award credit within the program and appear in the Granted col-
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Award Reports

umn. LOTW download provides this data for confirmations obtained through

LOTW. This is an awards status column.

Granted

This is the number of entities within the awards program that have been included
and approved for award credit. LOTW download provides this data for confirma-
tions obtained through LOTW. (Cards included in applications prior to LOTW are
not included in the LOTW download information and must be added manually.)

This is an awards status column.

Note: The “Not Submitted”, “Submitted”, and “Granted” awards status
columns are “transitional” columns. That is —a given QSO can be in only

one of these columns.

Award Reports

Printing awards reports is accomplished by selecting the File/Print option in the

Ham Radio Deluxe Logbook main menu.

The data that rolls-up to the totals in these columns come from information con-
tained within the QSO records in the logbook as follows:

1 Worked Confirmed Need QSL _ Entities Neededfl | Not Submitted Submitted Granted
Mixed 327 327 0 0 0 327
ow 26 pil] 12 1 0 Fif
Phane | m 267 7 0 0
Digital | 126 116 10 0 0 5
160m | 7 n 2 2 0 69
. 80m | 112 0 2 0 0 110 .
' Modify: MySOL Logbook (=
File Edit Options Tracking ShowFields Jhow:Tabs racking  Show:Fields  Show:Tabs =
Date 6-27-2013 [+ Freq; 16.126.000 Date B Frea: 18.126.000 Update F7) | |*
F2Sat:  13:15:51 = Band 17m [Clirack ; 2 D Band 17m [Cltrack Cancel
FI)End:  13:15.51 = FiE [Ciracke o 4[] ["track Reset (F4)
) Add Spat
FHCal  Jo2IOW ]| aRz @ O
oA — sudio Rec
RST Sent: 59 - @ =[5 ] i
RST Revd: 59 - E Locator 59 PMESio =1
Name Hioshi Ohno State Hiroshi Ohno
Comment: aTH 396-1 Inno Getennba oty Siz.
- WPX: a2
e T CER— | o o SWLren
Rotator: 356041666701 1367083 356041666701 13670833333 | ~log Coordinates|| Rotstor

ntry | Contact | Location | mf | Award | Custom | My Station

Sent: [N - Rovd: [No - QSLs counted depend _”Pg:zg = ?m‘rsidcc —
(] {Ban - ] (Bant
Direct = TEIEIEED= [71DXCC (Chalenge) ["]DXCC (Challenge)
paper (QSL), eQSL. or |7 pyec Mixed) [ DXCC (Mocec)
LOTW [E]DXCC (Moce) [F]DXCC (Mode)
Vie: e [7]DXCC (Satelite) £ ] DXCC (Satelte)
[TIFFMA i
This includes the traditional [CI0TA FJI0TA
confirmation data that is []ITU Zones [T]ITU Zones
downloaded with LOTW [CJJARL (Band) [CI4ARL (Band)
[FJJARL (1 [FIJARL (Mixed)
B4 _| |FlaRL ode)
=inn mnm = nn oo

m

This data is only recently available
in LOTW download and ONLY for
confirmations verified through
LOTW. Therefore, users may have
to manually track these fields until
that data is more available in
downloaded format

The Worked, Confirmed, Need QSL, and Entities Needed data comes from the
QSL, eQSL, and LOTW tabs in the ALE. The Not Submitted, Submitted, and
Granted data comes from the Award tab in the ALE. When the Award tab is not
populated automatically from the online system (like LOTW), the information
should be populated manually when applications are made. (Again, a given QSO
cannot have both Submitted and Granted values. Selecting one de-selects the

other.)

Ham Radio Deluxe
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The cells provide the totals for the column within the selected award. When
you double-click on a cell, it will produce a list of the entities that represent that
total. For example, the following image indicates that there are ten entities
worked for the DXCC Digital award where QSLs are needed:

Display n Worked Confirmed Meed QSL  Entities Needed Mot Submitted Submitted Granted

|| Mixed \ 320 328 1 1 1 0 327
e ® oW | 257 281 6 53 7 0 274
\ 7 m 7 61 5 0 267
| 1 0 115
:

Phone

' ARRL DXCC (HRD)
Digital

ARRL FFMA (HRD) 128 116 10 214

Double-clicking on the “10” provides a list of those entities:

DXCC| Country Prefix| Country
456 6W Senegal
o9g 9y Trinidad & Tobago
184 CP Bolivia
178 ER HMoldowva
453 FR Reunion Is.
8@ HR Honduras
56 PY@F Fernando de Noronha
214 TE Corsica
464 V3 Namibia
? 158 VE Australia
Award Tracking |MysQL o |

There are three choices for displaying the QSOs represented by this list. These
three choices are available in the Filter icon in the icon bar above the list. Click-
ing this button “toggles” the filter between the three values.

o The Filter [Off] condition assumes that the operator wants to see all
Filte.rﬂEGfF] the QSOs among the list of entities shown. This is most helpful for
~—————— chasing QSL cards (Need OSL column), where the operator wants to
see all the QSOs with the displayed list of entities.

= The Filter [Oldest] assumes the operator wants to see only one
[Oldest] QSO among the list of entities shown. This is most helpful for
making award submissions (Not Submitted column) where only
one qualifying QSO is needed.
= The Filter [Newest] assumes the operator wants to see only one
B e QSO among the list of entities shown. This is most helpful for
making award submissions (Not Submitted column) where only

one qualifying QSO is needed.

= Once the desired filter is selected, the operator can display the results by
view sl clicking the View All button.

Filter

Example 1 What QSOs do I need to obtain cards from to increase my DXCC Digital Awards
confirmation?

Going back to the ten entities in the Need OSL column, the operator would want
to select Filter [Off] and View All. This would render a complete list of QSOs
with those ten entities where a QSL could be obtained.
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DXCC | Country Prefix| Country Call Q50 date Time on | Band | Mode | Revd
456 6W Senegal 6W1SP 1i1/8/2@12 17:24:1% 15m PSK31 5885
S 9y Trinidad & Tobago SY4NED 2/11/2052 21:87:806 1¢m PS5SK31 59

ig4 CP Bolivia CP&EB 1@/14/28@2 19:42:80 15m PSK31 58
179 ER Moldowva ER10O T/14/2811 22:83:468 3¢Pm PS5SK31 5898
453 FR Reunion Is. FRSAB 2/15/2062 @2:25:00 2¢m PSK31 59
88 HER Honduras HR2/LULDY 2/14/20#9 B3:27:80 4¢m RTTY 550
56 PYBF Fernando de Noronha PY@FZ 3/22/2@99¢1 ©3:23:80 2Pm PS5K31 59
214 TE Corsica TESMH 9/26/2010 14:36:808 15m RTTY 55
| Namibia V51GE 2/11/2@082 |
15¢ VK Bustralia VE5PO 5718/ 2881
158 VE Australia VE3FFB 4/2@/ 2014 589
158 VE Australia VE3PK 12/28/2000 ©6:59:50 2¢m PS5SK31 5989
158 VE Aunstralia VEZD5G 12/28/2000 ©6:52:80 2¢m PSK31 5989
158 VE Australia VETS4 1@/8/2000 ©O:08:50 1¢m PS5SK31 58989

e
[ [a [Award Tracking |MySQLI 14 I

Notice that, for the 10 entities where a QSL is needed, there are fourteen QSOs.
This gives the operator the ability to decide which QSOs to pursue. The operator
can select QSOs in this view and print QSL cards or labels from this list.

Hint: Select Ctrl + A will select all the QSO. Press the Ctrl button, while click-
ing individual QSOs, will select a number of individual QSOs as desired.

[P HRD Logbook - [ARRL DXCC (HRD): WASPIE Logbook] o S
File Edit View Browser Calendar Countiies Logbook Tools Window Help _8x
WL AT SOOI 5615 _ic.255.000
Open || LayoutA LayoutB | Rig Control Digital Master Rotator | Tune-Main Tune-Sub | Add Manager | About s 18'36'15 14.235.000 3.780.000
'z € Radio Screen | ] WASPIE Logbook | (@ KI7DG - Callsign Lookup by QRZ.COM | % Award Tracking | ] ARRL DXCC (HRD): WASPIE Logbook  E-] ARRL DXCC (HRD): WAIPIE Logbook xl LSy I_
£ N = 3
SO = X | X B2 B = Q o * =] % ® @ @ + 3 E]
o | Add Contest Delete View | Cut Copy Paste | Refresh Width Layout EditSelections QRZ.com | Awards Tracking Backup More..w | Filter QSL Awerd | LOTW Upload LOTW Download =4 o
£
2| Display = DXCC‘ Country Prafix‘ Country ‘ call ‘ QS0 date ‘Tima on |Band‘ Mode | Rewd | (Q
o Seneg: §W1SP 17:24:19  15m PS:
'd""" O ¢ 9Y4NED U
= CP6EB O
| ayout ¥ ER100
=
e Y
| : o
5
WASPIE Logbook — x
TestLog
My Logbook 5 : Edit
5 Refresh
& Auto Width
269
& Award Tracking
Lookup »
Databases
Gptions 5 Layouts 3
T Edit Selections b | [AN [Award Tracking [MySQL [14 |
DX Cluster: Spots: WASPIE-3 on WASPIE-2 (DXSpider), 1 active Alarm Backups v 7 x
I Close | Show = AL * T Wl Fitter Band+Mo = | ) (3| & Alarms - (5 Options | @B QRZ:  Bulk Editor v
| c ‘ B | M ‘ L ‘ Mode Freq| DX Call | Country (ARRL Prefix) | Con (Ems s Spotter ‘ Time ‘ ~RZ ~Dist | DX Grid| Worked Modes b
»
v XX Uss 18.129.0 AT1/WI2NY Qatar (A7) a5y meort tr WIaNy 1834z 32° 788l LLSSMH CW E
v X X v W 21.225.2 TZEBB Mali (TZ) Hea? (e s W3LPL 18272 75° 5737 IKT6RI 5SB, USB
v XX v oW 21.828.3 BVIEK Taiwan (BV) Hear QsL.cc L WALEL 18262 324° 7688 PLBS 558, USB
v X v v us 18.115.9 YB2DJ Indonesia (YB) U, LIRDES Ero NIEW 1824z 305° 9422 OIZEIM  CW, [SSB], [USB]
v X X UsB 18.158.9 ATL/WIZNY Qatar (A7) goor Clublog > VRIER 1813z 32° 7281 LLSSMH W
v X v v uss 18.115.9 YB@DJ Indonesia (YB) Q5L Cards 17592 3@5° 9422 OISGIM CW, [SSB], [USB]
v v X v ot 21.885.2 4LEA Georgia (4L) RITE Q5L Qs0s 17592 23° 6664 LNIINV CW,358,USE
v v 24.893.9 TEALS Corsica (IK) Heard in NC 17572 47° 5435 JN4ZMC  RITY, [CW]
v X X DIGI 21.983.6 EYTAD Tajikistan (EY) Form Setup 17442 10° 744 MMSBJT  CW,SSB,USB
v X v v o 24.895.8 9H3XK Malta (9H) Heard in NC Beis 17392 49° 5925 JMISFV  PSK31,SSE,USB, [CW]
v X v v oo 21.818.2 R92GE Bahrain (9) Heard in NC 17372 510 7888 LLS&  558,USB, [CH]
v i oW 18.074.9 2356 Macedonia (23) 17352 41° 5960 KN@1RM BSK31,5SB,USE, [CW]
PRV S . - - s PR g e P e [P —— 2
<1 il I v
| DX Cluster: Spots: WAIPIE-3 on WAIPIE-2 (DXSpider), 1 active Alarm | 30 Day Solar Data  Solar Cycle Progression  Audio Monitor ~ Monitor
| Greyline |
Edit and Print Labels NUM

Example 2: What QSLs do I need to submit to include in my next awards application for the
DXCC Phone Award?

The awards totals indicate that five QSLs are ready for to be submitted in an
award application:
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Display 2
|| Mixed

® cw
Phone

Award Programs
" ARRL DXCC (HRD)

Double-clicking on the “5 generates a list of t

Worked
329
287
279

Confirmed Need Q5L  Entities Needed Mot Submitted Submitted Granted
328 1 1 1 0 327
281 6 53 7 0 m
272 7 61 0 267

he entities that will be submitted:

SPE FO/fa
298 FW
225 15
498 T33
11 Vo4

DXCC| Country Prefix| Country

Bustral Is.

Wallis & Futuna Is.
Sardinia
Banaba I. (Ocean I.)

Endaman & Nicobar Is.

|—|—|Award Tracking |MySQL El—

Because there may be more than one QSL for some of these entities in this list, |
will select Filter [Oldest] and View All. This provides the list needed for submis-

sion:

DXCC | Country Prefix| Country | Call | RE0 date Time on | Ba.nd| Mode | Rewvd
49@ T33 Banaba I. (Ccean I.) T334 11/15/2@13 23:4L:59 15m USB 59
5@8 FO/fa Austral Is. TX6E 3/29/2@14 @1:98:04 12m USB 59
298 FW Wallis & Futuna Is. FWsJJ 2/23/2814 21:33:48 1fm USB 55
225 IS Sardinia IS@FDW 4/23/2@14 @3:83:28 2Pm USB 58

11 vU4 Andaman & Nicobar Is. VU4E 3/29/2814 @l:56:87 12m USB 5589

[ [Nl [Award Tracking [MySQL [5 |

The operator can print this list by clicking File/Print in the Ham Radio Deluxe
Logbook menu. Additionally, the operator can save this list as an Excel or delim-
ited text file so that the information can be combined into a single award applica-

tion.

F:. HRD Logboaok - [ARRL DXCC (HRD): WASPIE Logboak]

File Edit View Browser Calendar Countries Legbook Tools

Window  Help

] = © " A 0 1 . e = .

Open || Layout A LayoutB | Rig Control Digital Master Rotator | Tune-Main Tune-Sub | Add Manager | About = 18:50:58 14.235.000 3.780.000
E #3 Radio Screen | =] WASPIE Lngbnukl /& KITDG - Callsign Lookup by QRZ.COM | &% Award Tracking | [] ARRL DXCC (HRD): WASPIE Logbook -] ARRL DXCC (HRD): WASPIE Loghoak x| - Xy
g N = 3
il @ X B & B B ) @ = L] % 3 =
o| | Add Contest Delete View | Cut Copy Paste | Refresh Width Layout Edit Selections QRZ.com | Awards Tracking Backup More..~ | Filter QSL Award | LOTW Upload LOTW Download =2
4
3| Display k Dxcc| Country Prefixl Country ‘ call ‘ Q30 date ‘ Time on ‘ Bandl Hnde‘ Rovd ‘
— . 3 Banaba I. (Ocean I.) T33A  11/15/2@13 23:48:59

Sgjcction Bustral Is. TX6G ~ 3/29/2014 P1:98:94
= Wallis & Futuna Is. FWSJJ 2/23/2@14 21:33:40
— wll = Sardinia ISPFDN 4/23/2@14 @3:03:28

5 Zndaman & Nicobar Is. VU4K  3/29/2@
=1 Database A New Window
= [

s

WASPIE Logbook Edit 3
T LE“LL"T) . Refresh
ogbeol
) 4 Aute Width
i= Layout
Q Query
W Fiter [O1dest]
# Award Tracking
Laokup 3
N oo
Options 3 Layouts b

Edit Selections  »

DX Cluster: Spots: WASPIE-3 on WAIPIE-2 (DXSpider), 1 active Alarm

B Close | Show = ALL

- T WSl Fitter Band+Mo - | 1.1} (3 | ff Alarms + (R Options | @ QRZ.com | (@) Add Spot

| Country (ARRL Prefix)

e |3 |u 1| Mode Freq| DX Call

v X v UsB 24.980.0 7QTVW Malawi (TQ)
v X v W 18.086.2 J28NC Djibouti (J2)
v XK v cw 50.247.2 ZF1EJ/B Cayman Islands (ZE)
v XX UsB 18.129.0 A7T1/WI2NY Qatar (A7)

v X X v 21.225.2 TZEBB Mali (TZ)

v XX v 21.020.3 BVIEK Taiwan (EV)
v X W v UsB 18.115.2 YB@DJ Indonesia (¥B)
v XX USB 18.158.@ AT1/WIZNY Qatar (A7)

v X v v U 18.115.0 ¥B2DJ Indonesia (¥B)
v v X v D1er 21.0988.2 4LBA Georgia (4L)
[P 24 202 n Twars Fammine 1T

Backups ' [ Al [Award Tracking [MysQL |5 |
Bulk Editor »
%
A0IF2
lopois b ADIF 3 (ADX)
| Comment ‘ Spoty  LOTW Y Cabrillo, orked Modes -
QS¥ 24985 outside EU now H3RL eQSL.cc 4 Excel XML , [SSB], [USB] H
Heard in MD W3LPL HRDLog.net » K31, [CW]
NSDG ClubLog » 58,558, 55TV, USB, [t
EASIAO IS SELF SPOTTING !!! WIZNY »
Heard in MR WILEL
Heard in BC W3LEL
10, S7 in N Calif NT&W
good ears through EU VAZEW
W2ES
RITY WBSTUE

7881 LLSSMH CW

18272 75 5737 IK76RI  S5B,USB
18262 324 7688 PLOS 558,USB
18242 3@5° 9422 OISETM  CW, [SSBI, [USB]
18132 32 788l LILSSMH CW

17592 385° 9422 OISETM  CW, [SSBI, [USB]
17592 29° 6664 LNLINV CW,SSB,USB
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Award Reports

Clicking on the Matrix button generates a matrix report for the selected awards
program. This is very similar to the style of report that is provided by the ARRL
for DXCC awards. But this report shows Granted (G), Confirmed (C), and
Worked (W) countries by award.

€5 Radio Sercen | ] WADPIE Logbook | 2 KITDG - Callsign Lookup by QRZCOM % Award Tracking x|

‘ 4 R | @ p o @ [ & voon .- & B o | ® & b W a
Print Preview | Excel Bafl Matrix JVerify | [del] Entities =05 | LOTW | QSL Cards Definitions | Refresh Width | Totals QSOs Sort Column2 | Hide Calors | Homepage
El Entity Mixed cw Phone Digital 160m 80m 40m 30m 20m 17m 15m 12m 10m &m 2m
£/ 1A Sov. Mil. Order of Malta = |
=15 Spratly Is. | -

3A Monaco |-

IB6 Agalega _St. Brandon Is. |---

388 Mauritius [ |

B9 Rodrigues Is. | - i

3ic Equatorial Guinea |--

3C0  Annobon ls. | ]

Dz Fiji [ |

3D2/c Conway Reef | | v v

3D2fr Rotuma ls. | -

DA Swaziland | - | | | |

¥ Tunisia v | ¥ [ |

3w Yietnam - ‘

3x Guinea |- ‘- ‘

3V Bouvet [ | e

Ip  Peterlls. = |

44 Azerbaijan | ‘-

AL Georgia [Fe| | |

40 Montenegro = | | = |

45 SriLlanka [ |

4Ull  ITU HG = | | |

Ham Radio Deluxe

Operators can create (define) their own awards by selecting the Definitions but-
ton in the Awards Tracking tab.

=) /?‘ ¥ veral A &
Matrix !Venfy [del] Entities e(QSL [ LOTW | QSL Cards Definitions
r:‘_ﬂ Award 2 Definitions — A I_
A @ & x ) + < » o
Add Copy Modify Delete | Move Up Move Down | Import Export (Q
Title | Award | Lock | ‘ U
ARRL DXCC (HRD) Locked O
ARRLFFMA(HRD)  FFMA Locked O
ARRLVUCC (HRD) VUCC (Band) Locked x
ARRLWAS (HRD) WAS (US) Locked
CQ DX (HRD) Locked
CQ DXField (HRD) Locked
CQWAZ (HRD) Locked
CQWPX (HRD) Locked
eQSL eDX100 (HRD) Locked
eQSL eGrid (HRD) Locked
eQSL ePFX300 (HRD) Locked
eQSL eWAS (HRD) Locked
eQSL eZ40 (HRD) Locked
IARUWAC (HRD) Locked
I0TA (HRD) I0TA Locked
ITU Zones (HRD) ITU Zanes Locked

The operator can create a new award based on one of the hard-coded (Locked)
awards by selecting one and clicking Copy, or build a new award from scratch by
selecting Add.
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5] Award 2 Definition @]
Add Copy Modify Delete | Move Up Move Down | Bands: All I
Title: I 5L types: Paper  [V]LOTWw (] ensL
URL Default Award to track: [ - ]
Description: - td ain Field to display: I COL_DXCC - ]
_ Allfields: -
Locked ] Mote: & lock prevents any changes to the Load from File con
definition. Mate: DCC, US States, ITU Zone, CO Zone and 10T are predefined.
Defirition
[] DXCC Filter: Label | Award | Field | Match | Value i

[ Girid resolution: 1

Ignare if emply

Ignare if zero

[7] Case-insensitive [uppercase]

Test

[E]'A3PIE Logbook
[ Test Log
[ My Logback

Timestamp | Action | Result

Apply

o (o)

Because the awards definition builder is very flexible, it would be hard to describe
a specific example. It is recommended that the operator tinker with this by creat-
ing a copy of a hard-coded (Locked) award and learning it through trial-and-error.

DX Cluster (and the associated Options)

Ham Radio Deluxe has a very powerful DX Cluster capability that is designed to
maximize a DXer’s productivity. Configuring the DX Cluster window is done by
clicking the Options button in the DX Cluster pane.

| DX Cluster: Spots: WAQPIE-3 on WAQPIE-2 (DXSpider), 1 active Alarm g x

:G Close | Show = ALL ~ T WSIFilter Band+Mo = | |7 (4 gmarm;vlﬁopﬁons I B QRZ.com | (@ Add Spot
The following DX Cluster Options dialog box will be displayed:
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DX Cluster (and the associated Options)

DX Cluster Opticns

%

Connect on startup
Reconnect  connection lost

Preamble

After connecting load:

Announcements: 1{}7'
Spots: 500 -
WCY: ] -
VW a5 -

To post spots and
announcements you
must register with the
cluster sy=sop.

L | »

The recommended
nodes are: -

Spots and Announcements

Some cluster nodes require
registration before spots and
announcements can be sent -
contact the cluster sysop for
more help.

Send e-mail to the GBTMBC sysop

Connection |Pq::pea|ar1ce | Layout | Selection | Spot Fiters | WSI | Alarms I Alams:E-Mail I Alarms:Speech | QSL | Ak
MNodes are shown in this order in the 'Node’ dropdown
Add Modify Delete | Move Up Move Down | Move Top
Title Address Por Lr:mgl_‘_I
WASPIE-2 hrd wa3pie.net 8000 .y
MNIKT-2 n9kthomenetorg 5000
VE7JCCA ve/cc.net 23
HBSDRV-9  spiderham-radio-deluxe.com 8000
WAZRX dxc.wIznonet 7373
CC User localhost 7300
Skimmer localhost 7300
GB7MEC gb7mbc.spoo.org 5000 =
4 | 1 3
Defaults User Info
SS1D:
Password:
Callsign: WASFIE -3 -
Default password if not set for the
cluster. Name: Mike
Locator: EM1 3af
Home nede:  WASPIE-2
QTH/City:  Prosper, TX
The DX cluster node you nomially
use, leave this empty if you do not : . ;
use other cluster nodes. To edit User Info. My Station

Send e-mail to the HESDRY-5

Connections
Tab

Ham Radio Deluxe

| oK || cancel |

The Connections tab defines how the operator will connect to the DX Cluster

system:

A list of DX Cluster nodes (telnet servers) are shown. There are about 500 cluster

nodes included. The operator can choose from one of those or add one that’s not
included by giving it a title, providing the IP address or DNS name, and the IP

port number.

Add New

Add a new cluster definition to the list

Title:
Address:
Fart:
Loagin:

Password:

[Optianal)

[Optianal)

Cancel

aK.

If a password is required for the selected cluster, or Home node is defined by the
operator, these are added in the Defaults section.

If the operator desires that the connection to be made when Ham Radio Deluxe
Logbook is launched, or reconnected in the event of a disconnect, those options
can be set in the upper right.
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Appearance Tab

¥

Chapter 8 - Awards Tracking

At logon, the operator can opt to automatically pull down Announcements, Spots,
or solar data from WCY or WWV. The number of each can be specified here.

The User Info is obtained from the My Station data.

Note: If you are connecting to the same node from multiple computers, it is
necessary to select a unique identifier — or SSID — for each connection.
Failure to do so will disconnect the previously connected session.

DX Cluster Options

-

%

Connection | Appearance | Layout | Selection I Spot Filters | W5l I Alams | Alamg E-Mail | Alams:Speech | @SL |t

The appearance of the Announcements and Spots lists

Colors

Altemate colors every TowWs.
_
Size:
-

Font

Slash zero: Display & instead of 0 (zero)

[ Bald [halic [ Grd lines

% Courier Hew

The Appearance tab provides options for changing the font or alternating row colors:

e

“

DX Cluster Opticns 2

| Connection | Appearance | Layout |Se-|ection I Spot Filters | WSI I Alams | Alarms:E-Mail | Alamms: Speech | Q5L |tk
The Column layout in the Spots display

orked Status Indicator: This indicates whether this COUNTRY is not-worked,
orked, or corfirmed. NOTE:  This value is aligned with "Country Needed({Moed)"
or the spotted DXCC Courtry.

1-;' [ Indicate Calculated Fields with icon.

Available Selected [Ci)[&](#](#] [ pistance -
. " . . | | The distance is shown
HRD:Band f— WSl:Country (C) —_| | in either kilometers or
HRD:DX Count WSl Band (C+B miles - see the
e v l: ] Appearance pane to E
HRD:Distance WSlEMode (C+M) select this option.
HRD:Heading 3 MemberLOTW . i
HRD:Latitude HRD:Mode Distance & teading B
HRD:Longitude 4 SpotFrequency _|| | heading is shown from
. = | your locator (see Your
HRD:Mode SpotDX Call Information pane).
MemberLOTW HRD:DX Country e Il
MembereQSL SpotComment
SpotComment SpotSpoter Call The distance is shown in either
SpotDX CQ SpotTime || kilometers or miles - ses the
SpotDX Call HRD:Heading popesrance pans 1o selectthis
SpotDX Country 1l HRD:Distance i
D e P 1T = rorcoce The distance and heading is
Description:

shown from your locator (see
Your Information pane).

| ok || Cancel |

74

4
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Layout Tab The Layout tab is a very important tab, as it is where the operator will select the
information that they wish to display in the DX Cluster pane.

The field names now provide an indication about the source of the information.

* Fields that begin with HRD indicate that the information provided is created
by logbook from other related sources of information about that spot. For
example, heading and distance are estimated using the “center-of-country”
coordinates for the spotted station’s country.

* The fields that begin with Spot contain information that comes straight from
the DX Cluster node. For example, the Country provided by the cluster
varies in format between cluster nodes. Selecting Spot:DX Country will
display exactly what the cluster node provides (which is why most operators
prefer HRD:DX Country so that it’s shown in a consistent format).

* The fields that begin with “WSI” are Worked Status Indicators. These
columns assist the DXer in determining what spots are needed for new
countries on band or mode.

* The fields that begin with “Member” display an indicator that shows

whether or not the spotted station is a user of LOTW or an AG member of
eQSL.

Note: It is HIGHLY recommended to use the layout Defaults for some
period of time to gain familiarity with the most commonly selected

fields.
.

DX Cluster Opticns x —

@)
|Cnnnection | Appearance I Layout | Selection | Spot Filters | Wl | Alams I Alarms:E-Mail | Alams:Speech | QSL [ fk (g

o

How spots are selected o
~

Selecting a Spot ALE Window
) Single-click @ Double-click _) Single @ Multiple

These values are sent to the cluster node when you connect

Spider and CC Cluster Options Region
Region 1 [¥] Change Modes on DX Spat
) Use shidx @ Region 2 (US) Use Q15X on Frequency
@ Use sh/mydx ) Region 2 Reset Split on ALE Resst
" Region 3 Reset Split on ALE Save

Limit Comment to 30 Letters

Selection Tab The Selection tab provides options for the behavior when selecting spots.

» Selecting a spot — with frequency and mode change for the rig — can be done
with a single-click or double-click. A double-click is recommended, as this
gives the operator the ability to single-click to display the spotted station’s
information in the Lookup Pane.

* Some operators want the ability to open multiple ALE windows
simultaneously.

* DX Spider and CC Cluster have the ability to send the first “lot” of spots (as
determined by the Connection tab) in a format that honors the server-side
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Spot Filters
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filters. Using sh/mydx is recommended (this works regardless of the

existence of server-side filters).

* ITU region is selected here.
* The behavior of mode change and QSX are selected here.

¥

DX Cluster Optiens

P

| Connection I Appearance | Layout I Selection | Spot Fiters |WSI | Alarms I Alams:E-Mail I Alarms:Speech I QSL | Ak

Define the spot filters

x

Add Copy Modify Delete

.’.

+

Move Up Move Down

Title
ALL
HF
WHF
UHF
Digital
STV
Swiss

F min |
0.0m
1.800
50.000
400.000

F max| Max. | Callsign

2450000 250
30,000 999
250,000 100
500.000 100
- 100

- 100

- 100 H[BE]1-9]*

PSK.RTTY OLIVIA THORMTBE3
STV

' Filter

The Spot Filters tab enables the operator to create filters for the data being delivered to
the DX Cluster window (ie. after the application of server-side filters). These filters are

displayed in the dropdown menu in the DX Cluster window.

HF
VHF
UHF
Digital
SSTV
Swiss
2190rm
600m
160m
E0m
60m
40m
30m
20m
17m
15m
12m
10m
Gm

“14m
12m

1.25m

1 70cm
4 23cm

AL

m

1

ALL
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WSI Tab

Ham Radio Deluxe

DX Cluster (and the associated Options)

3

DX Cluster Options

Y

| Connection | Appearance I Layout | Selection I Spot Filtters | WSl

|Narrr|s |.Narrns:E—MaiI Alame:Speech IQSL il

The appearance of the WSI

Worked Status Indicators

W5| Rows

[] Show WS with Row Calar

' You have confimed G50s with this country. [Confimed]
7 Youh rfimed QSOs with th Worked] | e 1ot B M C o=
ou have uncaonfime 5 with this country. [Worke
) EBX X X Mo Matches
¥ You have not worked this country. [Not Worked]
* fou have confimed GS0s with this call in your log. EE vivl¥ Al Confimed
= You have uncorfimed QS0s with this call in your log. EHEE fod Al Worked
WOWEX e
Q5L types in Worked Status Indicators
Do Confirmation Searches using Q5L EHEE / Matched Band
[7] Do Confimation Searches using eQSL EHEE T4 g::ddi-l'\"lode
Do Confirmation Searches using LaTW
WOED X s
EE'EE 7 Matched Mode
Mixed
EE'EE' /X Mode+Country
WOEE X tocem
EBEE 7 Matched Courtry
Mixed
OFME"Y % eaniecouey
| oK || Ccancel

~

[T

A

¥00qgboT

The WSI tab defines the behavior of the Worked Status Indicator fields in the lay-

out.

On the left hand side, the WSI icons are defined and the QSL types to include in

WSI are selected. In the right-hand side, the operator has the option of color-cod-

ing spots based on selected criteria.

Note: If no QSL types are included, then the DX Cluster will not show a
yellow yield sign (Worked, but not confirmed). Please select at least one

QSL type.
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Alarms Tab

152

¥

o

DX Cluster Opticns P

|Cor1nedion Iﬁppeamnce I Layout |Selectior1 Spot Fitters |WSI | Alarms |.Narrns:E—MaiI Alams:Speech I GSL [ 4]+

DX Cluster Alarm Definitions

B

Add Copy Modify Delete | Move Up Move Down

Enable | Title Callsign
DXCC Needed 707BS7|FTS[EJ]F|FTION2458]W *|FT012458]C* | [AKNW]HZK |HM.*|P
O Test WAIPIE

The Alarms tab enables the operator to define the criteria with which email or
speech alarms are generated.

-

Add Alarm Definition _

Enable:  [¥] Enable [ Title o

Title: Any text you like, used in the Alarms
: dropdown in the DX Cluster window.

Callsigr: Callsign

[ ] The callsign you are waiting for - this can
b Add ; . ; ;
also be a regular expression - see
below.

m

Camment:

Filtar To =et an alarm for HESDRV just enter
e ALL s HBSDRV in the Callsign field. To look for
Interval: 5 Mihutes any station enter .* (a wildcard match).

e o Country
Dptians: L An easy way to set an alarm for one or

[] Text to Speech more countries is to select the country
and then press Add. When you press Add
the prefix list for the current country is
appended to the list in the Callsign field.

Comment
] Free-format text which desribes the

0k [ Cancel ] [ Help

A

Selecting Add provides a dialog box for a new alarm. It must have a title, and then
the operator can choose between callsign or Country alarm, by dropping the field
down to select from a list of Countries. The filter field provides the option to
select among the filters created in the Spot Filters tab.

The options select email and/or text to speech alarms configured in the next two
tabs.

Ham Radio Deluxe
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DX Cluster (and the associated Options)

¥

DX
1

Cluster Opticns =

| Connection | Appearance | Layout | Selection | Spot Filters | Wsl I Alams | Alarms:E-Mail | Alams:Speech | QSL 4]k

Optional E-Mail Configuration, used for DX Cluster alarms

Port {0 for default): 587

SMTP server address (outgoing mail): smip.gmail.com

SMTP server account / password:
Outgoing e-mail address from):

Outgoing e-mail address {o):

HRD is on 20 meters

Results

View

Results Help

SMTP Outgoing E-Mail

This is the configuration for sending e-mail, for example in Qutlook Express these settings are
found in the Outgoing Mail Server part of the Servers configuration for the email account
yvou use. The information required is supplied by your ISP.

-

Note: 551 / TLS server access is currently supported only on port 25, 465, and 587.

-

Mote: F you dont have a hard SMS connection and you want to send text messages for alams, you may use the email tesdt
message interface published by most cell phone companies.
Click on the link below to see a list of email addresses.

Alarms:E-Mail
Tab

bt dhww w emailiextmessages. com’
| ok || Cancel |
The Alarms:E-Mail tab enables the operator to configure and test the email
alarms. Using the email address for the operator’s smartphone is a nice option, as
MMS text messages display nicely on a phone.
HRD DX Cluster> 3COBYP
21280.0
HRD DX Cluster
DX Callsign ......: 3COBYP
DX Locator .......:
DX Country .......:
Anncbon-3C0
Frequency ........: 21280.0
: 23-
Feb-2014 21302
Spotter ........... WBORUR
Spotter locator ..:
Spotter comment ..:
153
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¥

DX Cluster Opticns &

| Connection I Appearance I Layout | Selection | Spot Filters | WSI | Alams I Alams:E-Mail | AMlams:Speech [QSL[4 | *

Optional Text-to-Speech Configuration, used for DX Cluster alarms

Options: Spell alphanumeric words
[] Use phonetics when spelling words

Test message:  MNew DX is on the air.

How To Configure and Use Text+4o-Speech in Windows XP

Alarms: Sp eech The Alarms:Speech tab provides an audio indicator that an alarm has triggered.
Tab

DX Cluster Options %

| Appearance I Layout I Selection I Spot Fitters | WSI I Alams | Hlams:E-Mail I Alamms:Speech | GSL Members L [

Lookup of QSL, eQ5L, and LOTW
‘250 Import URL:

hitp:/fwww eqsl co/Q5Lcard / DownloadedFiles/AGMemberList bd
LOTW Impart LURL:

hittp:/Awww hbSbza net Aotw.dotw bd

eQSL Ertries: 84249 5/7/2014 4:36:05 P[] Auto
LOTW Entries: ~ 75871 5/7/2014 4:36:11 P [¥] Auto

[] Ask before doing automatic updates.

QSL Members The QSL Members tab configures the update frequency and automation for the

Tab LOTW and eQSL (AG) member’s list. Operators are prompted for this when
launching Logbook for the first time. The set-it and forget-it option is the recom-
mended choice. This sets both lists to Auto and does not ask before automatic
updates.

(Interesting note: This data indicates that there are about 9,000 more eQSL AG
members than LOTW members).

Button Bar

DX Cluster: Spots: WAQPIE-3 on WASPIE-2 (DXSpider), 1 active Alarm a x
[ Close | Show - ALL « 7 WSIFilter Band+Mo ~ | .} (& | <ff Alarms+ [ Options | @ QRZ.com | () Add Spot

The button bar in the DX Cluster pane provides a number of useful options.
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Connect

DX Cluster: WAIPIE not connected
» Connect Mode WASPIE-2 -

The connect button starts a connection to the selected DX Cluster node. The DX
Cluster node can be selected from a dropdown list.

Close
This button terminates the telnet session with the selected DX Cluster
node.

] Close

DX Cluster: Spots: WASPIE-3 on WASPIE-2 (DX5pider), 1 active Alarm

While connected, the title bar shows what SSID the operator is using (WA9PIE-3,
in the above example), the cluster node the operator is connected to (WA9PIE-2,
in the above example), the type of DX Cluster node the operator is connected to
(DXSpider, in the above example), and how many alarms are active.

Note: Ham Radio Deluxe Logbook supports DXSpider, CC Cluster, and
AR Cluster server nodes via telnet.

ALL . The filters dropdown (shown above) enables the operator to filter DX
Spots based on the filters created in Options/Spot Filter. Provided val-
ues include HF, UHF, VHF, 160m, 80m... etc. =

HINT: It is not good practice to try to filter spots by geographic zone from within O
Ham Radio Deluxe. These types of filters are best when created on the server/
node. Google search can provide the filter command set for DXSpider, CC
Cluster, and AR Cluster.

NEW — The WSI Filter is a powerful asset to the DXer and
DX awards fan. This filter is capable of hiding spots that are
not needed for band or mode. Options are Band, Mode, and Band or Mode. As a
result, the DX Cluster window will display the following:

¥00qb

T WS5I Filter Band+Mo ~

DX Cluster: Spots: WAIPIE-3 on WAIPIE-2 (DX5pider), 1 active Alarm a2 x
[ Close | Show ALL ~ °F WSIFilter Band+Mo = | |3 [ | < Alarms = [ Options QRZ.com | @ Add Spot
C |B |M|L |Time Freq| DE Call | Spotter | Comment Country (ARRL Prefix) ~AZ| ~Dist*
¥ XK '/ ¢ 1544z  21.286.6 ELZDBF  KIGSE Republic of Horea (S. Korea) (HL)  325° saze 15
v X v 1543Z  50.907.8 XE2HWB/B NSD& Mexico (XE) 204° 879
v XX 1542Z  21.928.0 SV2ASF/A WSOZI QSX 21222.8 w/1@0w...tnx new o Mount Athos (SV/A) 41° 6133
v X ¥ v 15aez 24.995.0 R92GE W3LPL Heard in PR Bahrain (A9) kb i 7808
v XX 1539Z  21.9208.0 SV2ASF/A WLEV Mount Athos (SV/R) 41° 6133
v X v 1539Z  24.908.0 TOGR W3LEL Beard in NC and MR Rfghanistan (¥A) 16° 7679
v XK X o 15362 21.286.0 XXOLT K7GSE Macao (XH3) 328° 8127
v X v 1535  50.908.0 EUVIDEO KITOL 49.760 growler >FN44 MATNE Belarus (ET) 32" 5605
XK '/ 15397  21.286.0 HL2DBP  KV4UL 57 Republic of Korea (5. Korea) (HL)  325° 6328
v o X 15262 21.883.1 EX2B W3LEL RITY Heard in PA Kyrgyzatan (EX) g 7251
v X X 15262  21.286.5 EYTAD KT9L RITY Tajikistan (E¥) 19° 7404
v X X W 15247 21.285.7 EXSLT WR4G535WL hrd wkg with yl2ei Macao (XX9) 328° 8127 |
. i W "I R T I e i £y e e R Gk ) “”»
DX Cluster: Spots: WASPIE-3 on WAIPIE-2 (DXSpider), 1 active Alarm | 30 Day Solar Data  Solar Cycle Progression  Audio Monitor  Monitor
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Chapter 9 - Digital Master-780 Introduction

9 Digital Master-780

Introduction

DM-780 is a very sophisticated, feature packed, program that allows you to send
and receive many of the popular amateur radio digital modes, including SSTV and
several PSK versions using a computer sound card. It supports AFSK modes as
well as FSK RTTY.

The program integrates with the Ham Radio Deluxe Rig Control program to control
band and frequency changes without exiting the program. It’s also integrates with
the Ham Radio Deluxe Logbook to allow easy callsign look-ups and logging of
your digital contacts through its built-in Add Log Entry (ALE) screen.

DM-780 has features not found in any other program on the market today. The
SuperSweeper gives you the ability to view and decode multiple signals using CW,
BPSK and RTTY in single window. You can also enable the SuperSweeper History
file to keep track of and display information about callsigns you have heard from
your location.

The SSTV module has a built-in editor for creating templates for your outgoing
messages on background pictures from your own photo collections. It can also
place an incoming picture within one of your outgoing pictures so your contact can
see just exactly how his transmission looked when you received it. These are just a
few of the many great features of DM-780.

Getting Started

Computer
requirements

Lets start...

Ham Radio Deluxe

Our suggestion of a minimum specification would be a Pentium 4 machine with
2Gb RAM running at least Windows XP Service pack 3 - The program runs very
well on Windows XP, Vista and 7 but will not run satisfactorily on older Windows
operating systems.

Start DM780 from within your Ham Radio Deluxe application by click-
ing on the DM780 button in the toolbar. For now continue to use the
PM780 1 Dem-o-matic TS-2000 rig if you do not have a data interface with your
radio.

When you first open the DM780 for the first time you will see a Getting started
dialog that you must complete. The first item of business is entering your callsign.

159
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File Edit View QSO Browser Logbook SSTV SuperSweeper World Map Tools Window Help -5 X
= & = 2 ] E= 3 ] = = _
QSO SuperSweeper | Radio Soundcard Waterfall Rig Control Logbook Rotator | Program Options B Full Screen B

BPSK-31 Getting Started > -x
) &1 G Ga A-E @ res://C:\Program Files (x86)\HRD Software LLC\Ham Radio Deluxe\Digital Master.exe/333 >~ 2O
-

Getting Started

I
—

1-2-3-4-GO

This help text is displayed because you do not have a callsign defined in your tags window
(1) Tags (Callsign, Name, ...)

« R Click here to display the Tags window

Start here
EntepPalues in the Taw wwmm macros
(shdrtcuts which save you ng the same text every time you have a
QSONThe values are aved automatically.

QTH Laax

E-Mail siman@hbdre.ch Put your own callsign in the About Me: Callsign field.
HomePage www hb3dry.ch

Chis EPC 1114

Locator
Your focater, this e used in the Worki Map,

distance and bearing cakuiations l
T Matros Tags [Modes
< | I | »
hrd://tags_window/
Ready CPU: 4% | | Audio: 2% | | Overload | % HRD Logbook: My Logbook |RSID| OVR CAP NUM SCRL 02:33
L = =

1 Click where is says Click here. This will open the Programs Options
window.

2 In the first dialog line your callsign should auto-populate with the callsign
listed in License Manager.

3 Enter you name in the line below labeled Name. We will come back and
enter more information later in this chapter.

[]

Callsign NOZRD

Gordy
Age
Locator
QTH
E-Mail
HomeFage
Clubs

= My Equipment
Radio

Antanna

4 In the Programs Options window, select Soundcard in the first window on
the left side.

5 Verify that correct sound card is selected. If it is not... well you know what
to do. We will save calibration for a bit later.

6 Close the Program Options dialog window.

- Digital Master 780 - [BPSK-31]

File Edit Wiew QSO Browser Logbook SSTV

P & 2 it E
HF

QSO SuperSweepe youndcard | Waterfall

On the Toolbar click on Radio if it is not open.

8 Click on the Configure button in the Radio tool bar. This will open the
Radio Configure dialog window.
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Connections

Ham Radio Deluxe

pieapunog | 000Z'S1

Getting Started

|~

tMode: LSB

||~  RxFiter |

|~ QuickMem:Chs ||~ Split Simplex |

|~

Yarous

l

9 The Configure Radio window is where you layout your display. This is
similar to what you can do in Ham Radio Deluxe Rig Control. If you do not
see any radio functions, click on the Connect button.

[#] Automatically connect

[ Connect |
- Made |[[~  FxFiter
> OuickMem ||~ Split
= Various |[=
e
el ] ]
T—r—r—
T——— —
iﬂ Save I [@,‘I Help ]

Connect to HRD User Interface

Ham Radio Deluxe:

1

The connection uses TCP/IP - you must have TCP/IP
started.

Make sure Ham Radio Deluxe (HRD) is started and
connected to a radio (you must use build 1317 or later).

In HRD select IP Server from the Tools menu, make sure
the IP Server is started (DM780 will connect to the IP
Server).

Configure Radio Pane:

1

Address - the address or name of the computer where the

HRD User Interface is running, localhost (or 127.0.0.1)
can usually be used to connect to the local computer, the
actual network address is shown in the IP Server window.

Do NOT enter the address of the HRD Remote Server,
always use the HRD User Interface address. Even if
HRD is connected to a remote radio, you always connect
to the HRD User Interface.

Port - the default port is 7809, use the same port
selected in the IP Server window.

Always connect to HRD - if checked an attempt is made
to connect to HRD when the program starts even if not
connected when the previous session ended. By default a
connection attempt is only made if previously connected.

Press Connect.

FTT - Select 'Program Options' fram the "Tools' menu

2]

10 You can close the Configure Radio window.

Before you really use the DM-780 program you must make some connections to
your rig for CAT control and audio input/output.

CAT Control
CAT control provides software control of your rigs receive and transmit features
via a cable connected from the rig to either a serial port or USB port on your com-

puter.
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Some rigs, like the Kenwood TS-2000 only need a serial cable connection
between the rig and the computer for rig control. Others require a CAT interface
product of which there are several good ones on the market. Keep reading and we
will discuss some of them. Some do rig control only while others interface rig
control and audio.

Audio Input /Output

You also need an audio interface to send and receive the data (Audio tones) to and
from your rig and this is done by connecting your rigs audio output and input to
your computers sound card.

DM-780 requires the use of a sound card some type of interface from the sound
card to the radio. Although the computers built-in sound card can be used it is rec-
ommended you either install a second sound card. The second sound card can be
either internal or external. The advantage of having the second sound card it can
be used for your digital communications while eliminating the possibility of trans-
mitting unwanted computer sounds. You would also be able to listen to music on
your computer while still operating in the digital modes.

Next we need to interface the sound card to the radio. Interfacing can be done in
so many ways that it would take days to plow through all the available informa-
tion. You can do a Google search and find hundreds of articles on the subject. It is
possible to connect your radio directly to your sound card without any form of
isolation but it is not recommended. We’ll assume that you want to do things
properly, so here is a home brew circuit that has proved its worth many times.

DIY Solution Audio Interface with Tx/Rx Control

This solution will work with any Icom or Yaesu rig that has a 6-pin mini-DIN con-
nector for external audio. It will work on just about any other rig but you will have
to modify the connections to your radio. If you plan to use the circuit below,
please check the actual connections to the mini-DIN connection of your rig.

Note: HRD Software LLC does not accept responsibility for damage to
your rig should things go wrong.

Ham Radio Deluxe
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10yF 'r%nmlum
'3.5 mm Sterso plug
TIP Sound Card "LINE OUT"
s
— U PC GmundU

P2 35mm Stereaplug Shiald Radm Ground/Shield
"RING" Mot used

Rl OPTOCOUPLER

If"DTR" fine & to be
@ the PTT driver. then LED1 ko 425
@usepin4 Lt R1 Ng: PTT @@@ i)
&) (S = i = alE]
g (DTR) (DTR optional)
MH:L D3 Sodket
P3 il Iy P C Ground + Rear P anel Wian
PC Ground = Radio Ground & pin Mini DIN
3.5 mm Stereo plug
TIP Sound Card "LINE IMN® ;
A A R Audio
= . 8] §]
L P1 Shield PC Ground ==
RING" Not ussdl L =PC ground

Transformers are 1:1 600 Ohm

Fadio Ground Shield
available from Radio Shack

A proven audio interface: Cheap and easy to build

You should always use the rig’s high-impedance audio output if there is one avail-
able: this supplies a constant signal level to the sound card. Most rigs also have a
TX audio connector independent to the microphone input: you are advised to use
this input. Some commercial interfaces don’t allow this: It is recommended that
you avoid any interface requiring use of the microphone connector and speaker
output of your radio unless there is no other option for getting the audio signals to
and from the radio.

Commercial Interface Solutions

There are also some very nice commercial solutions available for interfacing the
radio’s audio to the computer.

Timewave Technology has a very good reasonably priced CAT rig control product
called the HamLink USB which allows rig control. As with all CAT rig control
interfaces, the level of rig control is controlled by the capabilities of the rig.

Timewave also offers the PK232SC - which has a built in sound card and CAT rig
control. This unit has many other useful features such as Digital Signal Processing
which helps clean up the audio signal. More information can be found at their
website: http://www.timewave.com

Tigertronics provides two different interfaces. One has a built-in sound card and
one does not. The advantage of having an interface with a built-in sound card is it
frees up the computer’s internal sound card for computer audio, such as listening
to CDs, while using the external sound card for the digital modes.

il SE:‘._{H.‘.’ILHIJ{ Model SL-1+

SignaLink Model SL-1+

Ham Radio Deluxe 163
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The SL-1+ connects to your computer's sound card and to your radio's Mic, Data
or Accessory Port. It is designed to work with ALL computer sound cards, and
with ALL radios. The SignaLink SL-1+ is compact, low powered and fully iso-
lated for optimum performance. It supports ALL sound card Digital and Voice
modes, and does NOT use a serial or USB port!

-

®  SignalLink™ usB

SignaLink USB

Note: Neither SignalLink product interfaces with the radio for CAT control.

The SignaLinkTM USB combines the legendary performance of their SignaLink SL-
1+ with a state of the art “built-in” low-noise sound card. The SignaLink USB has
only one USB connection to the computer, and in most cases, only one connection
to the radio. Convenient front panel controls make setup and operation very easy.
The SignaLink USB is fully isolated and is compatible with ALL radio Mic, Data,
and Accessory Ports, and supports virtually ALL sound card Digital and Voice
modes. Both of the above interfaces are available from on the Tigertronics web-
site at http://www.tigertronics.com

Another commercial solution to interfacing the radio’s audio to the computer is
the Navigator.

The Navigator

The Navigator interface is available on the web from U.S. Interface Products. The
website is at http.://www.navigator-interface.com/naviusa_004.htm The Navigator
is a high quality interface between the rig and the computer, for use in running the
digital modes such as PSK31, Olivia, MFSK, Hellschreiber, MT-63, etc. It also
works fine for SSTV.

The Navigator interfaces to the rig using a USB port, thus it does not require a
serial port on the computer. The Navigator has a built-in sound card for audio
from the radio to the computer. It also provides CAT control to the rig via a serial
connection from the Navigator to the rig. The Navigator is completely configured
and defined in software, and future updates are expected to be flash-ROM updates
that can be installed by the user.
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Ham Radio Deluxe

The Navigator is also directly supported by DM-780 by clicking on Program
Options and then selecting Navigator from the list of options on the left side of
the window.

iR RErEE N

—

micro KEYER I

Micro KEYER IT™ is the most powerful single radio All-In-One USB interface
and the only USB interface to fully support voice operation including microphone
switching. With an single USB port, micro KEYER II™ works with any Windows
based logging or control program for CW, voice, FSK and digital (RTTY, PSK31,
SSTV, OLIVIA, MFSK, WSIJT, etc.) operation. micro KEYER II™ includes a
radio control interface that supports all standards (RS-232, CI-V, Kenwood and
Yaesu TTL), a powerful CW memory keyer using K1EL's WinKey, a Digital
Voice Keyer, two channel audio for transceivers with dual receivers, automatic
microphone selection, and a buffer/sequencer for amplifier or LNA control. micro
Keyer Il is available from the MicroHam website at Attp://www.microham.com.

West Mountain Radio offers several RIGblaster products with various features.

Visit their website at Attp.://www.westmountainradio.com for more information.
Note: Because West Mountain Radio control the radio in a slightly different
manner we had to add special support for these interfaces. Please visit
the Options in Ham Radio Deluxe and select the COM Port TX tab then
click the West Mountain - RIGblaster support box (See image below)
& Options )
COMPort TX - OutOfBand | Mouse Wheel Selection Window | Theme Updates | Yaesu | i
RTS/DTR/Both/N e
‘O éalibrgtignj S Accelerators I Comms COM Port TX ] ICOM Calibration ] Internet ]
S-Meter |
Internet COM Port TX Configuration ‘
Enable
O"I'Etoﬁa"d Some early radios do not support switching TX/RX via CAT commands, so the only option is to
Innt?ame:l use a pin onthe CAT control COM port (this requires a special CAT cable).
Out of band _
Mouse Wheel Radios COM Port Pin
CW Fine S
CW Hot IC-706MKIG @ None
Other Fine IC-725
Other Hot IC-735 " RTS
Selection Window = IC-736 ~ DTR
Advanced values IC-738
| Tree expand IC-751A ¢ DTR+RTS
Theme IC-756
Main Tabs IC-765
Appearance 3
Color :g_;g?DSP West Mountain Radio: RIGblaster
Layout IC-821H
Position TT-OMNIVI [ Always use RTS instead of sending
Menus, Toolbars | CAT commands
Theme ¥
Updates
Reminder ¥

Other companies who provide audio interfacing solutions that work well are:
» ZLP Electronics: http://www.g4zlp.co.uk
» Rig Expert: http.//www.rigexpert.com/index?s=standard

If you choose to use one of the commercial audio interfaces, make certain you fol-
low the manufacturer’s instructions carefully for installation and set up.
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Program Options Overview

™ Digital Master 780 - [BPSK-31]

File Edit View QSO Browser Logbook SSTV SuperSweeper World Map Tools Window Help

2 & = 2 B = e | o &
QSO SuperSweeper | Radio Soundcard Waterfall = Rig Control Logbook Rotator ||Program Options -

" BPSK-31 X [

Clicking on the Program Options icon brings up the menu where you can config-
ure the appearance and many options found in DM-780. Below is a brief descrip-
tion of each option.

Program Options |
Appearance Theme
Callsign (My Infa) Visual Style Color Scheme
Clock
Logbook () office 2000 () office 2007 () Blue
Modes + IDs () Office XP () Office 2007 Ribbon () Olive
PTT () Office 2003 () Visual Studio 2008 () Metallic
| Radio () Native XP () Visual Studio 6 (@) Default
|| @so (@ Windows XP () Visual Studio 2010
Soundcard -
Sounds =S
Storage Appearance: IPmpeny Page 2003 V‘ [¥]Bold selected
SuperSiesper Color style: |Native XP vJ [ system colors
Waterfall
Layout ISize To Fit hd ‘ ["] oneNote colors
Alarms... Position: |Tcp VJ [ static frame
Favarites... Clientframe INone V‘ []showicons
Macros...
Maodes... Splitter Style Splitter Gripper
Navigator... ()Flat  ()Sof3D (@ Gradient @ oficeXP () None
= i Vertical :
z 3D ) Gradient (@) Office 2003
Audio Recorder.., - - =
PSK Reporter... R
oain anes
Soundcard Calibration... d
Time Synchronisation... || Transparentfioating pane windows (Browser, Logbook, Waterfall ) Defaults
L2l Getting Started ‘

Program Options Menu

Appearance: Select the theme and skins used for the main display

Callsign (My Info): Enter information about your station used in macro tags and
the My Station screens.

Clock: Configure appearance and time format of the tool bar clock
Logbook: Configures and connects DM-780 to Ham Radio Deluxe Logbook.
Modes + IDs: Configure CW and RTTY Ports and setup RSID and Video ID
PTT: Configure transmit Push To Talk options

Radio: Configure appearance of the radio pane

QSO: Configure appearance of the receive and transmit panes

Soundcard: Configuration of the soundcard used by DM-780
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Sounds: Enable warning sounds used by DM-780

Storage: Configure program and storage directories for DM-780
SuperSweeper: Configure DM-780’s panoramic frequency monitor screen
Waterfall: Configure DM-780’s waterfall appearance and options
Alarms: Set and maintain alarms

Favorites: Set up and maintain frequency/mode listings

Macros: Access to the Macro Manager

Modes: Create Modes tool bar on the waterfall display

Navigator: Configuration for U.S. Interface Navigator

Audio Recorder: Configure Ham Radio Deluxe audio recorder utility
PSK Reporter: Configure PSK Propagation Reporter

Soundcard Calibration: Calibrates soundcard for use in SSTV

Time Synchronization: Adjust computer’s time to national time standards
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Configuring DM-780

You should now have your audio connection made between the radio and the com-
puter so it’s time to start configuring DM-780.

Now, let’s get started. DM-780 can be run as a standalone program, however, to
take advantage of the many integrated features from Rig Control and Logbook, we
recommend running the entire Ham Radio Deluxe suite.

Your 1 Select Program Options from the Toolbar. This will bring up the Program
Information Options window used to configure DM-780.

2 Select Callsign (MyInfo) from the menu on the left side of the screen.

Program Options
_————————————————

Appearance QS0 Tags
Callsign (My Info) | .
Clock E-Mail o
Logbook HomePage
Modes + IDs Clubs
PTT = My Equipment
Radio Radio |
Qso Antenna

| Soundcard Power

| Sounds Computer

f Storage Interface
SuperSweeper Accessories

I Waterfall = Other

Temperature
AIarrrTs... Weather L
]
Modes.. Other2
Mavigator... Others
Otherd
Audio Recorder... = Computer
PSK Reporter... Mode
Soundcard Calibration... Program DM780v6.2.3.260 RC 1.1 6.2.3.26
Time Synchronisation... ProgramFull | Digital Master 780 v6.2.3.260 RCL—
Radio
Your radio - K3, TS-480, IC-703, ...
[ L7} Getting Started ]

QSO Tag and My Station Set up

3 Enter any additional information that you would like displayed. The center
portion of this option contains information about you and your station used
for substitution tags within DM-780 macro sets. We’ll discuss setting up the
macro sets later on in the documentation, but for now, just type in all
information under the QSO Tags section. Don’t worry about the lack of a
SAVE button on this screen, your data is automatically saved when you exit
this screen by clicking the red X in the upper right corner of the display.
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- My Station Identity to sync with:

Configuring DM-780

Mot
Do T

Edit My Station Directly ]

4 After you have entered the information in the QSO Tag portion, you will
notice on the right side there is a button Edit My Station Direct. Clicking

on this brings up the My Station data screen.

Information in the My Station screen is used by Ham Radio Deluxe Logbook.
If you have already set up the Logbook portion of the suite, this screen
should be populated with the required information and you can just close it

out and continue with the set up.

® My Station

=

These values are uzed in the Add/Madify Logbook window.

KB3NPH |' Guest_|
& = Reguired by DX Cluster for Connection in Logboak

B Callsigni: SIG:
| Cwner: SIG info:
_ Operator: % ncataor:
B Mame: iJ ;]
Street: | Latitude: 0.000000
B City: - Longitude: 0.000000
Courty: CQ zone: 0 [
State/Province: | . IOTA:
ZIP/Postal Code: Country:
eMail: Web Page:
License ’7 Club:
Equipment:
Antennas:
Power: Watts %

Copy Al

My Station Set Up

Ham Radio Deluxe allows you to set up multiple QTH locations. This allows you
to have a “Home” location as well as other locations such as a vacation home or

favorite portable locations.

Multiple Callsigns

If your License Manager shows more than one callsign
such as for parent and child or husband and wife, you
are able to enter station set up information for each call-
sign. You can also set up “Guest” accounts for club or
special event stations.

o

NOZRD | KDOHUV | Guest

[ Add Location ]

l Remove Location l
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If you haven’t already set up the My Station data, in the Description field you see
the word HOME for a profile of your Home QTH. This generates your main
“location”. Then go ahead and fill in all the rest of the information for this loca-
tion. Please note which fields are required if you use one of the DX Clusters.

Most of the fields are self-explanatory. A couple of the fields do need a little
explanation. The field SI/G stands for Special Interest Group. This could be a club
or any organization you belong to. The SIG Info field could be a website address
for a group. You could leave these fields blank if you like.

& Locator: EMN36QR
Latitude: 0000000 oo
Longitude: ~ 0.000000 0"0"0'E
CQ zone: 0 ITU: O

Another spot you might need help is once you enter your Locator, for example
EN36QR, if you hit the little arrow that points downward, that will automatically
fill in your Latitude and Longitude fields.

% Locator: EN36QR
[+
Latitude: 46.729167 467 43"55'N
Longitude: -92 625000 92°37"30'W
CQ zone: 0 ITU: 0

By the same token, if you know your Latitude / Longitude, enter them and hit the
upward pointing arrow to fill in your Locator.

If you operate from mobile or maybe have a vacation ==
. ® | My Station

home, you can generate My Station profiles for those

locations as well by clicking on the Add Location but-

ton. You can copy the data from the Home location to | NOZRD [KDOHUV | Guest|

be placed in an additional location then just edit any- Addlocaion D

thing that is to be different for that profile. Each profile |

is auto-saved when you exit the screen by clicking the

red X in the upper right corner.

Remove Location |

Once you’ve completed configuring your 7ags and My Station, your almost home.
Just a couple more things before you can go on the air live with DM-780.

Now that we have our sound card interfaced to the radio and our personal infor-
mation set up its time to start configuring DM-780 to receive some signals.

The first thing we need to do is tell our software where the sound card for our dig-
ital operation is located.

1 Click on Program Options, on the toolbar:
2 Select the soundcard option.
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Program Options
Appearance Soundcard |
Callsign (My Info) )
Clock Input {Receive)
Logbook Device: [Mc!-o;ﬂa_m-_}e{-lw USB Audio CODEC ']
Modes + IDs s ) (High Definition Audio Device
PTT PUEES Line 1 (Virtual Audio Cablei

’ licrophone (4- USB Audio CODEC
Radio
Q50 Dutput (Transmit) ] Use input device
|_Soundcard | Device: | Speakers'®- USB Audio CODEC ) -|
Sounds
Storage Source: E]
SuperSweeper
Wabertall Output (Transmit)
Alarms... @ 0dB & 25dB ) 5dB @ 10dB &) 15dB ) 20dB
Fawvorites...
Macis.., [¥] Show sample rate in main status bar
Modes...
Mavigator...
[ Show Supported Formats ]
Audio Recorder... l Seoundcard Calibration ]
PSK Reporter...
Socundcard Calibration... For recording and playback of wave files see: Recording
Time Synchronisation...
[ L7 Getting Started ]

3 Locate the Input (Receive) device at the top of the options. There is a drop-
down box where you select the input device on the sound card that receives
the audio from the radio. In this illustration we are using the Microphone
input from our USB external sound card.

4 For the Output (Transmit) device, another drop-down box where you
select to send the audio from the sound card to the radio. In this case, the
Speakers of our external sound card is selected.

5 Everything else should be left at DEFAULT for your system at this time.
Just click the “X” in the upper right corner to exit the Program Options and
your settings will be saved automatically.

You should now be back to the Getting Started Screen in DM-780. To clear this window,
let’s click on the “X” on the tab just to the right of where it says “Getting Started”. This

08, 1a1sen enbiq

tab is located just below the QSO and the SuperSweeper icons on the menu bar. Your
screen should now look like the picture below.
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[E= gt Master 750
i File Edit View QSO Browser Logbook SSTV SuperSweeper WorldMap Tools Window Help

o & L i) = i - H
: Q50 SuperSweeper | Radio Soundcard Waterfall | Rig Control Logbaok Retator | Program Options 5 & Full Screen

5814

Version 600119
Preview/Beta 2.2

Copyright © 2005 - 2012 by HRD Softveare, LLC

Ready CPU: 1% ) IAudm‘ 5%y | Soundcard RX: 8000.08Hz | Overload | % HRD Logbook: My Logbook | RSID

DM-780 Tour

Now that we have the bawsic setup completed for DM-780 it is time to take a tour of the
program. You will find this program to be both confusing and easy at the same time. That
is what happens when you have a powerful application available to use.

DM-780 Toolbar QSO Window

172

Click on the QSO icon, located on the left end of the toolbar. This is going to open DM-
780s main display window.

"™ Digital Master 780 -

File Edit View QSO Browser Logbook SSTV SuperSweeper World Map Tools Window Help -8 X%

RS Rt B e Sl 2 | ziaz
QSO SuperSweeper Radio Soundcard Waterfall | Rig Control Logbook Rotator | Program Options - : Full Screen =
S CW % - X

W HR @8- mE [ o 25 [~

=
gl e + 5 | Filter: (= + 50Hz | WPM: 180 | ,/Signal 5§ 9->N ZfOptions
L |12:02:59 PM> Main
(=]
m
E
=

=

D

o

S

@

o
fr=t

@

b Send (F1) M Auto (F2) ala- »| &
CallCQ Reply Info Closing [ Default~
Enter text to be sent 1500 Hz IMD: S/N:0dB

Ready CPU: 9% i | Audio: 0% | | Overload | HRD Logbook: My Logbock [RSID| OVR CAP NUM SCRL 12:11

The CW Mode screen above is divided into several sections. The larger white section is
the receive panel, the smaller white section is the transmit panel.

On the left side of the screen are several tabs. The top one is for the ALE (4dd Log Entry)
panel. The next one is for Macros. Both of these will be discussed in detail later in this
section. The bottom tab opens the 7ag window which you have already seen.
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The receive panel and transmit panel are self-explanatory. The receive panel is where
incoming text is displayed. The transmit panel is where text is prepared for transmission.
The ALE (Add Log Entry) section is just that. This is where data about your contact is
placed to be added to the logbook after your QSO is over. Information in the ALE can be

entered manually from the keyboard or automatically from one of the Call Sign look-up
services configured in HRD’s logbook module.

Changing Operating Mode

08/ JaiseN renbiq

To change this window to a different 2 & B ° o
operating mode click on the mode selecttabin |° QSO SuperSweeper | Radio Soundcard Waterfall
the top left corner of the QSO window, There oW %
you will see over a dozen different digital E:CW.) TEETYEE
operating modes displayed. Each of these = ow 'L® 5 | Filter ©
modes is further sub-divided into variants of E ] RTTY v g
the digital mode. Note our example of PSK ml [ Psk v eeskar |
offers three variants of PSK for you to choose E’ QPSK v BPkR-63
from. We have selected to most popular PSK [ CONTESTIA » BPSK-125
operating mode. DominoEx  »
=
. . 2 Hell 8
After you have made your selection you will g VEsk R
notice that there has been some subtle changes % MT63 ,
in the QSO window for operating in PSK. & OLIVIA ,
File Edit View QSO Browser Logbook SSTV SuperSweeper World Map Tools Window Help -8 X
2 = ® m i 3 @ £ = \97-
QSO Superg;ieeper Radio Soundcard Waterfall = Rig Control Logbook Rotator | Program Options - : Full Screen 12:27:36 -
~~ BPSK-31 X vxl
BPSK-31- A A2 &- (- & ([T M Z II'
Z||12:26:57 pa> Main
T
El
g
Fl
. b Send (F1) M Auto (F2) a8 »| &
CallCQ Reply Info Closing | ZfDefault-
|
Enter text to be sent 1500 Hz IMD: -27dB S/N: 23dB
Ready CPU: 9% | Audio: 0% | | Overload | HRD Logbook: My Logbook OVR CAP NUM SCRL 1227
Some things, however, have not changed as they are common to all of the operating
modes.
Next. to the mode selection tab is a series of " BPSK.31 x
tool icons. In order from the left:
\| BPSK-31- | & | @ & - | &
Save Received Text - This allows you to
save all your received text to a file in Rich Text Format in a location of your choice.
a Viewer - Opens a viewer so you can view your saved received text.
2 [Erase - Clear the receive screen.
é Alarms - Manage and select user defined alarms. Help you spot desired stations.
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. Channels - Select to receive one, two or three channels at one time. Allows you to
keep tabs on up to three different conversations at one time. You can only transmit
on the Main channel which is the top most or left most depending upon your display
choice.

4 Options - This is another way to access Program Options that you have access
through the toolbar.

Waterfall

There is one important panel missing from our display. There has to be a way to tune in
the digital signals on a frequency. That’s the job of the Waterfall.

Digital Master 780 - [BPSK-3:

File Edit View QSO Browser Logbook SSTV SuperSweeper World Map Tools Window Help

% & i o m % Q &
QSO SuperSweeper | Radio Soundcard |Waterfall || Rig Control Logbook Rotator | Program Options

On the tool bar click the Waterfall icon.

™ Digital Master 780 - [BPSK-31] EI@

File Edit View QSO Browser Logbook S5TV  SuperSweeper World Map  Tools Window Help -8 X

2 & 2 i = %2 @ & = 22:38:04
Q50 SuperSweeper | Radic Soundcard | Waterfall | Rig Control Logbook Rotator | Program Options 2 ¢ Full Screen - - =
< BPSK-31 X%

- X
Bpsk-31- | [l A | 7 2 - |- i ([T » M 2 “AFC
=
% PA, FN1@wx [101.8° 910.2mi] FN1@wx [101.8° 910.2mi]. Name is Dick Dick. How is the copy trthere? *
2 Kao
-E WB3AVF EN
& XP4Fe
= eh taf !'o p f XB4ielp =
da?aatig eF
K4BEZ K4BEZ DE WEB3AVF. RR Ben thank you for the report. YoTu arec comin il
=
) b Send (F4) M Auto (F2) 3 | G- »|
-
P CallCQ Reply Info Closing | 50 Default -
m
3l
=]
Enter text to be sent 1808 Hz IMD: -16dB S/N: 24dB
Waterfall > 3 X
Zoom: xl Main: 4 <« 1808 » B | Signak = [ 4% AFC | Decode | % Options

80m 40m 30m[20m[15m 10m 6m | « » | @ Faves © JIModes

Soundcard Menito

Ready CPU:18% g Audio: 25% g Soundcard RX: 7326.22Hz | Overload | “% HRD Logbook: My Logbook [RSID| OVR  CAP NUM

The waterfall is a requirement for working PSK and this version is loaded with
features to make your digital contacts jump. Full operational details can be found
later in this section.
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SuperSweeper
™ Digital Master 780 - [SuperSweeper] EI[
File i (50  Browser Logbook S5TV  SuperSweeper World Map  Tools  Window  Help
2 / ? i 2@ =y = 22:43:1
Qs0 Radic Socundcard Waterfall | Rig Control Logbook Rotater | Program Options < @ Full Screen -

uperSweeper X

BPSK-31 - | bRestart 4% Redraw | o) History &2 Q50 - | JL Alarms |- | 0 Options 80m 40m 30m 20m 15m 10m 6m | « »

:rouble typing! 73 and take care of yourself Ben. K4BEZ DE WB3AVF SK ned

1in tnx fer QS50 Jooe, 73, God bless. 5/12/2914 22: Z KP4FBM de NSDFD =

JAN-EARN WY : 1nc Cp CQ DX de KB4LAG KB4LAG CDX CQR DX de KB4LAG KB4LAG H

DERCRYEEY WSWV =k t2/ 14 22:4act WoMD sk QRZ QRZ QRZ de WEWV WEWV WEWV

Active: 5/20 Hold: 20 secs  Rewind: 10 secs Decoder: 0% Overloa
Ready | CPU: 14% ) Audio: 24% gg Soundcard RX: 7336.50Hz = Overload | % HRD Logbook: My Logbook [RSID| OVR  CAP MU

SuperSweeper is a great tool to see what is happening on the bands. This high powered
tool allows you to set alarms to alert you of stations that you want to locate. The blue

signal is caused by an alarm for stations calling CQ. The setting up and use of
SuperSweeper is discussed later in the section.
Radio Panel
Thee next operational feature found on the toolbar is Radio. This allows control of your
radio without switching back to Rig Control.
™ Digital Master 780 - [BPSK-31] =
File Edit View QSO Browser Logbook S5TV  SuperSweeper World Map  Tools Window Help
2 & ? i 2@ =y = 23:03
Q50 SuperSweeper || Radio | Soundcard Waterfall | Rig Control Logbook Rotator | Program Options 2 ¢ Full Screen -
T5-2000 < 23 BPSK-31 X | SuperSweeper
b« » | 4B PR BPsk-31- | [ & | @ & - |- i i [* N 2
= -
1 4.070.050 8- C CQ DE WESAVF WB3AVF
@ CQ CnW DE WB3AVF WE3Re F =
i CQ CQ CQ DE WB3 e yB3AVFE
ENTTE @ o cq:
= i ee®, LeecEGit 1 =
[v Mode:lse  |[w  FtFite | in v icms o
|v Quick tem: O ||v Offzet; Simplex | - B tn etICN I;THERE? QRZ PSE DE hoe3i i
- arious E tt d t
. 8 oW
TH m
5- | Send (F4) M Aute (F2) 3| @ »| |
RF power: 27 ' X
D CallCQ  Reply Info Closing | 20 Default~
RF gain: 65 » |
U
Enter text to be sent 731 Hz IMD: -23d
Ready | CPU: 20% pm Audio: 20% Soundcard RX: 737347Hz  Overload | “% HRD Loghook: My Legbook [RSID| OVR  CAP

You can see that you have some controls displayed when you open up the window. There
are built in features.
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There are several items in the radio panel toolbar that make
operation easier. The << and >> icons shift your frequency
up or down in 500 Hz increments.

T5-2000 > B x

The next group of icons allow to tune to preselected favorite
frequencies either by selecting the frequency from the drop
down list or by using the two arrow icons to scroll through the list. You can managed the
contents of this list by selecting Manager from the drop down list.

T5-2000

lz‘« »

3.577.000 MHz
3.582.500 MHz | _
7.038.500 MHz |~
7.072.500 MHz
10.133.000 MHz

w»  tode USE | 14.075.000 MHz
14.077.000 MHz

> Cuick Mem: Off 14,106,000 MHz
: 14.108.000 MHz

¥ Maious  [15102.000 MHz
21.086.500 MHz

28,076,000 MHz

Radio Panel Config

The last icon in the Radio panel is the config button. This ot v x
allows you to cofigure buttons, drop downs and sliders that  [» ] « » | ¢ iz~ b

are very similar to those you set up in Rig Control. If the

item does not have a label, no function is assigned and it 7. 07k0 .000
does not display.

To assign a function to one of the buttons, click on a button to select it and you will see a
Select Button window where you can make your assignment. Do the same for the drop
downs and sliders. When you are done click on the Save button.

The remainder of the icon buttons in the toolbar should be familiar to you by now.

Main Window Tour
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We now return back to our main display.

Now, let’s review selecting a mode. The most popular of the digital modes is BPSK-31
and the most used frequency for this mode is 14.070 in the 20 meter band. At this time,
tune your radio to 14.070 and set it to upper sideband, since ALL digital modes are used
in upper sideband, with maybe one exception and that’s QPSK which can be used in USB
or LSB. You might also want to tune your antenna for lowest SWR on this frequency
before we go any farther.

Next, in the upper left corner of the large receive panel, you will

see a small tab with a drop-down arrow. Clicking on this brings up w'—@ A
the Modes menu. Highlight PSK and another menu will show up | ZT:KSK :
with BPSK-31, BPSK-63 and BPSK-125. Click on the BPSK-31 LT

mode to select. cw , all

Looking at the main display, you will also notice that the tab just :z;ﬂmm : ;ti;
above the ALE also reflects the current mode being used. MFSK .
We have selected the mode so now take a close look at the MT63 ’
Waterfall. oLVIA v

RTTY 2 &

} g —
Throb »
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Waterfall

100

Ready

Transmit Panel

Ham Radio Deluxe

| Main: 4 « 1444 » b | Signak = - 4% | AFC | Decode | #f0Options }  14.070.000 $160m 80m 40m 30m [20m|17m 15m 12m 10m 6m | % » | G Faves } JJModes

oo 500 6o 1 1100 1200 1, 161 1700 1800 1900 2000 2100 2zoo 2300 2400 2500 2600 2700

| cPu:13%|; | Audic: 20% gy Soundcard RX: 800003Hz | Overlozd | S HRD Logbook: My Logbook|RSID OVR €2

The Waterfall actually has three sections. The top gray section is the Waterfall tool bar.
The black area contains audio frequencies calibrated in HZ, and the blue area is the actual
Waterfall. The reason for the name is the light colored signal traces flow from the top to
the bottom of the display just like a waterfall. The traces are actually signals from
different stations.

PSK Bandwith

The bandwidth of a BPSK-31 signal is 31.25 Hz. Our waterfall is
about 3000 Hz wide. Since BPSK has such a narrow bandwidth,
the use of audio off-set frequencies can be used to display many
BPSK signals on the waterfall at one time. Notice how each signal
is displayed under a different audio frequency on the waterfall. In
the picture on the left you see what our cursor looks like on the
waterfall. The yellow bar is about 31.25 Hz wide. There is an :
arrow at the top of the cursor and two lines extending downward | 4ig. 772
from the cursor. Placing he cursor on a BPSK-31 signal with the

arrow in the center of the signal and the trailing lines on either side of the signal tunes in
the base frequency of 14.070 + the audio frequency off-set to allow you to decode that
signal in the Receive panel.

1500 1600 1700

Go ahead and try a few on your own. It takes a little practice to position the cursor
properly.

Display Check

At this point if you are not showing any traces on your waterfall or are unable to decode
the traces, go back and recheck your sound card settings, cables, and if using a
commercial audio interface, read the manufacturer’s installation instructions over again
to make sure everything is set correctly.

Once you are receiving and decoding signals its time to try to transmit using DM-780 and
BPSK-31.

The Transmit panel is where you prepare text to be transmitted. This text can either be
entered manually thru the keyboard or by using one of the pre-defined macros. For this
test we will be entering the text manually.

In the waterfall, place your cursor somewhere near the center of the waterfall on an area
where you don’t see any signals. Wait a short time to make sure the frequency is clear and
then proceed.

Before we continue with the transmit test it is recommended you install a dummy load, if
you have one. If you don’t have a dummy load it’s best then to decrease your RF output to
it’s lowest possible setting which will give you some deflection of your power meter to
indicate you are indeed transmitting.

Place your cursor inside the lower Transmit panel of the main display. Now, type in the
following:

CQ CQ CQ DE (your callsign 3 times with a space between each) followed by PSE K
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The transmit panel should look something like this:
i

: b Send (F4) Bl Auto (F2) [l Pause (F3) [0 Stop (F5) dbBreak-in| 32 7 = B | - 4 Repe:
@cqxz | k2 CQ | k7 QRZ | b2 Him de Me | @aHlmdeMe K | @?RST Mame, QTH | @Statmn | §
CQ CR CQ DE KIXXX KIXXX KIXXX PSE K |

Enter text to be sent

Text in Transmit panel for sending

Transmitting

Pressing the Send or the F4 key will transmit the string you just typed in the Transmit
panel. Your transmitter should now key and the text transmitted. As the text transmits it
will show in the Receive panel and a strike-through will move through the text in the
Transmit panel. Immediately after sending the text, press the Stop or the F5 key to un-key
your transmitter.

=
J

19:52:56> Main
CQCQCQDE Ki XXX Ki XXX Ki XXX PSEK

Send (F4) Bl Auto (F2)} [l Pause (F3) [ Stop (F5) - Break-in | ¥2 Y2 P o ) | T3~ 4% Repeat [#] RSID
@?CQ:(Z | Pz CQ | b7 QRZ | P2 Him de Me | @H.m de Me - K | Bl RST, Name, QTH | e Station | @«Log Stat

L. All text sent, press Escape to stop

Text send from the Transmit Panel

If your transmitter keyed and you have seen deflection on your power meter, you’re in
business. If the transmitter keyed and you see no deflection of the power meter, first, go
back through the audio set up and make sure you have selected the proper Output
(Transmit) device in the Program Options sound card settings. If everything is correct
there, try increasing the RF power just a bit and maybe even increasing the audio volume
on the sound card you’re using. If you’re using one of the commercial external interface
devices, check the installation instructions to make sure you have everything set correctly
for the unit you’re using.

If all else fails, first contact the manufacturer or distributer for the sound card device your
using. If all seems fine there contact HRD support through one of the methods listed on
the support page at www. hrdsoftwarellc.com

Transmit Now we will take a closer look at the tools available on the Transmit Toolbar.
Toolbar

! [ Send (F4) Bl Auto (F2) ||l Pause (F3} [ Stop (F5) 4bBreak-in | %2 /7 [ "”_,"I.n;ai' 4+ Repeat [ RSID + [ VideoID » | %! 5

Transmit Tool Bar

Clicking on the Send button OR pressing the F4 key starts transmitting data currently in
the Transmit panel.
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The Auto button or F2 on your keyboard will start transmitting data currently in the
Transmit panel and will automatically stop and return to receive mode when all text is
sent.

The next two options are normally grayed out when in the receive mode. They are the
Pause (F3) and Stop (F5) buttons. The Pause button allows you to pause transmitted text
at any point while it is send. This allows you to edit the text following the pause, such as
inserting a comment or deleting part of it, then clicking the Pause again resumes
transmission where it left off to the end of the text.

The Stop (F5) immediately stops the transmission and returns the rig to the receive mode.

The Break-In is a toggle and turns the Break-In mode ON or OFF. With this mode toggled
on, text that is typed into the transmit panel is sent immediately, however, if you pause
typing while this mode is turned on, the transmitter switches back to receive. Once you
start typing again, the transmitter keys and you continue from where you stopped. This
allows you to listen briefly to see if your contact is trying to Break-In on your
transmission, just like is done during CW operation when a sender pauses briefly to see if
his contact is trying to break in.

| 2 As text is being sent, an overstrike line moves thru the text in the Transmit panel.

If you Pause the transmission at any point, when you Un-pause it, the transmission
continues where you left off. Pressing this icon removes the overstrike line from the sent
portion of the text making it appear to be un-sent. When you resume, the transmission
begins again from the beginning of the text in the window.

. The Eraser icon does just that. Pressing this icon erases all text in the Transmit
L5 Panel.

. DM-780 can send the contents of text files. Clicking on this icon allows you to
e navigate to a folder where you have text files stored. Once in the folder you can
select a text file which will automatically be opened in the Transmit Panel where
you can then transmit the contents of the file.

# Clicking on this icon allows you split frequency operation in the current passband.
= To do this, first select the frequency or audio frequency where you want to transmit.
Place your main cursor on that frequency and press the lock icon. An indicator will
appear with a TX inside a little box that shows the transmit frequency. This will be the
frequency where your contact will receive your transmissions.
— Now, move your cursor to the frequency you are receiving on. This will
E be your contacts Transmit frequency. When you transmit, DM-780 will
LR SECl automatically shift and transmit on the frequency indicated by the TX

marker on the Waterfall. In this case, the audio frequency is 1600 for
| transmit and 1700 for receive, a 100 Hz split.

To clear the split and go back to normal, just click that lock icon to release it.

This icon brings up a drop-down menu that allows you to turn off or set an
interval timer. This comes in handy when calling CQ. You can set a time interval
in this option to automatically send a CQ call for you at the specified time
interval. Once you set a time interval, you start sending your CQ macro. Once it starts
sending you will see the Repeat icon on the tool bar becomes active. Clicking on the
Repeat icon now sets DM-780 to transmit the CQ macro, wait the preset time interval,
and resend the macro again. This will continue until you click the Repeat icon to toggle
the repeat off.

G

— This is the icon to toggle your RSID on or off. For those not familiar with
+IRD - RSID, it stands for Reed-Solomon ID
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RSID was originally developed by Patrick Lindecker, FOCTE. The Reed-Solomon ID
(RSID) is a short 16-tone MFSK transmission which identifies the mode in use. The
RSID transmission is about 180Hz wide and lasts for just less than two seconds.

You should enable RSID when using an 'exotic' mode such as Olivia so that users of
programs with RSID support know what mode you are using. For a full list of modes
supported by this program look in the Program Options for Modes + IDs.

There are two ways to enable RSID: 1) In Program Options select Modes + Ids and check
the option to show the RSID button in the Transmit tool bar, 2)Add the tag <rsid> to the
beginning of a CQ macro. The latter is most recommended since it is rather annoying to
have the RSID popup coming up EVERY time a contact transmits during a QSO. By
including the tag in the CQ macro, the RSID information only displays when the CQ is
received.

#Video D - | When activated, the Video ID places text in the waterfall which can be
T seen by the sending and receiving stations. The Video ID is based on the
Hellschrieber digital mode.

Video ID

The Video |0 is sert at the beginning of each soundcard
transmission and is displayed in the waterfall display. The
format is based on Hellschreiber.

) Callsign HBE

1 Mode BP
95

@ Callsign + Mode DK
R3

@ Vertical Vi

) Horizontal

[¥] Show Video 1D button on QS0 transmit toolbar
See also: Q50 Transmit

The Video |D is enabled in macros and the TX toolbar.

Video ID Set Up Screen

The Video ID is set up in the Modes + IDs area in the Program Options display of DM-
780. Above you can see there are several items you can have sent in the Video ID.
Callsign, Mode, or both. When activated a display is seen on the Waterfall that looks
similar to the one shown above. It can be sent in a Vertical or a Horizontal display. This is
an eye-catcher for anyone sitting watching the waterfall.

| [5 This next icon toggles a mini-logbook display on the Transmit tool bar. Click once
L85 to turn it on and again to turn it off.

i b Send (F4) Bl Auto (F2) [l Pause (F3) [ Stop (F5) <[} Break-in | X2 7 [ & | (i~ 3 Repest [#RSID + [#]VideoID - Iﬁ'*

 Calk: Recw: 599 Send: 599 Narne: | = Add | 3 Reset

Mini-Log on Transmit Tool Bar

Last but not least, clicking on this icon activates the QSO Options panel from the
' Program Options menu.
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Receive Panel

We’ve gone through the options on the Waterfall and the Transmit toolbars, so now we’ll

Toolbar look at the Receive Panel Toolbar.
‘EBPSK-31'|H_};|(?Q' T Pl a | L
Receive Panel Tool Bar
: Clicking on this icon revels a drop-down menu where you can select the
P BPSK-31~| .
.~ digital mode you would like to operate.
N= Click on this icon to allow you to save to a file all the text in the current receive
L2 panel.
A | Opens a Viewer to allow you to go back and review all text in the receive panel.
| This icon erases all text in the receive panel.
a Clicking on this icon allows you to manage, select and activate alarms.
These icons move your cursor up and down the waterfall to the next active
signal.
3 | Rewind (replay) the last transmission on the current frequency selected on the
T Waterfall. g
= This icon has a drop-down menu that allows you to activate up to three receive  =-
panes (channels), along with associated channel markers for each channel on the Q)
Waterfall. This allows you to monitor and participate in three QSOs at the same
time, if you are one of those “Muli-taskers”..... QZJ
AR Activates the QSO Options panel in the Program Options Menu. 7))
= ~+
E— D
—
Waterfall ~
Toolbar (o)
o
!H:II-HII
Toom: ¥l B | Main: 4 4 1861 ¥ B | Signak. 5 & 4+ | AFC | Decode | _"?f"C}ptions 14.070.000

Ham Radio Deluxe

Looking at the Waterfall tool bar you will see buttons that control various things. On the
left end you will see ZOOM. To the right of word ZOOM you will see a left pointing
arrow, the number x1 followed by a right pointing arrow. This number controls the
magnification of the waterfall. Click on the x1 will increment it to X2 and the arrows on
each side will become active. Pressing on the left arrow will now shift the waterfall to the
left and pressing the right arrow will shift it to the right. The magnification can be
increased up to x4 by clicking on the number.

To the right of the word Main you will see a number. In the above picture the number is
1862. That is the audio frequency that your main cursor is currently sitting on. On the left
of this number you can see the left pointing solid red arrow. Clicking on this arrow moves
the main cursor down the waterfall in 10 Hz increments. Clicking on the left pointing
chevrons, between the arrow and the number, moves the cursor down the waterfall in
increments of 1 Hz. These can be used for fine tuning in on a waterfall signal. The arrow
and chevrons on the right side perform the same function except they move the cursor up
the waterfall.

The next control is Signal. The blue arrows to the right move the cursor up or down the
waterfall to the next signal detected.
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The Re-cycle symbol to the right of this plays back the last transmission received from a
trace on the waterfall.

AFC toggles the Automatic Frequency Control on or off.

The Decode button toggles a little receive pane on the waterfall that displays the text
being received from the signal your cursor is centered on.

The Option button brings up the Waterfall Options screen where visual changes can be
made to the Waterfall.

Next is the Frequency Tool bar. When activated from the Options it displays the
frequency the radio is tuned to. HRD Rig Control must be running for this option to work.

The rest of the tool bar explains itself. There is a list of
17m 15m 12m 10m bands. Clicking on a band button brings up a drop-down
list of frequencies available on the band which are used
by the mode you are in. If you change mode, the
available frequencies change. Check the frequency to
change the radio frequency.

Clicking on the Faves tool activates the Favorite
Frequency panel. This panel contains an editable listing of modes and frequencies
normally used by the modes in each band. Items with check marks in the Enabled column
are the ones contained in the band buttons we previously described.

The Modes icon activates a panel where you can add another tool bar to the waterfall.
This would be a Modes Tool bar, and could be displayed by individual mode buttons,
such as BPSK-31, Olivia, RTTY, CW SSB, etc. It could also be configured to just display
groups with drop-down pick menus for each mode. This is a choice for the operator. Use
the extra space for the waterfall or take part of the waterfall to display this tool bar.

%rogrﬂm Options
MAppearance Cenrter Marker, Cther iColor I Frequency, ﬁcESpeed ! Weak Signial |
Callsign (My Info)
Clack Center Frequency Marker Center Frequency Marker
Define up to three center frequenc

Logbook

9 [ Enable certer frequency marker normally set to the center of a nar
Modes + IDs ‘d[ladio connection required) When enabled a [C] but_ton isldisp\
PTT waterfall toolbar - pressing this but

! N e - I omperrgee = the radio DM780 channel frequenci
Radio 5 |1000 = @ |2000 : the DM780 channel is in the center
Qs0 T = narrow filter.

Soundcard @ |1500
Ol You must also define a Radio macr
Sounds : enable the narrow filter - or select
Storage Radio Macros from the radic pane in DM780 or fi
radio's front panel.
SuperSweeper T Sh S, @ B e Bening
| Waterfall ] =how acio control macres: (2] Butans e Radio Macros
1t i; normally conven_ient to display
i radl_o macro !Juttons in the waterfa
Alam'!s... SRS Typically radio macros are used to
Favorites... . narrow or wide filters.
Macros Erase when changing frequency
=l i Various
Mades.., (] Only update ff visible Jess CPL) Erase when changing frequenc
Navigator... [7] Show radio frequency toolbar the waterfall when the radio freque
changes.

: [ Show soundcard in window title Only update if visible - only upc
Audio Recorder... waterfall f visible - saves CPU cycl
PSK Reporter.., computers with less-powerfull grap
Soundcard Calibration Tuning Show radio frequency toolbar

: g current radio frequency in the watt
Time Synchrenisation... Guides: [F toolbar.
. Show soundcard in window titl
|| Mouse the name of the current scundcard
_ the waterfall title bar.
[ Tuning indicator
& Getting Started
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Configuration Tabs

Above is the Waterfall Configuration panel. There are 4 tabs on this panel and each
configure a different aspect of the waterfall. Below is a list of the options that are
configured from this tab.

Waterfall Options Center Frequency Marker

Define up to three center frequencies, normally set to the center of a narrow filter. When
enabled a [C] button is displayed in the waterfall tool bar.

R ; Here the Center Frequency Marker is activated and set to the center
. 14.07C of the filter. If you are decoding a trace to the left or right of this

marker, clicking on the [C] marker tunes the radio to bring the bring
e the signal to center on this marker, therefore placing the signal your
decoding in the center of the narrow filter.

oo 1590
1
:

d You must also define a Radio macro button to enable the narrow filter
gl - or sclect the filter from the radio pane in DM780 or from your
o radio's front panel.

Radio Macros

It is normally convenient to display special radio macro buttons in the waterfall tool bar.
Typically radio macros are used to enable narrow or wide filters.

Various
Erase when changing frequency - erase the waterfall when the radio frequency changes.

Only update if visible - only updates the waterfall f visible - saves CPU cycles on
computers with less powerful graphics cards.

Show radio frequency tool bar - shows the current radio frequency in the waterfall tool
bar.

Show sound card in window title - shows the name of the current sound card selection
in the waterfall title bar.

Tuning Guides

Tuning guides - channels - vertical bars displayed in the waterfall when help you
position the M, A and B channels over the received signal.

Tuning guides - mouse - vertical bars displayed at the current mouse position in the
waterfall, helps you correctly select a signal.

Tuning indicator - the traditional display which helps you tune a signal correctly.
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tProgram Options

Appearance
Callsign (My Infa)
Clock
Logbook
Modes + IDs
PTT

Radio

Qso
Soundcard
Sounds
Storage
SuperSweeper

| Center Marker, Other | Color _| Frequency, Mode, Speed | Weak Signal |

Waterfall

Alarms...
Favorites...
Macros..,
Modes...
Mavigator...

Audic Recorder...
P5K Reporter...

Soundcard Calibration...
Time Synchronisation...

[ @  Getting Started

)

Colors

~) Traditional
() Custom scheme
@ Select from list

Banana
Bizame
Blue
Blueband
Brown
Cyan 05
Cyan 10
Cyan 20
Grey
Jungle
Negative

m

w1

Wwaterfall settings do not affect decoding!

The waterfall display takes the audio from the soundcard and converts it to power (signal strength).
If you enable the Spectrum option you see the relative signal amplitude. Use the colour schemes to
highlight the signal peaks so that vou can find the signal traces.

Suggested schemes: Default and Scope 1

Custom Scheme

Add
| b
< Add
Selection
w

Waterfall Color Options
On this option panel the operator can adjust the color settings of the Waterfall to his own
preference. This is strictly a trial and error type adjustment. If you don’t like one color
setting, try another until you find something that you like and is easy on your eyes.

Waterfall color settings do not affect decoding!

The waterfall display takes the audio from the sound card and converts it to power (signal
strength). If you enable the Spectrum option you see the relative signal amplitude. Use the
color schemes to highlight the signal peaks so that you can find the signal traces.

Suggested Schemes
The best and most commonly used schemes are: Default and Scope 1
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tproglam Options
Appearance Center Marker, Other I Color | Frequency, Mode, Speed |T'\a';¥§ignal
Callsign (My Infa) i —— —
Clock ode assban pee
Logbook @ Waterfall > [ Spectum Grid Min: |100 = |Hz Faster = higher CPU usage
Modes + IDs 7 Spectrum
PTT Gk = = Max: (3000 = |Hz 1 3 4
Radio = B
Qso
Soundcard Waterfall Display Mode ({Does not affect decoding) Smoothing
y - Use clipping to shift the data so that
zounds (2) Roct - data is 4th root of linear FFT power =] baseline noise is at the bottom of the
torage ) Log - data is 10log{) of FFT power screen, thus giving a larger viewing
SuperSweeper s RN e s dynamic range.
Waterfall | @ Log (as above) wi % to 90% baseline clipping
A Clipping: 10% [} i |
e Defaults
Favorites...
Macros... Appearance
Modes..,
Mawigator... Baclground
Audio Recorder... & [#]Bold [ halic
P5K Reporter... -
H Ge -

Soundcard Calibration... e
Time Synchronisation...

Frequency

[ Show RF frequency fradio + audio, requires a radio connection)

[[] Add offset @) +

l @  Getting Started |

Frequency, Mode, Speed Tab
This top section allows you to select the Mode for the Waterfall. You can display the

Ham Radio Deluxe

standard Waterfall, display a Spectrum representation, or both. You can also adjust the
Passband width to your taste. You can also adjust the speed that the Waterfall moves. The

higher the speed the higher the CPU usage, so those with a slow CPU might want to

select a slow speed to avoid a possible jerky display or pauses during printing of received

or transmitted text.

The center portion of the above panel adjusts the Waterfall Display Mode only, and does
not affect decoding. This section adjusts for clipping of the signal. Use clipping to shift
the data so that baseline noise is at the bottom of the screen, thus giving a larger viewing

dynamic range.

The lower portion of the panel adjusts the appearance of the frequency bar of the
Waterfall. You can select the background and text color, and font for the numeric display.
You can also adjust it to show either the audio frequencies or show the RF frequency +

Audio. To do the later, requires a radio connection.
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Weak Signal Configuration

Program Options @
= et Do
Appearance | Center Marker, Other | Color E_Frequency. Mode, Spead | wear aignal |
Callsign (My Infa) :
Clock Options Waterfall settings do not affect decoding!
Logbook [¥] Enhance / Amplify frecommended)
Modes + [Ds 7] Advanced Enhance / Amplify
PTT = When enabled all signals are uniformly increased
: in strength =o that the strongest signal is at the
Radio Gain: 75% maximim strength, similar to your radio's AGC
Qs0 option.
Soundcard ) Advanced
Sounds When enabled automatic gain is applied to alf
signals by using an advanced digital amplifier
Storage Bandwidth: 1000Hz alggorithmy: 2 2 2
SuperSweeper
| Waterfall | ) This amplifier has both gain and bandwidth, the
=ignal iz amplified by the selected gain such that
Al the signal strength of the strongest signal inside
[T nees the bandwidth does not get clipped or cause
Favorites... visual overload.
Defaults
Macros.. " 5
Gain
Modes... The gain applied to the signal, range is 0 to
Mavigator... 100%. The effect of gain depends to a large
extent on the current Colour scheme (selected in
Audio Recorder... the Cololrsipdne].
P5K Reporter... Bandwidth
. . The bandwidth of the amplied applied to each
Seoundcard Calibration... : -
.oun A I_ I'E.IDI'1 signal, range is 100 to 1,000Hz.
Time Synchronisation...

Weak Signal Panel

This panel helps adjust and compensate for weak signals on the Waterfall.

Enhance / Amplify

When enabled all signals are uniformly increased in strength so that the strongest signal is
at the maximum strength, similar to your radio's AGC option.

Advanced
When enabled automatic gain is applied to all signals by using an advanced digital
amplifier algorithm.

This amplifier has both gain and bandwidth, the signal is amplified by the selected gain
such that the signal strength of the strongest signal inside the bandwidth does not get
clipped or cause visual overload.

Gain
The gain applied to the signal, range is 0 to 100%. The effect of gain depends to a large
extent on the current Color scheme (selected in the Colors page).

Bandwidth

The bandwidth of the amplification applied to each signal, range is 100 to 1,000Hz.
Now that we have DM-780 configured, can both transmit and receive digital modes, and
have gone through some of the various tool bar options, its time to start looking into the

more advanced features of the program. This includes the use of macros to create short-
cuts to use during your QSOs, logging QSOs, using SSTV and customizing your display.

Since you should be basically up and running at this point, HRD Software LLC would
like to welcome you to the fascinating world of Digital Communications.
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Main Display Configuration

B Digital Master 780 - [EPSK-31]
i File Edit View QSO Browser Logbook SSTV SuperSweeper WorldMap Tools Window Help

i % & 2 i % c3 e « » ~
i Q50 SuperSweeper | Radie Soundeard |Waterfall | Rig Control Logbook Retator | Program Options 2} Full screen 14.070410 . g
[ BPSK-31 x|
3
E Add Log Entry ‘ * 2 | Modes vﬂ‘ i ppsicats | bl (A 2 -] 4 6 G\E'ﬁ‘i-'_ﬂ
S E st 232 FH 2 =] &
@ =t PSK & | oe’s
2| F3 Bnd: 2032 £ [« E . mocn
2 : :
H [ e | bdvAoe iiyietpee
g racd BPSK-63 *nl eeeiedifaep aTendnett nal
| Mams: kit onteta ite ie( asoeoetea Co:l0le t#e retaF eeeieeie-le el
aTH - uMleet E
Locator: E QPSK = s
oty [ < QPSK-31 USB i p Send (F4) [ Auto (F2) Ul Pause (F 5) A Break-in | %0 /7 [ 7 | (Zie 4% Reoeat [#IRSID » [#|VideoDD - | 3 (5
Fequercy: 14.070410 S I
s 1 QPSK-125 USE
Band 20m vl QPSK-31 LSE
Mode: PSK31 - QPSK-63LSB
et = . QPSK-125 LSB
Revd: 599
CONTESTIA 2
Remark
B e Contestia8250 || ™| _
“ Add |M.. M. OSL H. e Lo Mimdes| | | Enter text to be sent 1604 Hz 20 secs | | IMD: -21dB S/N: 22dB
[ waterfal )
i Zoom: pa | BB =7 | Main: 4 « 1604 » P | Signal < 4% AFC | Decode | %fOptions } 14.070410 { 160m 20m 40m 30m 17m 15m 12m 10m 6m | € » | G Faves | [dModes

1000 1100 1200 1300 1400 16do oo 1800 1900 2000 =00 =2=oo 2300 2400 =300 =600 2roo 2800 =900 3000

:

v

L
£
3

| % HRD Logbook: My Logbook |RSID OVR CAP HUL

DM-780 Main Display

There are many configuration options available for the visual display of DM-780. If you
will notice there is a scroll bar located on the right side of the ALE panel. Using the scroll
bar and sliding down to the bottom of the ALE reveals more control buttons for the ALE.
Many people don’t like to have to use this scroll bar so one option is to reduce the hight of
the Waterfall.

Placing your cursor along the top edge of the waterfall, just below the transmit panel,
clicking and holding the left mouse button, will allow you to drag the top of the Waterfall
down so you can see the options on the bottom of the ALE. Doing this, though, brings up
another problem. When you get it to the point where you can see the bottom of the ALE,
the Waterfall is so narrow it makes it hard to select the signals.

Full Screen An alternative would be to press your F11 key. This takes the display to the Full Screen
Mode mode.
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~ Z2BPSK-31 x|

At Uity -7
2 st 2032 3 [5]
@ End: 2032 [ [4)
F5) Cal:
Name
amH
Locator
Gy [——
Frequency: 14.070.410
Band: |2|}m -
Mode:  |PSK31 -
Sent EE -
Revd 599
Remark

7 | [Reset (7] [ 5]

Add [ M. M. [QSL[F | |
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X

Modes "“ iBpsk3t- | (3] 2 A -] 4 b &M o - AFC
PSK £ ‘ i
BPSK-31 - ‘ I:
BPSK-63
BPSK-125 ‘ Don Don
QPsSK £ my QTH .... Omak Wa. USA

QPSK-31 USB
QPSK-62 USB
QPSK-125 UsB
QPSK-31 LSB
QPSK-63 LSB my count_v.. Okanogan

QPSK-125 LSB -

i b Send (F4) bl Auto (F2) +!RSID + [+ VideoID ~ | | A

my LOC .... DN@8dj [290.7° 2,124.1mi]

Break-in | %2 /7 5 B | Kdv 4% Repes

CONTESTIA 2

Contestia 8/250
Contestia 8/500
Contestia 16/500
Contestia 32/1000
Contestia 4/125
Contestia 4/250
rsna

1498 Hz 20 secs | IMD: 2008 S/N: 2948

| | Enter text to be sent

Waterfall
bt

i Zoom:

Multiple QSO
Windows

188

| Main:

- & x

2300 2400 2500 2600 2700 2Boo  2g

CPU: 0% | Audio: 43 |y

F11 — Full Screen Mode

Soundcard R%: 800011Hz | Overload | % HRD Logbook: My Logbook | RSID OVR CAP NUM SCR

Now in this mode you can see the lower part of the ALE, and as you will learn later,
below the three icons at the bottom a line of text will appear when you have a call in the
Callsign box indicating the worked status of that call. Plenty of room for all of that now,
but another problem has been introduced.

You have lost your tool bar and have no way of selecting any other options available.

: = b
-.1 Clock En
Main
; Frequency r—
— Full 5creen -
h, Locator E]
e Last Q50 Added i
Customize...

SOLUTION: Select an empty spot on the tool bar and click your right mouse button. A
menu will pop up looking like the one at the left. Un-check each of those checked options
in this menu to remove them from the tool bar. Remember, removing the Clock from the
tool bar isn’t going to hurt you, you always have the system clock on the Windows Task
bar. The frequency is displayed on the Waterfall tool bar. Everything else will now be
available from the Text Menu at the top of the screen.

Now you can adjust the height of the waterfall to something easier to work with and still
see the entire ALE without having to use the scroll bar.

On the Text menu at the top of the display, click on QSO and select New Window. You
will see a new tab appear on the display. The tab will be identical to the first one created.
Click on this new tab. It doesn’t look like anything changed. Your still in the BPSK-31
mode and the screen looks just like the previous tab.
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™ Digital Master 780 - [BPSK-31]

Main Display Configuration

File Edit ‘u’iew Q50 Browser Logbook 55TV SuperSweeper World Map Tools Window Help
S2BPSK-317 3 BPSK-31 % |
| add Log Ent - B | DIGITAL DEFAULT > 1 [irenee s o) E r
FZ}SDQ”W Q feesat-id Q|2 2 o] S B SIS [
{ tart:  21:18 7 PSK >
£ 9 5628,)3'?26?("9600.0CUCUY
F3) Bnd: 2122 [ [ ek 0
(IE = £ CONTESTIA  »
(F5) Call: «Q £ &
W »
MName: P 1) CQ (Video) DomioEs "
QTH: R Hell ,
Locator: = MFSK 3
SO &
Country: | v| Q MTE3 3
| Frequency: 14.070.410 P2 cAL VA ’
b 4) Q50 RTTY 2
Band: 20m v| id ” RKY 12
b 5 BIY RTTYM 8 RTTY-50
| Mode:  |PSK31 - :
— ol GREEHNG THOR 8 RTTY-75 e g
| Sent:  EEH 7) NAME/QTH é Breakiin | ¥ &7 5 [ | - 3 Re
2 e i Throb 4 RTTY-45-FSK
[Revd: 599 8) RST (Q) i | .
9) PREV. QSO
Hemak: 0) FIRST QSO
STATION
) | |Reset (F4) | | 4R cLuBs
QsL
WX it
[ Rdd M. M. [QSL[H- - _DIGITALD... | Tags | Modes | | |[Enter text to be sent
Waterfall
iZoom: < d | ¥ | Main: 4 « 1500 » b | Signal < i 4% | AFC | Decode | fOptions i 14.070.410  160m 80m 40m 30m [20m|17m 1

Ready

1300 1400

| cPu: 0% |

|Aud|0 3% ||

1800

1700 1900 z000 2100

| Soundcard RX: 8000.05Hz | Overload

|8

Click on the BPSK-31 tab, in the upper left corner of the Receive panel. When the drop-
down selection box opens, come down to RTTY and click on RTTY-45. You now have
TWO mode tabs open on the main display.

Let’s try another. Click on QSO on the Menu and select New Window. You now have
THREE mode tabs. In this new tab, let’s select Olivia 8/500.

The tabs in your display should look like the following picture.

™ Digital Master 780 - [Olivia 8/500]

! File Edit View QSO
; &= BPSK-31

| Add Log Entry

F2) Stat:  91-34 <
F) End: 2136 = [<
(F5) Call:

Mame:

&= RTTY-45" 2

Browser Logbook  S5TV

2 Olivia 8/500 X |

~ I | DIGITAL DEFAULT
' biGITA )
Q) e
[ 1) CQ (Video)

SuperSweeper

World Map  Tools  Wind

! Olivia8/500 - | [ (3| ¢

: Defaults | Tune margin:

z,7

You can have as many mode tabs open as you like and easily switch back and forth just
by clicking on the tabs. To close a tab just click on the “X” located to the right of the tab

name.
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If you a QSO and someone sends you a link a website, you don’t have to exit DM-780 to
view the site. You don’t even have to open your favorite browser. All you have to do is
click on the link, in the receive panel, a browser tab will open to the website you clicked.
™ Digitsl Master 780 - [Home]
i File Edit View QSO Browser Logbook SSTV SuperSweeper WorldMap Tools Window Help

i [ B2Rrrvas | &2 0Mmies/500 & Home x|
3 (] G| 40 ] AP ] @] s | httpy//www hrdsoftwarellc.com/

HRD-SOFTWARE LLC

Welcome!

Welcome to the HRD site.

TO BUY HRD Click HERE
Products

e HRD 6.0 Status: PrEREIEASEAVAIASIE

Support HRD 6.0 Known Bug List
Calendar
HRD 6.0 Beta Resolved Bug List

Contact

BUY HRD 6.0 Beta 2.2 Resolved Bug List

Version 6.X QRZ XML Lookup Setup

HRD 6.0 Beta 2.2 is now available for download.
Download HRD 6.0 Beta 2.2 by Clicking Here
A purchase key is needed to use the HRD 6.0 Preview.
Buy Now.

Ta Naumlasd tha fras vareinn B 24 Build 284 Flick Hara

httpi/fumwhrdsoftwarellc.com/services/buglisthtml

Ready | cpu:3%)) | Audio: 1% | Soundcard RX; 7998.50Hz | Overload | S HRD Loghook: My Loghool

Looking closely at the above picture, you can see you now have four tabs on the display.
Three Mode tabs and the Browser tab.

DM-780 — Digital Modes

At present, DM-780 handles 14 of the most popular digital modes used in amateur radio.
These modes are BPSK, QPSK, CONTESTIA, CW, DOMINOEX, HELLSCHRIEBER
(HELL), MFSK, MT63, OLIVIA, RTTY, RTTYM, THOR and THROB and VOICE.
Each mode is subdivided into variants of the mode.

The mode can be selected from a number of places in the DM-780 display, depending on
how you customize your display. Modes can also be selected by right-clicking on the
waterfall and choosing from the popup menu.

| Bl Bt Yew 050 Brewier logbock STV Spetwepe Woldlbp Tosh Wedow el wess -ax
| > ; P
per oes-n v _.—.l
o6l Usa .x
E et Loy mtry =7 | Moo - g Aon. 4 aim o P S
L TR T P s it s
e 3 -
FRbe 611 s L Qescal LS
o & GRS LS
et e \p -
o W - T
am i Cortrstia 130
e arsx E c iy
, = QPeC U5
QPSE63 Ush .
ey 14070000 i :
et | 20m =i 4 & St F4) 8 donm 2 5 Benskein | 30 2 i 7 SaD o) v
sl Satolid R )| QA | G| G50 BTV | GRLITING | NI | 65110 | P A58 | Gk LV 7 | AVTG-406 |
- B - QP L iﬁ E i
et 030
CONTESTIA *
Fan
e M itatia A s
R W T TR TR TEMETADEF. Tap Modes e bt st

B e 10 s D N L% B8

I L e

jrerp—— i 1843

You can select from the Modes Pane, which can be pinned to the display or by clicking on
the small mode drop-down tab located in the upper left corner of the Receive Pane.
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Podes

o
T

b

PSK

BPFSK-Z1
BPSK-62
BEPSK-125

QPSK =

QPSK-21 LISB
QPSK-62 USE
QPSKE-125 UISE
OPSK-31 LSB
QPSK-62 LSB
QPSK-125 LSB

[vilmﬁul Aty A b

0
Q

b

COMNTESTLA

Contestia S/250
Contestia 8/500
Contestia 16,500

. Macros J| Tag\S\_Mol:lﬁ J

Enter

v * sk A2 8] 5 B S S
I esx [ eeskm |
L QPSK v BPSK-63
1 COMNTESTIA  » | BPSK-125 F]ﬂt\
| cw v
DominoEx »
Hell y ZROT.m.r Qil W
MFSK 3
MT63 v
OLIVIA 3
RTTY 3
RTTYM 3
“ THOR v [l Pause (F3) 8] Stop. {FS
ALL | QS0 | BTU | GREETING

You will find that some modes, like BPSK and QPSK require only about 25 to 40 watts to
maintain a good QSO contact, while others require more power. You will also find that
some modes, like OLIVIA and CONTESTIA, require more RF power but perform
extremely well under adverse band conditions. You can often be able to copy an
extremely weak DX station when there is a high noise level using one of these modes.

Experimenting with the different modes and variants can be a lot of fun and you can find
the mode that works best for you under even the worst band conditions.
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DM-780 — Logging QSO

DM-780’s integration with the Ham Radio Deluxe Logbook makes it very simple to log
each QSO by using the ALE (Add Log Entry) panel.

EFiIe Edit View Q50 Browser Logbook 55TV 51

P 3 & 2 i E
i Q50 SuperSweeper | Radio Soundcard | Waterfall || Rig C
¥ 52 BPSK-31 x|
= I e
|5 |fddiog Entiy ~ % )i ppsk31
| =l F2 stan: 1445 £ 2
w3 -
=] o - 2 X -
& (F3) End: 1511 [£ -
8 (|2 | 5 cal: # 1
2™
="| Name: Inne
=]
ﬂ aTH: -
o
Locatar: c n
Country: [ '] c0 :
Frequency: 14.070.000 3 -
Band: 20m - i t
Mode: —
Sent: E - '—‘—: @. ?n
Rowd: E99
Remark:
-\.ﬁi] More | My St... ﬁ QsL Help Enter text t
Add Log Entry If you DO NOT have Ham Radio Deluxe Logbook running and ARE NOT connected to
(ALE) panel it, this panel will be grayed out. If active, you can manually enter a callsign in the Call

field, press the TAB key on your keyboard and depending on how you have the call look-
up configured in Logbook, the call will be looked up and all information will be
populated in the ALE.

Once the callsign and other information is entered in the ALE, the “HIS TABS” will
become active in the macros and when used will be replaced with the data from the ALE
window.

There is also an alternate method of entering the callsign into the ALE and automatically
completing the look-up.

You can place your mouse cursor on the callsign in the Receive Pane and right-click.
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ALE Alternate
Method

Worked Status
Pop-up

Ham Radio Deluxe

wjlw wiijlw pse kn Ucm

DM-780 — Logging QSO

' W . | fa3
th8cm de E‘f’ﬁ'Sll—[ga”sigr1

3

F:{.cvd
Reowd Rpt
Rewd Exch
Mame
QTH

Locator

0| bCALL| [QSO]| B

Rermark

0 | “rMacros~

I0TA
Age

URL

Q) | PREV. QSO | FIRST Qs(

Copy Ctrl+C

EE|
U Add Alarm

Callsign Lookup

& | AFC | Decode | =Ad B0

R

& www.grz.com/db/ew8cm
Eqsl.cc 'EWBCM'
Google 'EWECM'

160m 80m 40m 30m | 20r

Using this method brings up a context menu where you can select Callsign, left-click and

the call will automatically be added to the ALE and the look-up will be performed to
populate the rest of the data. This method makes logging quick and easy, especially

during contesting.

In performing this alternate method of entering a callsign into the ALE, you might have
noticed another feature of DM-780. When you hover over a callsign, a balloon will pop
up indicating whether you have worked and logged the call in the past.

» WC3A WC3A WC3A k

wcC3a
.| weza
' pe,ee dta e i wca

: ;
beae EC'V United States

2 United States
)s e 0?aeaMs United States

20m: Worked +
20m: PSK31
Last QSQ: 9/25/2012 10:10:45 PM, 20m, PSK31

20m: Worked v

20m: AM,CV¥,DOMING, FM, HELL, MFSK16, OLIVIA, PSK31,PSK63,QPSK31,RTTY, 558,55 TV, USB

10m,17m,20m,2190m,2m,30m,40m,80m

e Attve)eB & 11

Again, these features will only work if you have Ham Radio Deluxe Logbook running

and connected to DM-780.
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10 DM-780 — SuperSweeper

From the DM-780 tool bar, clicking on the SuperSweeper icon adds a tab to the main
DM-780 display and brings up an outstanding feature of the program.

™ Digital Master 780 - [SuperSweeper]
i File Edit View QSO Browser Logbook SSTV SuperSweeper WorldMap Tools Window Help

e ) i ik
: QSO SuperSweeper | Radio Soundeard Waterfall | Rig Contrel Logbook Retator | Program Options 5 | Full Sereen

7:11:38

22BPSK-31 4 SuperSweeper X
BPSK-31 ~ | WP Restart 3 Redraw | 4 History =2 SO ~ £ Alarms - | 5 Options : 160m 80m 40m 20m 20m 17m 15m 12m 1
1 11.072.90

14.072.70

30
I2EGLMA 2EPLMA de KIPF KISF K
f 2EQIMA d1RI@»@a F 2EFLMA 2EFLMA de KIP

14.072.10—*

14.071.90

107170 Vi % VE2RDL '+ 21 QRC QRZ I rr de VE2ADL VE2ADL VEZADL pae* T UR CALL SEVER

A3 6o miv sBe | soJoepy 7

14.071.50

14.071.30

14.071.10—f= =0

| 11.070.50

the “X” on the right end of the tab.

: Q50 SuperSweeper | Radio Soundcard Waterfall | Rig Control Logbook Rotator | Program Options

9_

«Q

=

= — - — Active: 4/10  Hold: 30 secs Rewmﬂ:iﬂse:s Dacndsr:l%l; m

_QS0:RX| | 050:TX | —

Ready | cpu: 25| | Audic: 26% |y Soundcard R¥: 7999.62Hz | Cverload | % HRD Logbook: My Logbook]| RSID O Z

SuperSweeper You can now switch between the SuperSweeper and the BPSK-31 display by clickingon Q)
Dis p | ay the tabs just above the display window. You can also close the active window by clicking Z),_
D

=

\l

0

o

- BPSK-31. g 4+ SuperSweeper X
BPSK-31 - | Bk Restart 4% Redraw | Lof History &2 QS0 ~ S04 Alarms - | 250 Options

T
a
(=}
lE |
=
@
BPSK-31 — The advantage of using the SuperSweeper window is its capability to decode multiple
SuperSweeper signals on one screen. This is a lot different than using the main display with the waterfall
Tabs or spectrum display where you can decode only the signal you have marked with your
Cursor.
Modes

Modes available in SuperSweeper are selected by clicking on the drop-down mode
indicator in the upper left corner of the window.
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™ Digital Master 780 - [SuperSweeper]
! File Edit View QSO Browser Logbook SSTV  SuperSweeper World Map  Tools  Window Help

z & © M %@ 5

-~ o
Radic Soundcard Waterfall | Rig Control Logbook Rotator | Program Options

i Qs0 SuperSweeper

=

2= BPSK-31" 49 SuperSweeper X |

BPSK-31 = || EFRestart 4% Redraw | L-) History 2= QSO = L1 Alarms - | 0 Options

E: BP S}% E“]

BPSK-125
CW

|1 CW (KY Cmd)
[l CW (WinKey)
U cw (55B)
RTTY-45
RTTY-50

RTTY-75 O FACAUNWEY 17 KBPWIZ de BRKAVN AKAVN pse k t
RTTY-45-F5K

|{RTTYM 8/500

|{RTTYM 16/500
RTTYM 32/1000
RTTYM 4/125 -

| |RTTYM 47250
|RTTYM 4/500

||[RTTYM 8/1000

(| RTTYM 16,1000
| RTT¥M 8/2000

| RTTYM 16,2000 B e e Re ee—i (Coo uual monitorsk Angmna @ meter
RTTYM 3272000 2

|| RTTYM 6472000

SuperSweeper Mode Selection

In the screen shot above, you will notice the call AK4VN followed by a check mark and a
red X. If you have HRD Logbook running and are connected, when SuperSweeper
recognizes a call it places it on the end of the red trace. The symbols after the call are
Work Status Indicators. The first, the green check mark, indicates you have worked the
country of origin for this call. The red X indicates that you HAVE NOT worked this
operator. In the above, what we’re seeing is, the country of origin of this call is the United
States and we have worked it, but we have not had a QSO with AK4VN.

Histo ry Rep ort Another useful feature of SuperSweeper is the History report. Clicking on the History
icon in the SuperSweeper tool bar brings up this feature.
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When enabled, the History logs callsigns recognized, by SuperSweeper, the time, band,
continent and country of origin. It also shows if you have worked the country, indicated
by either a green check mark for worked or a red X for not worked, and whether or not

you have worked that particular call.

This feature can come in handy if you are trying to determine how the propagation on a
band is running. You can find what areas are being received the most, at your local

station, and by checking the times you can see what time of day the propagation into an
area was the best from your station.

This feature can be enabled or disabled by clicking the Enable button on the History
panel. You can also enable or disable the Status, which shows at a glance how many
countries, how many stations and what continents were heard by clicking on the Status

icon.

Clicking the Report icon transfers the data from the History panel to the Notepad, where
you can save or print the report if you choose to keep it for future reference. Clicking on
the Erase icon clears the History.

Starting a QSO from the SuperSweeper can be done using two different methods. In the
first method, while watching SuperSweeper, and you see a callsign in light colored area
on the left end of the trace, if you double-left-click on the callsign two things will happen.
First you will be taken back to the main DM-780 display. The second thing that happens
is the call you clicked on will automatically be transferred to the ALE and an automatic
look-up will be done to populate the information about the call. You will also find your
cursor is on the frequency that is being used by the QSO.

From here all that needs to be done, when the contact finishes his current QSO, you hit
your CALL macro which puts out a call for the station callsign appearing in the ALE call
field. From there just proceed as normal to carry on your QSO with the contact.
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The second method is holding a QSO in the actual SuperSweeper window. On the
SuperSweeper tool bar, clicking on the QSO option changes the layout of the window.

T Digital Master 780 - [Supersweeper] [F=aEER
| File Edit View QSO Browser Logbook SSTV SuperSweeper WorldMap Tools Window Help e x
i3 & ? m % ; i
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SuperSweeper QSO Display

You will now notice you have the ALE panel, a OSO RX and a QSO TX panel displayed
along with the SuperSweeper. Clicking on the red trace of any QSO will now display the
received text in the OSO RX window located in the lower left part of the window. If there
is a callsign displayed in the white end of the trace, hovering your cursor over the call will
bring up the balloon to let you know whether or not you have worked that station. If you
double-click on that callsign, the Call Look-up panel will open in the display. The
callsign will be transferred to the Look-up panel and details will be populated from the
call look-up service you have configured in the Ham Radio Deluxe Logbook. If you
decide you would like to work this station, on the top of the Look-up panel, click on the
LOG icon. This will populate the ALE panel.

You can now make your contact and carry on your QSO just as you would do from the
main DM-780 display using the QSO TX and the QSO RX windows.

When your QSO is completed, click the ADD (F7) icon at the bottom of the ALE to save
the contact to your logbook and clear the ALE for the next contact.
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11 DM-780 — Macro Manager

Macro Toolbar

Ham Radio Deluxe

Macros are a great way to handle repetitive operations in the digital modes. They allow
you to pre-define operating procedures and execute them with just a click of the mouse.
It’s much more convenient to just click on a macro to send a CQ call rather than type in
the call each time.

DM-780 contains a Macro Manager tool that allows you to set up and maintain an
unlimited number of macro sets to handle these procedures. When installing DM-780 for
the first time you will find a default set of macro definition. This is usually a READ
ONLY file and should be kept as a template to build other editable sets. Sets can be made
mode specific for CW, PSK, RTTY or set up for contesting exchanges. The uses for
macros are almost unlimited.

When you create a custom set of macros it’s recommended that you not only save the set
within the DM-780 directory but also in an external directory, such as in a folder in your
Documents. In the event you have to re-install HRD from scratch, having the macro sets
saved in an external folder will eliminate the need to re-create the sets. You can just load
them from the external folder and save them back into the DM-780 program folder.

Macros can be accessed from either a tool bar located between the Receive Pane and the
Transmit Pane of DM-780 or from a macro pane which can be pinned to the display. This
choice is yours.

Between the Receive pane and the Transmit pane, just below the Transmit tool bar, you
will find the Macro toolbar. Left clicking on any one of the Macro buttons will
automatically transfer the contents of the macro to the Transmit pane and depending on
how the individual macro is configured, it will AUTO SEND the contents or wait till you
press the SEND button to transmit the contents.

i b Send (F4) Bl Auto (F2) [|ll Pause (F3 Stop (F5 Break-in | 2 /7 [ 8| - 4% Repeat [#]RSID - [#] VideoID - | [»| (51

i CQx2 | CQ | QRZ | Him de Me | Him de Me - K | RST, Name, QTH | Station | MFSK Pic | BTU | 73 | 73 | 73 | % Macros ~

From here we can send a macro by clicking on the macro button or we can edit individual
macros by right clicking on the macro button which will take you directly to the Macro
Editor. For this part of the documentation we are going to use the Macro Manager by
clicking on the far right icon called Macros then click on the drop-down option
Manager.
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Appearance Macros Pane First Mame
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[T Erase TX Windaw
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Above is a screen shot of the Macro Manager with the Default macro set displayed. From
the Macro Manager you can edit the contents of individual macros, create new sets,
modify the macro tool bar and edit how each macro functions.

Tool Layout
In the bottom portion of the Macro Manager you will see three columns.

Appearance

The first column manages how the tool bar appears on the main display. With a tick in the
“Button” option, the macros are shown on the tool bar as individual macro buttons.

With the tick in the “Popup” option, the macros are displayed as GROUPS with a drop-
down menu for each group to select the macros within that group.

The next option under appearance is “Icons”.

» If the function of a macro is set to “Send Immediately”, an arrowhead is
placed to the left of the macro name in the tool bar.

« Ifitis setto “Erase TX Window” after sending, there will be an “Eraser”
icon in front of the macro name.

» If both are ticked, both icons will appear.

» Ifthe macro is a Radio Control macro, another icon will appear to designate
the macro as a control macro.
In the Macro Manager screen you will see a column named “GROUP”. Each macro is
assigned to a group. Under the Macro Pane heading there is a check box to display the
macros in order of groups. You also see a check box for showing the macro set title. This
title is displayed on the tool bar and also at the top of the macro pane.

The third column shows First Name. When a call is looked up and the data is entered in
the ALE the contacts full name usually appears in the Name field of the ALE. By
checking the box under First Name, when a macro is sent that contains the <his: name>
tab, instead of sending the contacts full name, the macro will only send the contacts first
name.
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New Macro Sets
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™ Macros Manager
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Import - Defaults Load S5ave As
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Macro Manager toolbar

Above is the Macro Manager toolbar.

This next section will deal with creating a new macro set. As mentioned before, it’s

The New icon opens an empty Macro Editor window.

Copy allows you to highlight a portion of one macro definition and paste it
into another macro.

Highlight a macro and click the Edit button brings up the Macro Editor
and allows you to edit an individual macro.

Highlighting a macro and clicking the Delete icon deletes the macro from
your list.

Highlighting a macro and pressing the up or down arrow on the tool bar
moves the icons position up or down in the list.

Clicking on the Import icon brings up a drop-down menu of the ten macro
sets in DM-780. This can be used when creating a new macro set. You can
create an empty set then Inport an already created set into the blank one to
use as a template to edit the new set.

Clicking the Defaults loads the Default set of macros.

If you have created more than ten sets of macros, you have the ability to
Save these additions sets to some location of your choice. Once the set is
created click the Save As icon to save the set.

The Load icon allows you to load any macro sets you have saved. These
functions give you the ability to have an unlimited number of macro sets.

always best to keep the default macro set as a template. This can remind us of the format
for each macro.

Macros et | Default - I Set Title

Enable GiPSK Contest Modes D =fir
= DIGITAL DEFAULT
Cicat 4 Cw PSK. COC
C:S5et5 x Co
C:SetB i R=
Set 7 . . -
Ficor g <his:
FiSet 3 ¥ <his:
Rigettl. - ' —H

[ T H oo oo

To create a new macro set, just above the window that contains the macro definitions, you
will see a field called Macro Set. This is a drop-down field which currently contains the
word Default. Clicking on the drop-down arrow in the field brings up a box containing

10 macro sets. Some of these sets may already have names assigned, which indicates

there are already macros created within the set.

Select an empty set from this drop-down menu. Usually a name like Sef followed by a
number is an empty set.

Let’s say for example that you select Set 4. Clicking on Set 4 will bring up an empty

editor screen with Set 4 showing in the Macro Set field. To the right of this field you will
see a button that says Set Title. Clicking on the Set Title button will bring up a box where
you can enter a name for this group of macros.
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Title (w23

Enter a new walue for this macro set, then press '0F"

Sef 4

[ Ok H Cancel |

In our example, let’s name this new set My PSK so type this name over the name
currently in the Set Title box and click the OK button. My PSK now appears in the Macro
Set field. We are now ready to create the individual macros for this set.

We now have an empty macro set named My PSK in the Macro Manager. Since we’re
new to programming macros we are going to use the Default set as a template to make our
My PSK macro set.

On the Macro Manager tool bar click the Import macro. A drop-down box will appear
and from that, place your cursor on Default and click the left mouse button. A new dialog
box will pop up asking you if want to Replace My PSK with Default or Add Default to
My PSK.

Since we’re starting with a blank set it really doesn’t matter which you select. If you had
macros already in this set and just wanted to add the Defaults to those you would select
the Add option, or if you wanted to replace them you would select the Replace option.

I Moo = ler | <]
Title: * [7] Enabled Quick Edit
. Riight-click on a Macro entry in the 50 window's
Toolbar Title: * Macros list or taclbar to edit the macro
Group: * =
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[* = required) [7] Send immediately ¥ CONTESTIA
utstop 7 ow
7] Start on new e ;‘ DominoZx |5
[] Erase T windaw & Hell
¥ MFSK
¥ MT63
[+ RSID_| | [+ videe | | @) oLvia
% Textfrom File ¥ PsK
el T
! » Radio Control « i »
" Tags | Somples | Help: Help:Radio Control | HelpVideo 1D | HelpiReed-Solomon ID (RSID)
Mv Taas. His Tags: Soecial Tags (description):
accessories  |+| |age add-log add gso to logbook -
age [ |band date date (local, windows format) setwhen sending tag
antenna callsign date_utc date (utc, windows format) setwhen sending tag
callsign country erase erase bowindow
clubs firsthame erase-nc  erase xwindow
computer frequency imd pskimd (as shown in the status bar)
e-mail iota last-senttext resend the lastsenttext
homepage locatar now_hhmmss  time (local. hhmmss) setwhen staring macro
interface mode now_utc_hhmm  time (utc, hhmm) setwhen starting macro
locatar =z|| |name now_utc_hhmmss time (utc, hhmmss) setwhen staring macra E
mode gth gso- decrement gso (contest) counter
name rcvd gso+ increment gso (contest) counter
otherl revd_exch gso-mode current mode (adif formaf)
other2 revd_rpt gso-mode-count total number of gsos inthe logbook for the current mode
other3 remark gso-total-count total number of gsos in the logbook
otherd sent repeat enable repeats
power sent_exch resetlog  resetaddlog entry window
program sent_rpt sfn signalto noise (as shown in the status bar)
@ programfull = |urd send-pic start sending a mfsk16 picture
anee qth stop stops sending and processing the macro
oK. radio E time time {local, hhmmss) setwhen sending tag -

Macro Editor
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With the Macro Editor, we create each individual macro and set how it executes. Here is a
brief explanation of the various functions available in the Macro Editor.

Macros contain free-format text with optional tags. Tags are enclosed within angle
brackets <> and contain:

* Information about yourself such as your callsign and name - taken from the
Tags window,

» Information about the other station such as his callsign and name - taken
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from the Add Log Entry (ALE) window,
» Special tags such as the date and time.
Example:
<his:callsign> <his:callsign> de <my:callsign>
<my:callsign>
73"s and thanks for the <my:mode> QSO k

In this example <his:cal Isign> is replaced with the value in the Callsign field in the
Add Log Entry window and <my : cal Isign> is replaced with the value in the Callsign
field in the 7ags pane of the QSO window. (Select 7ags from the QSO menu to display the
Tags pane.) The

tag is replaced with the current mode (PSK31, RTTY etc.) as shown in the mode
dropdown in the QSO window.

So if HB9DRYV is working GD4ELI using RTTY the actual text sent is:

GD4EL1 GD4ELI de HB9DRV HB9DRV
73"s and thanks for the RTTY QSO k

Adding Tags

To add a tag to the current macro:

1 Position the cursor in the definition field where the tag is to be inserted.
2 Make sure 7ags is selected in the tab strip.
3 Double-click on an entry - the my: and his: prefixes are added automatically.

Options
The extra options are:
» Send immediately - when the macro is selected DM780 starts sending.
» Autostop - switch to receive when the macro is sent.
» Start on new line - make sure the text starts on a new line.
» Erase TX window - erase the contents of the TX window when selected.

Load Text from File
When you select this option the text

<fFile:YOUR-FILENAME-HERE>Fi le-contents-go-here<eof>
is added to the macro. Replace YOUR-F I LENAME-HERE with the full path of the
filename. the contents of the file replace the text between the <File: .. .>and <eof>
tags. This option is typically used for sending weather reports from automatic weather
stations.

Now we’ll create a macro that does a CQ call. The first thing is to create a title for the
macro. In this case, the title will be CQ. Type the title in the title box at the top of the
editor.

The next field is “tool bar Title”. This is the title that appears on the macro button. Since
we are going to have this macro do a CQ call two times, we will make the tool bar Title
CQ X2, again without the quotation marks.

We’ll now create a Group for this macro. Let’s call this group CQ. Enter CQ in the Group
field.

We want to make sure this macro is going to be Enabled on the macro toolbar, we need to
place a check mark in the box to Enable the macro. This box is just to the right of the
macro title field.
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In the large yellow area we can now build our macro. Place your cursor in the editor area
and type CQ CQ CQ DE. Hit the space bar after the DE and look down at the Tags list. In
the My Tabs column you will see callsign. Double-click on callsign and you will see the
<my:cal Isign> tag displayed in the editor after the DE. Your macro will look
something like this..... CQ CQ CQ DE <my:callsign>. Place the

<my:cal Isign> in the macro two more times, making a space between each tag.
Immediately after entering the last tag press ENTER on the keyboard and repeat the
sequence.

After entering the second CQ call, place PSE K and from the Special Tags column,
double click on the Stop to place the <stop> tag at the end of the macro. Your finished
macro should look like:

CQ CQ CQ DE <my:callsign> <my:callsign> <my:callsign>

CQ CQ CQ DE <my:callsign><my:callsign> <my:callsign> PSE

K <stop>
When you’re finished entering your macro definition we can now set the macro options.
For this macro, under the Macro Options, located on the right of the upper portion of the
macro editor, place a check in all four options. These options determine how the macro is
transmitted. It will start transmitting immediately when you press the macro button, it
will begin on a new line, it will automatically stop at the end of the text and erase the
transmit window when finished executing.

To save the macro just click the OK button in the lower left corner of the editor and you
will be returned to the Macro Manager screen.

Now we’ll talk just a bit about some special tags used within macros. There are several of
these tags that perform various operations. Some are used in standard macros and some
are used to create Rig Control macros.

Reed-Solomon IDs
This idea was originally developed by Patrick Lindecker, F6CTE.

The Reed-Solomon ID (RSID) is a short 16-tone MFSK transmission which identifies the
mode in use. The RSID transmission is about 180Hz wide and lasts for just less than two
seconds.

You should enable RSID when using an 'exotic' mode such as Olivia so that users of
programs with RSID support know what mode you are using.

For a full list of modes supported by this program look in the Program Options for Modes
+ IDs.

There are two ways to enable RSID:

1 In Program Options select Modes + Ids and check the option to show the
RSID button in the transmit tool bar. Clicking this button will transmit the
RSID at the beginning of each transmission you make.

2 Add the tag <rsid> anywhere in the text being sent. By adding this tag to a
macro, the RSID will only be sent when the macro is executed.

Insert Video ID

A special feature of DM780 is the ability to send an ID string which can be read in the
waterfall - for more information select Modes from the Program Options in the main
menu and tool bar. Many thanks to Dave Freese WIHKJ for the original design and
coding in fldigi.

The Video ID bandwidth is ~ 80Hz.
When you select Insert Video ID the text
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<ident:YOUR-TEXT-GOES-HERE>

is added to the macro, the <tdent> tag must be at the start of the macro. Replace
YOUR-TEXT-GOES-HERE with the text to be sent, for example:

* Callsign: <ident:HB9DRV>
« CQ: <ident:CQ>
. 73: <ident:73>

There are two special options:

* Call: replaced with the callsign in the tags window, and
* Mode: replaced with the current mode.
Whatever you send - keep the text short!

Callsign
<ident:call>CQ CQ CQ de HB9DRV HB9DRV HB9DRV pse K

Mode
<ident:mode>CQ CQ CQ de HBO9DRV HB9DRV HB9DRV pse K

CcQ
<ident:CQ>CQ CQ CQ de HBODRV HBODRV HB9DRV pse K

73
<ident:73>G4POP de HB9DRV 73 and thanks for this QSO

A radio control macro contains commands sent to Ham Radio Deluxe to configure your
radio, for example to set a special filter. The text in the definition is not added to the input
(TX) window. These definitions are specific to the radio you are using.

The tag {{RADIO-CONTROL must appear anywhere in the macro definition. If you
have added this by mistake just remove the lines containing the tag.

The easiest way to add entries is to use the Radio window, as you select options in the
Radio window the options are sent to Ham Radio Deluxe and the corresponding text is
added to the definition (remember to press the Connect button in the Radio window).
Only add one entry per line.

Note: Lines starting with # are treated as comments and are not passed to
Ham Radio Deluxe. Blank lines are ignored.

Commands
There are four command types:

e Center frequency on/off,

* Drop down (menu) buttons,
* Normal press buttons,

+ Sliders.

To simplify the command parsing any spaces in the button / slider names are replaced
with a tilda (~). Slider entries contain the radio title, this is for historical reasons.

Center Frequency
¢ center-on
* center-on 1750
» center-off
To enable the current center frequency option in the waterfall enter center-on.
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Note: The center frequency option must be enabled (checked). To specify
the center frequency just add the frequency in Hz after the center-on tag,
for example center-on 1750.

To undo the center frequency option and restore the previous radio frequency enter
center-off.

The center-on and center-off text must be the only entry on the line. Typically you
combine these options with a filter settings, for example when enabling the center
frequency option a narrow filter is selected, when undoing a normal (wide) filter is
selected.

#++

#

# {{RADI0-CONTROL

#

# For the TS-2000

#

# Set the center frequency to 1250Hz, adjust DSP
filtering

# to Low = 1000Hz, High = 1400Hz.
#

H——

center-on 1300
Set slider-pos TS-2000 DSP~low~cut 11 // DSP low cut = 11
Set slider-pos TS-2000 DSP~high~cut O // DSP high cut = 0

Drop down-Button

When you select an entry from a drop down button it is added to the end of the definition.
Existing entries for the same drop down button are not overwritten as a drop down button
can contain unrelated commands.

Press Button

When you press a button the editor first tries to replace an existing entry for this button; if
there is no entry then a new entry is added to the end of the definition.

Ham Radio Deluxe
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Chapter 12 - Satellite Tracking Introduction

12 Satellite Tracking

Introduction

Note: This chapter needs a lot of TLC to get it to match the current
build. It will get totally redone soon.
NOZRD - The Work Wacker

If you are new to satellite tracking visit Attp.//www.amsat.org/ maintained by The
Radio Amateur Satellite Corporation (AMSAT) for excellent articles written for
new satellite users.

Ham Radio Deluxe®s Satellite Tracking support would not be possible without the
help of David Taylor and his open source satellite-tracking library. After using
David*s code to get started [ wrote my own library, shipped as a DLL with Ham

Radio Deluxe and based on NORAD SGP4/SDP4 Implementations by Michael F.
Henry.

Note: The most important rule: it's the frequency on the satellite that is
important, not the frequency on your radio. This is the most common
mistake made when using a satellite.

If you are using two radios for satellite tracking — one for transmit, the other for
receive — read this section first, then refer to Synchronizer on page 92.

Dual radio support is arguably the most flexible way to work with satellites.

Satellites

The software requires information about the satellites you will be tracking, this
information is known as Keplerian elements. Johannes Kepler (1571 — 1630) dis-
covered the three laws of planetary motion in 1609 and 1619 — a remarkable feat!
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wll Satellite Tracking: Local - JN46AT - RS-22 - Uplink OFF - Downlink ON

@ Satelites | @ Obsorvar| & Ground Conral | @ Schodule | @ Curant Dats Mutesl Visibility | @ Visibility | ® Modt Passes | @ Singlo Pass Flat DDE @ 4 *
Select a maximurn of 100 saballiies fram the Available list
Available Selected Diata Folder

HOAS14 - AD27 {Londed whan Satallites Tracking starts)
HOASAE AD-S1

NOAR Fo29 Folder,  D\Hemm BadiotDebugiSateltes

HNOAAT GO-32 [z e 2 5 | |

NOAR B prd |&  Select ||r.|. Detaut || Add File

OKEAND y |RE-22 [ I |

OKEAN- » | | 5050 I—I‘ I I—Iﬁ' Betosr)

00-38 vO-52

PIE

PO ) Dewnload wsing HTTR
FOSAT €«

RESURS Fia URL

RBs0m v oamabeurbd  hip fwww celestrak comMNORAD felernent: s/arnabeur, b
RS12n3

FiS15

SICHY

8033

S04

B0-42

SN

TO-31

LARS

o

U014

uo-z2

U0-36

WO-18

WO-38

v Last download. 211272005 200422
[] Dowmload when Sassllite Tracking stans
| AMSAT Operatonal » |
Download Edit List (RERRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRR]

[ AMBAT Semi-Oparstional 2> ] :I

The satellites window lists the files containing the Keplerian elements used to plot
the position of satellites and compute the correct frequencies for the uplink and
downlink.

The default folder is Satellites located below the folder where you have installed
Ham Radio Deluxe - for example:

C:\Program Files\Amateur Radio\Ham Radio Deluxe\Satellites.
To change the folder just press Select.

It is recommended that you update the data files in the Satellites folder when you
start using Ham Radio Deluxe as the files shipped in the kits will be out of date by
the time you start to use them. These files should ideally be refreshed every few
days.

If you check the ‘Download when Satellite Tracking starts’ option then the files
are downloaded every time you start satellite tracking.

To download the latest Kepler data files press Download. The files are down-
loaded to the folder containing your satellite data.

To edit the list of files press Edit List. The file is Ham Radio Deluxe Satellite
List.txt in the folder Satellites folder.

Example:
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-+t

#

# The entries below are downloaded using the Satellites page

# in the Satellites data option. Data is saved in .txt files.

#

# Entries must start with http://

#

# Ham Radio Deluxe only supports the two-line format, for example:

#

# AQ-40

# 1 26609U 00072B 03309.95521145 -.00000007 00000-0 00000+0 0O 3675
# 2 26609 9.9303 22.9678 7977178 228.8131 2B8.6254 1.25597973 13867
#

#,,
FRERE R R R R R R R
# #

# when you change this 1ist you should delete old files which are #
# no longer being used. #

# #
EHEHEHEHEHEHE R

From AMSAT (recommended for Amateur radio satellites).

http://www.amsat.org/amsat/ftp/keps/current/nasabare. txt

From Celestrak

I W

Remove the # comment to add these.
http://www.celestrak. com/NORAD/elements famateur. txt

# http://www.celestrak.com/NORAD/elements /qoes. txt

# http://www.celestrak.com/NORAD/elements /stations. txt

# http://www.celestrak. com/NORAD/elements /visual. txt
# http://www.celestrak.com/NORAD/elements fweather. txt
#

New satellite data files can be downloaded from the Internet, for example from
hitp.//www.amsat.org/ or from http://www.celestrak.com/ maintained by T.S.
Kelso.

The only supported file format is two-line element sets, for example:

AOQ-7

1 07530U 74089B 03265.96753648 -.00000029 00000-0 10000-3 O 2356
2 07530 101.7328 311.4393 0012255 21.1784 338.9793 12.53565904320301
AD-10

1 14129U B3058B 03265.06525444 -.00000148 00000-0 10000-3 0 9658
2 14129 26.3223 129.7582 5974698 27.0721 354.5394 2.05868478124501

The verbose format is not supported.

The bare NASA format elements from Attp.//www.amsat.org/ contain all satellites
of interest to radio amateurs.

Alternatively if you look at Attp.//www.celestrak.com/NORAD/elements/ you will
see many files that can be downloaded. Just download these files and save them in
the Satellites folder selected previously. For more information about the contents
of these files browse Attp.//www.celestrak.com/.

All text files in the Data Folder are loaded into Ham Radio Deluxe, so you should
delete old files if you no longer need them.

Select up to 100 entries from the Available list by either double-clicking on indi-
vidual entries or by highlighting one or more entries and pressing >. By pressing
>> all entries (up to a maximum of 100) are moved to the Selected list.
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212

wll Satellite Tracking: Local - JN46AT - RS-22 - Uplink OFF - Downlink ON

& Saslits | @ Observer & Ground Cortrol | @ Schodule | @ Curort Data Mutesl Visibility | @ Visibility | ® Modt Passes | @ Singlo Pass Flat DDE @ 4 *

Enteryour location and haight above sea level and any cther siations o be ploved

“our Locabon 1ol
Localor. | JMAGAT TR Swation Latitidiy Langitudi
= [ GD4ELI 5431250000 437500000
tor dirct
Laftude: 45 Rt m 45 5 N =
Longiude; B + [a m |1 s |[E &
Huright Formats
Motrs: | 1035 (@ Local @ kme
Faat 3395 CIUTC GMT Ciniles
Chengos s eppiadinmmdicily

In the Observer window you enter your location and height above sea level in
meters or feet (for users more familiar with imperial measurements: 1 metre is 3.3
feet). You also enter an optional list of stations that are plotted on the world maps.
Only the checked [X] entries are plotted.

Enter your location either:

* By entering your Maidenhead Locator in the Locator field and the pressing
Convert >> or
* By entering the Latitude and Longitude directly.
You also select the preferred time format; either Local (default) or UTC. Distance
is displayed in either kilometers or miles.

You must press Apply to update the satellite settings.
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Ground Control

Ground Control

Tabs

Ham Radio Deluxe

A0S 4:21
Los  12:35
Azim  315.45°
Elov  -9.61"
Range 4.242km

Hame A0S
SE£0-50
158
AD-51
Lo-19 2

R8-22 2
GO-32
vV0-52
HO=44
50-41 2
188

AD=7
AD-51
E8-22

V0-52 00:39:13
HO-44 01:00:05
B0-41 D1:28:38
E5-22 02:00:29

Fol

Fuaatar

Rasatellite Tracking: Local - JNABAT - $0-50 - Uplink OFF - Downlink ON

Options | AMSAT arg

S0-50 20030052 Southbound

@ Samolitns | @ Obsarver| @ Ground Conrol | & Schoduln | @ CumentData| & Mutual Visibity | @ Visibisty | @ NewtPassos| ® Singlo Pass | ® Plot| & DOE | @ Help
VFO Sasallite L) [ — =
[ [aptsn % 145,850,000 A“_'_u';uh‘_': o =
R¢ [ [AMan > _436.795.000 | 436.003.023 l_lhn" | - . 15
¥ 60 ——i 2% -
s
: E §
Semlise (5050 [JLineas Transpondar E =) 5 w ¢
a 136
Tmods: LS8 ¥ e - %
made |1 L m T .
Fipode 158 IS TR
a8 88%s8 3
[ Enable Manusl Tuning (F2) < |[ « > goE o oE e e

omom )

Visible e
B:14
9:21
14:28
11:24

2:30 o

This window is used to adjust your radio's TX (uplink) and RX (downlink)
frequency to compensate for the Doppler effect (the apparent shift in
frequency of a wave due to the relative motion of source and observer).

Doppler shift is calculated in accordance with Kepler's laws.

Enter the satellite uplink (your TX) frequency in the Satellite TX field.
Enter the satellite downlink (your RX) frequency in the Satellite RX field.
Select the VFO you will use for TX and RX (see rest of this section).

If you are using a transverter select the Options tab and enter the transverter

offsets.

When you are tuning remember that the important frequency is the satellite fre-
quency, not the frequency on your radio. The frequency on your radio is the satel-

lite frequency corrected for Doppler shift.

Plot

A plot of the selected satellite”s position and footprint. Use the plot offset buttons
to offset the plot time.
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S0-50 20030:52 Southbound

Options
Infrequently used options are located here to avoid cluttering up the display.

TX: -1.882
RX: +5.637
@ Transverer

™ [
Reload Data
Rx O

Swaps TX and RX frequencies.
Copies TX frequency to the RX.
Copies RX frequency to the TX.

Displays pass details using the default text editor, useful for pro-
gramming memories in a handheld UHF/VHF transceiver.

For example:

S0-50

Tx: 145,850,000
Rz 436,795,000

Date / time Azim Elev Receive Transmit

wed 11-1an-2006 07:38:00 109.4 -0.
wed 11-3an-2006 07:38:30 105.3 0.
wed 11-Jan-2006 07:356:00 101.3 0.
wed 11-3an-2006 07:39:30 0O7.1 0.
wed 11-3an-2006 07:40:00 093.0 0.

o]

-0

436,796, 788 145,849,402
436,795,169 145,845,609
436,705,532 145,840,822

wed 11-3an-2006 07:40:30 BS.0
wed 11-Jan-2006 07:41:00 85.0

Reloads the latest Kepler data — see Satellites on page 129.

Doppler — the current frequency correction.
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Transverter — if you are using a transverter enter the correct offsets here and check
TX and RX as appropriate.

AMSAT.org
The satellite*s page in AMSAT.org (if available). Note: not all satellites are sup-
ported yet.

This is a useful way of getting information about satellites modes and frequencies.

214 Ham Radio Deluxe



Chapter 12 - Satellite Tracking Ground Control

Kenwood
TS-2000

Ham Radio Deluxe

Saudi-OSCAR 50/SaudiSat 1€ (50-50) -
Uplink
Diowrilink

Launched

al exparnments, including a moda J) FM amateur repeater expenment oparaling on
and 436 800 MHz downiink. SO-50 15 operational for 10 minutas whan tumead on

1) Transml for 1-2 ssconds on 145 850 MHz wath a tone of 74 .4 Hz to arm the 10 manute bmer on

board the spacec

7) Nad transmit on 145 850 MHz (FM Voice) using 67 0 Hz to key the repeater on and off within the 10
Minute wandow

Note, Sanding e 74 < lane agam witfin the 10 mmoabe window wil resel the 10 mmole bimer

Top

Amateur Radio on the Internatienal Space Station (ARISS)

Region 1 2m uplink 145,200 MHz FM

Regions 2 & 3 2m uplink 144 400 MHZ FM

Cross Band Repeat Uplink 437 200 MHz FM

The computer can only update both main and sub frequencies either:

¢ Inreceive mode, or

* In transmit mode with SAT selected.
A special solution is required when the uplink (TX) and downlink (RX) frequen-
cies are in the same band. When you start the TS-2000 you have an extra TX VFO
option Sub+XIT which is only used for same band split operation (see below).
When selected the Sub VFO is used for transmitting, Doppler correction is
applied by adjusting the XIT value.

Cross Band
In normal cross-band satellite mode (for example transmit on 70cms and receive

on 2m) select:
[TX VFO TX), |B/Sub (the TS-2000 always uses the Sub VFO for
RX VFO A/Main,
SAT on
Split off

The TS-2000 must be in satellite mode so that the computer can update the TX
frequency.

Be careful with the TS-2000's TF SET button, each time you press TF-SET the
uplink (TX) frequency and the downlink (RX) frequency are swapped. So if the
frequencies in Ham Radio Deluxe are the opposite of those shown on the radio

just press TF SET once.

Same Band (Split)

An example is talking to the astronauts on the ISS where the TX frequency is
145.200.000 MHz and the RX frequency is 145.800.00 MHz. You cannot use SAT
mode as this is only used for cross-band operation, so you use Split mode.

'TX VFO Sub -t XIT,
RX VFO Main,
SAT off,

Split on.

XIT will be switched on as soon as you check TX [X] updates. If you switch it off
then Ham Radio Deluxe will switch it on again.
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The RX (main) frequency on the TS-2000 is set to the correct RX frequency (sat-
ellite + Doppler correction).

The TX (sub) frequency on the TS-2000 is set to the TX satellite frequency; the
Doppler correction is applied by adjusting the XIT value. When you transmit the
TS-2000 displays the TX (sub) frequency +/- XIT so the frequency displayed on
the TS-2000 is the correct frequency (satellite + Doppler correction).

When you start transmitting you may hear beeps from the radio - it takes Ham
Radio Deluxe a few seconds before it detects that you are transmitting. When
Ham Radio Deluxe detects transmit mode it stops updating the RX (main) fre-
quency until you return to receive as the frequency cannot be updated by the com-
puter while transmitting with SAT off.

FT-847

You must select SAT mode on the FT-847 so that Ham Radio Deluxe can read and
set both the TX and RX frequencies. It is not possible to determine the state of the
FT-847's SAT button so you must press the SAT button in Ham Radio Deluxe so
that it shows SAT as being enabled.

In normal cross-band satellite mode (for example transmit on 70cms and receive
on 2m) select:

TX VFO B/Sub
RX VFO A/Main
SAT on

Split off
Tracking off

(you do not need to enable tracking, the computer
does everything for you, also the tuning response
with Ham Radio Deluxe is much faster with
tracking off). To switch tracking off press the A >
B button underneath Track.

The FT-847 must be in satellite mode so that the computer can update the TX fre-
quency.

When in SAT mode the FT-847 takes a long time to respond to 'Read Frequency'
requests - especially if tracking is on, as a result when you tune the FT-847 with
the radio's tuning dial the displayed frequency will not update very quickly.

Other

The transmit frequency of some Yaesu radios such as the FT-817 and FT-857 can-
not be changed while in transmit mode, so it is not possible to apply Doppler cor-
rection while transmitting. If you think your Yaesu radio can be updated while
transmitting please contact the author.

IC-910H

In normal cross-band satellite mode (for example transmit on 70cms and receive
on 2m) select:

TX VFO Sub
RX VFO Main
SAT on

Ham Radio Deluxe
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Single VFO
Radios

Linear
Transponders

Ham Radio Deluxe

Ground Control

The IC-910H must be in satellite mode so that the TX uses the Sub frequency. If
the bands on the radio are the same as Ham Radio Deluxe but reversed press M/ S
to switch the Main and Sub frequencies.

Because the IC-910H cannot display the same band on both Main and Sub Ham
Radio Deluxe cannot update the frequencies unless the correct bands are select
using the radio controls.

In same-band mode:

TX VFO Main

RX VFO Main

SAT off
A few notes:

* The TX mode is not updated from the radio.

* The software has to switch between Main and Sub so that the Sub VFO is
updated, it is not possible to detect the radio's current Main / Sub selection
so the radio operates in main mode all the time. If you press Sub on the radio
you will see that radio switch back to Main as soon as the Sub frequency is

updated.

If you are using a single VFO radio such as the FT-817 then you use the same
VFO for TX and RX. Use the TX (F1) button to switch between TX and RX.
When you switch to TX the transmit frequency is loaded into the radio before it
switches to transmit, when you return to receive the receive frequency is loaded
into the radio after it switches to receive.

So the rule is: always use the TX (F1) button to switch between transmit and

receive.

Check [X] the Linear Transponder Tracking option if you are using a linear tran-
sponder such as HAMSAT / VUSAT / VO-52. These satellites receive a specific
range of frequencies (typically 40 - 100 kHz) in one band, convert them to another
band and amplify the converted signal for transmission back to your planet. The
converted signal is inverted - LSB becomes USB etc. - this is known as an invert-

ing transponder.

Do not use the satellite tracking built into your radio - let Ham Radio Deluxe do
the work for you (for example on the FT-847 this is the Tracking option). To set
up the linear transponder frequencies:

TX center The center frequency of the uplink (TX)
band. For example on VO-52 the uplink band
is 435.220-435.280 MHz (LSB/CW) so the
center frequency is 435.250.000 MHz.

RX center The center frequency of the downlink (RX)

As you tune your RX frequency the TX frequency will be correctly adjusted by
applying [1] offsets from the center frequencies and then [2] Doppler correction.

To adjust your transmit signal so that it matches the receive frequency use the spin
button to the right of the TX center field. It will be necessary to adjust the transmit
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signal as your radio(s) may not be correctly aligned, also the linear transponder in
the satellite may also not be correctly aligned.

The tracking option in a radio cannot correctly compensate for Doppler, this is
one reason why many QSO's drift gently across the linear transponder's available
bandwidth. Only correct computer control will ensure that two or more stations
stay on the same frequency while the satellite passes overhead. When using the
linear transponder option Ham Radio Deluxe will correctly control your radio's
frequencies so that are they are both compensated for Doppler shift.

The frequency resolution is set the 1 Hz for:

* AIlICOM,

e All Elecraft,

¢ All FlexRadio,

* All Kenwood.
All other radios are set to 10 Hz. If you have a radio that supports 1 Hz resolution
and is not in the above list please contact the author.

Option Description

VFO The VFO used for the uplink (TX) and downlink (RX). If checked
[X] the selected VFO is updated regularly as the satellite frequency
is corrected for Doppler shift.

Satellite The satellite frequency. Click the Open button to select a new
frequency from a popup window containing the Favorites
definitions or enter the new frequency. band. For example on VO-
52 the downlink band is 145.870-145.930 MHz (USB/CW) so
the center frequency is 145.900.000 MHz.

Transverter |If you are using a transverter enter your transverter's intermediate
frequency here and check the [X] box. If you are not using a
transverter either leave this field empty or do not check the [X] box.
The radio frequency is calculated as: Satellite - Transverter +

Doppler shift.

Radio The radio frequency as computed by Ham Radio Deluxe taking
Doppler shift into account.

Satellite Select the current satellite from a dropdown list that contains the
entries selected earlier in the Satellites window.

Plot for Determines the amount of information that is plotted over the

surface of the planet for the current satellite.

TX>RX Copy the Uplink satellite frequency to the Downlink satellite
frequency.

RX>TX Copy the Downlink satellite frequency to the Uplink satellite
frequency.

TX <>RX |Exchange the Uplink and Downlink satellite frequencies.
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Schedule

Schedule

" satellite Tracking: Local - JN4SAT - VO-52 - Uplink ON - Downlink ON
@ Sawlltos | @ Obsorver| @ Ground Control| @ Schedule | @ Curmart Dista | @ Mutssl Visibilay | @ Visibilty | @ Mowt Passos | @ Singlo Pass | @ Flat| @ DDE | @ ¢ *
Pass Schedule for the next 24 hours
AD2T - - - - -
AQ-51
FiO-29
T S E - = -
IS5
R5-22 - - -
S0-50
VD52 - - - - -
Wed 21.00 Thu 0000 Thu 03,00 Thu 0800 T 09,00 Thu 1200 Thu 1500 The 18.00
Fanga inhours: () O3 O Oz One @4 O Qe O O

This window shows the pass schedule for the satellites selected in the Satellites window.

Current Data

& Saslitts | @ Obsorvar | @ Ground Control | @ Schodule | @ CurerdDista | & Mutual Visibilty | @ Visibilty | @ Modt Passes | @ Single Pass | & Plat| ¢

Altitude km

wll Satellite Tracking: Local - JN4SAT - VO-52 - Uplink ON - Downlink ON

Current satellite detn. used for Ground Cantral and DDE

Vis  Samllies Finld Value
X AD27 Satellite vo-52
¥ A5 Visible Ha
X FO Direction Southbound
X Gox Azimuth * 319.64
¥ 55 Elovation * -52.11
X RS Longitude 132.16 W
«  S0-50 Latitude 15.53 H
iy vos: | Range km 10.842,32

B617.22

Range rate  4.09453070
1:00:08

Los

Fofrosh overy 010

1:12:40

| soconds

DDE | @ ¢ *

oll[[9Yes

—T—

This window shows all computed information for a selected satellite. This win-
dow provides the data for the Ground Control and DDE windows.

Press Viewer to display the data with the default text file viewer, usually Notepad.
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"I satellite Tracking: Local - JN4SAT - VO-52 - Uplink ON - Downlink ON

Salelite.  |AD2? 4 [acs
Fuowe: 7 5 ampe 22122005
* 220122005

Elevaiion: 10 | minimum 22-12/2005
22-12-2005

Swation Locatar
) Obsenser JN4BAT
B4 GDMELL  I074TH

oo
~2005
#2005

24-12-2005
24-12/,2008
24-12/2005
2471272005
25/12/2005
25-12-2005

6 24-12
g 74

Fd oos
24-,12-2005

25-12-2005

2571272005 25122005
26-/12/2005 127
26-12-2005

261272005

26/12/2005 2005
27-12-2005 122005
27,12/,2008 r
27/1272005

27-12-2005

27,12/,2008 27,12-,2008
2B-12/2005 287 oos
28-12/2005 28-12-2005
2B-12/2005 28-12-/2005
28-12-2005 1 28-12-/2005

Select wo or more stabions, thes kst s
defined on the Observer page

3% 25-12-2005 D6:

Duration
=00
00

0 S T G O D0 B GG A D

@O AEWOED D

JUTCGMT

Satallite mutual visibility (satelita is in rangs of two or more locations)

& Saslitos | @ Obsorvar| @ Ground Control | @ Schodule | @ Curort Data | @ Mutusl Visibilty | @ Visibility | @ Moxt Passes | @ Single Pass Flat

The mutual visibility window answers the question 'when is a satellite simultane-
ously visible from two or more locations'.

The information is determined up to 99 days in the future for any stations from the

list defined in the Observer page.

The satellite is considered to be visible if the elevation is the same as or greater

than the selected value.

Use the Viewer option to display the data in Notepad, for example:

Batellite ......:
Future ....... :
Min elevation ..:
Time format ....:

Fom +

| station | Locator

Fom +

| observer | JIN46AT

| GD4ELI | I074TH |

Homm o +

e~ +

| AOS LoS | Duration |

e~ +
2271272005 05:54:26 22/12/2005 06:03:26 9:00
2271272005 07:36:24 2271272005 07:40:24 4:00
2271272005 15:40:35 22/12/2005 15:46:35 6:00
2271272005 17:18:32 2271272005 17:26:32 8:00
23/12/2005 05:26:14 23/12/2005 05:34:14 8:00
23/12/2005 07:06:54 2371272005 07:14:54 8:00
23/12/2005 15:13:42 23/12/2005 15:17:42 4:00
2371272005 16:50:24 2371272005 16:58:24 8:00
24/12/2005 04:58:15 24/12/2005 05:04:15 6:00
2471272005 06:38:06 2471272005 06:47:06 9:00
24/12/2005 14:47:38 24/12/2005 14:48:38 1:00
2471272005 16:22:36 2471272005 16:30:36 8:00
24/12/2005 18:02:24 24/12/2005 18:08:24 6:00
2571272005 06:09:35 2571272005 06:18:35 9:00
25/12/2005 15:55:07 25/12/2005 16:02:07 7:00
2571272005 17:33:43 2571272005 17:41:43 8:00
26/12/2005 05:41:17 26/12/2005 05:50:17 9:00
26/12/2005 07:22:32 26/12/2005 07:28:32 65:00
26/12/2005 15:27:59 26/12/2005 15:33:59 6:00
26/12/2005 17:05:24 26/12/2005 17:13:24 8:00
27/12/2005 05:13:10 27/12/2005 05:21:10 8:00
2771272005 06:53:27 2771272005 07:02:27 9:00
27/12/2005 15:01:22 2771272005 15:04:22 3:00
2771272005 16:37:25 2771272005 16:45:25 8:00
27/12/2005 18:18:40 27/12/2005 18:22:40 4:00
2871272005 04:45:24 2871272005 04:50:24 5:00
28/12/2005 06:24:48 28/12/2005 06:33:48 9:00
2871272005 16:09:45 28/12/2005 16:17:45 8:00
28/12/2005 17:49:01 28/12/2005 17:56:01 7:00

B it +
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Visibility

Ham Radio Deluxe

Visibility

"I satellite Tracking: Local - JN4SAT - VO-52 - Uplink ON - Downlink ON

@ Sawlltos | @ Obsorver| @ Ground Control | @ Schoduls | @ CurartDista | @ Mutssl Visibilay| @ Visibily | @ Nowt Passos | @ Singlo Pass | @ Flat| @ DDE | @ ¢ *

Saelita vizidity (satellie is in range)

Show @pl  Oymsiblenow () Visible inpes 30 = rminutes iirwi

Vis Satellite Azimuth Elevation d K0S d LOS Lan Lat Range Altitude Range Rate
x ( 126.80 70.04 8:01:53 127.35 £ 56.15 5

x 15442 -76.63 ?3:51 31.26 E 12.88 S .0

x 158,29 -73.39 49:49 1%0.%2 E 72.10 & 13.557.11 . =-1.6%916760
X 136.73 1.67 14:58 29.41 E 23.04 H 3.518.51 817.68 -€.35537886
X 0.00 0.00 Visible 0.00 E 0.00 N 0.00 0.00  0.00000000
x 132.69 19,12 1:21:50  1:33:32 42,74 E  6.0Z N 5.747.98  B76.69  4.79986937
o 8.30 9.02 Visible 5:01 13.75 E 64.05 H 2.146.57 664.28 0.02086673
x 318.42 -54.29 59:00  1:11:32 133,05 W 11.36 B 11,112.16  616.10  3.08572984

The visibility window gives you an overview of the satellites you have selected in
the Satellites window.

Select the satellites that are displayed:

* All - displays all satellites,
* Visible now - displays only the satellites which are currently visible,

* Visible in next... - displays the satellites visible at any time in the time
period you select, for example the next 60 minutes.

For each entry in this display the columns are:

Column | Description

Vis Whether the satellite is currently visible.

Satellite The name of the satellite.

Azimuth The azimuth of a satellite is the angle between the vertical plane
containing it and the plane of the meridian. It is customary to reckon
the azimuth of a line from the south point of the horizon around by
the west from O[deg] to
360[deg].

Elevation  |The angular distance above the horizon.

AOS Acquisition of signal is the elapsed time at which the satellite
becomes visible and a signal can theoretically be heard. If empty
then the satellite is already visible.

LOS Loss of signal is the elapsed time after which the satellite is no
longer visible and the signal can theoretically no longer be heard.

Lon The satellite's current longitude.

Lat The satellite's current latitude.

Range The distance of the satellite from the observer's location measured in
kilometers. (A mile is 1.6 kilometers; a kilometer is 0.62 miles.)

Altitude The altitude of the satellite above sea level measured in meters.

Range Rate |The value required to calculate Doppler frequency adjustment.

221

9ll|[21esS



Next Passes

Chapter 12 - Satellite Tracking

Next Passes

Nexd passes jor o salected satellita

Fr1 23-Dec-2005
Fri 23-Dac-2005
Fri 23-Dec-200%5 2
Fri 23-Dec-200%
Fri 23-Dac-2005
Sat 24-Dec-200%
Sat 24-Dec-200%
Sat 24-Dec-2005
Sat 24-Dec-2005 &
Sat 24-Dec-2005
Sar 24- =2008 23:€
Sun 25-Dec-2005
Sun 25-Dec-2005
Sun 25-Dec-2005
Sun 25-Dec-2005
Sun 25-Dac-2005
Bun 25-Dec-2005 22:
Mon 26-Dec-200%
Mon 26-Dac-2005
Mon 26-Dec-200%5
Mon 26-Dec-200%
Mon 26-Dec-2005
Mon 26-Dec-2005 2
Mon 26-Dec-2005

16.08%

Vis | Salies V0-52: A0S A0S hzi LOS Max ElevsAzimuth

X AD27 Wed 21-Dec-2005 137.22* 20.82°

¥ ADSI Wod 21-Dec-2005 : 190, 48° 31440

X FO Thu 22-Dec-200% 270.60° 0.46% 282

X Gox Thu 22-Dec-200% 5é.00* 1.65"

¥ 55 Thu 22-Dec-2005 19.95¢ 31.15¢

¥ RS Thu 22-Dec-2005 1.89° 21.54% 2

«  S0-60 Thu 22-Dec-200% 333.04" 1.26"

iy vos: | Thu 22-Dec=-2005 : 76,92 s.80°
Thu 22-Dec-2005 : 147,80 2 44.517
Thu 22-Dec-200% .93 20.09°
Fri 23-Dec-2005 8 5.22*

41.807

This window shows up to 1,000 passes for a selected satellite. Note: do not select
more than 100 passes unless you have a very powerful computer, minimum CPU
frequency of 2 GHz is recommended.

Press Alarm to add an audio alarm when a satellite is about to pass overhead.
Press Plot to plot a selected pass in the Single Pass window.

Press Viewer to display the data with the default text file viewer, usually Notepad.

Single Pass

222

Local - JN4BAT - VO-52 - Uplink ON - Downlink ON

@ Sawlitos | @ Obsarver| @ Ground Control | @ Schodule | @ CurartDista | @ Mutisal Visibilay | @ Visibily | @ Neut Pas
VOE52 21:23:04 - 21:36:36 Local
a0
0 S 1360
n 35°
&0 2"
* 50 225 «
& 4 RS
Iz.82
20,16 *
653.08 ka .
W — ai 1,406, 19 ka 13
[21-Dec-2008 21:31:26)
20 an°
10 45"
[1}
212300 21:25:00 212100 21:23:00 21:31:00 213300 213500
1, Vatical Markar
Ogevor kin | @ agmat Twe T IEEER
[E4Bepup inid] O Ainade CileRmouse A7 316.95° A 615.13kn
E] ’ZJ ZI :_—>| (I Bange Oor Et -56.76% Ra| 11,401,93km

Elevation
Azimuth *
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Chapter 12 - Satellite Tracking Plot

This window plots a single pass for the satellite selected in the Next Passes win-
dow. The elevation is plotted on the left y-axis; time is on the x-axis. Select Azi-
muth, Altitude or Range to be plotted on the right y-axis.

If Popup info is checked a vertical dashed marker line is displayed which either

tracks the current time or is positioned by clicking on the chart with the left mouse
button.

As the marker position changes, the azimuth, elevation, altitude and range are dis-
played in the marker fields.

Plot

W™ satellite Tracking: Local - JN4SAT - VO-52 - Uplink ON - Downlink ON

@ Sawlitos | ® Obsorver| ® Ground Control | @ Schoduln | @ Currart Dista | @ Mutissl Visibiley | @ Visibilty | @ Nowt Passos | @ Singlo Pass| @ Flol @ DDE| @ € *

180 135" 90 5" b L a0 13 180°

Fopup { Flot Oplians
[latBange  [Zlauoplat Praw 2mine ¥ Rafesh S sec v

[Clazims glav  []Pgsiton [ mewesn | Mest[zomins % omser[ccf[<] - [2][]

This window shows the position of one to four satellites above the surface of the
planet.

Ham Radio Deluxe 223
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DDE

"I satellite Tracking: Local - JN4SAT - VO-52 - Uplink ON - Downlink ON

@ Sasollites | @ Obsarver| @ Ground Contral | @ Schoduls | @ Curant Dets | @ Mutusl Visibilty | @ Visibility | @ Most Passes | @ Singlo Pass | @ Plat DDE |@ 4 *

CDE Servar configueation (Opsional)

Format HNeva - The DDE Senser makas aatalite data svailabla for ather
prograrms

This i€ opfiansl - stan the DOE Server anly i raquired by &
Jed-party program. for example rotator contral

Field Value

DDE Service HEW32

DDE Tepic HFW_DATA

DDE Item HFW_SERVER

HFW_SERVER VO0-52 AZ:315.9 EL:-58.4 RR:3.472B306546 AH:N

This window controls the DDE server. If you want to use Ham Radio Deluxe's
data with another program you must start Ham Radio Deluxe's DDE Server.

Select the DDE format: currently only Nova is supported. Press Start to start the
DDE server.
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Chapter 13 - Antenna Rotator

13 Antenna Rotator

Introduction

Introduction

Why?

Your Locator

This program was written to provide better support in Ham Radio Deluxe and the
associated satellite tracking software.

The Main Features

The main features are:

L]

Support for NOVA and Orbitron DDE.

Connect to an unlimited number of rotators simultaneously.
Many rotator protocols supports, for example:

* AlfaSpid,

* EAATX,

o (GS-232A,

¢ Idiom Press,

* Prosistel.

Works maps — double-click to move the rotator.

Full diagnostics in the logfile.

Select Options from the Tools menu and enter your locator in the Your Informa-
tion pane.

Rotator Display

The same display is used for all rotators:

Connecting

Ham Radio Deluxe

TR

@ HRD Rotator - [AMSAT IF-100]

File | Edit View Tools Window Help & Donate -8 X%

B & & & i
New Open Options . DCE:Enable |Nova Orbitron
Logfile AMSAT IF-100 >

Ll Disconnect.
Callsign: Country; - Locator: Zoom: 100% = Path; [Shart Long

Mercator Great Circle

Ready

In the example above you see the software connected to an AMSAT IF-100 rota-
tor which supports both azimuth and elevation (it’s designed for tracking satel-
lites). The world map uses the famous Blue Marble image from NASA.

To connect the program to your rotator:

227
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Rotator Display

Selecting a
Bearing

Formats

228
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1 Make sure all cables are correctly inserted,
2 Start your computer,
3 Start this program
Select the correct rotator type from the Rotator dropdown:

@ HRD Rotator - [Rotator]

File Edit %ew Tools Window Help £ Donate
B )

Mew  Options
Logfile = AMSAT IF-100-° Rotator X

| Connect  Rotator: aMSaAT IF-100 Paort: LFT1 -

(AMSAT IF-100 .
AlfaSpid RAK Az

o AlfSpid RAS AzfEl

Aot Bramgaraw

Callzigr:

' & ‘330 Heron RT-20
/ 4 B Hy-Gain DCU-1
‘300 (| Idiom Press
.'I iy Prosistel "D
| 5 Prosistel Combo
| w70 Yaesu Az
| - Yaesu Az/El

- l-lll'

If the rotator supports more than one protocol then a Protocol dropdown is dis-
played, if so select the correct protocol to be used. If in doubt consult the rotator
handbook.

If a serial or parallel port is used to connect to the rotator then select the correct
port from the Port dropdown.

The EA4TX/ARSWIN option communicates with EA4TX’s ARSWIN software
using the DDE protocol — ARSWIN must be already be started.

Select the Refresh rate — how often the rotator controller is polled for the current
status. Some controllers such as the IF-100 cannot provide this information, in
which case the Refresh rate dropdown is not shown.

p comect Finally press Connect. If you experience problems look in the Logfile
window.

Select a bearing by either:
1 Entering a callsign — the HRD countries file is used to locate the latitude and
longitude for the country.
2 Selecting a country from the Country dropdown.
3 Entering a 4- or 6-character Maidenhead locator.
4 Just double-clicking anywhere on the map.
Switch between short and long path bearings by pressing either Short or Long.

Two map formats are currently supported:

1 Mercator — an aspect ratio of 2:1, and
2 Great Circle — created from the Mercator image. A great circle map
You can zoom the image from 100% to 1,000%.

The Great Circle map can be rotated in steps of 30 degrees. This is often desired
by users in the southern hemisphere.

Ham Radio Deluxe



Chapter 13 - Antenna Rotator DDE Support

Displaying
Tracks

In the Mercator map you can display the signal track and bearing at the current
cursor position by selecting Show Track from the Rotator toolbar.

DDE Support

Supported
Format

The program contains a DDE client which accepts DDE data in the Nova and
Orbitron formats from external programs such as HRD Satellite Tracking.

& w

' DDE: Enable Orbitron

Before enabling DDE support:

1 Select either Nova or Orbitron in the DDE toolbar.
2 Make sure the Nova or Orbitron software is started.
3 Press Enable.

The DDE data is shown in the status bar.

DDE SMA0-07 AZZ12.8 EL-51.8 DN143898200 UP435235073 AZ:212.8 EL:-31.8

You can now use the DDE data to drive the rotator — press Track DDE in the
Rotator window.

i@ Track DOE

Logfile
Using

Ham Radio Deluxe

The logfile contains all diagnostic information. For full diagnostics make sure the
Full Diagnostics option is selected.

229
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| HRD Ratator - [Loafile] S

| Teio | gt yaow ook window toi G Donate £

li @& 5 W o e

| vew ophons 5 LOEiEnskle Moval Orbron &
Logfile * | AMSATIF-100 | Rotatr v

| @ ! &
Erasn Tt Viwer 41 Diagnostics
| Time Class Tuxt X
| 11:08:00 Counties Country prefix EW sllocated te DXOT 027 snd 054 (Belsrus snd Eurcpesn Fussis)
Counties Country profix BC allocated to [ {Belarus and Europesn Ruszsia)
Counties  Country prefix RD allocated to [ 18 and 054 {Azerbaijen and European Bussia)
Counties  Country prefix RO allocated to [ 14 and 054 {Armenia and Eurvpean Russia)
auntims  Country prafix U0 allocated ta O {Balarus and European Russia)
Counties  Country prefix UD allocated to [ arhaijan and Europesn Russis)
Counties  Country profix UG allocated to [ onia and European Russia)
Counties  Country profix RF sllacated to [ 54 snd 075 (Europosn Riosis ond Goorgis)
Counties Country profix HY allocated to [
) Counties Country prefix BL ellocated to D
Countiws  Country prefix WH7 allocated to
" Country prafix BHM7 allocatad ta
Country prafiz AHT allocated ta
11708700 Counties Country prefix EX ollocated to b
Counties  Country prefix FM sllocated to [
Counties \umu,' prefix U sllocated to OO
Counties  Country prafix VESYJ allocated to OXOC 036 and 1
Countiws  Country prefiz U0 allucated to O
Countias Country prafix RO allocatad ta DXOC
Counties  Country prefiz AHD allocated to DXRCC nnq and 5
Cauntins  Country profiz FHB allocated ta 5
Counties  Country prefix EY allocated to [
) Counties Country prefix BRI sllocated to O
Counties Country prefix UH ellocated to D
Counties  Country prefix EZ allocated to [
Countiems  Country prafix R4 allocated ta [
Counties  Country prefix UB sllacatad to [
Cauntins  Country profix EM allacated ta [
Counties  Country profix EN sllocated to [
Counties Country profix E0 allocated to [
Countiws  Country prefiz UL ellocated to D
Counties Country prefix Rl allocated to [
0 Countias Country prafix UL allocated ta [ D 13 .
11:00:00 Counties Country prefiz UM allocated te DXCC 135 and 282 (Kyrgyzsten and Uzhekistan)

33 (Iran and Iraq)
30 (European Russia end Kazakhstan)

110 and 138 [(Hawaii and Rure 1.)

110 and 138 [Mawaii and Fura 1.)

and 130 {Hawaii and Rure 1.}

ropean Russia end Byrgvzsten)

oan Russis end Eyrayzsten)
zakhstan and Latvis)

{Cocos-Reeling Is. and Lord Howe 1.)
hstan and Maldavia)

pean Fussia and Moldavia)
[American Samca and Swains Is. )
{AmoTicen Semos and Swains Is.)
(Europesn Russis and Tejikistan)
ropean Russia end Tajikistan)
{European Russia and Turksenistan)
ropwan Russia and Turksenistan)
ropean Russia and Turkmenistan)
ropenn Russia snd Ukraine)
ropean Russia and Ukraine)
roposn Russia snd Ukraine)
ropesn Russia end Ukraine)
ropwan Russia end Uzbekists
ropean RIISG!Q and

100 General Loading layout from C:“Docunents and Settings Simon“Application Data~Simon Erown, HESDEVHRE

LFT Driver Imitislising parallel port driver
LFT Dra Service hwinterface already exists
LFT Driver The sArvice Iwinterface already started

Use the Text Viewer option to display the logfile in your default text program
(usually this is Notepad) from where you can save the logfile as a file on your
hard disk.

Options

Appearance

General

230

Select Appearance from the Tools menu.

Skin

As you have already seen in other Ham Radio Deluxe programs you can select a
skin and display theme. Select Appearance from the Tools menu top display the
Skin and Theme windows.

Image

Two images are included as resources in the executable file:
* NASA’s blue marble and
* David Taylor’s WXtrack.

You can select an image from a file on your computer; a good site for maps is
http://flatplanet.sourceforge.net/maps/ with many great options.

Select High quality for image scaling unless you have a very low power CPU,
normally CPU usage will not be a big problem. The quality is noticeable when
zooming.

Select Options from the Tools menu or press the Options toolbar button to display
the general options:

Select Options from the Tools menu or press the Options button in the main tool-
bar.

Ham Radio Deluxe
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Your Information
You must enter your locator in this window so that the program can correctly

compute bearings.
E
Options
rour Information | Image  Parallel Pors
Location
Locator: JNABFT
or enter direct
Latitude: |46 * |48 m |45 S Mo

Longitude: |4 = N7 m 24 5 W. |=

Parallel Ports
Use this window to configure your parallel ports if you are using and older rotator
controller with a parallel port connection.

=

Options
“aur Infarmation  Image | Farallel Fors

Fort Address

Ham Radio Deluxe 231
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Command Tester

Appendix A

Command Tester

Introduction

Starting

Ham Radio Deluxe

Too Many Radios

In a project like Ham Radio Deluxe it is not always possible for the developers to
have every radio available for their own use: it’s very expensive and takes up too
much room.

This is where the user community helps - by using the Command Tester individ-
ual commands are tested by the users of Ham Radio Deluxe and the results sent to
the developers as a text file in a standard format.

Very often the problem is either determining the data returned for the various
mode / filter / frequency combinations supported by a rig or working out how to
set a rig option.

The handbooks supplied by manufacturers can be wrong or just not contain
enough information to successfully implement a command.

Data Formats

There are major differences in the formats selected by the manufacturers whose
radios are supported by Ham Radio Deluxe.

The Command Tester supports all necessary formats for the radio manufacturers
supported by Ham Radio Deluxe.

Command Types
There are two types of command — Get and Set.

Xipuaddy

* A Get command returns an item of information, for example the VFO
frequency or mode.

* A Set command changes a rig setting, typically the frequency or mode.
Command Tester supports both Get and Set commands.

To start the Command Tester:

* Make sure you have not connected to a radio with Ham Radio Deluxe if you
will be using the same COM port for the Command Tester. If you have a
radio connection then you must disconnect using the Disconnect option in
the File menu.

* Select Command Tester from the 7ools menu.
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Connect

General
Options

236
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B CAT Command Tester E\
Connection
USE THIS DISPLAY AT YOUR OWN A
ICOM CHY v [COM1 | (19200 v |EH Conneat RISK
[Jcts [JoTR [IRTS This display is used to test
CAT commands cutside of the
main Ham Radio Deluxe
Cormmand framewark. The results can be

saved to & text file for
later analysis.

Connection

Select the type of command to
be sent, Elecraft, ICOM CI-V,
Kenwood, Ten Tec or Yaesu.

@ Help ] [ Close -

Title Sent Received

To connect to your radio you must select:

COM port where you have connected the interface cable to the radio,

The baud rate (COM port speed). If you are not sure of the correct speed
consult your radio manual.

CTS used for flow control, specifies whether the CTS (clear-to- send) signal
is monitored for output flow control. Used by Kenwood.

DTR used either for flow control or to provide power for the CAT interface.
This depends on the manufacturer’s protocol and your CAT interface.

RTS used either for flow control or to provide power for the CAT interface.
This depends on the manufacturer’ protocol and your CAT interface.

Then press Connect.

When you press Connect a warning message is displayed. Using incorrect
commands can confuse some radios, so if you are not sure what you are doing
now is the time to leave Command Tester.

'§ Sending invalid commands can result in loss of stored data and £ or require you to reset your radio, Use this display

at your own risk, Simon Brown is not liable for any damage caused.

Continue 7

Yes I | Mo

7 Press Yes to continue.

These options are common to all formats.

Send — sends a command to the radio.
Erase — clears the contents of the results window.

Save — saves the contents of the results to a file in ASCII format. You can
send the contents of this file by email to help the developers of ham Radio
Deluxe.

Help — pressing help displays the contents of the small help window as a text
file using Notepad.

Close — closes the Command Tester. If there are entries in the results
window you are prompted to save them first.

Ham Radio Deluxe
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Results

Platforms

Ham Radio Deluxe

Command Tester

The results are shown in the bottom half of the Command Tester window.

e Title — as entered in the Title: field.

* Send — the command sent to the rig, shown in ASCII and/or Hex as
appropriate.

* Received — the received data, shown in ASCII and/or Hex as appropriate.
Examples of Ham Radio Deluxe use with various platforms is shown here.

Elecraft

The Elecraft protocol uses ASCII characters; it appears to be based more-or-less
on the Kenwood protocol. Refer to the ,,Elecraft KIO2 Programmer*s Reference™
for full information.

The data sent and received is always shown in ASCII (text) that makes debugging
relatively easy.

If you select Show hex output the returned data is also shown in hexadecimal (see
the Change mode to RTTY below).

When a Set command is sent — for example MDG6; to set the mode to RTTY there
is no response from the rig, so instead MD6;MD; is sent — set the mode to RTTY
(MD6;) and then read the mode (MD;) — this way there is always returned data.

CAT Command Tester
bonneston TSE THIS DISPLAY AT YOUR OWH |
COM2 «||4800 | CTS [ DTR [ RTS Connect RISK 12| >
This display is used to test CAT
Cormpany: Kerwood - commands outside of the main Ham U
Radio Deluze framework. The
Title: [Change mode 1o ATTY, read mode 4@ Shows hies outpul results can be =aved to a text O
file for later analysis.
Cind: [MDE : MD : + |none ~| D
Connection 3
/it for rx terminater. | ; j' The logic and fields are the
same 2= those in the main HRD Q—
C i d —
P Send I% Erase I Save I € Help I Close CREGRS RLACCH P X
Title ‘Sent ‘Recelved
Read VFO A [OK] FA: [OK] FADOOO7035000;
Read mode [OK] MD: [OK] MD1:
Read S-meter [OK] SH: [OK] SHOOOO;
Change mode to RTTY. read mode [OK] MD&:MD: [OK] MD&:

Change mode to RTTY., read mode (hex) [OK] MDE;MD; [OK] <0=z4D><0=xdd><0x365<0=3E>

In the Change mode to RTTY example above the returned string is shown in both
ASCII and hexadecimal because the Show hex output option was selected for this
command.

Fields

» Title — a description of the command you are testing, for example “Read
Frequency” or “read Mode”. Mandatory
*  Cmd —the ASCII string sent to the rig. Elecraft strings are terminated with a

2

*  Wait for rx terminator — when reading the response read characters from the
rig until this character is returned or a timeout occurs.
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Examples
[Test Description
Read Command is FA; returned data format is FA + 11 digits + ;.
Frequency | . EA00007035000;
Frequency is 7.035.000 MHz.
Read Mode |Command is MD; returned data format is MD + 1 digit + ;.

- MDI;
(1=LSB, 2=USB, 3=CW, 6=RTTY, 7=CW-REV, 9=RTTY-REV)

Read S-Meter

Command is SM; returned data format is SM + 4 digits + ;.

+ SMO0000;
Returned value is in the range 0000 to 0015.

ICOM CI-V
The example below is uses an IC-7800 with:

* From: (controller address) EO (personal computer, the default value),

* To: (CI-V address) 6A (the default for the IC-703). Refer to your ICOM
radio manual for the correct CI-V address for your rig.

The data received from the radio is always shown in hexadecimal.

£ CAT Command Tester @

Connection USE THIS DISPLAY AT YOUR OWl #

RISK

This display is used to test
CAT commands cutside of the
main Ham Radio Deluxe
framework. The results can be
saved to a text file for
later analysis.

Carmmand

Title: |Read S-Meter

Connection

From: EO To: 6A Cmd: | 15 Sub: 02

Select the type of command to
be sent, Elecraft, ICOM CI-V,
Kenwood, Ten Tec or Yaesu.

Data:

> Send ‘ [N Erase ] [ Save ] [K_)) Help ] [ Close b
Title Sent Received
Connected
Read Freguency [0K] FE FE EO0 ba 03 [OK] FE FE EO 6A 03 90 66 01 14 00 FD
Read Mode [OK] FE FE EO 6& 04 [OK] FE FE EO0 6A 04 03 01 FD
Read S-Meter [OK] FE FE EO &A 15 02 [OK] FE FE EO0O 6A 15 02 00 02 FD
Fields
[Field |Description Status
Title |a description of the command you are testing, |Mandatory
for example “Read Frequency” or “read
Mode™.
From |controller*s default address. Enter EO (Personal | Mandatory
Computer).
To transceiver”s default address, the IC-703 uses |Mandatory
68. The address used by your radio is found in
the user manual.
Cmd |command number (refer to the radio Mandatory
handbook).
Sub Sub command number (refer to the radio Optional
handbook). If there is no sub command then
this field must be left empty.
Data  |if the command supplies data (for example If there is no data for the
setting a new frequency or mode) then enter the |command then these fields
values in these fields. must be left empty.
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Examples

Command Tester

These examples show a CI-V address of 6A, the default for the IC-7800. Change

this to the CI-V address assigned to your radio.

[Test Description

Frequency empty.
The returned data is:

* FE FE (preamble)

* EO (Controller address)

* 6A (IC-7800 CI-V address)

* 03 (Command number)

* 893806 07 00 (frequency in BCD format)
* FD (end of message)

Read Command is 03, no sub command or data; these fields must be left

must be left empty.
The returned data is:

* FE FE (preamble)

* EO (Controller address)

* 6A (IC-7800 CI-V address)
* 04 (Command number)

* 0001 (mode)

* FD (end of message)

Read Mode |Read ModeCommand is 04, no sub command or data; these fields

must be left empty.
The returned data is:

* FE FE (preamble)

* EO (Controller address)

* 6A (IC-7800 CI-V address)
* 15 (Command number)

* 02 (Sub command number)
* 01 09 (s-meter value)

* FD (end of message)

Read S-Meter|Command is 15, sub command is 02. There is no data; these fields

Mode / Filter

A common problem is determining the data returned for the possible mode and

filter combinations.

To list all combinations follow the following steps for each mode and filter com-

bination:

1 Select the Mode and Filter on your rig using the rig buttons and controls.

2 Enter a value in the Command Tester Title field which corresponds to the
mode and filter selected in 1 above, for example Mode = USB, Filter =

Wide.

3 Enter a command of 04; clear the sub command and data fields.

4 Press Send.

When you have finished press Save to save the contents of the Results window to
a file which you can forward to the Ham Radio Deluxe development team.

Other

Follow the logic in Mode / Filter above for other commands which you want to

investigate:
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1 Select the option on your rig using the rig buttons and controls.

2 Enter a value in the Command Tester Title field that corresponds to the
option you are investigating.

3 Referring to your rig”s handbook enter the command, sub command and

data value as appropriate to read the rig"s current value or set a new value. If
there is no sub command or data then these fields must be left empty.

4 Press Send.

Yaesu

Starting with the FTDX-9000 Yaesu has changed the CAT protocol to one very
similar to that used by Kenwood. So if you are fortunate enough to have the
FTDX-9000 please use the Kenwood commands.

The example below uses the FT-817. The data received from the radio is always
shown in hexadecimal. The overall format of Yaesu commands is always P1 — P4
+ OpCode, the actual commands and the data returned from the rig depends on the
model and also on the EPROM revision level.

Some commands do not require specific values for P1 — P4, it is recommended
that is a value is not specified in the radio handbook then you enter 00, this is the
approach taken in Ham Radio Deluxe.

Be aware that there are many errors in the Yaesu documentation, so the data

returned may not agree with the handbook and the radio”s current settings.

B CAT Command Tester x|
i~ Connection
USE THIS DISPLAY AT =~
comMl w3400 +|[ CTS [ DTR [ RTS Connect YOUR OWH RISK

This display is used
to test CAT commands
outside of the main

Title: IReadTXStatus Ham Radio Deluze
framework. The

- (0D . (00 . (oo . oo |F7 results can he saved
Fi: F2: Fi: F4: Opcode: to a text file Por

later analysis.

- Company, raesu Jad |

Connsction

> Sod % Emse @ sme [@ bep | [ o || o
Title | Sent [Received |

Connected
RFead Freguency & Mode [OK] 00 00 00 00 03 ([OK] 00 35 78 15 00

Read BX Status [OK] 00 00 00 0o E7 [0E] OO
Read TX Status [OK] 00 00 00 00 F7 [0K] FF
Fields
Field Description Status
Title a description of the command you are Mandatory
testing, for example “Read Frequency” or
“read Mode”.

P1 —P4 |cthe command parameters. Not all commands require

parameters; it is recommended
that parameters that can be set
to any value be set to 00. Fields

left empty are set to 00.
OpCode [the instruction OpCode. Mandatory
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Examples
[Test Description
Read The OpCode is 03, P1-P4 can have any value, in this example they

Frequency |are set to 00.

and Mode « P1:00 P2: 00 P3: 00 P4: 00 OpCode: 03
The format of the returned data is 5 bytes, the first four containing the
frequency in binary coded decimal followed by the mode.

The returned value is 00 35 78 15 00 which corresponds to a
frequency (00 35 78 15) of 51.875.300 and a mode (00) of LSB.

Read RX The opcode is E7, P1-P4 can have any value, in this example they are
Status set to 00.

* P1: 00 P2: 00 P3: 00 P4: 00 OpCode: E7
The format of the returned data is 1 byte.

The returned value is 00.
Read TX The OpCode is F7, P1-P4 can have any value, in this example they
status are set to 00.

* P1:00 P2: 00 P3: 00 P4: 00 OpCode: F7
The format of the returned data is 1 byte.

The returned value is FF (not in TX mode).

Other Commands
For the commands you want to investigate:

1 Select the option on your rig using the rig buttons and controls.

2 Enter a value in the Command Tester Title field that corresponds to the
option you are investigating.

3 Referring to your rig™s handbook enter the P1 — P4 parameters and OpCode

as appropriate to read the rig™s current value or set a new value. If there are
no values specified for P1 — P4 then enter 00 in these fields.

4 Press Send.

Portmon

Introduction

Ham Radio Deluxe

This excellent utility for monitoring COM port activity can be downloaded from
http.//www.sysinternals.com/.

Quoting the Sys internals website: “Portmon is a utility that monitors and displays
all serial and parallel port activity on a system. It has advanced filtering and
search capabilities that make it a powerful tool for exploring the way Windows
works, seeing how applications use ports, or tracking down problems in system or
application configurations.

Portmon works on NT 4.0, Win2K, XP and Server 2003, Windows 95 and Win-
dows 98.

It is often useful to run Portmon when unexpected results are returned from a
radio (or other device such as a rotator or keyer).

The Steps:

1 Close any programs connected to your radio or device being interrogated.
2 Start Portmon.exe
3 Make sure these options are set:
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Menu Option State / Comment
Options Show Time ON
Options Show HEX ON if ICOM, Yaesu or TenTec

OFF if Elecraft, Kenwood
ON if you are not sure (I read hex)

Options Clock Time OFF
Computer |Select your local computer
Capture Ports The COM port where you have

connected the interface to your radio,
select only one COM port to avoid
confusion.

Capture Capture Events ON

4 Start Ham Radio Deluxe then connect to your radio.

5 Let Ham Radio Deluxe run for about 60 seconds while you perform your
tests.

6 Stop Ham Radio Deluxe (File menu: Disconnect).
In Portmon set the Capture: Capture Events option to OFF.

8 Save the logfile to disk, put into a zip file if possible and send to
mailto:simon@hb9drv.ch .

Sample Log For this example the Process and Port columns are not shown to save space. The
log shows the startup for an IC-7800, results are in Hex. The Time for each com-
mand is shown which helps detect timeouts.

# |Time | Request Result | Other

o 0.00005929 IRP_MJ_CREATE SUCCESS Options: Open

1 0.00000167 IOCTL_SERIAL_SET QUEUE_SIZE  SUCCESE  InBize: 1024 OutSize: 1024

2 0.00000341 IOCTL_SERIAL_PURGE SUCCESS  Purge: TXABORT RXABORT TXCLEAR RXCLEAR
3 0.00000261 TOCTL_SERIAL_GET_BAUD_RATE SUCCESS

4 0.00000123 IOCTL_SERIAL_GET_LIWE_CONTROL SUCCESS

5 0.00000092 IOCTL_SERIAL_GET CHARS SUCCESS

6 0.00000085 IOCTL_SERIAL_GET_HAWDFLOW SUCCESS

7 0.00000903 IOCTL_SERIAL_SET_BAUD_RATE SUCCESS Rate: 19200

8 0.00000479 IOCTL_SERIAL_SET_RTS SUCCESS

9 0.00000371 IOCTL_SERIAL_SET_DTR SUCCESS

10 0.00000278 IOCTL_SERIAL_SET LINWE CONTROL SUCCESS  StopBits: 1 Parity: NOMNE WordLength: 8
11 0.00000118 IOCTL_SERIAL_SET_CHAR SUCCESS  EOF:0 ERR:3f BRE:3f EVI:0 X0M:11 XOFF:13
12 0.00000257 IOCTL_SERIAL_SET_HAWDFLOW SUCCESS Shake:1 Replace:40 XonLimit:341 XoffLimit:341
13 0.00000085 IOCTL_SERIAL_SET_TIMEOUTS SUCCESS  RI:SO0 RM:250 RC:250 WM:250 WC:250

14 0.00000421 IOCTL_SERIAL_SET_DTR SUCCESS

15 0.00000396 IOCTL_SERIAL_SET_RTS SUCCESS

16 0.00000200 IOCTL_SERIAL_SET WATIT MASK SUCCESS Mask: RXCHAR TXEMPTY CTS DSR RLSD BRE RING
17 0.00000270 IOCTL_SERIAL_PURGE SUCCESS  Purge: TXABORT RXABORT THCLEAR RXCLEAR
18 0.00002902 IRP_MJ_WRITE SUCCESS Length 7: FE FE 6A ED 19 00 FD

19 0.00576019 IRP_MJ_READ SUCCESE  Length 1: FE

20 0.00000294 IRP_MJ_READ SUCCESS  Length 1: FE

21 0.00000237 IRP_MJ_READ SUCCESS Length 1: 6A

22 0.00000230 IRP_MJ_READ SUCCESS  Length 1: EO

23 0.00000228 IRP_MJI_READ SUCCESS Length 1: 19

24 0.00000231 IRP_MJ_READ SUCCESE  Length 1: 00

25 0.00000229 IRP_MJI_READ SUCCESS Length 1: FD

26 0.01237115 IRP_MJ READ SUCCESS  Length 1: FE

27 0.00000319 IRP_MJ_READ SUCCESS  Length 1: FE

28 0.00000233 IRP_MJ_READ SUCCESS  Length 1: EO

29 0.00000226 IRP_MJ_READ SUCCESS  Length 1: 6A

30 0.00000232 IRP_MJI_READ SUCCESS Length 1: 19

31 0.00000229 IRP_MJ_READ SUCCESE  Length 1: 00

32 0.00000229 IRP_MJT_READ SUCCESS Length 1: AA

33 0.00000231 IRP_MJ_READ SUCCESE  Length 1: FD

34 0.00002705 IRP_MI_WRITE SUCCESS Length 6: FE FE 6A ED 03 FD

35 0.00524006 IRP_MJ READ SUCCESS  Length 1: FE

36 0.00000282 IRP_MJ_READ SUCCESS  Length 1: FE

37 0.00000228 IRP_MJ_READ SUCCESS  Length 1: 6A

38 0.00000234 IRP_MJ_READ SUCCESS  Length 1: EO

39 0.00000228 IRP_MJT_READ SUCCESS Length 1: 03

40 0.00000237 IRP_MJ_READ SUCCESE  Length 1: FD

41 0.01239791 IRP_MIJT_READ SUCCESS Length 1: FE

42 0.00000308 IRP_MJ_READ SUCCESS  Length 1: FE

43 0.00000231 IRP_MJI_READ SUCCESS Length 1: EO

44 0.00000231 IRP_MJ READ SUCCESS  Length 1: 6A

45 0.00000229 IRP_MJ_READ SUCCESS  Length 1: 03

46 0.00000230 IRP_MJI_READ SUCCESS Length 1: 00

47 0.00000237 IRP_MJ_READ SUCCESS  Length 1: 00
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N8VB vCOM

N8VB vCOM

Introduction

Configuration

Ham Radio Deluxe

N8VB*“s vCOM driver creates up to ten sets of paired virtual COM ports; use
these like you would use a null-modem cable. Virtual null-modems are pure soft-
ware; no hardware is involved.

Note: vCOM is only supported on Windows 2000, and Windows XP.

When using the 3rd-party program support you must use a virtual null-modem
cable to connect Ham Radio Deluxe to the 3rd-party program. Ham Radio Deluxe
opens one end of the virtual cable; the 3rd-party program opens the other.

Virtual null-modems are also used in the remote station support to connect Ham
Radio Deluxe to the Ham Radio Deluxe serial port client program — see Remote
Station Support on page 111.

NS8VB s vCOM driver is copyrighted 2005 by Philip A Covington NSVB.

The easiest way to install the N§VB vCOM driver is by selecting N§VB vCOM
Configuration from the Tools menu.

With this window you can install, update or remove the vVCOM driver.

NBVB vCOM Configuration 3]

Input Files

Select either the default files shipped with HRD o files from a kit downloaded from NEVE's
wehsite,

Driver [.SY5) D:yHam Radio\ReleasevCOMywCOM sys

Information (INF):  D:\Ham RadioReleasewCOMYNEYBWwCOM.int D

Driver name = NBYBVCOM, version = 0.0.0.226

Configuration

Selectthe number of paired ports and assigned COM port numbers. The COM port numbers
mustnot be in use by existing hardware or other non-vCOM drivers.

O1  |coMzn v |comz2t v Os
@2 |Ccomz2 v | [comz3 v O7
O3 O6
O4 O
Os O1o

I Load from Information (INF) file ]

Cancel

In the above example the driver version is 0.0.0.226 or build 266.

Input Files
The key files are:

*  Driver — vCOM.sys,

¢ Information — N8§VBvCOM.inf,

» Device console utility - devcon.exe (a command-line utility that acts as an
alternative to Device Manager).

These files are shipped in the vCOM sub-folder.
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(] To install a different version of the vCOM driver you must find the kit on
N8VB*s website, unpack it and select the information and device driver files.

Selects the default files shipped with Ham Radio Deluxe.

Ports

Select the number of paired ports (null-modem cables) to be created and the port
numbers assigned to the pairs. The port numbers must be unique; you must not
select a port number already assigned to a hardware device such as the COM port
on your computer.

If the vCOM driver is already installed the current values are read from the regis-
try, the key is:

HKEY_LOCAL_ MACHINE SYSTEM
CurrentControlSet
Enum
Root
MULTIPORTSERIAL
0000
Device Parameters

[ Losdiommomaiongneiie | Loads the default values from the currently select infor-
mation (.INF) file.

Installation
To install the driver a batch file (install.bat) is created which in turn uses
devcon.exe. A sample batch file is shown below:

PROMPT $G

co /D Civbocuments and settingshsimonhapplication pata’\simon Brown, HESDRW\Ham
Radio DeluxedwCoM_Temp

DIR

@ECHO T T
BECHD *
BECHD %  The N8VE wCoM driver will now be installed
BECHD *

BECHD *
BECHD *
BECHD ¥

devcon —install N8vBwCoM. inf nSwvhbvcom
PALISE

H
H
H
YOou must REBOOT your computer after the installation is complete %
H
H

BB B R R BB R BB N R BB W R BB W R R W R R R W R R R

The batch file, device console (devcon.exe), device driver (vCOM.sys) and infor-
mation file (.INF) are copied to a temporary folder. The BAT file is then run from
this folder.

When devcon starts you see a window similar to that below if you are using Win-
dows XP:

Hardware Installation

! 5 The software you are installing for this hardware:

MNEYE wCOM Virtual Serial Port Driver

has not passed Windows Logo testing to verify its compatibility with

Windows <F. (Tell me why this testing is important,)

Continuing your installation of this software may impair or
destabilize the correct operation of your system either
immediately or in the future. Microsoft strongly recommends
that you stop this installation now and contact the hardware
wvendor for software that has passed Windows Logo testing.

Continue Anywey H STOP Installation

Ham Radio Deluxe
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Press and the installation proceeds. A typical log is shown below:

CihDpocuments and Settingshsimondapplication patassimon Brown, HESDRV“Ham Radio D
eTuxe>PROMPT §3

>C0 /D Ciypocuments and Settings\simonhapplication DataZsimon Brown, HESDRVNHam
Radio DeluxedwCoM_Temp

>DIR
volume in drive C s System
volume Serial number is 307E-B730

Directory of C:\Documents and SettingshSimoniapplication Data’\simon Brown, HESD
RV Ham Radioc Deluxe'wComM_Temp

23/04/2006 20:38 <DIR>
23/04/2006 20:38 <DIR>

24,/03/2003 23:13 55,808 devcon.exe
24,/04 /2006 19:36 725 Install.bat
24,/04 /2006 19:36 3,937 N8VBwCOM. inf
23,04 /2006 21:11 696 Update. bat
09/07 /2005 13:05 19,456 wCOM. sy's

5 File(s) 80,622 hytes

2 Dirds) 9, 087,946,752 hytes free

The N8vE wCoM driver will now be dnstalled

¥ou must REBOOT your computer after the installation is complete

»devoon -install WBVEwCOM. inf nBvhwcom

Device node created. Install is complete when drivers are updated...

updating drivers for n8vbwcom from C:“Zoocuments and Settingshsimonmvapplication D
ata\simon Brown, HESDRVYHam Radio DeluxelwCom_TempyNSvEWCom, inf.

privers updated successtully.

>PAUSE
Press any key to continue . . .|

After installing you must reboot your computer.

Update and Remove follow the same logic as installation using a custom BAT file
and devcon.exe.

Auxiliary Switching

uaddy

Introduction A standard PC used to come equipped with an 8-bit parallel port that can be used o
to switch auxiliary equipment such as antennas, bandpass filters and power ampli- >3
fiers. If yours does not, you can obtain an online or at a well equipped computer
store a parallel port card that you can plug into your computer. This expansion
card will not work on a laptop computer.

Ham Radio Deluxe supports the parallel port via fully configurable manager and
monitor displays.

Typical uses of this option are to switch antennas, either automatically as the fre-
quency changes, or by selecting an option from the Parallel Port pane of the

Selection window.

Technology The parallel port sends eight bits at a time. The layout of the parallel port pins is
shown below.

@U 91'2 911 @10 @9 ®3 ®7 ®6 ®5 @4 @3 @2 1

25 24 23 22 21 20 i 18 17 16 915 14

The data pins are shown in red; DO is pin 2, D7 is pin 9.

To indicate that a bit has a value of 1, a charge of 5 volts is sent through the cor-
rect pin. No charge on a pin indicates a value of 0. This is a simple but highly
effective way to transmit digital information over an analog cable in real-time.
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The manager window is invoked from the 7ools > Parallel Port > Manager

menu.
Parallel Port Manager * ‘ ﬂ
File Edit
= | BE %+ ¥
Enter one or more definitions in the list below. When the frequency changes Ham Radio
Deluxe sets the port to the value for the first enabled entry in the listwhich matches the
new frequency. If there is no match then the portis not changed.
Port Address Yarious
LFT1: DAutD—Switch as frequency changes i
0278 - Dlnclude in selection window (requires restar) l
03BC -
Title From Tc Port DV D& I I
[¥] Fhombic 1.800.000 2,000,000 LPTL 1 i) ||
V] Log Periscdie 3.500.000 3.800.000 LPTL © 1
[¥]5 Elem Yagi T.000.,000 T.030.000 LPTL O i) |
[V Miracle Whip 14.000.000 14.350.000 LPTL O 0
[¥]7 Turn Helix 21.000.000 21.450.000 LPTL © i)
[¥] a5RV 28.000.000 320.000.000 LPTL O 0 I
< | n 3
I [ 0K, H Cancel ] |
— — — 2y
Definitions

Each definition consists of:

» [X] Enabled selection — if not checked then the definition is ignored when
Ham Radio Deluxe detects a new frequency. The definition is still shown in
the selection window if this option is enabled.

» Title —a description of the antenna or component that will be switched when

the entry is selected.

* From — the lower end of the frequency range.

* To — the upper end of the frequency range.

* Port - the LPT port to be switched by the definition.

* DO0-D7 — the parallel port data bit settings, each bit is either 1 (on) or
0 (off). DO is pin 2, D7 is pin 9.

Port Address

The default port addresses for LPT1, LPT2 and LPT3 are 0378, 0278 and 03BC
respectively. If your computer has a different configuration just select the address

that corresponds to the port.

You will find the port address via the Device Manager settings display located in
the System control panel applet.
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System Properties.

| General | Computer Name | Hardware | Advanced | Automatic Updates | Remate |

Device Manager

The Device Manager lists all the hardware devices installed on
= your computer, Use the Device Manager to change the propeties
of any device

Device Manager ]

File Action “iew Help
co HES 2 A %D
# @ Display adapters

Flh DVD/CD-ROM drives
#@ Floppy disk controllers | General | Part Settings | Driver | Details | Pesources |

- Floppry disk drives

=8 Human Interface Devices (g ECFP Printer Port (LFT1)
#-24 IDE ATAJATAPL controlers

- [EEE 1394 Bus host contr

ECP Printer Port (LPT1) Properties

-2 Keyboards Resource settings:

-1 Mice and other pointing def Fesource type Setiing
=8 Monitors WO Range  0378-037F
-5 MUIG-port serial adapters /0 Range 0775-077B
=88 Network adapters W DA 03

= ‘g Other devices

= Ports (COM & LPT)

¥ communications Port ({
. ECP Printer Port (LFT1

=R Processors

-4 SBP2 [EEE 1394 Devices Use automatic settings Change Seting

42 SCSI and RAID controllers

=@ Sound, video and game o

e Storage volumes Mo conflicts.

Conflicting device list:

[ oK ] l Cancel

In the Windows XP example above the base address is 0378.

Xlpuaddy

Various
The options are:

» Auto-switch: as the frequency displayed by Ham Radio Deluxe changes a
lookup is made against the parallel port definitions and the parallel port
switched to the configuration for the first definition in the list that matches
the new frequency.

+ Selection window: displays a Parallel Port pane in the main Ham Radio
Deluxe selection window. See Selection Window on page 45.
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Creating or Modifying Definitions
To create a new definition:
1 Select Edit > New from the Manager menu bar.

Parallel Port Editor X
—
Title:
Enahle
: From: 0.000.000 kHz .
| To: 0,000,000 MHz
| Part @ LPTT LFTz (ILPT3

pD7-po: D7) D[] D5[C] D4[C]
D3] Dz[] D1 [C] Dol

[ Ok ] ’ Cancel ]

Enter a title for the definition.
Enter the frequency range for the definition.
Choose the port if you have more than one.

DN B~ W N

Choose a pin number. Make sure you are not using one that is already
defined with another definition unless you have a need to.

6 Click on OK to save your new definition.

The steps to modify a definition are the same except that you must first highlight
the definition and then select Edit > Modify from the manager menu bar.

Monitor The monitor window is started from the Tools > Parallel Port > Monitor menu.
Parallel Port Monitor (e = o S
Port (@ LPTI LFT?2 LFT3

D7 D D& D4 D3 D2 D1 DO

O D0 DODOOOO O

Definition: ’ vl

The monitor:
» shows the current state of the data pins for a selected parallel port,

» allows you to select a definition, and
» toggle the data pins directly.

The Definition field shows the definition that matches the current pin
selection (if any).

K1EL WinKey

Introduction “WinKey brings high functionality, fully featured Morse keying to logging appli-
cations. Although designed for Windows-based software implementation,
WinKey can add value to all logging programs regardless of operating system or
platform. Can also be used as a stand-alone keyer.”
Source: http.//www.klel.com/
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Main Window

Options

Ham Radio Deluxe

K1EL WinKey

A lot of the description of the WinKey support is taken from the WinKey docu-

mentation, copyright K1EL.

(Photos from Attp./www.klel.com/)

K1EL’s WinKey is an excellent computer controllable keyer solution. It supports
everything a CW enthusiast could want. Many computer programs support
WinKey; here is a description of the Ham Radio Deluxe support.
You will need a standard 9-pin serial cable (not NULL-modem).

Select KIEL WinKey from the Tools menu, the WinKey window is displayed.

.J

12wpm | # | Macro (Crl+#)
—w |1 CO
[IRepeat |55 2 2 ‘\Weather
& F3

- (;-

HI BARRY THANMES FOR COMING BACK TO MY CALL
UR RST 599 599 IN SUNNY LaaY]

\4

Here the user is sending text at 12 wpm — the speed is adjusted with the sliderin O
the top-left. If Repeat is checked the text is retransmitted after a user- configured
value between 2 to 60 seconds, in this example 5 seconds.

Text is entered using the keyboard; only the allowable CW characters can be

entered.

Macros are selected by double-clicking on an entry in the macros list or by using
an accelerator key combination such as Ctrl+1.

Press F2 to start sending.

12wpm | # Macro (Ctl+#)

== |1 CO
[repest |55 2 2 ‘Weather
Sending. Full

HE-EARRY—THARIE—FOR—COMIMG EACK TO- MY CALL
URE R3T 599 59% IN SLMNY LAAX

HI BARRY THAME

Characters sent to the keyer are marked with the strike through effect. Characters
sent by the keyer to the radio are displayed at the bottom of the window.
Press F1 to mark sent text as unsent, F3 to erase the contents of the window.

Press the Options button (F8) to display the Options window. As an intelligent
owner of the WinKey you will have studied the available literature, so some of the
information here should be obvious. But in case you have forgotten something...
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Keyer

WinKey EJ

Keyer | Speeds | Options | Pin Config | Macros | Lodfile | Help

Kewer Mode “anous
Ultirmatic [Jautospace
(@ Marmal []Contest spacing
O Ultimatic (O Dah priority [v|Paddle echoback
(O Bug () Dit priority [v]Paddle watchdog

[]5wap paddles

Pot |COM1 v Serial echaback

Select the type of keyer and the COM port to which the keyer is connected.
When you press Connect the keyer is initialized and an echo-back test performed.
The test must succeed for the connection to stay open. This ensures that you have
not accidentally connected to another device such as a rotator, which may have a
fit if driven by the WinKey protocol!

A sample log for a successful connect:

o~ +
| Time | Text
___________________________________________________________________________ T

09:58:02 Connhecting to COM1

09:58:02 Setting buffer sizes to 2048, 2048

09:58:02 Setting speed to 1200,n,8,1

09:58:02 Setting timeouts

| | |
| | |
£ |
I 09:58:02 I Setting DTR, clearing RTS I
| | |
| | |

09:58:04 Echoback test, sent "HRD BY HBY9DRV", received "HRD BY HBY9DRV"
09:58:04 Firmware reyision 10
09:58:04 Starting read thread
B e e e et +
Autospace

If you pause for more than one dit time between a dit or dah WinKey will interpret
this as a letter-space and will not send the next dit or dah until full letter-space
time has been met.

The normal letter-space is 3 dit spaces. WinKey has a paddle event memory so
that you can enter dits or dahs during the inter-letter space and WinKey will send
them as they were entered. With a little practice, autospace will help you to send
near perfect Morse.

Contest Spacing

Reduces the wordspace time by one dit. Instead of 7 dits per wordspace, contest
spacing selects six dits per wordspace.

Paddle Echoback

When enabled all characters entered on the paddles will be echoed back to the
host. From the host perspective paddle echo and serial echo are the same, in either
case the letter sent in Morse by WinKey is echoed back to the host. The echo
occurs after the letter has been completely sent.

Paddle Watchdog

The paddle watchdog counter disables the key output after 128 consecutive dits or
dahs. This is to guard against the paddles being accidentally keyed continuously.

Swap Paddles
Allows right- and left-handed operators to share the same keyer.
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Serial Echoback

Echo back is a feature that is included to allow a host application to stay exactly in
sync with Morse letters sent. When this mode is enabled all data taken out of the

serial buffer is sent to the host after it has been sent in Morse. This allows the host
to reconcile differences in timing introduced by WinKey*s internal 32-byte serial
buffer. Note that only letters, and not buffered commands with their parameters or
wordspaces, are echoed back to the host.

Speeds
WinKey E|
Keyer | Speeds | Options | Pin Config | Macros | Logfile | Help

Keyer min: : 1 0 wpm

Kesrer max: j 40 wpm

Speed potmin: J 10 wpam

Speed pot max: j A0 wprm []Track changes

Farmsworth: J 10 wpm [ ]Enahle

With Keyer minimum and Keyer maximum you set the range available in the
WinKey main window.

Similarly with Speed pot minimum and Speed pot maximum you set the range
available with the potentiometer mounted on the top of the WinKey enclosure.

Farnsworth speed is the speed at which characters are actually sent.
Options
WinKey @
Kever | Speeds | Options | Pin Config | Macros || Logfile | Help
1stextension: |0 ms iy “Weighting: J 50 %
Compensation: 0 ms i PTTLead: [} 0ms
Switchpoint: b0 % & PTT Tail: J Oms
Dit : Dah ratio:  [1:3.00 S i T
Sidetane: £ (-_3'10 C'133 (j"IBB C'zﬂ

(Fin & must be setto sidetone) wordspace before ending paddle inserion

These options define the shape of the transmitted signal.

Ist Extension

This addresses a problem often encountered when keying older transceivers that
have a slow break-in response. Due to a slow receive to transmit changeover time,
the first dit or dah of a letter sequence can be chopped and reduced in length. Add-
ing a fixed amount to the first element of a sequence can compensate for this. For
example, an R would be sent with the first dit elongated but the subsequent dah-
dit sent normally. The compensation amount is transceiver dependent and is gen-
erally independent of sending speed. Note though that this is usually only a
noticeable problem at higher CW speeds >25 WPM.

Compensation

This allows a fixed amount to be added to the length of all dits and dahs. QSK
keying on modern transceivers can cause shortening of the dit and dah elements
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that is especially noticeable at high speeds. WinKey allows the length of the dit
and dah elements to be increased uniformly to compensate for this. The adjust-
ments are made in units of one-millisecond steps. The maximum adjustment is
250 msecs.

Key compensation is very similar to Weighting in that any adjustment added to
the dits and dahs is subtracted from the spacing so the speed is not changed. The
difference between weighting and compensation is that compensation is indepen-
dent of speed, so if 10 msec of key compensation is selected 10 msec will be
always be added regardless of speed. So be careful at high speeds and large values
of key compensation, you may end up with no inter-element space.

Switchpoint

Controls when WinKey will start looking for a new paddle press after sensing the
current one. If there is not enough delay the keyer will send unwanted dits or dahs,
if there is too much delay it bogs you down because you can't get ahead of the
keyer. The default value is one dit time (50) and is adjustable in percent of a dit
time. Faster operators report a setting somewhat less than default is more pleas-
ing. If the paddle sensitivity is set to zero, dit and dah paddle memory is disabled.
The delay is calculated with this formula:

DELAY_TIME = (SWITCHPOINT * DIT_TIME)/50

where SWITCHPOINT is a value between 10 and 90.

Dit: Dah Ratio

Allows WinKey to deviate from the standard 1:3 ratio of dit/dah. The formula to
determine dah/dit ratio is:

DAH/DIT = 3.(nn/50)
A value of 50 selects 1:3, a value of 33 would select 1:2, and a value of 66 would
select 1:4. This causes an intentional distortion of the Morse waveform. Some
operators use this option to make their CW sound less “machine like”.

Weighting

This command allows a proportional amount to be either added or subtracted from
the length of all dits and dahs sent. A value of 50 selects no weighting adjustment.
Values less than 50 reduce weighting and values greater than 50 increase weight-
ing. Note that weighting does not affect sending speed because any increase in
keyed time is subtracted from spacing time. A reduction in weighting results in a
thinner sounding keying; increased weighting results in a heavier sound. Since
weighting tracks speed, a given weighting will sound the same at all speeds.

PPT Lead / PTT Tail

WinKey provides a transmitter PTT output that can be used to switch a transmitter
or linear amplifier over to transmit mode in advance of actual CW keying. You
have control over the time delay between when PTT is asserted and when CW
keying will start, this is lead-in. You also have control over how long the transmit-
ter will stay in transmit after keying has stopped; this is the tail delay.

Note: PTT pin 5 can be reconfigured as a sidetone output, see Sidetone Frequency
option.

Sidetone

Pin 5 can be configured to output a square wave sidetone by using the Set Pin 5
Mode option. When sidetone is enabled, pin 5 functions as a sidetone square wave
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output. The PTT delays still work as described by the Set PTT Lead/Tail Com-
mand, but a PTT output is not available.

Available sidetone frequencies are: 3759 Hz, 1879 Hz, 1252 Hz, 940 Hz, 752 Hz,
625 Hz, 535 Hz, 469 Hz, 417 Hz, 375 Hz.

Pin Config
WinKey [5__<|
Keyver | Speeds | Options | Fin Config | Macros | Logfile | Help
Cutput Fin

()Fin & = Sidetone

(C)Pin & = Deassened, Pin 3 = Key output

(OPin & = Key output, Pin 3 = Deasserted
Determines how the output pins are mapped.
Macros

WinKey E|

Keyer | Speeds | Options PinConfig|MﬁCFDS|LogfiIe Help

Title Erase Value
ca Mo C(Q C0 CQ DE HBIDRW/F HBIDRW/P HEIDRW/P K K
Weather Mo Wi HERE SUN 402 MO WIND

Define an unlimited number of macros that can be selected in the WinKey main
window.

Xlpuaddy

Logfile

X

WinKey

Keyer | Speeds | Options | Pin Config Macros|LDgfi|B|Help

Time Text =
21:17:10 Connecting to COMI1

21:17:10 Betting buffer sizes to 2048, 2048

21:17:10 Betting speed to 1200,n.8,1

Setting timeouts

21:17:10 Betting DTE, clearing RTS B
21:17:13 Echoback test, sent HRD BY HBSDEV, receive.
| >

A AR

I Erase ] I Wiewer ] DIrace

To help diagnose problems use the Logfile window. The Viewer option displays
the contents of the window in your default text file (.txt) editor. If you check Trace
then all traffic over the COM port is logged.
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Help
WinKey g]
Keyer | Speeds | Options | Pin Config | Macros | Logfile | Help
Ham Radio Deluxe sLJpporTs the Winkey device
from K1EL - see hitp: e Klel.com . Winkey is a
RS-232 CW generator for Windows-based
applications.
Prosign Key Assignments
" ER / DN
Some basic help text; specifically the Prosign key assignments.
Prosign Assignments
" RR /" DN
$ SX : KN
" WG ; AA
( KN < AR
) KK = BT
+ AR > SK
- DU @ AC
Settings
Overview User settings are stored in the registry and in files in the user’s application- spe-
cific data folder.
Registry The registry key used for storing options in Ham Radio Deluxe is:
HKEY_CURRENT_USER Software
Amateur Radio
HamRad1oDe luxe
Options
The values in this key will not make much sense — they are used by Ham Radio
Deluxe to preserve settings such as window geometry (size, position) and the cur-
rent scheme.
The values in the key can be safely deleted at any time. Don’t change values with
a registry editor — you may cause unexpected problems for Ham Radio Deluxe!
Files Ham Radio Deluxe stores files in the folder defined by CSIDL APPDATA, this is

254

the file system directory that serves as a common repository for application-spe-
cific data. A typical path is:

C:\Documents and Settings\username\Application
Data\Simon Brown, HB9DRV\Ham Radio Deluxe.

You will not normally need to directly access the files in this folder.

[File Description

*.css Cascading style sheets, used by HTML export options — for
example in Logbook Analysis.

Ham Radio Deluxe Logbook database

Logbook.mdb

*.opt Optional schemes — see Schemes on page 29.
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[File Description
Ham Radio Deluxe Bands Band layouts
02.txt

Ham Radio Deluxe
Countries.txt

A default Log Windows country file

Ham Radio Deluxe Custom
Defs - <radio>.txt

Custom CAT commands for a specific radio — see CAT
Commands on page 103.

Ham Radio Deluxe Favorites
01.txt

See Favorites on page 69.

Ham Radio Deluxe Logbook
Analysis Defns.txt

TBA

Ham Radio Deluxe Macros -
TS-480.txt

Macro definitions — see Macros on page 103.

Ham Radio Deluxe Parallel
Port Defns.txt

Parallel port definitions — see Auxiliary Switching on page
53.

Ham Radio Deluxe Satellite

Definitions.txt

Used by Ground Control on page 133 — contains a list of
satellites and associated frequencies and modes.

The Archive option in the Tools menu takes a copy of the registry values and files
used by all Ham Radio Deluxe programs (Ham Radio Deluxe, PSK31 Deluxe,
Mapper) and copies them to another folder.

& Archive E|
Copy all HRD settings to the folder of wour choice
Fram: HRD Settings Falder
ChDocuments and Settings’, SimoniApplication Datal Simon Brown, HBIDRY
Ta: Archive Falder
UAHRD Archivet 31-Dec-2005 (-]
Status
Exporting registry
File ..: Registry Values HamRadioDeluxe Z005-12-30.r1e:
File ..: Registry Values Mapper 2005-1Z2-30.reg
File ..: Registry Values P3E31l Deluxze 2005-12-30.reg
Copving files
From ..: C:~Documents and Settings>Simon~Application I
To ....: U:~HRD Archive~31-Dec-2005
4 >
l Browse From ” Browse To ]
| Copy | ’ Cancel ]
D Select the destination folder
Browse the From folder
Browse the To folder
e 1 Start copying files and registry values.
255
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When you press Copy you see a DOS window appear briefly a few times. Ham
Radio Deluxe uses regedit /e to copy the registry values, this in turn causes the
DOS to appear.

To restore registry values just double-click on a .reg file. Windows will prompt
you to load the values into the registry.

Logbook Database

Introduction

Tables

256

The logbook uses a very simple Access database. Originally DAO 3.5 (Access 97)
was used as the programming interface; this has been replaced with ODBC in
early 2006 starting with version 3.3 build 984.

Apart from getting away from DAO and the need to install the DAO support (not
shipped with Windows) ODBC is needed for used of 64-bit Windows, as DAO is
not supported on 64-bit Windows.

The database structure is the same for DAO and ODBC. Each table contains an
auto-incrementing primary key.

To analyze the database yourself:

1 Start Microsoft Access,

2 Convert the database if necessary using the Convert Database option
selected from the Tools menu; do not overwrite the database!

3 Use the Analyzer> Documenter option selected from the Tools menu.
Notes:
E Do not use programs such as Microsoft Access to convert the database — or if
you do just make sure that you do not overwrite the database. If you convert

to a newer version of Access you may not be able to open the database with
Ham Radio Deluxe.

[G Take regular backups.

Bands

This table defines the frequency ranges for the ADIF bands, used when exporting
to ADIF.

Columns
[Name [Type [Size |
PrimaryKey |Long Integer |4
MinFreq Long Integer |4
MaxFreq Long Integer |4
Title Text 32
ADIF Text 32
Comment Text 64

Countries

The country list; used to lookup a country based on prefix, also to cross- reference
a country and DXCC number.
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Columns
[Name [Type [Size |
PrimaryKey |Long Integer (4
Country Text 64
DXCC Text 32
Comment Memo -
Prefix Memo -

Logbook

This table stores information for each QSO.

Columns
[Name [Type [Size |
PrimaryKey Long Integer |4
Created Date/Time 8
Modified Date/Time 8
Station Text 32
EndTime Date/Time 8
StartTime Date/Time 8
Remark Memo -
ReportRecv Text 32
ReportSent Text 32
BandMHz Text 32
Mode Text 32
Frequency Text 32
Locator Text 32
Country Text 64
DXCC Text 10
IOTA Text 10
QSLRecv Text 10
QSLSent Text 10

QSLRecvDate Date/Time 8
QSLSentDate Date/Time 8
eQSLRecv Text 10
eQSLSent Text 10
eQSLRecvDate | Date/Time 8
eQSLSentDate Date/Time 8

eQSLStatus Text 255
QSLVia Text 64
Name Text 128
Address Text 255
QTH Text 255
MyStation Text 128
MyOperator Text 32
MyOwner Text 32

Logbook Database
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Name Type Size
MyAntenna Text 128
MyCallsign Text 32
MyLocator Text 10
MyPower Text 32
MyName Text 32
MyCountry Text 64
MyStreet Text 64
MyCity Text 64
MyCounty Text 64
MyState Text 64
MyZip Text 20
MySig Text 32
MySigInfo Text 64
MyLatitude Text 12
MyLongitude Text 12
MyCqZone Text

MyltuZone Text

Mylota Text 10
Customl Text 64
Custom?2 Text 64
Custom3 Text 64
Custom4 Text 64
Custom5 Text 255
Custom6 Text 255
AntAz Text 3
AntEl Text 2
AntPath Text

SatName Text 32
SatMode Text 32
ContestCheck Text

ContestClass Text
ContestPrecedence | Text

ContestContest Text 64
LocationCounty | Text 64
LocationState Text 64
LocationContinent | Text 2
LocationArrlSect |Text 4
LocationCqZone |Text
LocationltuZone |Text
LocationDistance |Text 10
LocationLatitude |Text 12
LocationLongitude| Text 12
StationEmail Text 64
StationUrl Text 64
StationEquipment |Text 255

Chapter -
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[Name [Type [Size ]
StationAge Text 4
StationSig Text 32
StationSigInfo Text 64
StationTenTen Text 10
PropagationAlnde |Text 10
PropagationKInde |Text 10
PropagationMaxB | Text 10
PropagationNumB | Text 10
PropagationNumPi| Text 10
Modes
The supported modes, this list contains all modes supported by ADIF.
Columns
[Name [Type [Size]
PrimaryKey Long Integer |4
Title Text 32
ADIF Text 32
Comment Text 64
QRZ

When a QRZ lookup is made a copy of the returned data is stored in this table so 2>
that subsequent lookups are much faster. g
The fields correspond to the fields extracted from the returned QRZ data. CDD
Columns Q
P

[Name [Type [Size ]

PrimaryKey Long Integer |4
QRZUpdated Date/Time 8

QRZCallsign Text 255
QRZName Text 255
QRZAddrl1 Text 255
QRZAddr2 Text 255
QRZCountry Text 255
QRZGrid Text 255
QRZHomePage |Text 255
QRZQsIMgr Text 255
QRZLatitude Text 32
QRZLongi- | Text 32
ADIF

Ideally Ham Radio Deluxe’s logbook will support all ADIF fields. The table
below contains all ADIF fields as of ADIF spec 2.1.7 and the location in the Add/
Modify window. Grateful thanks to Dave, AA6YQ for maintaining order in the
Yahoo! ADIF group.
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This table is really a programmer’s checklist to ensure essential fields are sup-
ported. ADIF fields that have not yet been added have empty values in Ham
Radio Deluxe Field.

Antenna and Satellite are combined into one dialog.
For ADIF information: http://groups.yahoo.com/group/adifdev/files/ .

Ham Radio  |Ham Radio _ |ADIF Field
Deluxe Deluxe Field

Window

Antenna/ Azimuth ANT AZ
Antenna/ Elevation ANT EL
Antenna/ Mode SAT MODE
Antenna/ Name SAT NAME
Antenna/ Path ANT PATH
Contact 10-10 TEN_TEN
Contact Age AGE

Contact Email EMAIL
Contact Equipment RIG

Contact SIG SIG

Contact SIG info SIG_INFO
Contact URL WEB

Contest Check CHECK
Contest Class CLASS
Contest Contest CONTEST ID
Contest Precedence PRECEDENCE
Location ARRL sect ARRL SECT
Location Continent CONT
Location County CNTY
Location CQ zone CQz
Location Distance DISTANCE
Location ITU zone ITUZ
Location Latitude LAT
Location Longitude LON
Location State/province |STATE

Main Address ADDRESS
Main Band BAND

Main Cntry COUNTRY
Main Cntry (read- DXCC

Main End TIME_OFF
Main Freq FREQ

Main IOTA I0TA

Main Locator GRIDSQUARE
Main Mode MODE

Main Name NAME

Main QTH QTH

Main Remark COMMENT

Ham Radio Deluxe
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Ham Radio  |Ham Radio _ |ADIF Field
Deluxe Deluxe Field

Window

Main RST Recv RST RCVD
Main RST Sent RST SENT
Main Start QSO_DATE
Main Start TIME_ON

Main Station CALL

My Station City MY CITY

My Station Country MY _ COUNTRY
My Station County MY CNTY

My Station CQ zone MY CQ_ZONE
My Station Equipment MY RIG

My Station IOTA MY IOTA

My Station ITU zone MY _ITU ZONE
My Station Lat MY _LAT

My Station Locator MY _ GRIDSQUARE
My Station Lon MY LON

My Station Name MY NAME

My Station Operator call OPERATOR

My Station Owner call OWNER CALLSIGN
My Station Power TX PWR

My Station SIG MY SIG

My Station SIG info MY _SIG_INFO
My Station State MY STATE

My Station Street MY _STREET
My Station ZIP MY POSTAL CODE
Propagation A index A _INDEX
Propagation K index K _INDEX
Propagation Max bursts MAX BURSTS
Propagation MS shower MS SHOWER
Propagation Num bursts NR_BURSTS
Propagation Num pings NR_PINGS
Propagation Prop mode PROP_MODE
Propagation Solar flux SFI

QSL Info QSL Recv QSL RCVD
QSL Info QSL Recv QSLRDATE
QSL Info QSL Sent QSL_SENT
QSL Info QSL Sent QSLSDATE
QSL Info QSL Via QSL VIA
Depreciated OPERATOR
Depreciated VE PROV

In ADIF files PROGRAMID
In ADIF files PROGRAMVERSIO
t.b.a. BAND RX
t.b.a. FORCE_INIT
tb.a. FREQ RX

Logbook Database
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Ham Radio _ |Ham Radio __|ADIF Field ‘
Deluxe Deluxe Field
Window
t.b.a. GUEST_OP
t.b.a. NOTES
t.b.a. OWNER_CALLSIGN
t.b.a. PFX
t.b.a. PUBLIC KEY
t.b.a. QSL_RCVD _VIA
tb.a. QSL_SENT VIA
tb.a. QSLMSG
t.b.a. QSO_COMPLETE
t.b.a. QSO_RANDOM
t.b.a. RX_PWR
t.b.a. SRX
tb.a. SRX_STRING
t.b.a. STATION_CALLSIG
t.b.a. STX
t.b.a. STX STRING
t.b.a. SWL

Links

Ham Radio
Deluxe

Other Software

262

Homepage — http://hrd.ham-radio.ch/.

Forums — Attp://forums.ham-radio.ch/.

Yahoo! Mailing list — http.//groups.yahoo.com/group/ham-radio-deluxe/.

BV Software by DF3CN - http.//www.df3cb.com/ . Excellent QSL management
and label printing software.

DXLab by Dave Bernstein AA6YQ - http://www.gsl.net/dxlab.

IrfanView - http://www.irfanview.com/. Great image viewer and sound file player.
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Numerics
3rd-Party Programs 94

A
Activation Key 10
Add ADIF Record 90
Add Quick Save Entry 59
Adding A Logbook Entry 105
ADIF 259
Add Record 90
Logbook Table 259
Advanced Features 67, 87
ALT 29
Ant/Sat 109
Archiving 255
Audio 87
Audio Browser 88
Audio Grabber 87
Audio Interfacing
DM-780 162
Autospace 250
Auxiliary Switching 245

B
Band Layout Manager 53
Adding A Definition 54
Copying A Definition 55
Band Layout Selection 36
Band Layouts 53
Adding A Definition 54
Copying A Definition 55
Manager 53
Selecting 55
Band Selection 29
Bands
Logbook Table 256
BSP 29
Button
Connect 32
selection 32
Buttons 30
Radio Control 30
Radio Feature Control 31
Ttuning Control 31

C
CAT Command 39
CAT Commands 59
Macros 59
Manager 59
Clock Format 36
Clock Position 42
COM Port TX 48
Command Tester 235
Commands

Ham Radio Deluxe

INDEX

DDE Support 90
Commercial Interface Solutions
DM-780 163
Comms 47
Computer requirements
DM-780 159
Configuration
Customize Layout 37
Configuration Options 13
COM Port 17
Company 15
Connecting 18
Radio 16
Configuring DM-780 168
Connect 32
Connect Button 32
Connect Toolbar 32
Connecting to the Remote Server 77
Connection Process 15
Connections
DM-780 161
Contest 109
Contest Spacing 250
Controlling Your Radio’s Features 30
Buttons 30
Sliders 31
Countries
Logbook Table 256
Current Data 219
Customize Display 34
Customize Layout 37
Schemes 37

D
Database 99
Logbook 99, 256
Database Configuration 112
Date & Time 36
DDE 224
Satellite 224
DDE interface 5, 99
DDE Monitor 90
DDE Support 90
Commands 90
Dem-o-matic 13
Digital Master-780 159
Digital Modes
DM-780 190
Display
Buttons 41
Configuration
Buttons 41
Customize 37
Faceplate 42
Frequency 43

- May 15, 2014

Layout
Radio Layout
Configuration 38
Meters 44
Schemes 37
Slider Layout 45
Sliders 44
Tuning Dial 45
Customize 37
date & Time 36
Faceplate 42
Layout 38
Customize 37

Display Scroll 30
DM-780 1, 159

Audio Interfacing 162
Commercial Interface Solutions
163
Computer requirements 159
Configuring 168
Connections 161
Digital Modes 190
Full Screen Mode 187
Logging QSO 192
Macro Editor 202
Tool Layout 200
Macro Manager 200
Macro Toolbar 199
Macros
Adding Tags 203
Load Text from File 203
Options 203
Radio Control 205
Main Display Configuration 187
Main Window Tour 176
Multiple QSO Windows 188
New Macro Sets 201
Program Options Overview 166
QSO Window 172
Radio Panel 175
Receive Panel Toolbar 181
Soundcard Setup 170
Station Set Up 101, 169
SuperSweeper 175
Transmit Panel 177
Transmit Toolbar 178
Tuning Guides 183
Waterfall 174, 177
Color Options 184
Configuration 184
Frequency, Mode, Speed Tab
185
Options
Center Frequency Marker
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183
Weak Signal 186
Suggested schemes 184
Waterfall Toolbar 181
DM780 35
Toolbar 35
DM-780 Toolbar 172
DM-780 Tour 172
DM-780Getting Started 159
Docking panes 51
Drop Downs 31
Dropdown Button 39
Dropdowns 40, 43
Hiding 40
Dual Radio Satellite Tracking 94
DXLab 262
Dynamic Data Exchange 92

E

Enable Restart 76
eQSL 108

External IP Address 67

F
Faceplate 42
Favorite 33
Toolbar 33
Favorites 56
Manager 56
Markers 58
File Locations 254
Files 254
Fine Tuning 28
Firewall 68
Firewall Ports 68
Frequency Direct Entry 28
Frequency Display 35
Configuration 36
Enhanced Display 35
Frequency Selection 27
Frequency Selection 27
FTDX-9000 52
Full Screen 34
Toolbar 34

G

Getting Started 27
Griffin 28

Ground Control 213

H
HIPH 1
Ham Radio Deluxe
Links 262
Remote Server 70
Serial Port Client 80
Serial Port Server 83
HamLinkUSB 4
HB9DRV 1

Ham Radio Deluxe

Hide dropdowns 40
Hide status texts 40
Hiding dropdowns 40
HyperTerminal 95

|
ICOM Calibration 48
Icom CI-V Details 19
Import / Export Logbook Data 117
Insert Video ID 204
Installation 5
Internal IP Address 68
Internet 49
Internet Connection 3
IP Address
External 67
Internal 68
Static 68
IrfanView 89, 262

K

KIEL WinKey 248
Keplerian elements 209
Keyboard Accelerators 46

L
Layout Size 42
Links 262
Load from File 38
Logbok
eQSL 108
LogBook
Custom 110
Logbook 1, 34, 99
Add 34
Adding An Entry 105
Ant/Sat 109
Contact 107
Contest 109
Database 256
Database Configuration 112
Import / Export 117
Location 108
Logbook Table 257
Main Display 104
My Station 110
Options 106, 111
Printing 116
Propagation 109
QSL 108
Tables 256
ADIF 259
Bands 256
Countries 256
Logbook 257
Modes 259
QRZ 259
Toolbar 34
Logbook Add
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Toolbar 34

Logbook Database 99, 256

Logbook Problems 117
Logfile 253
Logging QSO

DM-780 192

M
Macro Editor 202
Macro Manager 200
Macro Toolbar 199
Macros 39, 59, 253
CAT Commands 59
Macros Manager 63
Main Display 104
Main Tuning 29
Main Window Tour
DM-780 176
Manager
Band Layout 53
CAT Commands 59
Favorites 56
Macros 63
Parallel Port 246
Marker
Quick Save
Size 59
Marker Size
Favorites 58
Quick Save 59
Markers 58
Favorites 58
Show 58
Size 58
QuickSave 59
Show 59
Menu Bar 32
Menus and Toolbars 31
Mode 36, 39
mode 35
Mode Selection 30
Modes
Logbook Table 259
Supersweeper 195
Monitor
Parallel Port 248
Mouse Wheel 28, 50
MP3 Player Options 89

Multiple QSO Windows 188

Mutual Visibility 220
My Station 110

N

N8VB 243

N8VB vCOM 243
New Tab 14

Next Passes 222
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O

Observer 212

ODBC driver 99

Options 34
Logbook 111

Out Of Band 49

P
Paddle Echoback 250
Paddle Watchdog 250
Parallel Port 245
Parallel Port Manager 246
Parallel Port Monitor 248
Passing Audio 85
Plot 223
Port 7805
Firewall 68
Port 7806
Firewall 68
Portmon 241
Preset Tab 14
Printing Logbook 116
Product Activation 9
Program Options 34, 46
Band Layouts 53
Com Port TX 48
Comms 47
ICOM Calibration 48
Internet 49
Keyboard Accelerators 46
Mouse Wheel 50
Out of Band 49
Selection Window 50
Themes 51
Toolbar 34
Updates 52
Yaesu 52
Program Options Overview
DM-780 166
Propagation 109
Prosign Assignments 254
Protocols 61
PSK Bandwith 177
Public Interfaces 5

Q
QRZ 259
Logbook Table 259
QRZ Lookup 106
QRZ.com 106
QSL 108
QSO Connection 197
Quick Save 34, 59
Markers 59
Toolbar 34
Quick Save Entry 59
Quick Save markers 34

Ham Radio Deluxe

R
Radio Control
Sliders 31
Radio Control Macros 205
Radio Feature Control
Buttons 31
Radio Interfacing 3
Radio Macros 183
Radio Panel
DM-780 175
Radio’s Features 30
Raio Control
Buttons 30
Receive Panel Toolbar 181
Record 87
Reed-Solomon IDs 204
Refresh 91
Registration 9
Registry Settings 254
Remote Audio 85
Remote Connection 79
Remote Port Settings 81
Remote Radio Control 67
Serial Port Server 67
Remote Server 67, 70
Remote server connection 77
Remote Station Control
Remote Server 67
Remote Station Support 67
Rig Control 1
Rotator 1

S
Satellite
Current Data 219
DDE 224
Ground Control 213
Mutual Visibility 220
Next Passes 222
Plot 223
Schedule 219
Single Pass 222
Visibility 221
Satellite Observer 212
Satellite Tracking 1, 209
Satellites 34, 209
Sattelites
Toolbar 34
Save as File 38
Schedule 219
Selection 32
Toolbar 32
Selection button 32
Selection Window 50
Serial Echoback 251
Serial Port Client 80
Serial Port Server 67, 83
Serial Ports Tab 15
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Set Button 91
Set Dropdown 91
Set Frequency 91
Set Mode 91
Settings 254
Registry 254
Shortwave Database 34
Show Markers
Favorites 58
Quick Save 59
Single Pass 222
Skype 85
Sliders 34
Appearance 44
Layout 45
Radio Control 31
Toolbar 34
Snapshots 66
Soundcard Setup
DM-780 170
Speeds 251
Sstatus Text
Hiding 40
Static IP address 68
Station Set Up
DM-780 101, 169
Status Window 42
SuperSweeper 175, 195
Modes 195
QSO Connection 197
SuperSweeper Display 195
SuperSweeper Tabs 195
Supported Radios 3
SW Data 34
Swap Paddles 250
Synchroniser 92
System Requirements 2
Computer 2
Internet Connection 3
Public Interfaces 5
Radio Interfacing 3
Supported Radios 3

T
Tables
Logbook 256
TeraTerm 95
The Connection Process 15
The Preset Tab 14
Tigertronics 4, 163
Timewave 4, 163
Toolbar 32
Connect 32
Customize Display 34
Digital Master 780 35
DM780 35
Favorite 33
Full Screen 34
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Logbook 34
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